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Publication Information 
© 2024 Imagine Communications Corp.  

     Proprietary and Confidential. 

Imagine Communications considers this document and its contents to be proprietary and confidential.  
Except for making a reasonable number of copies for your own internal use, you may not reproduce this 
publication, or any part thereof, in any form, by any method, for any purpose, or in any language other 
than English without the written consent of Imagine Communications. All other uses are illegal. 

This publication is designed to assist in the use of the product as it exists on the date of publication of 
this manual, and may not reflect the product at the current time or an unknown time in the future. This 
publication does not in any way warrant description accuracy or guarantee the use for the product to 
which it refers. Imagine Communications reserves the right, without notice to make such changes in 
equipment, design, specifications, components, or documentation as progress may warrant to improve 
the performance of the product. 

Imagine continues to strive for accessibility and is committed to making sure that electronic files are 
accessible for all customers. Please feel free to email mailto:support@imaginecommunications.com if 
you experience any difficulty in accessing these materials. 
 

Trademarks 

Selenio™ and SNP™ are trademarks or trade names of Imagine Communications or its subsidiaries.  

Microsoft® and Windows® are registered trademarks of Microsoft Corporation. All other trademarks and 
trade names are the property of their respective companies. 
 

DTS Copyright 

When keyed with the SNP-ASK-DTOKEN feature keys, this product includes software technologies 
licensed from DTS Technologies, specifically including the DTS Neural upmix, downmix, and multimerge 
algorithms.  These algorithms and their implementation herein are subject to U.S. and other patent 
protections.  

 

 

 
 

Dolby E Copyright 

When keyed with the SNP-ASK-DEE or SNP-ASK-DED feature keys, SNP includes software technologies 
licensed from Dolby Laboratories, specifically Dolby E Encoding and Decoding.  
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Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 
Dolby Laboratories. Copyright 1998–2008 Dolby Laboratories. All rights reserved. 

 
 

intoPix Copyright 

When keyed with the SNP-PSK-JXSE or SNP-PSK-JXSD feature key, this product includes JPEG XS 
compliant features that are covered by patents in the United States and in other jurisdictions owned by 
intoPIX SA (“intoPIX”) and/or Fraunhofer-Gesellschaft zur Foerderung der angewandten Forschung E.V. 
(“Fraunhofer”) and listed at www.jpegxspool.com. Additional patents may be pending in United States 
and elsewhere. In addition, when keyed for it, this product incorporates JPEG XS implementation 
technology licensed from IntoPIX Technologies SA 

 

 

 
 

Contact Information 

Imagine Communications has office locations around the world. For domestic and international location 
and contact information, visit our Contact page (https://www.imaginecommunications.com/contact). 
 

Support Contact Information 

For domestic and international support contact information see:  

• Support & Customer Community Portal (https://community.imaginecommunications.com/s/) 

• Worldwide Support e-mail (mailto:support@imaginecommunications.com) 

• Warranty & Contract Information (https://www.imaginecommunications.com/services/customer-
care) 

• Imagine Communications Training (https://imaginecommunications.com/services/training/) 

 

https://www.imaginecommunications.com/contact
https://community.imaginecommunications.com/s/
mailto:support@imaginecommunications.com
https://www.imaginecommunications.com/services/customer-care
https://www.imaginecommunications.com/services/customer-care
https://imaginecommunications.com/services/training/
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Preface 

Manual Information 

Purpose 

This manual provides information about the Selenio™ Network Processor. 
 

Audience 

This manual is written for engineers, technicians, and operators responsible for installation, setup, 
maintenance, and operation of the  Selenio™ Network Processor. 
 

Revision History 
Edition Date Revision History 

1.0 December 2017 Initial Release 

1.1  September 2018 New features/content:  

• Configuring a Section for HD or UHD (on page 116) 

• Configuring Proxy Output (on page 261) 

• Configuring a Dual Conversion Personality (on page 135) 

• Configuring a Remap Personality (on page 133) 

• Low Latency; see Configuring a Processor (on page 113) 

Updates to List of Alarms (on page 109) and Configuring Processors 
(on page 112) 

Corrections to Using Magellan Control System with SNP (on page 332) 

1.1.1 October 2018 HDR changes included in Video Tab: Color Adjustment (on page 415).  

Updates to specifications.  

1.1.2 December 2018 New features/content:  

• Initial support for ST 2022-6 Tx  

• PTP locking with black burst assist  

• 12G HD-BNC I/O support  
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Edition Date Revision History 

1.2 May 2019 New features: 

• ST 2022-6 support 

• HDR support  

• Addition of SNP-GW-3GX32-HS-QF frame  
with hot-swappable power supplies 

• 1080p23.98 and 1080psf23.98 

• NMOS IS-04/IS-05 initial implementation 

1.3 September 2019 New features: 

• Configure Local Host - Password Control (on page 103) 

• Local SNP Manager; see Using the SNP Manager Interface (on page 
62) 

• NMOS full support; see NMOS (on page 369) 

• Additional supported QSFPs; see Orderable Part Numbers (on page 
35) 

• Support for 2110-40 in Conversion mode; see Ancillary Data IP 
Filter (Conversion Mode) (on page 463) 

• Dolby E alignment; see Audio Tab: General Configuration (on page 
449) 

1.4 December 2019 New features: 

• Multiviewer Personality 

• MADI support; MADI Support (on page 293) 

• Clean switching for untimed/phased signals; see Input Tab: IP Video 
Configuration (on page 389) 

• 12G optical and coaxial  VSFP support; see Video/Audio Expansion 
Interface Supported SFPs (on page 39) 

• Video Tab: On Screen Display (on page 419)  

• License Management (on page 381): licenses are listed in Licensing 
and Ordering (on page 34) 

• Sharpness controls; see Video Tab: Scaler Configuration (on page 
419)  

• Improved ranges for Black and white Gain and clip levels; see Video 
Tab: Color Adjustment (on page 415) 

1.4.1 December 2019 New content:  

• Configuring a Multiviewer Personality (on page 237) 

1.4.3 February 2020 • Updates to features: 

• QSFP descriptions  

• FEC  

• License support  
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Edition Date Revision History 

1.5 April 2020 • Added the following parameters to the Multiviwer Personality 
Configuration: 

• Enable 9th Receiver  

• Display Colorimetry and TCS  

• Decimation Filter Sharpness 

• Force MAB Mode 

See Configure a Multiviewer Personality (on page 240) 

• Documented the remote user credentials. See Add Element (on 
page 85) 

• Added a note about number of PiPs exceeding the number of ports. 
See Configuring a Multiviewer Personality (on page 237). 

• Support for asynchronous clean switching. See Input Tab: IP Video 
Configuration (on page 389) 

• Color Processing Features 

• When configuring an element, new HDR Gain parameters are 
available for mapping when converting between SDR and HDR. 
See HDR Matching White Gain (on page 363) 

• When configuring programs, in the Video tab, the Color 
Correction section is now called Color Adjustment, with 3 sub 
sections. See Video Tab: Color Adjustment (on page 415). 

• A new Return to Neutral button lets you reset Color Correction 
settings to default. See Video Tab: Color Adjustment (on page 
415). 

• Mapping Mode now lets you select Scene Referred in addition to 
Display Referred. See Video Tab: Color Adjustment (on page 
415). 

• TSL5 configuration recommendation for SNP-MV. For instructions, 
see TSL5 Configuration (on page 238) 

• Restructured the Servicing section. See Servicing (on page 535) 

• Added Fan Replacement Instructions. See: 

• Replacing the IP Fan on SNP-GW-3GX32-HS-QF (on page 544) 

• Replacing the BB Fans on SNP-GW-3GX32-HS-QF (on page 557) 

• New SNP Management Tab when configuring an Element. Contains 
items previously on the IP Wan tab. See SNP Management (on page 
368) 



Selenio™ Network Processor 

User Guide  Preface 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 16 

 

Edition Date Revision History 

1.6 August 2020 • Quad Conversion Personality. See Configuring a Quad Conversion 
Personality (on page 141) 

• Support for SDI inputs and outputs, without the need for IP domain 
connectivity. See SDI Inputs to SDI Outputs within a Program (on 
page 253) 

• Support for SNP running as a master or a slave. See Configuring a 
PTP Network (on page 485) and see new Master parameters 
Configuring Reference for SNP - PTP (on page 351) 

• Support for connecting two SNPs using master slave technology 
without the need for a switch. See Synchronous SDI Point to Point 

• Updates to Recovering from a Firmware Upgrade Failure (on page 
96) 

• Updates to Input Tab: IP Audio Routing (on page 394) in the 
Configuring Programs section 

• Edits to the working with SDNO section including new logical 
templates that replace device names in SDNO 3.0. See Using 
Magellan Control System with SNP (on page 332) 

• Support for SD 

• See Support for SD over 2110 (on page 309) 

• Updated list of features to reflect support. See Main Features (on 
page 27) 

• Added the following status parameters that apply in case of SD-
SDI Input: EDH Present, AP EDH Errors, FF EDH Errors, Clear EDH 
Errors. See Input Tab (SDI): Video Status (on page 400). 

• Front Fan Replacement Instructions. See Replacing the FP Fan on 
SNP-GW-3GX32-HS-QF (on page 574) 

• Updates to the list of features. See Main Features (on page 27) 

• Updates to License Keys: 

• Added SNP-SK-QUAD-3GCONV. See Licensing and Ordering (on 
page 34) 

• Updates to the License Management dialog to apply licenses by 
processor. See License Management (on page 44) 

• Ability to name an SNP Unit. See Naming your SNP (on page 65) 

• Edits to Configuring HDR conversion  (on page 263) 

• Note about Programs Ancillary Data Configuration that applies to 
Dual and Quad Conversions. See Programs Ancillary Data 
Configuration (on page 139) 

• Edits to Input Colorimetry and TCS for SDI and IP Input 

• IP Input: Input Tab: IP Video Configuration (on page 389) 

• SDI Input: Input Tab (SDI): Video Configuration (on page 400) 

• MADI Licensing applies to Sync and Remap personalities. See 
Configuring MADI 
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Edition Date Revision History 

1.7 February 2021 • Edits to Configuring Reference for SNP - PTP (on page 351) 

• Support for Masterclock Devices. See Masterclock Devices (on page 
373) 

• Portrait Mode. See Configuring a Multiviewer Portrait Mode 
Personality (on page 250) 

• Color Processing, 3D LUTs. See Color Processing - Built In and 
Custom LUTs (on page 264) 

• Note about restoring factory defaults. See Configure Local Host - 
System Control (on page 99) 

• Edits and notes added to various sections (Features, Licensing, 
Quad Conversion, MADI Configuration, etc.) to note that MADI only 
applies to Sync and Remap personalities. 

• Additional Arista QSFP part numbers. See DATA QSFPs (on page 39) 

• LRC Routing Support to force routes when layouts are recalled. See 
LRC Routing (on page 273) 

• Edits to Configuring a Section for HD or UHD (on page 116) 

• List of supported process combinations on the Conversion 
Personality. See Supported Combinations (on page 136) 

• Edits to electrical specifications. See 12G/6G/3G/HD/SD-SDI Input 
Specifications (on page 510) and 12G/6G/3G/HD/SD-SDI Output 
Specifications (on page 512) 

• Updates to the list of UDP/TCP used by SNP. See UDP/TCP Ports (on 
page 102) 

• Note about license assignments via the REST API. See Acquiring 
Licenses (on page 381) 

• Updates to Licensing and Ordering information to reflect the SNP's 
shift to a new model of ordering, separating the base unit from the 
feature keys. See Licensing and Ordering (on page 34) 

• Information about SDI Input/Output Assignments. See SDI 
Input/Output Assignments (on page 253) 

• Added details about the LMMonitor default user. See Users (on 
page 68) 

• Updated the Proxy Output section to add information about proxy 
output in the Multiviewer personality. See Configuring Proxy 
Output (on page 261) 

2.0 October 2021 • Automatic Change Over (ACO) on the Sync Personality (on page 
124) 

• New Stat Personality. See Configuring a Simple Transparent 
Asynchronous Transport (STAT) Personality (on page 179) 

• (Preview Feature) New JPEG-XS Personality. See Configuring a 
JPEG-XS Personality (on page 146) 

• (Preview Feature) New Master Control Lite Personality. See Master 
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Edition Date Revision History 

Control Lite (MCL) Personality (on page 186) 

• Support for multi-unit cascading. See Multi-Unit Cascading (on page 
473) 

• New licensable features and updates to Licensing Information. See 
Orderable Part Numbers (on page 35) 

• System Logging. See Configure Local Host - System Logging Control 
(on page 100) 

• Custom hostnames for the SNP. See DNS (on page 357) 

• Unit Tag/Name for the SNP. See Naming your SNP (on page 65) 

• DHCP Support. See Using DHCP with your SNP (on page 466) 

• New option to have the SNP discoverable by Magellan RCP Control 
Panels. See Security (on page 368) ( Configure Element > System 
Tab) 

• Updates to the list of Data QSFPs. See DATA QSFPs (on page 39) 

• Updates to Licensing Information. See Ordering Information (on 
page 35) 

• Renamed Control Source ID to Device ID. See Masterclock Devices 
(on page 373) 

• Updates to the Packing Mode parameter (Output Tab, IP Video 
Configuration) to add an additional option. See Output Tab: IP 
Video Configuration (on page 454)  

• Updates to the Grandmaster UUID and Clock Identity parameter 
descriptions per the UI. See Configuring Reference for SNP - PTP 
(on page 351) 

• Updates to the Mapping Mode parameter. See Video Tab: Color 
Adjustment (on page 415) 

• Added Primary/Secondary Largest measured IGMP Leave and 
Primary/Secondary Largest measured IGMP Join status parameters. 
See Configuring IP Control for SNP  (on page 359) 

• Added new section "HDR Mapping Mode Defaults" in Configure 
Element > System Tab. See HDR Mapping Mode Defaults (on page 
363) 

• Note about SQD In to SQD Out not supported in the Sync 
personality. See Sync Personality and Configuring a Sync Personality 
(on page 120) 

• Support for 16 channels of audio. See Main Features (on page 27) 
and see updates to the Audio IP Tx Packet Time parameter 
(Configuring a Processor (on page 113)) 

• Note about the SFP+HDMI20+OUT+CAB SFP. See Video/Audio 
Expansion Interface Supported SFPs (on page 39) 
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Edition Date Revision History 

2.0.3 March 2022 • Advanced Audio Processing. See: 

• Configuring AAP (on page 379) 

• Advanced Audio Processing (on page 275) 

2.1 GA July 2022 • Advanced Audio Processing Updates 

• Support for MultiMerge. See DTS Neural MultiMerge (on page 
280) 

• MultiMerge Parameters. See AAP Tab: Parameters (MultiMerge) 
(on page 432) 

• Support for Loudness Control DTS Neural Loudness Control (on 
page 281) 

• Loudness Control parameters. See AAP Tab: Parameters 
(Loudness Control) (on page 435) 

• Added Combination codecs. See DTS Processing (on page 277) 

• Updated credits required for AAP processing. See DTS Credits (on 
page 289) 

• Updates to JPEG-XS support. See Configuring a JPEG-XS Personality 
(on page 146) 

• 8K Clean switching. See Support for 8K Clean Switching using IP (on 
page 315). 

• Updates to field replaceable power supplies Field Replaceable 
Spares (on page 43) 

• Removed the Collect SFP Power Stats button from the SFP status 
section in the System tab. See SFP Status (on page 365). 

• Added Chroma Anti-Alias parameter to Video Tab, Color 
Adjustment. See Video Tab: Color Adjustment (on page 415) 

• Support for SMPTE ST 2031 subtitles. See Subtitles on the SNP (on 
page 306). 

• JPEG-XS Encoder personality does not support Dolby E. See Audio 
Tab: General Configuration (on page 449) for Audio tab 
parameters, and JPEG-XS Encoding (on page 148). 

• SSH is now enabled by default. See Configure Local Host - System 
Service Control (on page 102) 

• Updated list of QSFPs. See DATA QSFPs (on page 39) 

• List of other supported QSFPs and cables. See Other Supported 
QSFPs and Cables (on page 41) 

• Added notes to the Force MAB mode and Low Latency Mode 
parameters. See Configuring a Processor (on page 113). 

2.1.2 LTD September 2022 • Support for Daktronics Scoreboards (on page 318) 

• Support for VPID information into the ST2110-40 ancillary stream 
output (on page 326) 

2.2 GA August 2023 • MCL Hardware Panel (on page 489) 



Selenio™ Network Processor 

User Guide  Preface 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 20 

 

Edition Date Revision History 

• Support for PTP, NTP, and UTC. See Time Sources (on page 484). 
Also see Interaction and Precedence across Configured Time 
Sources (PTP, NTP, and UTC) (on page 486) 

• Updates to the Console view, including new sections like CCSP 
Interface Documentation, Export Settings and Data, Import Settings 
and Data, etc. See Console (on page 91). 

• Note added to to the SSH section in the Console. See Configure 
Local Host - System Service Control (on page 102) 

• Output Tab: Program Ancillary Data Configuration (on page 459) 
settings in the Output tab for Conversion personalities. 

• New Parameters and Settings: 

• New parameter section under Configure > Element > System 

• Timecode Jamsync (on page 363) 

• Date and Time (on page 368) 

• New parameter (Input Tab) that allows IP Receivers to display 
signal status. See Input Tab: Clock Domain Status (on page 389) 

• Bouncing Box option available in the Video tab > Test Signal 
Generator of a Processor set to the Sync personality. See Video 
Tab: Test Signal Generator (on page 411) 

• Ability to set a custom program name. See Input Tab (SDI): 
Program Name (on page 399) and Input Tab: Program Name (on 
page 387) 

• New SDP Channel-Order parameter in the Output tab > IP Audio 
Configuration section. See Output Tab: IP Audio Configuration 
(on page 457) 

• Ability to receive and transmit IP 500 ms packet time (in addition 
to previously supported options). See the Packet Time parameter 
in Output Tab: IP Audio Configuration (on page 457) and Input 
Tab: IP Audio Status (on page 395) 

• Updates to the Audio IP Tx Packet Time parameter. See 
Configuring a Processor (on page 113). 

• New Packet time parameter (to define packet time at a stream 
level) in the Output Tab > IP Audio Configuration. See Output 
Tab: IP Audio Configuration (on page 457), allowing a mix of 
packet times at the processor and stream level. 

• ANC ATC Present parameter in the Program Ancillary Data Status 
(Input tab) for Conversion personalities. See Input Tab: Ancillary 
Data Status (on page 397) 

• For dual/quad conversion, in case of 1080p-to-1080i, a lower 
range is now supported for the horizontal and vertical BW 
parameters. See Video Tab: Scaler Configuration (on page 419) 

• Updated Playout Delay Parameter. See Configuring IP Control for 
SNP  (on page 359) 
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Edition Date Revision History 

• Updates to Ordering Information. See Orderable Part Numbers (on 
page 35). 

• Support for Dolby E Encoding and Decoding. See Dolby E Processing 
(on page 285) 

• Information when setting up RC 500/600 Masterclocks. See 
Masterclock Devices (on page 373) 

• Support for Generation and Processing of ATC Timecode in 
Conversion (on page 487) 

• Updates to the list of ports. See UDP/TCP Ports (on page 102) 

• MCL Updates 

2.2.3 LTD December 2023 • Updates to DTS Credits (on page 289) and Dolby E Credits (on page 
289) 

• Added a note to the Low Latency section in Configuring a Processor 
(on page 113) 

• Added a note about TSG in the STAT Personality. See STAT with SDI 
Input (on page 180). 

• Source ID Processing (on page 329) 

• Ability to set a background color for audio meters. See Configure a 
Multiviewer Personality (on page 240) 

• Support for Image Video (UMD Devices) (on page 370) 

• TSL V5 devices are now UMD Devices. See TSL V5 (UMD Devices) 
(on page 369) 

• Additional options added to the Loss of Video parameter. See Video 
Tab: Output (on page 407) 

• The Dual Conversion personality now provide copies of the main 
program on BNC 2, 3 and 4 for HD output. See BNC Output (on 
page 140). 

• On the Multiviewer personality, support for setting the Audio 
Meter Background Color and Audio Meter Scale Color parameters. 
See Configure a Multiviewer Personality (on page 240). 

• Added a note about the max playout delay. See Configuring IP 
Control for SNP  (on page 359). 

3.0 GA April 2024 • SNP-XL Hardware: 

• Front Panel (on page 52) 

• Back Panel (on page 53) 

• Relay Expansion Board Signaling (on page 54) 

• SNP-XL Ordering Information: 

• Orderable Part Numbers (on page 35) 

• SNP-XL Hardware Parameters: 

• Chassis and Board status. See Miscellaneous Status  (on page 
367) 
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Edition Date Revision History 

• Updates to the Console page for XL. See System Information (on 
page 92) 

• RTC time. See Configuring Reference for SNP (XL only) - RTC (on 
page 354) 

• SFP Tx and Rx Status. See SFP Rx/Tx Status (SNP-XL only) (on 
page 365) 

• New Dual Gateway Personality.  

• See Configuring a Dual Gateway Personality (on page 157). 

• QSFP Updates 

• Updates to DATA QSFPs (on page 39) and Other Supported 
QSFPs and Cables (on page 41) 

• Power Supply Updates 
See Field Replaceable Spares (on page 43) and Servicing (on page 
535) 

• Upgrade Failure Updates 

• Updates to Recovering from a Firmware Upgrade Failure (on 
page 96). 

• Parameter Updates: 

• Changed an option name for the Clock Domain Next Switch 
Stream parameter. See Input Tab: Clock Domain Next Switch 
Stream (on page 388) 

• Modified Input Tab: Ancillary Data Status (on page 397) to add 
Source ID and Brandnet. 

• Added 2 missing formats (1080p/24, 1080psf/24) to Configuring 
a Section for HD or UHD (on page 116) 

• Updates to the Daylight Savings Time setting description. See 
Date and Time (on page 368) 

• Updated Channel Gain/Invert/Mute parameters in Audio Tab: 
Output Channel Configuration (on page 450) with a note. 

• Added new Generate SSRC ID parameter. See Configuring IP 
Control for SNP 

• Updates to Security. 

• Dolby E Updates 

• Dolby E Encoder Latency (on page 286) and Dolby E Decoder 
Latency (on page 286) 

• Dolby E A/V Align parameter. See Video Tab: Video Control (on 
page 405) 

• Additional Multi-Unit Cascading examples including 2/3/4 unit 
configuration. See: 

• Cascade Concept/Example Using BNC Connections (on page 477) 

• Cascade Concept/Example Using SFP Connections (on page 479) 

• 2 Unit Cascade Layout Configuration (on page 480) 
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Edition Date Revision History 

• 3 Unit Cascade Layout Configuration (on page 481) 

• 4 Unit Cascade Layout Configuration (on page 481) 
 

• Graphics Prep Tool 
Support for running the tool via command line. See Running the 
Graphics Prep tool via Command Line (on page 227) 

• MCL Updates: 

• Support for defining Audio channel mixer assignment per Keyer 
Layer. See the MCL Audio configuration section in MCL 
Configuration (on page 211). 

• Updates to the source select parameter options for the MCL 
Hardware Panel. See MCL Hardware Panel Buttons (on page 
496). 

• Updates to Clean Feed Outputs. See Clean Feed Outputs (on 
page 214). 

• Updates to options for the Keyer button on the MCL Hardware 
Panel. See MCL Hardware Panel Buttons (on page 496). 

• Information on Max Frame Delay per personality. See Video Tab: 
Video Control (on page 405). 

• Updates to QSFP Status (on page 363) to add a note. 

• Updates to AAP Functions supported on various personalities. See 
Functions supported on various Personalities (on page 275) 

• Note about Proxy 3G output on the TR-07 and TR-08 Encoder. See: 

• JPEG-XS Encoder (on page 147), TR-07 Encoder (on page 167), 
Configuring Proxy Output (on page 261). 

 

Writing Conventions 

This manual adheres to the following writing conventions. 

Term or 
Convention 

Description 

Bold Indicates dialog box, property sheet, field, button, check box, list box, combo box, menu, 
submenu, window, list, and selection names 

Italics Indicates email addresses, names of books and publications, and first instances of new 
terms and specialized words that need emphasis 

CAPS Indicates a specific key on the keyboard, such as ENTER, TAB, CTRL, ALT, DELETE 

Code Indicates variables or command-line entries, such as a DOS entry or something you type 
into a field. 

> Indicates the direction of navigation through a hierarchy of menus and windows. 

hyperlink Indicates a jump to another location within the electronic document or elsewhere (in 
PDFs, click the page number to make the jump) 
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Term or 
Convention 

Description 

Internet 
address 

Indicates a jump to a Web site or URL 

Note 
Indicates important information that helps to avoid and troubleshoot problems 

 

 

Obtaining Documents 

Contact your Customer Service representative to request a document. 
 

Unpacking/Shipping Information 
This product was carefully inspected, tested, and calibrated before shipment to ensure years of stable 
and trouble-free operation. 

1. Check equipment for any visible damage that may have occurred during transit. 

2. Confirm that you have received all items listed on the packing list. 

3. Contact your dealer if any item on the packing list is missing. 

4. Contact the carrier if any item is damaged. 

5. Remove all packaging material from the product and its associated components before you install 
the unit. 

Keep at least one set of original packaging, in the event that you need to return a product for servicing. 

In the unlikely event that your product fails to operate properly, please contact Customer Service to 
obtain a Return Authorization (RA) number, then send the unit back for servicing. 

If the original package is not available, you can supply your own packaging as long as it meets the 
following criteria: 

• The packaging must be able to withstand the product’s weight. 

• The product must be held rigid within the packaging. 

• There must be at least 2 in. (5 cm) of space between the product and the container. 

• The corners of the product must be protected. 

Ship products back to us for servicing prepaid and, if possible, in the original packaging material. If the 
product is still within the warranty period, we will return the product prepaid after servicing. 
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Safety Standards and Compliances 
See the fiber optic section for information about the safe use of fiber optic products.  

WARNING: This equipment is not suitable for use in locations where children are likely to be present. 
 

Restrictions on Hazardous Substances (RoHS) 

Directive 2011/65/EU (ROHS2)—commonly known as the European Union (EU) Restriction on Hazardous 
Substances (RoHS)—sets limits on the use of certain substances found in electrical and electronic 
equipment. The intent of this legislation is to reduce the amount of hazardous chemicals that may leach 
out of landfill sites or otherwise contaminate the environment during end-of-life recycling. The Directive 
took effect on July 1, 2006, and it refers to the following hazardous substances: 

• Lead (Pb) 

• Mercury (Hg) 

• Cadmium (Cd) 

• Hexavalent Chromium (Cr-V1) 

• Polybrominated Biphenyls (PBB) 

• Polybrominated Diphenyl Ethers (PBDE) 

According to this EU Directive, all products sold in the European Union are fully RoHS-compliant and 
"lead-free." (See our website for more information.) Spare parts supplied for the repair and upgrade of 
equipment sold before July 1, 2006 are exempt from the legislation. Equipment that complies with the 
EU directive are marked with a RoHS-compliant emblem, as shown. 

 

Figure 1: ROHS Compliance Symbol 

 

Waste from Electrical and Electronic Equipment (WEEE) 

The European Union (EU) Directive 2002/96/EC on Waste from Electrical and Electronic Equipment 
(WEEE) deals with the collection, treatment, recovery, and recycling of electrical and electronic waste 
products. The objective of the WEEE Directive is to assign the responsibility for the disposal of 
associated hazardous waste to either the producers or users of these products. Effective August 13, 
2005, producers or users are required to recycle electrical and electronic equipment at end of its useful 
life, and may not dispose of the equipment in landfills or by using other unapproved methods. (Some EU 
member states may have different deadlines.) 

In accordance with this EU Directive, companies selling electric or electronic devices in the EU will affix 
labels indicating that such products must be properly recycled. (See our website for more information.) 
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Contact your local sales representative for information on returning these products for recycling. 
Equipment that complies with the EU directive is marked with a WEEE-compliant emblem, as shown. 

 

Figure 2: WEEE Symbol 
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Introduction 
Selenio™ Network Processor (SNP) is the industry’s first pure-IP media processing platform. This high-
density, scalable platform enables media companies to seamlessly transition from SDI to all-IP networks, 
while adhering to the SMPTE ST 2022-6 and ST 2110 standards.  

SNP delivers the essential capabilities required in today’s complex production environments, including 
HD/3G/UHD up/down/cross conversion and color space adjustments including High Dynamic Range 
(HDR) adaptations and conversions. It also provides critical signal synchronization, supporting different 
signal types and formats for video production.   

SNP interoperates with Imagine’s other UHD- and IP-ready solutions, including the Versio™ cloud-native 
integrated playout platform and EPIC™ MV monitoring and control system, for a seamless end-to-end 
production workflow. 
 

SNP Variants 
The SNP is available as Standard or XL. Both variants share the same main board, power supplies, 
software releases, APIs and protocols, and the same feature licenses.  

The SNP-XL is the latest addition to the SNP line -- it extends the SNP family to cover more SDI-intensive 
applications including very high-density synchronizing gateway needs. The SNP-XL chassis has a different 
I/O board in the back that breaks out the inputs and outputs separately (64 HDBNC connectors, 32 in, 32 
out), enabling SDI inputs and outputs simultaneously. SNP-XL is a 2RU unit. The extra vertical space 
inside allows for lower-RPM fans that are significantly quieter than the standard SNP fans. Using the 
new Double-Density Gateway personality, the SNP-XL supports twice as many simple gateway ports per 
unit, significantly reducing the price per port in the IP gateway applications. 

Also see: 

• Standard SNP Hardware  (on page 47) 

• SNP-XL Hardware (on page 51) 
 

Main Features 
• ST 2110-20 Video 

• ST 2110-30 PCM Audio 

• ST 2110-31 AES3 Transparent Transport  

• ST 2110-40 Data  

• ST 2022-6 SDI over IP 

• ST 2022-7 Seamless protection switching of IP streams  

• ST 2022-8 Timing of ST 2022-6 streams in ST 2110 systems  

• ST 2110-22 Constant Bit-Rate Compressed Video over IP networks (e.g. JPEG-XS) 
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• NMOS IS-04 discovery and registration  

• NMOS IS-05 device connection management  

• UHD over single ST 2110-20 stream 

• UHD over 6G/12G-SDI or Quad-SDI (2SI and SQD)  

• HD/3G and UHD clean and quiet switching  

• Support for SD (480i & 576i) 

• Personalities: Dual Conversion, Quad Conversion, Sync, Remap, Multiviewer, Multiviewer Portrait 
Mode,  Simple Transparent Asynchronous Transport (STAT) Personality and JPEG-XS 
(Encoder/Decoder Personalities) 

• 4 independent processing blocks for various operations (synchronization, conversion, UHD remap of 
SQD/2SI)  

• Multiviewer provides on screen Alarms, Alerts, Indicators, Captions/Subtitles on PiP 

• IP to SDI, SDI to IP, IP to IP, SDI to SDI domain transfers 

• Frame synchronization to PTP with adjustable output phasing and delay  

• Video proc amp, frame delay, and color correction 

• Audio proc amp and delay adjustment 

• HD/3G/UHD up/down/cross conversion (licensed option)  

• HD Proxy (as separate 1080i/p ST 2110-20 stream) for UHD signal monitoring (licensed option)  

• SDR/HDR (HLG, PQ, S-Log3) conversion (licensed option)  

• Audio embedding and de-embedding between SDI, ST 2022-6, and ST 2110 

• Flexible channel support of audio IP streams  

• Support for 16-channel audio streams for input and output in ST2110-30 and -31 

▪ Up to 16 channels per stream  

▪ On input, the packet time is auto-detected (1ms or 125 microseconds)  

▪ On output, 125 microsecond packet time must be used for streams with more than 8 channels 
of ST2110-30 or 6 channels of ST2110-3 

• MADI Tx and Rx, including extraction of audio channels from the MADI streams for output as 2110-
30, and receipt of 2110-30 for output as MADI (Note: this is a licensed feature and it applies to Sync 
and Remap personalities) 

• Clean switching of synchronous 2110 signals 

• Clean switching of synchronous and asynchronous 2022-6 signals 

• Support for multi-unit cascading 

• System Logging Control with configurable (syslog compliant) logging levels plus the ability to use an 
External Syslog Server 

• DHCP and user-selectable hostname for the SNP 

• License management 

• On screen display  

• Sharpness controls  

• Basic frame rate conversion (add/drop frame) in Conversion personality 

• Preset save/recall 

• Generate Black Burst (BB) output synchronized to received PTP timing  

• Dual QSFP28 Flexible Ethernet up to 100GbE  
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• 32 HD-BNC (8 are 6G/12G capable) connectors for SDI I/O 

• Redundant power supplies in single assembly or hot-swappable independent units 

• Front serviceable main processing board and  power supply 

• Local License Server, Local Web UI, and Local REST API Server 

• Security Enhancements 
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SNP Personalities 
SNP features personalities that can be applied on a processor-by-processor basis. See SNP Personalities 
(on page 118). 
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Supported Formats 
SD/HD/3G Formats Sync Stat 2xUHD 

CONV 
4x1080p 
CONV 

JPEG XS 
TR-08 

JPEG XS 
TR-07 

SNP
MV 

MCL 
DSK 

 in out in out in out in out in out in out in both 

480x720@29i     - -        - 

up to 512x720@29i 
(VBI) 

    - -        - 

576x720@25i     - -        - 

up to 608x720@25i 
(VBI) 

    - -        - 

1280x720 @50p              - 

1280x720 @59p              - 

1920x1080 @25i               

1920x1080 @29i               

1920x1080 @2398p              - 

1920x1080 @2398psf      -  -      - 

1920x1080 @24p              - 

1920x1080 @24psf      -  -      - 

1920x1080 @25p              - 

1920x1080 @25psf - - - - - - - - - - - - - - 

1920x1080 @29p              - 

1920x1080 @29psf - - - - - - - - - - - - - - 

1920x1080 @50p               

1920x1080 @59p               
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3840 x 2160 UHD Video 
Formats 

 

SYNC REMAP 2xUHD CONV JPEG XS 
TR-08 

JPEG XS TR-
07 

SNP 
MV 

MCL 
DSK 

in out in out in out in out in out in both 

UHD@2398 s ingle-raster 2110            - 

UHD@2398 as 4x1080p 2SI            - 

UHD@2398 as 6G SDI            - 

UHD@2398 as 4x1080psf SQD            - 

UHD@2398 as 4x1080p SQD - -   1,2 1,2 - - - - - - 

UHD@24 single-raster 2110            - 

UHD@24 as 4x1080p 2SI            - 

UHD@24 as 6G SDI            - 

UHD@24 as 4x1080psf 2SI            - 

UHD@24 as 4x1080p SQD - -     1,2 1,2 - - - - - - 

UHD@25 single-raster 2110            - 

UHD@25 as 4x1080p 2SI            - 

UHD@25 as 6G SDI            - 

UHD@25 as 4x1080psf 2SI            - 

UHD@25 as 4x1080p SQD - -   1,2 1,2 - - - - - - 

UHD@2997 s ingle-raster 2110            - 

UHD@2997 as 4x1080p 2SI            - 

UHD@2997 as 6G SDI            - 

UHD@2997 as 4x1080psf 2SI            - 

UHD@2997 as 4x1080p SQD - -   1,2 1,2 - - - - - - 

UHD@50 s ingle-raster 2110             

UHD@50 as 4x1080p 2SI             

UHD@50 as 12G SDI             

UHD@50 as 4x1080p SQD - -   1,2 1,2 - - - - - - 

UHD@5994 single-raster 2110             

UHD@5994 as 4x1080p 2SI             

UHD@5994 as 12G SDI             
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UHD@5994 as 4x1080p SQD - -   1,2 1,2 - - - - - - 

Note 1: UHD CONV can input SQD and downconvert to HD, or upconvert HD into SQD, but not UHD-to-SQD or SQD-to-UHD 
 

Note 2: UHD CONV cannot input 2SI or 2110 UHD and output SQD, nor can it input SQD and output 2SI or 2110 UHD 
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Licensing and Ordering 
SNP 1.7 onwards enforces feature licensing. Ensure that you have license keys for the features you 
expect to use, and note that the basic “Sync” personality requires a license.   

Customers who purchased models SNP-GW-3GX32 or SNP-GW-3GX32-HS-QF are entitled to four SYNC 
personality keys (which includes both SYNC and REMAP) in addition to whatever other feature keys they 
purchased.  Customers who purchase the new SNP-PLATFORM-4A or SNP-PLATFORM-2AU base product 
must purchase explicit keys from the SNP-PSK-xxx family of licenses for any desired functionality.  

See Ordering Information (on page 35) and License Management (on page 44) for more information.  

Licensing Notes 

• Note that licenses are enforced, so ensure you have keys in place for the features you rely on 

• Look in the License Management page (see License Management (on page 44)) of the UI on each 
SNP unit to determine if the unit is already keyed for the features which you purchased with the unit 
(or subsequently). 

• Please contact Imagine Customer Support, to request license keys for previously shipped units which 
reflect any licensed features previously purchased, and to purchase any new feature licenses.  The 
service team will require the unit serial number in order to generate feature keys, and may need to 
know the original purchase order date or order number to confirm the feature purchases in our 
records in order to create the license feature keys.  

• Confirm that the licenses appear in the License Management page after applying the feature key. 

• Assign license tokens to the processors as needed, according to your system design. 

• These license key can be applied to the unit when running releases 1.5 or 1.6 so please take the time 
to get keys put onto your units before attempting to upgrade to release 1.7 or 2.0. 

• Note regarding the REMAP license: In release 1.7 and beyond, REMAP is enabled by the SNP-SK-
SYNC or SNP-PSK-SYNC license key.   
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Ordering Information 

The following items are always included as part of your shipment.  

Item Number  Quantity Description 

170-101718Q00 

or  

170-101403Q00 

1 Selenio Network Processor complete base frame assembly 

 

Selenio Network Processor with hot-swappable PSU complete base frame 
assembly 

158-100081Q00 1 Rear rack mount and cable support kit 

AC power cords  2 Includes region-specific plug 
 

 

Orderable Part Numbers 

SNP 1.7 onwards has shifted to a new model of ordering codes, which separates the base unit from the 
feature keys. The base unit has no features without keys.  The table below summarizes the relationship 
between old and new ordering information.  The old ordering codes have been discontinued, but 
Imagine order management will work with customers to identify the current orderable items to match 
the old codes. 

Processor Personality licenses can be applied to any processor within an SNP unit. They are tied to the 
serial number of the SNP unit.  The SNP keeps track of the number of simultaneous uses and checks that 
against the current entitlement. 

Note: The original SNP-GW-3GX32 chassis has been retired from sale.  The metal shell and front panel 
assembly and power supplies have been superseded entirely by the SNP-GW-3Gx32-HS-QF chassis, now 
sold under the SNP-PLATFORM-4A part number. The revised chassis features hot-swappable power 
supplies and higher-performance fans.  In addition, all SNP main boards (regardless of chassis) shipped 
after November 2019 have been fitted with additional airflow-guides on the main circuit board in order 
to improve the operating temperature environment on-board.   

 

Type Part Number Old Part Number Description 

Platform SNP-PLATFORM-XL Not Applicable SNP Platform BASE – HW Rev A – XL package  

• 64XHDBNC I/O - 4 application processors, central 
ST2110/20226 IP interfaces.  

• Includes operating software suitable for 
installation and configuration. 

• Requires additional Software keys (SNP-PSX-xxx) 
for additional functionality.  

• Redundant, Hot-Swappable Power Supplies 

Platform 

 

SNP-PLATFORM-4A SNP-GW-3GX32  

SNP-GW-3GX32-HS-QF 

SNP Platform Base - Hardware REV A  

• 4 Application Processors 

• Common ST2110/2022-6/2022-7 Interface 
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Type Part Number Old Part Number Description 

• Requires additional Software keys (SNP-PSX-xxx) 
for any functionality 

• Redundant, Hot-Swappable Power Supplies 

To get the same base functionality as the older GW-
3Gx32(-HS-QF) requires the SNP-PLATFORM-4A and 
four SNP-PSK-SYNC keys. 

SNP-PLAT-UPG-
2A4A 

Not Applicable SNP Platform Upgrade Key 

• Adds 2 Application Processors to an existing 
PLATFORM-2AU, creating the equivalent of 
PLATFORM-4A 

Hardware 

 

SNP-HW-MCLPNL Not Applicable SNP Hardware Control Panel  

• For Master Control Lite (MCL) Personality 

SNP-HW-SSD64GU Not Applicable SNP Hardware Upgrade Kit  

• 64 Gbyte SSD (replaces existing drive inside unit).  
Kit includes preformatted 64G Solid State Drive 
and installation instructions. 

Software SNP-PSK-SYNC Not Applicable SYNC/Remap/STAT: SNP Platform Software Key 

• Enables STAT, SYNC and REMAP AP Personalities,  
supporting eight (8) 1080P or two (2) UHD Frame 
Synchronizers, or supporting two UHD SQD/2SI 
REMAP functions 

• One Key per AP.  (MAX 4 PER SNP) 

• HDR Conversion or HD Downscale require 
additional related keys. 

 SNP-PSK-
2CONVUHD 

SNP-SK-DUAL-CONV Dual Conversion: SNP Platform Software Key  

• Enables DUAL-CONV AP personality, supporting 
two UHD conversions on one AP (Max 4 per SNP). 

• HDR Conversion or HD Downscale outputs require 
additional keys.   

• This Key alternately enables QUAD-3GCONV 
personality. 

 SNP-PSK-4CONV3G SNP-SK-QUAD-CONV3G Quad Conversion: SNP Platform Software Key  

• Enables QUAD-3GCONV AP personality, 
supporting four 1080P conversions on one AP 
(Max 4 keys per SNP) 

• HDR Conversion requires additional related key. 
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Type Part Number Old Part Number Description 

 SNP-PSK-MV SNP-SK-MV Multiviewer: SNP Platform Software Key 

• Enables MV (and MV-PORT) AP Personalities 
supporting two Landscape (or one portrait) UHD-
output multiviewer. 

• HD downscale output is included (does not 
require the PSK-DOWNHD key).    

• One Key per multiviewer AP.  (MAX 4 PER SNP).  

• HDR Conversion requires additional HDR key. 

 SNP-PSK-JXSE Not Applicable JPEG-XS Encoding: SNP Platform Software Key 

• Enables JXSE AP personality, supporting eight 
1080p or two 2160p JPEG-XS Encodes to ST2110-
22 output (Max 4 keys per SNP) 

• HD Proxy requires additional related key. 

Note: With the purchase of the optional software 
license/key for JPEG-XS encoding or decoding, 
Imagine Communications pays the applicable license 
fee into the JPEG-XS PPL patent portfolio license 
pool, covering use of the device within the context of 
television "Broadcast Industry" infrastructure.   

 SNP-PSK-JXSD  • JPEG-XS Decoding: SNP Platform Software Key 

• Enables JXSD AP personality, supporting eight 
1080p or two 2160p JPEG-XS Decodes from 
ST2110-22 input (Max 4 keys per SNP).  

• HD Proxy requires additional related key 

 SNP-PSK-HDR SNP-SK-HDR SNP Add-On Feature Key  

• Adds HDR Conversion and Adjustment to Sync, 
Remap, MV, Dual-Conversion, or Quad-
Conversion AP 

• Max 4 per SNP.   

 SNP-PSK-DOWNHD SNP-SK-PROXHD SNP Add-On Feature Key 

• Adds output of two HD-Downscaled streams to 
Sync, Remap, or Dual-Conversion AP 

• Max 4 per SNP 

 SNP-PSK-MADIEXP SNP-SK-DUAL-MADI SNP Add-On Feature Key  

• Adds 128 additional audio channels to Sync or 
Remap AP 

• Max 4 per SNP 

• MADI SFPs sold separately 

 SNP-PSK-ACO Not Applicable SNP Add-On Feature Key  

• Adds 4xHD or 1xUHD Automatic Change-Over 
Switching feature to one Sync AP. Max 4 per SNP. 
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Type Part Number Old Part Number Description 

 SNP-PSK-ADVAUD Not Applicable SNP Add-On Feature Key  

• Enables Advanced Audio Processing  
(One per SNP). Requires additional keys for 
specific features. 

 SNP-PSK-MCL Not Applicable SNP Add-On Feature Key  

• Enables 1080P Master Control Branding 
personality, supports AB inputs, Background 
Mixer, 3x KeyFill inputs, 4x internal graphics on 
one AP (Max 4 per SNP). HDR aware. 

 SNP-PSK-MCLU Not Applicable SNP Add-On Feature Key  

• Enables 2160P Master Control Branding 
personality, supports AB inputs, Background 
Mixer, 2x internal graphics on one AP (Max 4 per 
SNP). HDR aware. This key also enables PSK-MCL 
functionality. External Key/Fill requires adjacent 
PSK-SYNC processor(s). HD Proxy requires 
additional related key. 

 SNP-ASK-DTOKEN Not Applicable SNP Add-On Feature Key  

• Adds tokens for Advanced Audio Processing 
functions (DTS). One Software key token for D-
CLASS PCM algorithms. 

 SNP-ASK-DEE Not Applicable SNP Add-On Feature Key  

• Audio Software Key - Enables one Dolby E 
Encoding Process  

 SNP-ASK-DED Not Applicable SNP Add-On Feature Key  

• Audio Software Key - Enables one Dolby E 
Decoding Process 

 SNP-PSK-GW88 Not Applicable 
SNP Add-On Feature Key  

• Enables Bi-Directional Gateway Personality 
supporting eight (8) 1080P or two (2) UHD 
Synchronizing Gateways in each direction (SDI-to-
2110 and 2110-to-SDI) at the same time 

• One key per AP (Max 4 per SNP) 

• HD Proxy requires additional related key 

• Does not support ST2022-6 
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DATA QSFPs 

Note: These are #3 on the Back Panel Diagram). See Back Panel (on page 49). 

 

100G QSFP Part Number  Description  

OP+QSFP+100G+BIDI 100Gb/s QSFP28 SR4 BiDi, LC Optical Connector, 100m over OM4 
MMF 

OP+QSFP+TRMM+100G  100GB/S QSFP28 SR4, MTP/MPO Optical connector, 70M with OM3 
and 100M with OM4  

OP+100G+CWDM4+2K 100Gb/s QSFP28 CWDM4, LC Optical Connector, 2km with single 
mode fiber (Green Tab)  

OP+QSFP+100G+10K 100GB/S QSFP28 LR4, LC Optical connector, 10KM with SMF 

OP+100G+LANWDM+40K 100G QSFP28 LAN WDM, 30km (40km with FEC) over SMF 

OP+100G+SWDM4+100M 100Gb/s QSFP28 SWDM4, LC Optical Connector, 70m over OM3 or 
100m over OM4 with multi-mode fiber (Grey Tab) 

OP+QSFP+XSR4+100G 100GB/s QSFP28 Parallel, 850nm, MTP/MPO optical connector, 200m 
over OM3 and 300m over OM4 MMF 

OP+QSFP+DR+100G 100G QSFP28 for use with 400G-DR4 system 500m reach over single-
mode fiber 

OP+QSFP+FR+100G 100G QSFP28 for use with 400G-XDR4 system2km reach over single-
mode fiber 

OP+QSFP+100G+PSM4 100Gb/s QSFP28 PSM4, MTP/MPO Optical Connector, 500M over 
SMF 

 

 
 

Video/Audio Expansion Interface Supported SFPs 

Note: These are #4 on the Back Panel Diagram). See Back Panel (on page 49). 

Note: The SNP hardware does not support Tx/Rx "Transceiver" devices. 

SFP Type Imagine Part Number Description 

MADI Audio OP+SFP+MADI+2RX SFP Series: Dual MADI Optical Receiver 

OP+SFP+MADI+2TX SFP Series: Dual MADI Optical Transmitter 

SFP+MADI+2RX MADI Coaxial Dual Receiver, Non-MSA, HD-BNC 

SFP+MADI+2TX MADI Coaxial Dual Transmitter, Non-MSA, HD-BNC 
 

SFP Type Imagine Part Number Description 

3G Optical/ 
Coaxial 

 

OP+SFP+TT+13+13 SFP Series: Dual-channel optical outputs of SD/HD/3G 1310 nm 
wavelength 

OP+SFP+RR SFP Series: Dual-channel optical inputs of SD/HD/3G PIN 
Receiver 
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SFP Type Imagine Part Number Description 

SFP+2ETX SFP Series: Dual-channel HD-BNC outputs of SD/HD/3G 
(reclocked output) 

SFP+2ERX SFP Series: Dual-channel HD-BNC inputs of SD/HD/3G 
(reclocked output) 

 

SFP Type Imagine Part Number Description 

12G Optical/ 
Coaxial 

 

OP+SFP+RR+12G 12G/6G/3G/HD/SD-SDI UHD VIDEO SFP, OPTICAL, DUAL 
RECEIVER, NON-MSA, LC, RECLOCKED 

OP+SFP+TT+12G 12G/6G/3G/HD/SD-SDI UHD VIDEO SFP, OPTICAL, DUAL 
TRANSMITTER, NON-MSA, LC, RECLOCKED 

SFP+2ETX+12G 12G/6G/3G/HD/SD-SDI UHD VIDEO SFP, COAXIAL, DUAL 
TRANSMITTER, NON-MSA, HD-BNC, RECLOCKED 

SFP+2ERX+12G 12G/6G/3G/HD/SD-SDI UHD VIDEO SFP, COAXIAL, DUAL 
RECEIVER, NON-MSA, HD-BNC, RECLOCKED 

 

SFP Type Imagine Part Number Description 

HDMI 

 

SFP+HDMI+IN SFP Series: HDMI to SD/HD Converter + Cable 

SFP+HDMI+OUT SFP SERIES: SD/HD TO HDMI CONVERTER 

SFP+HDMI20+OUT+CAB 12G/3G/HD-SDI TO HDMI 2.0 TRANSMITTER SFP+, 8 AUDIO CH 
(HDMI), NON-MSA WITH TYPE D TO A CABLE 

 

Note: For the SFP+HDMI20+OUT+CAB SFP, embedded audio channel outputs 3 & 4 are currently 
swapped. The SFP+HDMI20+OUT+CAB device does not support ST259 SD-SDI. 
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Other Supported QSFPs and Cables 

In addition to the QSFP optical modules and direct-attach cables which are sold by Imagine 
Communications and listed in DATA QSFPs (on page 39) and Video/Audio Expansion Interface Supported 
SFPs (on page 39), Imagine Communications has evaluated the following QSFPs and cables for 
interoperation with the SNP.   

As of the time when they were tested, these QSFPs and cables were demonstrated to work with the SNP 
hardware.  While Imagine Communications  does not sell or directly support these devices, we do have 
positive experience with their use with the SNP.  Note that optic and cable vendors do make changes 
within their supply chains from time to time, and past success may change even if the vendor's part 
number does not reflect a change. 

 

Part Number  Description  

QSFP-40G/100G-BIDI (See Note 5) Cisco 100G and 40GBASE SR-BiDi QSFP Transceiver, LC, 100m OM4 MMF 

QSFP-100G-DR-S Cisco 100G Base DR QSFP Transceiver, 500m over SMF 

QSFP-100G-FR-S Cisco 100G Base FR QSFP Transceiver, 2 km over SMF 

QSFP-100G-SRBD Arista 100GBASE-BIDI QSFP optical transceiver, up to 70m over OM3 or 100m over 
OM4 duplex MM 

QSFP-100G-SWDM4 Arista 100Gbase-SWDM4 QSFP Transceiver, up to 70m over OM3 or 100m over 
OM4 Duplex MMF 

QSFP-100G-SR4 (See Note 1) ARISTA 100GB/S QSFP28 SR4, MTP/MPO Optical connector, 70M with OM3 and 
100M with OM4 

QSFP-100G-PSM4 (See Note 3&4) ARISTA 100GBASE-PSM4 QSFP Transceiver, up to 500 M over Parallel single mode 
fiber  

QSFP-100G-XSR4 Arista 100Gbase-XSR4 QSFP100 Transceiver, up to 170m over parallel OM3 or 300m 
over OM4 MMF 

AOC-Q-Q-100G-5M (See Note 2) ARISTA QSFP28 to QSFP28 100GBE active optical cable 5 Meter  

AOC-Q-Q-100G-30M (See Note 2) ARISTA QSFP28 to QSFP28 100GBE active optical cable 30 Meter  

MCP1600-C003E30L Mellanox® Passive Copper cable, ETH 100GbE, 100Gb/s, QSFP28, 3m, Black, 
30AWG, CA-L 

MCP1600-C003E26N Mellanox® Passive Copper cable, ETH 100GbE, 100Gb/s, QSFP28, 3m, Black, 
26AWG, CA-N 

MFA1A00-C005 Mellanox® active fiber cable, ETH 100GbE, 100Gb/s, QSFP, LSZH, 5m 

 

Note 1: Supported Serial Numbers for QSFP-100G-SR4 part: 

• AMDxxx 

• ADPxxx 

• ANCxxx  

• AFHxxx  
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Note 2: Supported Serial Numbers for AOC-Q-Q-100G parts: 

• ADPxxx 

• ASPxxx 

• AEBxxx 

• AFHxxx 

 

Note 3: Supported Serial Numbers for QSP-100G-PSM4 part: 

• XCKxxx 

 

Note 4: Unsupported Serial Numbers for QSP-100G-PSM4 part: 

• XBTxxx 

 

Note 5: Supported Cisco QSFP PN: 

• SFBR-89BDDZ-CS4 
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Field Replaceable Spares 

The SNP includes tachometer-based alarming on each of the fans in the unit; in the event of a failure of 
one of the fans, it is strongly recommended that urgent action be taken to replace the failed fan -- the  
SNP will enter thermal shutdown to try and avoid permanent damage if the internal thermal sensors 
indicate one of the components become extremely hot.  

In order to facilitate timely replacement of the fans, we have introduced ordering codes for the 
individual fans inside the unit.  It is strongly recommended that facilities with a significant population of  
SNP units purchase spares of these relatively inexpensive fans in order to optimize the time-to-repair of 
units which exhibit a fan failure alarm. 

Field Replaceable Spares Description 

SNP-MAIN-PCB-ASSY SNP field-replaceable spare main PCB assembly; same part number for 
both SNP-GW-3GX32 and SNP-GW-3GX32-HS-QF frames 

SNP-350W-ACPS-ASSY SNP field-replaceable spare redundant 350W AC power supply assembly  
for SNP-GW-3GX32 frames 

SNP-400W-ACPS-HS (OmniPower) SNP field-replaceable single hot-swappable 400W AC PSU 
for SNP-GW-3GX32-HS-QF or SNP Platform (two per SNP) Note: This is 
one of two power supplies provided by Imagine Communications and 
can be used as the replacement part. For use with SNP Classic and SNP-
XL. 

SNP-400W-ACPS-HS (Zippy Inc.) SNP field-replaceable single hot-swappable 400W AC PSU  

Note: This is one of two power supplies provided by Imagine 
Communications and can be used as the replacement part. For use with 
SNP-XL only. 

SNP-FPNL-HS-HQF SNP field-replaceable spare front panel assembly with access door and 
quiet fans compatible for SNP-GW-3GX32 & SNP-GW-3GX32-HS-QF 
frames 

SNP-SPARE-BBFAN SPARE FAN FOR SNP BB FPGA FIELD REPLACEMENT 

SNP-SPARE-IPFAN SPARE FAN FOR SNP IP FPGA FIELD REPLACEMENT  

SNP-SPARE-FPFAN SPARE FAN FOR SNP FRONTPANEL QF/HQF FIELD REPLACEMENT 

See Servicing (on page 535) for installation and removal instructions.  
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License Management 

From the local SMM or remote SMM SNP Element UI, go to Configure > Licenses to open the Licenses 
dialog. From here, you can add, remove, and assign licenses.  

This dialog contains 2 tabs:  

• Major Features  

• Advanced Audio licenses 
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Licensing Notes 

1. Look at the License Management page to determine if the unit is already keyed for the features 
which you purchased with the unit (or subsequently). 

2. Contact Imagine Customer Support to request license keys for previously shipped units which reflect 
any licensed features previously purchased, and to purchase any new feature licenses.   

Note: The service team will require the unit serial number in order to generate feature keys, and 
may need to know the original purchase order date or order number to confirm the feature 
purchases in order to create the license feature keys.  

3. Confirm that the licenses appear in the License Management page after applying the feature key. 

4. Assign license tokens to the processors as needed, according to your system design. 

5. License key can be applied to the unit when running releases 1.5 or 1.6, so you can get keys put onto 
your units before attempting to upgrade to release 1.7.    

Applying Major Feature Licenses 

Licenses are applied on a per-processor basis. You can apply up to 4 of each license per SNP. Licensing 
and Ordering (on page 34) contains a complete list of current licenses. The License Management dialog 
lets you choose processors assigned for a feature, depending on the number of available tokens. For 
example, if a feature has 4 available tokens, you can select all 4 processors. But if you have only 2 
tokens, only 2 of 4 processors can be selected. By default, none of the processors are assigned 
automatically, so please make selections as appropriate in order to use the desired features on one or 
more processors. The Usage column updates to reflect your selections. 

Applying Advanced Audio Licenses 

Licenses 

Special Note about the REMAP license 

In previous releases of SNP, the Remap personality (SNP-SK-REMAP) was a separate feature key.  In 
release 1.7 and beyond, there is no explicit key for Remap, it is enabled by the Sync/Remap/STAT (SNP-
SK-SYNC or SNP-PSK-SYNC) license key.   

Other Notes 

• Multiviewer Personality: The Multiviewer and Multiviewer Portrait mode share the same license 

• Conversion Personality: The Dual Conversion license covers the Quad Conversion feature. For 
example, if a processor has been assigned the SNP-PSK-2CONVUHD license token, it can also turn on 
the Quad Conversion personality. 

Acquiring Licenses 

To acquire licenses, contact Imagine Communications Customer Service. You will need to provide the 
Serial Number from the License Management dialog box.  

Also see Acquiring Licenses (on page 381) 
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Software Versions 
Software  Minimum Version 

for use with SNP  
Notes 

Remote SNP Manager 3.0 Installed on a PC on the network. See Installing 
Remote SNP Manager (on page 74) 

SNP Firmware 3.0  

Magellan Control System 3.0 or higher See Using Magellan Control System with SNP (on 
page 332).  

Layout Designer 7.0  

VirtualBox  5.1 Comes pre-installed in the case of a pre-packaged 
SNP Manager box 

Magellan CCS Navigator 5.8.2 See Using Magellan Control System with SNP (on 
page 332) 
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Standard SNP Hardware  
The standard SNP is currently available in two flavors:  

• SNP-GW-3GX32 with standard fans and power supplies  

• SNP-GW-3GX32-HS-QF, with dual hot swappable power supplies and quiet fans.  
See Servicing (on page 535) for information on field-serviceable parts.  

Controls are on the front panel, and connections are on the back panel. See the following topics:  
 

Front Panel 

The SNP front panel contains controls to configure and manage the device. It is a replaceable 
component of the product. See Front Panel Assembly (on page 538) for more information. 

 

SNP-GW-3GX32-HS-QF/SNP-PLATFORM-4A/SNP-PLATFORM-2AU with Hot-Swappable Power Supplies 
and Quiet Fans 

The front panel is removable as a single piece, as described in Removing the Front Panel (on page 538), 
or just the access plate at the right can be removed to access one of the two (hot-swappable) power 
supplies while the SNP remains in operation. See Removing the Individual Hot-Swappable Power Supply 
(on page 540). 
 

Front Panel Controls  

 

Name Function 

Power  Turns off and on the SNP.  

Control knob Scrolls through parameters or options at the selected level.  

Enter  Selects or "takes" an option or value in a parameter.  

Exit Exits from one level in the parameter tree to a higher level in the tree. 

Default When browsing the parameter list, this button flashes to indicate that a parameter 
is set to the default value. If a parameter is not at the default value, press and hold 
the Default button for more than one second to reset the parameter to its default 
value.  
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Name Function 

Home For future use.  

Status For future use. 

Help When the front panel Menu is navigated to a parameter setting, press to display a 
description of the parameter.  

Reset This recessed button is located in a hole below and to the right of the LEDs on the 
front panel. It can be pressed using a paper clip.  

 

 

LED Functions 

LED Name Condition Indicated  

System • Green—Booted up OK, primary flash image, all FPGAs loaded and ready, Zenium 
running  

• Amber—Boot in progress, FPGA re-load in progress, or other "not-ready-yet" 
status  

• Red—Fail-safe image running, FPGA load failed, or other major problems  

• Off—Unit is not powered 

Data A 
Primary Link 

• Green—IPWan link good, link speed > 0, FCS errors below threshold  

• Amber—Link good and speed> 0, but FCS error rate above threshold  

• Red—Link speed = 0  

• Off—QSFP link not connected or system is not ready 

Data B 
Secondary Link 

MGMT • Green—At least one SDNO connection is established 

• Amber—At least one SDNO connection was established recently (within the last 
60 seconds) but there is none currently 

• Red—No SDNO connection is currently available, and none have been connected 
recently 

• Off—System is not ready 

Timing • Green—The unit is well-locked to the selected timing source (PTP) 

• Amber—The unit is currently locking to timing source (PTP) 

• Red—The unit is not locked  

• Off—System is not ready 

Alarm • Green—No major or minor alarms  

• Amber—Only minor alarms  

• Red—Major alarms  

• Off—System is not ready 

Note: Alarms disabled in the UI do not affect the alarm LED.  
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Back Panel 

The back panel for both SNP-GW-3GX32 and SNP-GW-3GX32-HS-QF has the same layout:  

 

Item Description 

1 IEC power inlets; see Electrical Requirements (on page 56) 

2 Ground pin (10/32 or metric M5/standard)  

3 QSFP100 Flexible Ethernet I/O 

• 100 GBE 

• Main and Protect, full 2022-7  

• Can be used for PTP timing slave for synchronization; See Connecting to a PTP Source (on page 
485).  

4 Four SFP+ sockets support SDI-on-fiber and MADI SFP; See Video/Audio Expansion Interface 
Supported SFPs (on page 39) for options  

5 GPIO/RS-232, for future use 

6 Dual 1G Management Ethernet ports; see Initial Setup (on page 60) 

7 Analog reference input (for future use) and analog black burst reference output generated from 
the PTP signal; see Configuring Reference for SNP. 

8 SDI inputs/outputs:  

• Amphenol HD-BNC (8 groups of 4) 8xUHD or 32xHD 

• 6G/12-G capable BNC of each quartet is labeled with a square of the opposite color 
 

 

BNC Ports 

 

BNC ports are divided in groups of four. BNCs are hard-coded so that the first four are assigned to 
Processor A Section1, the next four (numbers 5, 6, 7, and 8) are assigned to Processor A Section 2, etc.  

Note that the first numbered port in each group is labeled with an inverse square. This port is the 12G 
capable port for that group. Ports in each group are numbered in a clockwise fashion. For example, the 
left-most port on the chassis is port 2, not port 1.  



Selenio™ Network Processor 

User Guide  Introduction 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 50 

 

 

Pinouts: GPIO/RS232 9-Pin Connector (for future use)  

 

Pin No.  Signal  Comments  

1  GND Signal Ground  

9  GPIO4 GPIO Data  

5  GND Signal Ground  

3 Tx Transmitted Data  

7 GPIO2 GPIO Data  

8 GPIO3 GPIO Data  

2  Rx Received Data  

4 GND Signal Ground 

6 GPIO1 GPIO Data  
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SNP-XL Hardware 
The SNP-XL runs on the SNP-PLATFORM-XL Base, HW Rev A. 

In This Section 

Front Panel ............................................................................................... 52 
Back Panel ................................................................................................ 53 
Relay Expansion Board Signaling ............................................................. 54 
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Front Panel 

The SNP-XL front panel contains controls to configure and manage the device. It is a replaceable 
component of the product.  

 

The front panel is removable as a single piece, or just the access plate at the right can be removed to 
access one of the two (hot-swappable) power supplies while the SNP-XL remains in operation.  

 
 

Front Panel Controls 

Front Panel controls on the XL are similar to the standard SNP. 

 

Name Function 

Power  Turns off and on the SNP-XL. 

Control knob Scrolls through parameters or options at the selected level.  

Enter  Selects or "takes" an option or value in a parameter.  

Exit Exits from one level in the parameter tree to a higher level in the tree. 

Default When browsing the parameter list, this button flashes to indicate that a 
parameter is set to the default value. If a parameter is not at the default value, 
press and hold the Default button for more than one second to reset the 
parameter to its default value.  

Home For future use.  

Status For future use. 

Help When the front panel Menu is navigated to a parameter setting, press to display 
a description of the parameter.  

Reset This recessed button is located in a hole below and to the right of the LEDs on 
the front panel. It can be pressed using a paper clip.  
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Back Panel 

 

Item Description 

1 IEC power inlets; see Electrical Requirements. 

2 Ground pin (10/32 or metric M5/standard)  

3 QSFP100 Flexible Ethernet I/O 

• 100 GbE 

• Main and Protect, full 2022-7  

• Can be used for PTP timing slave for synchronization 

4/5 Optional Relay Expansion Boards  

Also see Relay Expansion Board Signaling. 

6 SDI BNC and SFP Outputs 

7 SDI BNC and SFP Inputs 

8 Inputs and Outputs for Processors A and B 

9 Inputs and Outputs for Processors C and D 

10 Genlock Reference 

11 Dual 1G Management Ethernet ports; see Initial Setup  

 
 



Selenio™ Network Processor 

User Guide  Introduction 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 54 

 

Relay Expansion Board Signaling 

The SNP-XL contains 2 expansion slots for optional expansion boards. In the first release, the Relay 
Expansion Board will be available. The Relay Expansion boards can be installed in both available 
expansion slots. 

This expansion board contains 5 relays that allow the backup signal to be bypassed on the output due to 
the loss of power of the protected equipment. The arrow indicates the direction of the bypass signal. 
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General Signal Flow of the Sync Personality 
SDI to IP 

 

IP to SDI/IP  
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Installation 
Prior to installing your system, ensure that certain environmental and electrical conditions are met. You 
should install it and make some connections.  

SNP can be installed in a 19" rack. See Rack Mounting (on page 57). 

For timing and synchronization purposes, SNP should be connected to a PTP source. See Configuring a 
PTP Network (on page 485). 
 

Electrical Requirements 
The SNP power supplies have a universal input of 100-240VAC at 47 to 63Hz (nominal), max 5.5A each. 
There is no voltage selector switch. For power supply specifications, see Power Consumption (on page 
516).  

The SNP has two independent power supplies, load-sharing when both are functional. In SNP-GW-3GX32 
frames, these two power supplies are mounted in a common package and serviced as a pair. In SNP-GW-
3GX32-HS-QF frames, each power supply is a separate unit and can be removed individually while the 
unit remains in operation (hot-swapping). See Servicing (on page 535) for more information.  

SNP has two IEC C14 power inlets, one associated with each power supply. Qualified power cords 
including UK-style, European-style, and U.S.-style plugs are available for international shipment.  

You can power down or reset the unit using the Power Switch (or reset soft-switch) on the front of the 
SNP. If a unit has been previously powered down, you can initiate power up of the unit from the front 
power switch as well. 

When mains power is lost and then later restored, the unit should return to the power state it was in 
when mains power was lost – either powered down or running. 
 

Environmental Requirements 
SNP units are cooled by forced air drawn in from the front, and exhausted through the rear. There must 
be free passage for air flow at the front and back of each unit to allow for adequate ventilation. Take 
care to select a dry, well-ventilated location with a minimum of dust. 

SNP units are designed for mounting in a standard 19-in. (48-cm) rack using front-mounting ears and 
rear support brackets, occupying a 1RU vertical space of 1.75 in. (4.4 cm). 

When installing an SNP in a rack, ensure that there is adequate space behind the mounting ears and 
clearance for the rear connecting cables. Allow about 10 inches (25 cm) of slack in the rear connecting 
cables for frame access and maintenance. 
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After unpacking the frame, and before installing into a console or rack, allow at least 30 minutes for 
temperatures to equalize and to eliminate any condensation that may have developed. SNP frames 
require an ambient temperature of between 32°F and 95°F (0°C to 30°C) with relative humidity of 10% 
to 90% non-condensing. 
 

Rack Mounting 
Although the pre-installed frame-mounting ears provide the main support for the SNP within a rack, you 
must install arms, brackets, and a cable relief bar at the rear of the unit to support the weight of cabling 
and frame stacking. 

The following items are included in kit 158-100081Q00: 

• Rear support arms (164-000306Q00) 

• Cable tie bar (164-000305Q00) 

• Brackets (164-100556Q00) 

• Bracket screws (4-40X1/4 PH_Q) 

• Tie bar screws (6-32X3/8 PH) 

 

Figure 3: Mounting Ear on Front Panel 

The following procedure describes how to install the rack supports. 
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1. Locate the support package in the box, consisting of two support arms, two brackets with screws, a 
tie bar, and tie bar screws.  

 

Figure 4: Rack Support Brackets (158-100081Q00)  

2. Attach the brackets to the sides of the frame using the screws that are provided. 

 

CAUTION 

To prevent damage to components inside the frame, do not use screws longer than those 
provided. 

 

Figure 5: Bracket Installation 

3. Attach the cable relief bar between the two support arms using the screws that are provided. 
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You can secure the cable relief bar through any of the screw holes on the arm.  

 

Figure 6: Attaching the Cable Relief Bar 

4. Push the SNP into the front of the rack, and attach the frame’s front-mounting ears to the rack using 
the appropriate screws (not provided). 

5. Slide the two arms into their slots from the back of the frame and attach the arms to the back of the 
rack. 

 

Figure 7: Installed Support Arms and Cable Relief Bar 

6. Make all necessary electrical and optical connections to the back of the frame. 

 

CAUTION 

Do not use slide/rail mounted equipment as a shelf or a work space. 
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Initial Setup 
The SNP ships with a default IP address, gateway, and subnet mask. You should change these settings so 
they are appropriate to your network.  

It is strongly recommended that you change the default passwords before connecting your SNP to any 
other devices. See Configure Local Host - Password Control (on page 103). 

For best results, use strong passwords for your user accounts as well. See User and Group Management 
(on page 67) for more information.  
 

Setting IP Address and Subnet Mask 

Ethernet control of SNP is managed through two RJ45-style gigabit ethernet connectors, Control A and 
Control B. For the location of these connectors, see Back Panel (on page 49).  

Depending on whether you're using bonded mode or dual address mode, you will configure these 
Ethernet management ports in one of the following ways.  

• Bonded Active/Backup mode (default): For best results use this option. Ports A and B have a 
common IP address. The two Ethernet connections can be made to your network or switches with 
no special configuration, since only one Ethernet port is active at any given time. This configuration 
is used for redundancy, in case one of the links fails. For Control Link configuration, only Control A is 
used.  

• Bonded LACP mode: Ports A and B have a common IP address, and traffic is balanced across the two 
ports if both are available. The two Ethernet connections can be made to your network via managed 
switches. This configuration is used for load-balancing and redundancy, in case one of the links fails. 
For Control Link configuration, only Control A is used.  

• Dual Addresses: In this mode the device has two equivalent control plane ports, with distinct IP 
addresses. The two ports should be on separate IP subnets and gateway addresses may be 
configured for each port. All management & control protocols and services are available on both 
ports concurrently.  

Setting the Control Link mode is described in Configure Local Host - Control Link Bonding and 
Configuration (on page 94). 

To allow devices to communicate on a network, for best results set all SNP devices to the same subnet 
(network location). When shipped, all SNP units are configured with the same default IP (device 
identifier) and subnet addresses. These addresses need to be changed so that each unit is uniquely 
identified and the network location of all units is accurately reflected. An IP address is made up of a 
four-item set of numbers (octet). For a class C network, you must change the first three octets to 
identify the location (address) of the unit on your network, and also change the last octet to uniquely 
identify the device from other SNP units.  

Defaults for Control A IP address: 192.168.100.250  

Net mask: 255.255.255.0 

Gateway: 0.0.0.0 
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Defaults for Control B 
(only for Dual Address mode) 

IP address: 192.168.101.250  

Net mask: 255.255.255.0 

Gateway: 0.0.0.0 

Note: For best results, set all SNP devices to the same subnet. Otherwise, you will also need to configure 
Gateway settings.  
 

Setting the IP Address Via a PC using an Ethernet Cable 
All SNP systems ship with a default IP address, subnet mask, and gateway. If you intend to control the 
unit remotely, or connect it to a network hub/switch along with other SNP units, you will need to 
reconfigure the IP with unique network settings. Local control (with a direct Ethernet requires an IP 
configuration on the PC's network interface. The IP address must be on the same subnet as the SNP 
Control A or Control B, depending on which port you connect to.  

For example, use PC IP address 192.168.100.10 for connecting to Control A or 192.168.101.10 for 
connecting to Control B. 

The first time you connect to an SNP frame: 

1. Using a cable, connect your PC to the SNP via one of the management ports (#6 in Back Panel (on 
page 49)).  

Be mindful of which port you are connected to, A or B.  

2. From a web browser on your PC, enter the default IP address of the port you are connected to.  

The default for Control Port A is 192.168.100.250, and for Control Port B it is 192.168.101.250.   

This takes you to a default local setup web page that allows you to configure your element and set the 
IP Address.  
 

Setting the IP Address at the SNP Front Panel 

Depending on the setting for Network Mode, you may need to configure just Control A, or both Control 
A and Control B.  

Follow these steps to configure the network addresses at the SNP front panel: 

1. Follow this path: System Information > System Control > Network Mode and choose the mode you 
want for your system.  

For best results, choose Bonded Active/Backup, and then configure Control A. 

If this is a new unit being configured, the default IP displays. Otherwise, the current IP address of the 
unit displays. 

2. Change the IP address by following these steps: 

a. Press Enter to navigate to one of the four octets in the IP address. 

b. Modify the address value by using the scroll knob to set a new number. 

c. Press Enter to move to the next octet, and then repeat step (b) above. 

d. Press Exit when you are finished configuring the address. 

3. Scroll to Netmask A, and then press Enter. 
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If this is a new unit being configured, the default subnet mask displays. Otherwise, the current 
subnet displays. 

4. Repeat the procedure described in step 4, this time for the subnet mask. 

5. Scroll to the Gateway A parameter, and then press Enter. 

If this is a new unit being configured, the default gateway displays. Otherwise, the current gateway 
address displays. 

6. Repeat the procedure described in step 3, this time for the gateway parameter. 

7. Scroll to Save Config A and click Enter, and then click Yes to commit the changes.  

8. If configuring as Dual Address mode, repeat steps 2 - 7 for Control B, this time for the IP Address B, 
Netmask B, and Gateway B parameters, then scroll to Save Config B, click Enter, and click Yes to 
commit the changes.  

9. Press Exit to return to the top of the menu. 

Rebooting the SNP is not required. 
 

Using the SNP Manager Interface 
SNP has two control interfaces available. The local SNP Manager interface controls the device over a 
network, including software upgrade, etc. The remote SNP Manager interface allows control of multiple 
SNP devices, but does not allow console-level access. When operators are logged in at both interfaces, 
changes made on one interface will automatically update on the other.  

The default user name and password you should use the first time you log in are:  

Login: admin 

Password: password 

• To log into the local SNP Manager interface, point the browser to http://<SNP IP>.  

• To launch the remote SNP Manager, point the browser to http://<SNP Manager IP> of the SNP 
Manager installation.  

Note: When using SNP 3.0 or higher, you must use remote SNP Manager 3.0 or newer.  

Note: When connecting to SNP, use Chrome or Firefox. Other browsers, such as Internet Explorer, Edge, 
or Safari, are not supported.  

This section is divided as follows: 

Local SNP Manager (on page 64) Naming your SNP (on page 65) 

 Element Overview for Local SNP Manager (on page 64) 

 About Screen (on page 66) 

 User and Group Management (on page 67) 

Remote SNP Manager (on page 
71) 

Dashboard Overview for Remote SNP Manager (on page 72)  

 SNP Manager User Interface (on page 84) 

 Active Alarms (on page 89) 
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Local SNP Manager 

In This Section 

Element Overview for Local SNP Manager .............................................. 64 
Naming your SNP ..................................................................................... 65 
About Screen ............................................................................................ 66 
User and Group Management ................................................................. 67 
SNP Manager Menus ............................................................................... 70 

 
 

Element Overview for Local SNP Manager 

When you log into a local SNP Manager, the Element Overview shows each SNP as an Element.  Click on 
a program to view controls and statuses for that program, as shown in Controlling a Device (on page 88).  

When a Program is surrounded by a yellow box, that Program has at least one minor alarm in a triggered 
state.  

When a Program is surrounded by a red box, that Program has at least one major alarm in a triggered 
state. 

 

When you navigate away from this screen, you can always return by selecting Views > Element from the 
main menu again. 
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Naming your SNP 

You can give your SNP unit a name by doing the following: 

1. Go to Configure Element > System tab 

2. Enter a name in the Unit Name section and click Apply Unit Name 

 

The name you provide helps you identify your SNP meaningfully in your ecosystem. This name is 
displayed: 

• On the browser tab when you access SNP  

 

• At the top of your SNP UI 
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Note: Apart from the SNP unit name, you can also provide custom hostnames for the SNP. See DNS (on 
page 357) 
 

About Screen 

Check the SNP Manager version by clicking About in the menu under the Imagine Communication Icon 
in the upper left corner of the screen. 

 

Information about an SNP's hardware and firmware can be found by connecting to the local device. See 
Configure Local Host - Software Update (on page 95).  
 

Accessing HTML Help 

You can open SNP online  help by clicking Help in the top left corner of the SNP Manager screen, by 
clicking the Imagine logo.  
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User and Group Management 

Users and Groups can be managed by clicking the logged in user in the top right hand corner of the 
screen. Select Manage Users. 

 

Note: The SNP Manager default login is "admin/password". The system only allows one admin user 
login at a time, so it is good idea that you create your own account and use it. This can be done from 
Dashboard>Admin>Manage Users>New Users. 

User names and passwords are device-specific. If you create a user on a local SNP Manager that user will 
not automatically be created on a remote SNP Manager, and vice versa.  

 



Selenio™ Network Processor 

User Guide  Using the SNP Manager Interface 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 68 

 

Users 

When first installed, SNP Manager has the following users created by default:  

• Admin: This user is a member of the Admin group, and can add or remove users, and has full 
read/write access to parameters on the device where they are logged in.  

• RemoteFmm: This user (and other members of the RemoteFmm group) can add elements to a 
remote SNP Manager. See Add Element (on page 85).  

• LMmonitor: This is the default user for the Live Manager (Magellan Control System) application to 
connect to the SNP. 

Note that you need to be a member of the administrator group to add or remove users. 

To manage users, click the logged in user on the top right hand corner and select Manage Users. A list of 
all users created for the system is displayed, along with details such as the username, first name/last 
name, whether the user is active, and the group that the user is assigned to.  

To add a new user to the system: 

1. Click the New User button. 

2. Enter details for the new user, and select the group to assign the user to. 

3. Click the Create button. 

 To delete an existing user: 

1. Select the checkbox against the user to delete. 

You cannot check the box beside the snp user and admin user because they are system default 
users.  

2. Click the Delete button that is displayed on the top. 

To search for a user: 

If you have a long list of users, use the search functionality to locate a specific user. 

1. In the Search box displayed to the right of the Users screen, enter search criteria to narrow 
down your search for a specific user or users. 

2. Click the Search button. 

To update a user: 

1. Click the Edit button against a User. 

2. Edit any required details including the Group the user has been assigned to. For example, you 
can update the Name or Password. 

3. Click the Update button. 

Note: Wen you click the Edit button against a user, you can see additional details for that user (to the 
right of the screen). 
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Group Permissions 

You can add users to the following groups:  

• Users in the Administrator Group have full permissions  

• Users in the Operator group have Read and Edit permissions 

• Users in the Viewer group have read-only permissions. 

• Users in the RemoteFmm group can add and remove devices on the Remote SNP Manager. This 
group only appears when adding users at a local SNP Manager. 

Click the Show button against a Group to see users currently assigned to that Group. You can directly 
delete users from a group (if required) by selecting a user and then clicking the Delete button that is 
displayed. 
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SNP Manager Menus 

See SNP Manager User Interface (on page 84). 
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Remote SNP Manager 

In This Section 

Dashboard Overview for Remote SNP Manager ..................................... 72 
Remote SNP Manager Overview .............................................................. 73 
Installing Remote SNP Manager .............................................................. 74 
System Requirements .............................................................................. 74 
Creating the SNP Manager Virtual Machine ............................................ 74 
Installing the ISO on the SNP Manager VM ............................................. 76 
Configuring Host PC VirtualBox NIC ......................................................... 77 
Customizing the Virtual Machine Control IP Address .............................. 78 
Reconfiguring SNP Manager VM Network Adapter to connect to the SNP network 80 
Updating Remote SNP Manager  ............................................................. 80 
Shutting down the SNP Manager VM ...................................................... 82 
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Dashboard Overview for Remote SNP Manager 

When you log into remote SNP Manager running on a virtual machine, the Dashboard Overview shows 
each SNP as an Element.  Click on an element to see the Processors etc. for that device, as shown in 
Controlling a Device (on page 88).  

When an SNP is surrounded by a yellow box, that SNP has at least one minor alarm in a triggered state.  

When an SNP is surrounded by a red box, that SNP has at least one major alarm in a triggered state. 

  

When you navigate away from this screen, you can always return by selecting Views > Dashboard from 
the main menu again. 
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Remote SNP Manager Overview 

Monitoring of multiple SNP devices can be done in two ways: 

• Using SNP Manager 

• Individual SNP devices can be monitored over a network by directly connecting to the device's IP 

SNP Manager needs to run on a separate PC, and it is recommended to control no more than ten SNPs 
under a single SNP Manager. See Installing Remote SNP Manager (on page 74).  

When using the SMM interface operating on a virtual machine, you will notice some differences:  

• Dashboard screen to choose which device to connect to. 

 
Click on an element to view the processors for that device.  

• IP address for the device listed in the space above the processors, so you can tell which device is 
being modified. 

 

• Add menu, which allows you to add and remove elements from the interface. See Add Menu 
(Remote SNP Manager Only) (on page 85).  
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• IP address in the alarms list so you can tell which device produced the alarm. 

• No access to Console in the Views menu. Console controls are available using the Local SNP only. 
See Console (on page 91).  

Note: When connecting to SNP, use Chrome or Firefox. Other browsers, such as Internet Explorer, Edge, 
or Safari, are not supported.  
 

Installing Remote SNP Manager 

Remote SNP Manager is a virtual machine created from an ISO file. The virtual machine ISO is tested 
working on VirtualBox hypervisor. The procedure generally includes installing VirtualBox, creating the 
SNP Manager VM, and configuring the virtual machine for network access. 

Note: When using SNP 3.0 or higher, you must use SNP Manager 3.0 or newer.  
 

System Requirements 

The host machine for the SNP VM should meet the following requirements:  

• Minimum of 16GB RAM  

• VirtualBox hypervisor 5.1 or higher 

• Minimum of 30 GB free space on HDD 

• 4 cores 

When connecting to SNP, use Chrome or Firefox. Other browsers, such as Internet Explorer, Edge, or 
Safari, are not supported.  

With this configuration you can support up to 10 SNP devices per SNP Manager.  
 

Creating the SNP Manager Virtual Machine 

SNP Manager will be running inside a virtual machine managed by VirtualBox. 

If you have VirtualBox installed, start with step #4 (below).  

You need to enable the host machine CPU Virtualization Support from the BIOS in order to run the VM 
properly. To install VM VirtualBox Manager, follow these steps:  

1. Download VirtualBox installer from https://www.virtualbox.org/wiki/Downloads 
(https://www.virtualbox.org/wiki/downloads). 

You will need VirtualBox 5.1  or newer. 

2. Boot or reboot the host machine, and enter BIOS configuration. 

On many systems, you can enter the BIOS configuration by holding down the F2 key while rebooting. 
Check the manual for your system if this is not the case.  

3. In the BIOS configuration, enable virtualization settings.  

4. Run Virtualbox installer and take all default options in setup wizard. 

https://www.virtualbox.org/wiki/downloads
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Once installation is complete a VirtualBox icon shows up on the desktop. 

 

5. Copy the SNP Manager ISO file to the VM host machine (or to a network drive that is accessible to 
this host machine). The file is about 1.5GB in size. 

The latest SNP Manager ISO file can always be found on our website. For complete contact 
information, see Support Contact Information (on page 3).  

6. Click on the VirtualBox icon to open the Virtualbox user interface. 

7. Click New to open the Create Virtual Machine dialog in Guided Mode, and complete the screens as 
follows.  

a. On the General screen's Basic tab, complete the following fields:  

• Name: Enter something descriptive 

• Type: Linux 

• Version: Red Hat (64-bit) 

b. On the Memory Size screen, configure Memory Size to 4GB memory size (4096 MB). 

c. On the Hard disk screen, choose the Create a virtual hard disk now option, and click Create. 

d. On the Hard disk file type screen, choose VDI and click Next. 

e. On the Storage on physical hard disk screen, choose Dynamically allocated and click Next.  

f. On the File Location and size screen, configure the virtual disk size limit as 30GB, and click 
Create. 

Your VM appears in the VirtualBox Manager. 

 

8. From the tool ribbon at the top left of the screen, click Settings, and from the menu at the left:  
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▪ Click System and on the Processing tab, configure Processor to 2 CPUs. 

▪ Click  Audio, and uncheck Enable Audio.  

▪ Click Network, and under Attached to: select Host-Only Adapter. 

9. Click OK to close the Settings window.  
 

Installing the ISO on the SNP Manager VM 
1. Select the Virtual Machine in VirtualBox manager and click Start from the ribbon bar at the top of 

the screen.  

The Virtual Machine launches.  

2. In the Select start-up disk dialog, click the Folder icon to select the location of your ISO file, and click 
Start. 

 

The SNP Manager Installation page opens.   

 
3. Select Install SNP Manager to the default disk and click Enter. 

The SNP Manager installation script runs on the screen.  

The script runs for a few minutes, and then displays "Installation complete" when successful.  
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The VM screen might go blank if the setup is left unattended for some time. Press any key to wake it 
up.  

4. Press Return if prompted to do so on the Install script's screen.  

The script cleans up and the Virtual Machine reboots.  

When reboot is complete, a command prompt window opens with a login prompt.  
 

Configuring Host PC VirtualBox NIC 

The default IP address for the SNP Manager is 192.168.1.11. In order to reach the SNP Manager 
configuration UI, you need to make sure that the IP address of the VirtualBox host-only network adapter 
is on the same subnet as the default IP address of the SNP Manager VM. 

The following steps describe how to accomplish the above on a Windows PC.  

1. Choose Start > Control Panel > Network and Sharing Center.  

2. Click Change adapter settings in the panel at the left of the screen. 

The Network Connections window opens.  

3. Right-click VirtualBox Host-Only Network and select Properties. 

4. In the Properties dialog, Select TCP/IPv4 configuration. 

 

5. Configure the VirtualBox Host-only NIC IP address and subnet mask to the default settings:  

IP address: 192.168.1.20 

Subnet mask: 255.255.255.0 

6. Click OK and exit the Configuration window. 

At this point, if you open a Command Line window and ping the SNP Manager VM at its default IP, you 
should get a response. 
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Customizing the Virtual Machine Control IP Address 

The next portion of the SNP Manager configuration is done in a web browser.  

Note: When connecting to the SNP Manager, use Chrome or Firefox. Other browsers, such as Internet 
Explorer, Edge, or Safari, are not supported.  

1. Open the SNP Manager VM configure page at https://192.168.1.11/configure.  

 

2. Click Edit.  
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3. Under IP Interface Configuration, choose "enp0s3" from the Select Interface menu.  

The screen updates with the following options:  

 

4. Enter the following information:  

▪ Interface IP/Netmask (such as "172.25.2.43/15") 

▪ Gateway  

5. Press Apply. 

The GUI shows the message "IP Change Failed", but this is to be expected. The connection between the 
SNP Manager virtual machine and the web browser will be lost because the IP address has changed.  
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Reconfiguring SNP Manager VM Network Adapter to connect 
to the SNP network 
1. Do one of the following:  

▪ (If the VM is still running) Select Machine > Settings from the menu in the VM window.  

▪ (If the VM is not running) In the VirtualBox Manager tool, select the SNP Manager VM and click 
Settings from the ribbon at the top of the screen.  

2. In the panel at the left of the dialog box, select Network. 

3. In the Adapter 1 tab, under Attached to: select Bridged Adapter, and from the Name list, select the 
NIC card that the SNP uses to connect to the network.  

4. Press OK.  

5. Press Start again to restart the SNP Manager VM if it is not already running.   

6. To test your connection, from a browser on a network computer, type the new IP address for the 
SNP Manager in the URL field.  

The SNP Manager login page opens. See Using the SNP Manager Interface (on page 62).  

Your SNP Manager is ready to connect to SNP devices. See SNP Manager User Interface (on page 84).  
 

Updating Remote SNP Manager  
Note: When using SNP 3.0 or higher, you must use SNP Manager 3.0 or newer.  

The following procedure is suitable for incremental upgrades. If you are upgrading from SNP 1.2 to 1.3, 
consult the SNP 1.3 release notes for the correct order of upgrading devices, and which procedures to 
use.  

To update SNP Manager software, follow these steps:  

1. Download the most up-to-date version of SNP Manager to your local machine. 

The latest software version is always available on our website. See Support Contact Information (on 
page 3) for more information.  

The SNP Manager will have a name like: SNP-Manager-1.3.0.15.snp.tar 

2. In your favorite browser, type the link as below in the URL field: 

https://[your SNP Manager  IP]/configure/ 

Note: When connecting to the SNP Manager, use Chrome or Firefox. Other browsers, such as 
Internet Explorer, Edge, or Safari are not supported. 

3. In the Software Update section, click Browse.  
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4. In the File dialog box, select the SNP Manager .tar file you downloaded  

 

5. To install the software, click UPDATE to start the installation. 

A progress bar appears. The update may take few minutes. When complete, a message indicates that 
the upgrade was successful. 

Important! Before logging in to the SNP Manager again, you should clear your browser cache.  

 To clear the browser cache in Chrome, press Ctrl+H to open the History page and select Clear 
Browsing Data. Ensure that Cached Images and files is selected, and then click the Clear Browsing Data 
button.  

 To clear the browser cache in Firefox, from the main menu choose Tools > Options > Privacy & 
Security. Scroll down to Cached Web Content and click Clear Now. 

Check the About screen to see the SNP version. See About Screen (on page 66). 
 

Recovering from an SNP Manager Upgrade Failure 

In the unlikely event that your upgrade should fail, please contact Imagine Communications Customer 
Service.  See Recovering from a Firmware Upgrade Failure. 
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Shutting down the SNP Manager VM 

To shut down the SNP Manager VM while minimizing the risk of data loss or file system corruption, 
select Machine > ACPI Shutdown from the main menu.  
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Front Panel Controls 
The SNP can be operated at the front control panel. Use the control knob and six buttons to navigate the 
parameter list and select levels, options, and value.  

Many of the parameter order is described in Menu Layout, and descriptions can be found in Configuring 
an Element (on page 350) and Configuring Programs (on page 384).  

 

Name Function 

Control knob Turn the knob to see a listing of parameters or options at the selected level on the 
display.  

Enter  Press to selects or "take" an option or value in a parameter.  

Exit Press to move from one level in the parameter tree to a higher level in the tree. 

Default When browsing the parameter list, this button flashes to indicate that a parameter 
is set to the default value. If a parameter is not at the default value, press and hold 
the Default button for more than one second to reset the parameter to its default 
value.  

Home For future use. 

Status For future use.  

Help When the front panel Menu is navigated to a parameter setting, press to display a 
description of the parameter.  
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SNP Manager User Interface 
Note: You can close dialogs in the SNP Manager interface by pressing the ESC key on your keyboard. If 
there are changes on the dialog box, you need to confirm the decision. SNP will not just delete your 
changes without offering you one chance to save them.  

• Add Menu (Remote SNP Manager Only) (on page 85) 

• Configure Menu (on page 349) 

• Views Menu (on page 87) 

If you log into SNP Manager, you will see the following 
menus:  

Add Menu (Remote SNP Manager Only) ................................................. 85 
Views Menu ............................................................................................. 87 
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Add Menu (Remote SNP Manager Only) 
The Element entry in this menu allows you to add and delete SNP devices on the Remote SNP's 
Dashboard Overview screen. See Dashboard Overview for Remote SNP Manager (on page 72). 

"Element" in this case is a generic term that refers to an individual SNP device.  

This menu only appears when you are using SNP Manager installed on a virtual machine.  
 

Add Element 

To add an SNP device (Element) into the Remote SNP Manager, follow these steps:  

1. Click Add > Element from the ribbon at the top of the screen.  

The Add/Remove Element dialog box opens.  

 

2. Enter the SNP IP address and an (optional but recommended) name for the device.  

Note: If you see a message indicating "Potential compatibility issues due to obsolete firmware 
revision", you need to upgrade your SNP to a newer revision, as described in Configure Local Host - 
Software Update (on page 95). See your release notes for version compatibility information.  

3. Enter the Remote Username and Remote password. 

Use the following credentials:  

Username: snp 

Password: imagine01  

These are the default system credentials for remote users. You can also choose to edit the default 
credentials (change the password for instance) or create new ones. Note that Remote users are 
members of the RemoteFmm group on the local SNP (not the SNP Manager). Members of this group 
can only be added/removed/edited from a Local SNP Manager. See Group Permissions (on page 69) 
for more information.  
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4. Click Add.  

Click the Name/IP field for an element to rename that element at any time.  

Three buttons are available for each element under the Functions heading. From left to right:  

• Configure Element:  Opens the Configure Element page for this particular SNP. See Configuring an 
Element (on page 350). 

• Reconnect to Element: Renews the connection between an SNP and SNP Manager if it was 
cancelled due to the firmware on SNP becoming out-of-date.  

• Remove Element: Removes this SNP from the Elements list.  

For best results, monitor eight or fewer devices in a group.  
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Views Menu 
The following options are displayed on clicking the Views menu: 

 

In This Section 

Element View (Dashboard) ...................................................................... 88 
Console ..................................................................................................... 91 
Alarms  ................................................................................................... 104 
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Element View (Dashboard) 

When you log into SNP Manager running on a virtual machine, or when you select View > Dashboard, 
the first screen that will appear is the Dashboard Overview. See Dashboard Overview for Remote SNP 
Manager (on page 72). To select a device to control or monitor, click on that device on the dashboard.  

When you run SNP Manager from the local interface, selecting View > Dashboard loads the control 
interface for the local SNP device. See Controlling a Device (on page 88).  

The Active Alarms banner at the bottom of the Dashboard screen can be expanded to view alarms for 
the device (local SNP Manager) or all connected devices (Remote SNP Manager). When the remote SNP 
Manager is in use, all alarms are identified by the element (device) that triggred them. See Active Alarms 
(on page 89).  

When you navigate away from this screen, you can always return by selecting Views > Element from the 
main menu again.  
 

Controlling a Device 

When you click on an Element in the Dashboard of SNP Manager on a virtual machine, or when you load 
the local SNP Manager or select Views > Dashboard while already connected to that device, controls for 
that SNP appear.  
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Note: The above image shows SNP Manager running on a virtual machine, which is why there is an Add 
menu, and why the display shows the IP address of the device to be controlled or monitored.  

When a program block is surrounded by a yellow box, that program block has at least one minor alarm 
in a triggered state.  

When a program block is surrounded by a red box, that program block has at least one major alarm in a 
triggered state.  

Each Processor block is divided into two sections with one (for UHD) or four (for HD) inputs (progams) 
that can be configured independently. Click a program to configure it. Controls are described in the 
following sections:  

• Program Configuration: Input Tab (on page 385) 

• Program Configuration: Video Tab (on page 404) 

• Program Configuration: Audio Tab (on page 449) 

• Program Configuration: Output Tab (on page 452) 
 

Active Alarms 

The Active Alarms panel at the bottom of the Dashboard allows viewing of active alarms for the 
monitored SNP device (local SNP Manager) or devices (remote SNP Manager). In a case where multiple 
devices are monitored from the same interface, devices are indicated in the Element column by their 
name and IP address on your network.  

Each row in the table represents an alarm on a device. The row color indicates the severity of the alarm 
(yellow for minor, red for major).  
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The above figure displays the Active Alarms panel on a remote SNP Manager. When displayed on a local 
SNP Manager, there is no Element column.  

 
Open/close Active Alarms panel 

 
Group/ungroup elements (remote SNP Manager only)  

When alarms are grouped by Element, all alarms for a particular SNP appear together. When 
they are not grouped, all alarms appear in a single list for sorting.  

Resize the Active Alarms panel by grabbing the = in the middle of its upper edge with your mouse and 
dragging it up or down.  

Note: When the logged-in user is in the Viewer group, the Disable button is not present.  

The same alarm descriptions appear here as on the Active Alarms tab. See Alarms  (on page 104). 

 



Selenio™ Network Processor 

User Guide  SNP Manager User Interface 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 91 

 

Console 

View > Console is only available when using the Local SNP Manager. It provides tools to upgrade device 
firmware, reboot, return to factory defaults, and download logs.  

 

 

In This Section 

System Information ................................................................................. 92 
CCSP Interface Documentation ................................................................ 93 
Configure Local Host - Control Link Bonding and Configuration ............. 94 
Configure Local Host - Software Update .................................................. 95 
Configure Local Host - Download Logs .................................................... 98 
Configure Local Host - Export Settings & Data......................................... 98 
Configure Local Host - Import Settings & Data ........................................ 98 
Configure Local Host - System Control .................................................... 99 
Configure Local Host - System Logging Control ..................................... 100 
Configure Local Host - System Service Control ...................................... 102 
Configure Local Host - Password Control ............................................... 103 
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System Information 

Operating Mode Displays "normal". 

Uptime Reports how long the system has been running 

Power on time  

Serial number This number is unique to this SNP device. It is required when requesting a 
License Key from Customer Service 

Main Board revision Displays the revision for the main board 

Chassis Type Displays classic or SNP-XL 

I/O Board revision Displays the revision for the I/O board 

Rx I/O Board Revision (SNP-XL only) Displays the revision for the Rx I/O board 

Tx I/O Board Revision (SNP-XL only) Displays the revision for the Tx I/O board 

Expansion Board 1 (SNP-XL only) Displays if expansion board 1 is present 

Expansion Board 2 (SNP-XL only) Displays if expansion board 2 is present 

mSATA size Displays the mSATA size. Applicable for SNPs shipping with 64 GB modules. 

Baseband FPGA DDR SDRAM 
size 

Displays the DDR SDRAM size. Rev Board 1 is 1 GB, Rev Board 2 is 2 GB. 

Clock generator versions Displays the clock generator version. 

Firmware version Displays the number associated with the software installed on the device 

FPGA Revision (IP and 
Baseband) 

 

Sync (S) Version Versions for different licensed features. Applicable depending on what is 
installed. 

You may be asked for information from this section of the screen when 
working with Imagine Communications Customer Service.  

Dual Conversion (2C) Version 

Quad Conversion (4C) 
Version 

Remap (R) Revision Version 

Multiviewer (M) Version 

Multiviewer (MVP) Version 

JPEG-XS Encoder (TR-08) 
version 

JPEG-XS Decoder (TR-08) 
version 

STAT (Stat) version 
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Master Control Lite (MCL) 
version 

JPEG-XS Encoder (TR-07) 
version 

JPEG-XS Decorder (TR-07) 
version 

JPEG-XS Encoder UHD (TR-07) 
version 

JPEG-XS Decorder UHD (TR-
07) version 

Dual Gateway version 
 

 

CCSP Interface Documentation 

System Information Includes a link to the complete parameter tree and alarm list. 

Processor Includes a link to processor specific parameter status. 

PTP Status Includes a link to the PTP Status section and associated parameters. 
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Configure Local Host - Control Link Bonding and Configuration 

Control Link Bonding 

Current Mode Indicates the currently selected control link mode.  

New Mode Choose one of the following:  

• Bonded Active/Backup (Default) 

• Bonded LACP - Uses Link Aggregation Control Protocol 

• Dual Addresses 

Note: You must click Apply for this change to take effect.  

Control Link Configuration 

Select Interface Select which of the 1G Management Ethernet ports to use to connect to 
SNP Manager.  

• Control A 

• Control B  

If no selection is made, SNP will use the first one it finds a signal on.  

Once you have made a selection, further information appears:  

MAC Displays the MAC address of the selected interface.  

DHCP See Using DHCP for the Control Interface (on page 466) 

Current address Displays the IP address of the selected interface.  

Current netmask Displays the mask of the selected interface.  

Current gateway Displays the gateway of the selected interface.  

New address Enter a new IP address for the device.  

New netmask Enter a new mask for the selected interface.  

New gateway Enter a new gateway for the selected interface.  
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Configure Local Host - Software Update 

Note: When using SNP 3.0 or higher, you must use remote SNP Manager 3.0 or newer.  

For SNP firmware upgrade, follow these steps:  

1. In the Software Update section, browse to select an upgrade package, then click "UPDATE".  

 

The whole upgrade takes about two minutes to copy files and six-eight minutes to reboot 
(depending on the configuration). Before the reboot happens, "Completed uploading firmware. 
Rebooting …" will be displayed on the page. When the reboot is finished, the company logo will be 
replaced by the menu selection on the front panel display.  

2. If remote SNP Manager lists this SNP as "not connected" on the Add/Remove Element page, click 
Reconnect to element. See Add Element (on page 85).  

3. If a popup appears indicating that the system requires a reboot, click Yes to allow the reboot.  

You may need to clear your browser cache to show the updated interface correctly.  
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Recovering from a Firmware Upgrade Failure 

Failsafe mode supports upgrade and front panel configuration only. This mode does not support normal 
product functionality, just recovery. You cannot use SNP in failsafe mode.  

1. To force the SNP into Failsafe mode, hold the Enter and Status buttons at the same time and toggle 
the Power button to the left of the display.  

 

2. As the SNP reboots, continue pressing the Enter and Status buttons for approximately 20 seconds, 
until the display shows the Serial Number of the SNP and "Failsafe Mode" indicating Yes. 

 

 

3. Press the Exit button, and scroll to the "Control Link A Config" menu and press the Enter button. 
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4. Verify that the IP Address of the SNP is correct, i.e. has not been reset to the default address of 
192.168.100.250.  If it has, then update the Control A IP Address.  Make sure to Save the IP address 
update. 

 

5. Now start a web browser and enter in the address bar: 
http://<snp_control_A_ip_address>/uilocal/  

NOTE: do not enter the IP address directly in the address bar since the browser may default to an 
https connection.  The connection is http (no s).  You should see the following Failsafe upgrade GUI 
page.  Browse to a known good software upgrade package and press the UPDATE button. 

 

6. Wait approximately 10 to 15 minutes for software to program the Flash devices in Failsafe mode.  
SNP will automatically reboot after the Flash devices have been programmed.  After the reboot, wait 
another 8 minutes for the SNP to boot-up. 

NOTE: that Preset files are erased during a Failsafe recovery, i.e. download Preset files to back them 
up before software upgrades. 
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Configure Local Host - Download Logs 

The log file contains debug information in a .tgz file (can be opened by WinZip).  

1. From the SNP Local interface, click Views > Console.  

Note: When connecting to SNP, use Chrome or Firefox. Other browsers, such as Internet Explorer, 
Edge, or Safari, are not supported.  

2. Click the Collect Logs button to create a log file for download.  

3. Click the SNP_logs_<IP Address>.tgz file to download the log, which can be unzipped for viewing.  

To view logs for SNP Manager, see Configuring SNP Manager (Remote SMM only)  (on page 383).  
 

Configure Local Host - Export Settings & Data 

This section contains settings for SNP configuration information that can be backed up prior to events 
such as replacing the mSATA disk. 

 Parameter & Alarm Settings  Select the checkbox beside the desired category to include in the exported 
file or select all items to include everthing. Control Network IP Settings 

MV Layouts 

Local User Database 

HDR LUTs 

Saved Presets 

Status This section either indicates that no data has been exported from this SNP 
OR it indicates time/data information for the last export. 

Collect Settings & Data Click this button to generate an exported .tgz file that contains all the 
selected settings. A link to the .tgz file is then displayed; click to save the 
exported file (saved to the Downloads folder on the local PC) 

 

Configure Local Host - Import Settings & Data 

This section contains settings for previously exported SNP configuration information to be restored on 
the SNP. 

Parameter & Alarm Settings  Select the checkbox beside the desired category to include the selected or 
all items (from the exported file) to restore to the SNP. Control Network IP Settings 

MV Layouts 

Local User Database 

HDR LUTs 

Saved Presets 

Status This section either indicates that no data has been restored to this SNP OR 
it indicates time/data information for the last restore/import. 
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Apply Settings & Data + 
Reboot 

Click this button to restore the desired configuration settings to the SNP. 
 
Note that on clicking Apply Settings & Data + Reboot, the imported settings 
for Parameter & Alarm Settings, Local User Database, and Saved Presets 
will wipe out and replace any settings you may currently have. 

 

Configure Local Host - System Control 

Reboot 

The SNP cannot be rebooted through the SNP Manager. To reboot SNP remotely, follow these steps:  

1. From the SNP Local interface, click Views > Console.  

2. Click Reboot.  

There is a reset button recessed on the SNP front panel. See Front Panel Controls (on page 83) for the 
location and usage of this button.  

To do a hard reset of the SNP you can reboot the box through the Power button to the left of the 
display.  

Restore Defaults + Reboot 

On the SNP Console configuration page (Views > Console), click Restore Defaults + Reboot to return the 
SNP to its factory default settings.   

Or on the front panel, navigate to the parameter to delete the previous user setting. The control path 
from the panel is System Information > System Control > Config Reset. Set it to Yes. Then reboot the 
unit by selecting System Control > Reboot. Set this to Yes as well. 

 

CAUTION 

Using the Restore Defaults + Reboot option will: 
- Wipe out all added users (leaving just the default Admin and RemoteFmm users)  
- Delete all user stored LUT files 
- Delete all presets 
- Set all user-settings/parameters to default including the IP WAN addresses/values 
 
Note that IP WAN settings are NOT stored in a preset, so please take note of these before 
performing a factory reset action. 

If restoring defaults is not enough, to return the SNP to factory defaults, boot into failsafe mode and 
click the "Factory Reset" button.  
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Configure Local Host - System Logging Control 

The SNP's firmware is instrumented with messages to indicate various conditions that may occur. 
System logging level controls are used to filter the type of messages logged and stored in the SNP's file 
system, and log messages are tagged with a severity level.  

Note: There is limited space allocated in the SNP's file system for logs.  Once the storage limit has been 
reached the oldest logs are deleted. 

The New Log Level parameter lets you select a level, which is then reflected in the Current Log Level. 
The log level from lowest level (or highest severity) of EMERGENCY to the highest level (lowest severity) 
of DEBUG, determines the amount of details that are logged.  

 

Note: It is recommended you only change these settings under Imagine Support supervision. 

Level Description Log Data Generated 

Debug This is the highest logging level, use for the 
lowest severity 

A log level of DEBUG generates 
the highest amount of logger 
data. 

These two levels should be used 
for system debugging only and 
should be used sparingly under 
the advice of Customer Service. 

Information Use for Informational messages 

Notice The default log level Generates a modest amount of 
logger data 

Warning Use for warning conditions  

Error Use for error conditions  

Critical Use for critical conditions  

Alert Use for alerts that require immediate action  

Emergency This is the lowest logging level, use for highest 
severity 

A log level of EMERGENCY should 
generate no logger data, unless 
something goes wrong 
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Remote Logging 

 

You can also choose to use a Remote Syslog Server.  
Enter its IP address in the New Remote Logger field in the following format: 

<IP address>:<port> 

Note: The remote logger will receive messages of all levels or severity without any filtering by the SNP 
regardless of the log level selected for the local logger. Do not use this option unless you really need it. If 
using, be mindful of the number of devices you use it on. For example, debug log messages northbound 
from 100 frames could result in significant network traffic. 
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Configure Local Host - System Service Control 

The SSH server is enabled by default. It is primarily used when Imagine Communications Customer 
Service needs to access a device. When SSH is running, an external user can enter the user password set 
in Configure Local Host - Password Control (on page 103) to control and monitor the SNP.  

Note: If any connection issues are seen with the client software, (for example, "unknown KEX 
algorithm"), upgrade your client software to its most recently released version. 

To stop SSH, click the Stop SSH button. 
 

UDP/TCP Ports 

The following public ports are used by SNP: 

Port Type Usage Reason 

22 TCP SSH For customer service 

53 UDP/TCP DNS Domain Name Service 

67-68 UDP/TCP DHCP Dynamic Host Configuration Protocol 

80 TCP HTTP Redirected to https 443 port 

443 TCP HTTPS User interface control 

943 TCP Policy Server For Magellan Panel Access Control 

4050 UDP CCSP Server CCSP control interface 

4517 TCP CCSP Server CCSP control interface 

5353 UDP mDNS Multicast DNS 

8100 TCP NMOS Node API AMWA NMOS IS-04 Node API for 3rd party tool SNP 
management 

9078 TCP SNP Manager For remote SNP manager (FMA) 

9089 TCP SNP Manager User interface control (SMM) 

29100 TCP SEAM Protocol Magellan Control System communication 

31000 TCP IconMaster Protocol MCL Icon Master Protocol for Processor A Channel 1 

31001 TCP IconMaster Protocol MCL Icon Master Protocol for Processor A Channel 2 

31002 TCP IconMaster Protocol MCL Icon Master Protocol for Processor B Channel 1 

31003 TCP IconMaster Protocol MCL Icon Master Protocol for Processor B Channel 2 

31004 TCP IconMaster Protocol MCL Icon Master Protocol for Processor C Channel 1 

31005 TCP IconMaster Protocol MCL Icon Master Protocol for Processor C Channel 2 

31006 TCP IconMaster Protocol MCL Icon Master Protocol for Processor D Channel 1 

31007 TCP IconMaster Protocol MCL Icon Master Protocol for Processor D Channel 2 

50000 TCP LD Gateway Layout Designer Control Interface 
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Note: If any additional ports are opened after deployment/installation, they should be closed 
immediately after use.  
 

Configure Local Host - Password Control 

It is strongly recommended that you change the default passwords before connecting your SNP to any 
other devices.  

Note: Only a user logged in as Administrator on the device can set and reset passwords.  

The User password configurable on on this page provides access to the System Shell by SSH. From there, 
you can type SD<space><dash><rootpassword> to enter the root.  

To change the default User or Root account password, follow these steps: 

1. In local SNP Manager, select Views > Console.  

2. Enter the current password (once) and the new password (twice) in the designated fields for the 
password you want to change.  

 

The default login account is: Username = user 
 Password = imagine01 

The root account is: Username = root 
 Password = imagine01 

3. Click the appropriate Set Password button.  

Note: you can’t login as root over SSH, only as "user".  

If you forget the User and Root passwords, click Reset to set them back to the default (listed above). 
After reverting to the default, you should change both passwords to something stronger immediately.  

For best results, use strong passwords for individual user accounts as well. See User and Group 
Management (on page 67) for more information.  
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Alarms  

The Alarms View provides details on alarms, and is divided into 3 tabs: 

• Active Alarms (on page 104) 

• Alarm Log (on page 105) 

• Configuration (on page 106) 
 

Active Alarms 

The Active Alarms tab groups and displays all alarms for a given Element, and you can expand or 
collapse the view.  

 

Details are provided on the Type of the alarm, the Time, Reason, and Priority. 

Element SNP device that originated the alarm  

Note: This column only appears when monitoring via remote SNP.  

Time Issued When the alarm originated 

Location The location of the alarm within the device, which will be one of the following:  

Processor_Section_ Program_ (where the specific processor letter, section 
number, and program number are defined) 

System/Subsystem (for system-level alarms) 

Alarm The name of the alarm 

Reason Why the alarm was triggered  
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Priority 1-4 is a minor alarm; 5-10 is a major alarm 

Disable Disable/enable an alarm directly from the Active Alarm overlay.This button does 
not appear when a user is assigned to the Viewers group.  

Click on a column header to sort by that column.  
 

Alarm Log 

The Alarm Log tab lets you view a log or all alarms, clear that log, refresh it, or export it as a CSV file. In 
addition to the alarm details that are listed on the Active Alarms tab, the Alarm Log also displays the 
following statistics:  

• Count: How many times the alarm has triggered 

• Raise: When the state is Yes, the alarm has been triggered, when the state is No the alarm has been 
cleared  

 

When using a remote SNP Manager, you can select an Element from a drop down list, or view alarms for 
all devices assigned to the remote SNP Manager. The Element column and drop-down menu do not 
appear on local SNP Manager. 
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Configuration 

The Configuration tab lets you edit details for alarms.  

1. (If you are using remote SNP Manager only): On the Configuration tab's Element drop-down list, 
select a device.  

 

2. Click Edit.  

This button turns the informational fields in the columns to the right of the alarm names into drop-
down menus or fillable boxes so you can modify the alarms' thresholds.  

3. Click the + beside a Processor to see the Programs within it.  

Using the menu beside each Processor, you can Enable or Disable all alarms for that processor.  

4. Click the + beside a Program to see all the alarms for that processor.  
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Using the menu beside each Program, you can Enable or Disable all alarms for that Program.  

 

Name The title of the alarm 

Note: the box to the right of the alarm column header is a filter. Enter text here and 
the alarms displayed will be limited to only alarms whose name contains the text 
you have entered. You have to enter three letters minimum.  

Enable/Disable When an alarm is listed in Enable state here, that alarm will trigger when its other 
conditions are met. In Disable state, the alarm will not trigger.  

Priority You can set each alarm a priority from 1 - 10. The  

• Minor: Priority 1 - 4 

• Major: Priority 5 - 10 

All alarms have a default priority of 4 (minor).  

Raise Delay How many seconds the alarm conditions must exist before the alarm is triggered. 
All alarms have a default raise delay of 0 seconds.  

Clear Delay How many seconds the alarm conditions must not be present for before an alarm 
deactivates. All alarms have a default clear delay of 0 seconds.  

Below the Processors, you can access the hardware/device specific alarms by clicking the + beside 
System. Alarms in this section are divided in to Fan, IP, Power_Supply, QSFP, Reference, and 
Temperature. Click the + beside the aspect of the device you want to view or modify to see those 
selections.  

Overall device alarms (for example Connection loss to Element) appear at the bottom of the list.  
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Alarm Filtering 

Enter text in the Name field to display only alarms that contain that text. Enter a minimum of three 
letters to trigger the filter.  

 

Alarms will still be nested within their programs, etc.  
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List of Alarms 

By default all alarms are enabled. 

Location  Alarm Name Reason 

+Processor (A/B/C/D)  

   +Section (1/2) 

      +Program (1/2/3/4) 

Note: Click the + to view the sections and programs associated with that 
processor.  

  Audio DMB Grp (1-4) 
Checksum Error 

A checksum (CRC) error is detected in the 
specified input embedded audio group 

  Audio DMB Grp (1-4) DBN 
Error 

Invalid DBN is detected in the input embedded 
audio group 

  Audio DMB Grp (1-4) ECC 
Error 

ECC error(s) are detected in the input embedded 
audio group 

  Audio DMB Grp (1-4) Missing No input is detected for the specified input 
embedded audio group 

  Audio DMB Grp (1-4) Parity 
Error 

Parity error(s) are detected in the input 
embedded audio group  

  Audio EMB Grp (1-4) Append 
Error 

Append errors are detected in the specified 
embedded audio group output  

  Audio EMB Grp (1-4) 
Overwrite Error 

Overwrite errors are detected in the specified 
embedded audio group output 

  Audio Format Incompatible One or more connected audio inputs are non-
PCM coming in but are sending out as ST2110-30 

  IP Receiver Ancillary Input 
Missing  

No ancillary IP input is detected on the specified 
streams (lists the streams with this error); check 
network and IP configuration 

  IP Receiver Ancillary Missing 
Packets 

Missing ancillary IP packets detected on 
streams(s) N,... Check IP source 

  IP Receiver Ancillary Out of 
Range packets  

Out of range ancillary IP Packets detected on 
stream(s) n, ... Check IP source  

  IP Receiver Ancillary Seamless 
Protection Missing  

Either primary or secondary seamless protection 
IP input is missing on the specified ancillary 
streams (lists the streams with this error)  

  IP Receiver Ancillary Switch 
Error 

IP input switching error is detected on the 
specified ancillary streams (lists the streams with 
this error) 

  IP Receiver Audio Input 
Missing 

No audio IP input is detected on the specified 
channel (lists the first four streams with this 
error); check network and IP configuration 

  IP Receiver Audio Missing Missing audio IP packets detected on streams(s) 
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Packets N,... Check IP source 

  IP Receiver Audio Out of 
Range packets  

Out of range audio IP Packets detected on 
stream(s) n, ... Check IP source  

  IP Receiver Audio Seamless 
Protection Missing 

Either primary or secondary audio seamless 
protection IP input is missing on the specified 
ancillary streams (lists the first four streams with 
this error)  

  IP Receiver Audio Switch Error IP input switching error is detected on the 
specified audio streams (lists the first four 
streams with this error) 

  IP Receiver Video Input 
missing 

No video IP input is detected. Check network and 
IP configuration 

  IP Receiver Video Missing 
Packets 

Missing video IP packets detected. Check IP 
source 

  IP Receiver Video Out of 
Range packets  

Out of range video IP Packets detected. Check IP 
source 

  IP Receiver Video Seamless 
Protection Missing 

Either primary or secondary video seamless 
protection IP input is missing  

  IP Receiver Video Switch Error Video IP input switching error has been detected; 
the cause for this alarm may be listed  

  Video Input Lost No SDI video input is detected;  check BNC signals 
and connections 

  Video Output Frozen Invalid SDI or IP video output is detected; check 
video source  

+System    

 +Calibration  

  FPGA Calibration Failure FPGA failed to calibrate 

 +Fan   

  BB(1-4) FPGA Fan Failure Fan failure detected on the specified baseband 
FPGA on the main board  

  Front Panel Fan (1-4) Failure  Fan failure detected on the specified front panel 
fan 

  IP FPGA Fan Failure  Fan failure detected on the IP FPGA 

 +Internal   

  License Server Not 
Responding 

Internal license server is not responding, system 
reboot is required  

 +IP   

  Playout Delay Too Low IP Rx playout delay configured below the 
recommended minimum 

  Receiver Bandwidth Exceeded Total bandwidth for all receivers exceeds the 
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maximum  

 +Power Supply    

  Power Supply (A-B) Failure  Power supply failure detected 

  Power Supply Fan Failure Power supply fan failure detected 

 +QSFP   

  QSFP (A-B) Data Not Valid Invalid module data detected for the specified 
QSFP; check QSFP module 

  QSFP (A-B) Low Input Power 
Alarm  

Low input power on lane(s) on specified QSFP; 
check QSFP signals and connections 

  QSFP (A-B) Not Present  No module detected for specified QSFP; insert 
QSFP module 

 +Reference  

  PTP Not Locked The PTP clock is not locked to master. Check 
network and PTP configuration 

 +SFP  

  SFP (A/B/C/D) Part Mismatch The detected SFP does not indicate the same ID 
as the SFP selected in the GUI  

 +Temperature   

  BB(1-4) FPGA Temperature 
Alarm  

The temperature is out of the expected range on 
the specified baseband FPGA  

  IP FPGA Temperature Alarm  The temperature is out of the expected range for 
the IP FPGA  

  QSFP (A-B) Temperature 
Alarm 

Temperature is out of expected range on 
specified QSFP module 

Cannot login Only appears for remote SNP Manager. Indicates that the remote SNP Manager 
cannot login to the SNP specified at the top of the screen.   

Connection Loss to 
element 

Only appears for remote SNP Manager, indicates that connection has been lost to 
the SNP selected at the top of the screen.  

Note: Element that is selected at the top of the dialog box.  
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Configuring Processors 
The SNP configuration page has four Processor groups: A, B, C, and D. Each processor can be configured 
with one of six personalities. 

See Assigning a Personality to a Processor (on page 117) for more information.  

Note: When using an SNP-GW-3GX32 equipped with standard front panel, if only two conversion 
personalities are needed, for best results use Processors C and D (instead of A and B) to achieve a more 
balanced temperature distribution among the four processors. 

Each processor can be configured for low latency mode. See Configuring for Low Latency Mode. 

Each processor has two Sections. BNCs for each Section can be assigned with different direction to 
achieve SDI->IP or IP->SDI transmit with the radio buttons on the Dashboard.  

 

Note: When in 2022-6 mode, due to a bandwidth routing limitation, do not configure more than six 
channels in a Processor to receive at 1080p/50 or 1080p/59, or the switch mode will revert to Make 
After Break mode resulting in non-clean switches.  
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Configuring a Processor 
Depending on the mode the processor is set to, the Configuration tab will have different options. For 
example, when in Sync, Remap, or Conversion mode, the Configuration tab for each processor will 
appear similar to the following:  

 
 

Low Latency Mode Note: Low Latency Mode is only supported on Sync and JPEG-XS  
(TR-07 and TR-08) personalities. The system must be synchronous (locked to 
the same PTP). 

This mode improves the system latency for the sync personality by not 
realigning to reference. Low Latency mode is available for both the SDI to IP 
Transmit path and the IP Receive to SDI path and is applied to the entire 
processor. When a processor is configured for Remap personality, low latency 
setting has no effect.  

When an output is configured for SDI, don't enable Low Latency unless it is 
connected to a downstream device that will re-align the signal to a timing 
reference.   

When low-latency is enabled, other "delay" controls become unavailable: 

• Frame delay  

• H (horizontal) phase  

• V (vertical) phase 

• Channel delay (found in the Audio tab) 

Note: When using the AAP, A/V timing is not achieved since the AAP codecs add 
latency to the audio path, and video frames are not delayed to compensate for 
any DSP delays. By design, there is minimum latency in low latency mode. 
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Default IP Audio Tx 
Packet Time 

Allows selection per processor. Options are:  

• 1 ms 

• 125 us 

• 500 ms 

Since 125us and 500us uses more bandwidth than 1ms, it is recommended 
only to use 125us/500us when combining audio transmitter in 4 to 16-channel 
configurations. Note that changing this parameter may cause an automatic 
change to the configured number of channels in individual audio channel 
configurations. 

Also see the Packet Time parameter (for stream level packet time settings) in  
Output Tab: IP Audio Configuration (on page 457). 

SFP Select Choose the type of SFP that SNP should be expecting in this position. Options 
include:  

• Unused 

• 2RX 3G 

• 2RX 12G 

• RX HDMI 

• 2 RX MADI 

• 2TX 3G 

• 2TX 12G 

• TX 12G HDMI 

• 2 TX MADI 

After you make this selection other options will be revealed depending on the 
SFP selected. See Configure SFPs (on page 115) and Audio Expansion  (on page 
303).  

Force MAB Mode When checked, the switch mode is set to Make After Break. Otherwise, the 
switch mode will depend on whether there's available bandwidth to do a Make 
Before Break switch. This can help to avoid oversubscribing the switch. See 
Make-Before-Break (MBB) Video Switching (on page 470).  
 

Note: This parameter does not apply to the Multiviewer and Multiviewer 
Portrait Mode personalities, since these only support the Make-After-Break 
mode. 

When in Sync or Multiviewer mode, the Section 1 and 2 areas will be populated. See Configuring a 
Section for HD or UHD (on page 116).  

The following sections describe the options on this screen:  

Configure SFPs ....................................................................................... 115 
Configuring a Section for HD or UHD ..................................................... 116 
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Configure SFPs 

This section describes options for configuring SFPs when in Conversion, Sync, or Remap modes. For 
information on configuring SFPs in Multiviewer mode, see Configure a Multiviewer Personality (on page 
240).  

Each SFP is associated with an SNP Processor as in the following diagram. Insert the correct SFP in each 
slot prior to configuring it.  

Note: The SFPs in slots A and D are oriented differently than SFPs in slots B and C. The positions of 
connections 1 and 2 are defined below:  

 

    

Electrical SFP Orientation  Optical SFP Orientation 

SFPs are configured on a per-processor basis. To configure the SFP, click Edit for that Processor.  

SFP 1 Output Enable When disabled, this reduces heat from the SNP frame. This field only 
appears when a TX SFP is inserted in the slot for this processor and HDMI is 
not the output of choice.  

SFP 2 Output Enable When disabled, this also  reduces heat from the SNP frame. This field only 
appears when a TX SFP is inserted in the slot for this processor.  

HDMI Output Source Choose Section 1 or Section 2 to be routed to both outputs. This field only 
appears when SFP Select is set to 12G TX SFP.  
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Configuring a Section for HD or UHD 
Note: This section only applies when the Processor Personality is Sync, Multiviewer, or Multiviewer 
Portrait Mode. See Configuring a Sync Personality (on page 120).  

There are two sections per processor and they are independently selectable to be HD or UHD. Input can 
be SDI or IP. Output can be SDI and IP concurrently.  

• Possible Input and Output Video Standards include 525i/59.94, 625i/50, 720p/50, 720p/59.94, 
1080i/50, 1080i/59.94, 1080p/23.98, 1080p/24, 1080psf/23.98, 1080psf/24, 1080p/25, 
1080p/29.97, 1080p/50, 1080p/59.94, 2160p/23.98, 2160p/24, 2160p/25, 2160p/29.97, 2160p/50, 
2160p/59.94 

• Possible Input Interface: SD-SDI, HD-SDI, 3G-SDI, 6G-SDI (2SI), 12G-SDI (2SI), 2110-20 

• Possible Output Interface: SD-SDI, HD-SDI, 3G-SDI, 6G-SDI (2SI), 12G-SDI (2SI), 2110-20 

Note: The SFP video output will follow the SDI UHD Output Link Selection in the Output tab for UHD 
outputs. It is not possible to have 3G-QL on the BNC outputs and a 12G-SL output on the corresponding 
SFPx output simultaneously. 

Each of the four processors has an Edit button on the Dashboard. Click Edit to see the following dialog 
box for that processor:  

For each section, you can choose:  

Operation Mode • HD: The section will contain four programs 

• UHD: The section will contain one program  

 

 

 

UHD Processor (1 program)  

 

 

 

HD Processor (4 programs)  

When you are done, click Apply Sections and reboot the SNP.  

Note: A reboot is required to change a processor's mode between HD and UHD.   
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Assigning a Personality to a Processor 
To assign a personality or change the personality on a Processor, follow these steps:  

1. On the Dashboard, with an element selected, click the Edit button for a Processor.  

2. On the Configure Processor dialog box, choose the Personality tab (see SNP Personalities (on page 
118)) 

 

Personality • Conversion 

• Quad Conversion 

• Remap  

• Sync  

• JPEG-XS Decoder 

• JPEG-XS Encoder 

• STAT 

• Multiviewer 

• Multiviewer Portrait Mode 

FPGA Status (read-only)  

3. When you are done making your selections, click Apply Personality.  

4. Reboot your SNP 

The FPGA Status field displays Loading until the change is complete.  
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SNP Personalities 

SNP personalities are determined on a per-processor basis. The following topics describe the 
personalities that are currently available:  

Personality How to Configure 

Sync Personality Configuring a Sync Personality (on page 120) 
Also see: Automatic Change Over (ACO) on the Sync Personality (on 
page 124) 

Dual Conversion Personality Configuring a Dual Conversion Personality (on page 135) 

Quad Conversion Personality Configuring a Quad Conversion Personality (on page 141) 

Remap Personality Configuring a Remap Personality (on page 133) 

JPEG-XS Personality Configuring a JPEG-XS Personality (on page 146) 

TR-07 Personality Configuring a TR-07 Personality (on page 165) 

Dual Gateway Personality Configuring a Dual Gateway Personality (on page 157) 

STAT Personality Configuring a Simple Transparent Asynchronous Transport (STAT) 
Personality (on page 179) 

Multiviewer Personality Configuring a Multiviewer Personality (on page 237) 

 Configuring a Multiviewer Portrait Mode Personality (on page 250) 

Master Control Lite Personality Master Control Lite (MCL) Personality (on page 186) 

 
The number of supported channels will depend on the personality assigned to a processor, as described 
in the following table:  

Personality Per Processor Maximum per SNP  

Sync • 8 x HD 

• 4 x HD + 1 x UHD 

• 2 x UHD 

• 32 x HD 

• 16 x HD + 4 x UHD 

• 24 x HD + 2 x UHD 

• 8 x UHD 

• others 

Dual Conversion  • 2 Conversions 
(Up/Down/Cross) 

• 8 Conversions 

Quad Conversion • 4 Conversions 
(Up/Down/Cross) 

• 16 Conversions 

Remap (UHD) • 2 Channels • 8 Channels 

JPEG-XS • 2X UHD 

• 8 x HD 

• 8x UHD 

• 32 x HD 

STAT • 8 x HD • 32 x HD 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 119 

 

Multiviewer/ Multiviewer 
Portrait Mode 

• 9 x HD 

• 8 x HD-3G 

• 2 x UHD 

• 1 x UHD + 4 x HD-3G 

• 1 x UHD + 5 x HD 

• 36 x HD 

• 32 x HD-3G 

• 8 x UHD 

• 4 x UHD + 16 x HD-3G 

• 4 x UHD + 20 x HD 

SNP contains four processors. Each processor can take on any personality.  
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Configuring a Sync Personality 
Note: This personality supports MADI. See MADI Support (on page 293). 

 

Sync Personality Support 
The SNP Sync personality has two sections per processor which are 
independently selectable to be (one) UHD or (four) HD streams. See 
Configuring a Section for HD or UHD (on page 116). 

HD Mapping • When mapped entirely for HD, an SNP will have a maximum of 32 HD 
programs.  

• Each of the 32 BNCs on the back panel of SNP is one-to-one mapped 
to one HD channel specifically.  

• See BNC Ports (on page 49) for more information.  

HD Proxies When in Sync Personality mode, HD proxies are available. See 
Configuring Proxy Output (on page 261).  

SDI/IP Inputs and Outputs • When using the SNP Sync personality, the input and output video will 
have the same standard.   

• The input can be SDI or IP.  

• If the input is IP, the output can be SDI and IP concurrently.  

• If the input is SDI, the output can only be IP. 

Configuring Sync See: 

• Configuring IP to SDI/IP (on page 121) 

• Configuring SDI to IP (on page 122) 

Sync Parameters See ACO Parameters (on page 130). 

Sync Licensing 
The required license option is SNP-PSK-SYNC (Sync/Remap/STAT 
Personality). See Orderable Part Numbers (on page 35).  

 

 Possible input and output video standards  
Possible Input and Output Interfaces 

HD section mode 

• 720p/50 

• 720p/59.94 

• 625i/50 

• 525i/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/25 

• SD-SDI 

• HD-SDI 

• 3G-SDI 

• 2SI-SDI  

• 6G-SDI 

• 12G-SDI  

• 2110-20 

• 2022-6   
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 Possible input and output video standards  
Possible Input and Output Interfaces 

• 1080p/24 

• 1080psf/24 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 

UHD section mode 

• 2160p/50 

• 2160p/59.94 

• 2160p/23.98 

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

 

Note: SQD IN – SQD OUT is not supported in the SYNC personality. 

 
 

Configuring IP to SDI/IP 

Ensure that the IP WAN has been configured before setting up any receivers, and that your SNP is 
configured for Sync personality.  

To configure an SNP program as receiving video from IP input, and transmitting it out as SDI, follow 
these steps:   

1. Choose the Section Input mode as IP for the section of the processor you're working on.  

2. Click the Program you want to configure.  

3. On the Input tab, make WAN-related configurations as appropriate for your network, including the 
following:  

▪ Check the "Video IP Receiver Enable" checkbox. 

▪ Set the correct Receiver Video Standard. 

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source. 
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4. On the Video tab, remove the check beside Enable Force Video Standard.  

 

Your SNP is now ready to convert IP video to output SDI.  
 

Configuring SDI to IP 

Ensure the IP WAN has been configured before setting up IP transmitters, and that your SNP is 
configured for Sync personality. 

To configure an SNP program as receiving video from SDI input, and transmitting it out as IP, follow 
these steps:  

1. Choose the Section Input mode as SDI for the section of the processor you're working on.  

2. Click the Program you want to configure to open its Configuration dialog box.  

3. On the Video tab, uncheck Enable Force Video Standard.  

4. On the Output tab, make the following selections:  

▪ Check Video IP Transmitter Enable under IP Video Configuration. 

▪ Set Transmitter Mode to ST2110-20.  



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 123 

 

▪ Make Primary and Secondary WAN settings based on your network.  

 

5. Click Apply to save the configuration.  

6. Repeat steps 5-7 for the audio and ancillary data.  

Your channel is now ready to convert SDI to IP.  
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Automatic Change Over (ACO) on the Sync Personality 

The SNP supports Automatic Change Over or ACO. The main goal of automatic change over is to protect 
IP based systems including SDI/IP mixed.  

ACO Support ACO can be used in UHD or HD mode, and gives you two inputs. 

• ACO on SNP Sync (UHD) (on page 125)  

• ACO on SNP Sync (HD) (on page 126) 

Configuring ACO See Enabling Automatic Change Over (ACO) (on page 127) for how to 
configure ACO 

Signal Quality Metrics in ACO In ACO mode, Signal quality metrics  (see Signal Quality Monitoring (on 
page 128)) are determined on both inputs; the better input goes to the 
Program output, thus providing smart switching driven by signal quality 
metrics.  

The other signal (that's not going to air) becomes the Preset output and 
can also be seen on a multiviewer. 

Users can choose to manually override this selection using manual or 
forced selection of input A or input B. This can be done via the ACO 
Manual Control parameter in the ACO tab of the Program 
Configuration. See ACO Parameters (on page 130). 

The SNP Management tab (Configure Element > SNP Management) 
provides global defaults for SQM settings (thresholds for audio signals, 
missing ANC packets, etc.) See SQM Global Defaults (on page 376).  

Reversion Modes Reversion modes control failback, or when the ACO switches back to the 
main input from the backup input (immediate, manual intervention, or 
manual/failure mode).  

The Signal Failure threshold determines the point at which a switch is 
made, based on the Signal Score, which is derived from settings in the 
"Failure point contribution" section (See the "Failure point contribution" 
section in ACO Parameters (on page 130)). 

Signal scores in turn, are determined based on weights or thresholds 
that can be defined for for settings like video loss, black, freeze, missing 
ANC, audio high/low, etc. effectively allowing for configuration of what 
is acceptable, and providing more granular control over ACO 
functionality.  

What to do in the rare event that both inputs fail can also be configured. 
(See the Video Output on Dual Failure parameter in the ACO 
Parameters (on page 130) section) 

The Onset Time parameter controls how long the failure needs to occur 
to trigger the switch and the Clear Time parameter determines how 
long it has to be good before you switch back. 

ACO Parameters See ACO Parameters (on page 130). 

ACO Alarms See  Alarms (on page 131) 
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ACO Licensing Automatic Change Over is a software key add-on to the SNP SYNC 
personality. See Automatic Change Over (ACO) Licensing (on page 132) 
and Orderable Part Numbers (on page 35) 

Once ACO has been licensed, an ACO tab is displayed on processors in 
Sync mode. ACO can be enabled or disabled per program. 

ACO Support from other devices Status from ACO and the ability to override also extends to Magellan 
control panels via CCSP parameters. See ACO Support from Control 
Panels and Third Party Devices (on page 132). 

 

 

ACO on SNP Sync (UHD) 

Supported Inputs • IP, SDI, 12G, or 2SI 

• Inputs can be mixed (one IP, other SDI) 

Supported Outputs • IP and/or SDI (depending on connector or 
VSFP) 
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ACO on SNP Sync (HD) 
 

Supported Inputs • IP or SDI 

• SD/HD/1080P 

• Inputs can be mixed (one IP, other SDI) 

Supported Outputs • IP and/or SDI (depending on connector or 
VSFP) 
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Enabling Automatic Change Over (ACO) 

Note: Ensure that you have an ACO license applied before enabling ACO. If you don't enable ACO on the 
processor, it functions as a normal Sync processor.  
 
The required license option is SNP-PSK-ACO (Automatic Change Over Feature). See Orderable Part 
Numbers (on page 35).  

To enable ACO: 

1. Go to the Configure Processor dialog 

2. In the Configuration tab, under General, select ACO Mode and click Apply Config 

 

3. The Processor column then displays Sync (ACO) to indicate the status 
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4. The Program Configuration dialog displays an additional tab for ACO. See ACO Parameters (on page 
130) for more details on settings in this tab. 

 

5. Once ACO has been enabled for a Processor, you also need to enable ACO per program. To do this, 
click a program within the Processor, and in the ACO tab, select ACO Enable. 

Note: If you skip this step, even though ACO has been enabled for the Processor in question, the 
individual program will function as Sync. You can also use this control (enable or disable as required) 
to have a mix of ACO and Sync. 

 
 

Signal Quality Monitoring 

Signal Quality Monitoring is controlled via the Configure Element > SNP Management tab, which 
displays a section for SQM Global Defaults. See SQM Global Defaults (on page 376). 

These global defaults are used for SQM settings in all non-MV personalities (since in case of MV 
personalities, these settings may be overwritten by PiP-specific values from the layout) and are 
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displayed regardless of ACO license presence or enabling. In the MV personality, these global defaults 
are used for things that are not specified in the layout. 
 

Program and Preset Status 

Once set to ACO mode and configured, a Processor shows the Program and Preset status for each input. 
You see: 

• PGM: Set to Off, TSG, Pass, Main, or Protect 

• PST:  Set to Off, TSG, Pass, Main, or Protect 
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This Program/Preset status is also seen in the ACO tab, ACO PGM Status and ACO PST Status 
parameters . See ACO Parameters (on page 130) 

 
 

ACO Parameters 

Program Configuration > ACO Tab 

ACO Configuration 

ACO Enable Enables ACO on this Program 

ACO Manual Control The default setting for ACO is Auto (where the best input signal is auto 
detected). The Manual control lets you override that by selecting one of:  

• Force Main 

• Force Protect 

• Force Switch 

• Force TSG 

Reversion Mode Settings include: 

• Immediate = When the main signal returns to a good state, go back to it 
immediately after the main signal has remained good for the number of 
seconds indicated in the Clear Time parameter 

• Manual = Do not switch and wait for user intervention. To re-arm the 
ACO,  set ACO  Manual Control to Force (Signal A) and then return the 
control to Auto  

• Manual/Failure = Wait for user intervention, but if the other signal fails 
for some reason, then switch back (and remain armed to switch again if 
needed) 

Dual Failure Timeout How long to wait (seconds) when both inputs are in a failed state, before 
taking the Video Output on Dual Failure action.  

Range is 0-30 (seconds), default is 7 

Video Output on Dual Failure This setting controls what to do if both signals fail. You can keep the frozen 
frame on the screen or put up a test pattern. Options include TSG and 
FrameSync. 
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Signal Failure Threshold Signal Failure threshold sets the number of failure points for a bad signal 
or the point at which a switch is done. Range 1-1000, default is 99. 

Signal Score for Main Input Various settings from the "Failure point contribution" section determine 
and sum up the Signal Score.  

Signal Score for Protect Input Various settings from the "Failure point contribution" section determine 
and sum up the Signal Score.  

ACO PGM Status The current ACO Program Output Status  
(Main, Protect, TSG, Freeze, Pass Main, Pass Protect, Black, Off) 

ACO PST Status The current ACO Preset Output Status 
(Main, Protect, TSG, Freeze, Pass Main, Pass Protect, Black, Off) 

Onset Time How long to wait (seconds) from when the signal failure threshold is 
crossed, until taking the failure action.   

Range is 0-20 (seconds), default is 5. 

Clear Time How long to wait (seconds) from when the signal failure threshold is no 
longer crossed (signal has become good) until the signal is considered 
good for use.   

Range is 0-20 (seconds), default is 2. 

Failure Point Contribution 

Loss of Video Failure points for loss of video. Range is 0-500 and default is 100. 

Video Freeze Failure points for video freeze. Range is 0-500 and default is 90. 

Video Black Failure points for video black. Range is 0-500 and default is 90. 

Audio High/Low Ch (1-16) Failure points for audio channel high/low. Range is 0-500 and default is 10. 

ANC Missing (1-4) Failure points for ancillary filter missing packets. Range is 0-500 and 
default is 0. 

 
 

Alarms 

Audio Level Error N (N:1..16)  Asserts when audio is too high or too low based on the global config for 
levels and delays. Note that the global delay value affects how long it takes 
for the condition to be asserted, and then the raise delay in the UI adds 
onto that until the alarm is asserted. 

ANC Missing N (N:1..4)  Asserts when the ANC Missing condition is determined, based on the 
global config. 

ACO Enabled but not armed Asserts when the manual control is not “Auto”, or when the reversion 
mode is Manual and fail-over has occurred 

ACO in B position Asserts when fail-over or manual action has put the ACO into the B 
position (the not-normal position) 
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ACO Support from Control Panels and Third Party Devices 

Status from ACO and the ability to override also extends to Magellan control panels via CCSP 
parameters. 

On Magellan RCP/VRCP Control panels, you can map buttons to ACO functions. For example, while you 
can control the ACO Manual Control from the SNP UI (Program Configuration > ACO tab), you can also 
map buttons on your Magellan Control Panel so you can Force Main, Protect, etc. And likewise for other 
functions. 

 
 

Automatic Change Over (ACO) Licensing 

The required license option is SNP-PSK-ACO (Automatic Change Over Feature). See Orderable Part 
Numbers (on page 35). 
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Configuring a Remap Personality 
Note: This personality supports MADI. See MADI Support (on page 293). 

 

Remap Support • The Remap personality is similar to the Sync personality but adds the 
ability to transcode to and from the SQD format 

• In Remap Mode each Processor Section has one Program.  

• Each program has a configuration page.  

• SQD is only available on the SDI inputs or outputs.  

• Each processor handles two UHD channels.  

• This mode is not for HD or 3G signals.  

• Processing includes a Color Processor (color space conversion, 
dynamic range conversion) and  Test Signal Generator (TSG).   

Supported Formats • The Remap personality remaps UHD between SQD and ST 2110, 12G 
(1.2), or 2SI signal formats 

Remap Licensing 
The required license option is SNP-PSK-SYNC (Sync/Remap/STAT 
Personality). See Orderable Part Numbers (on page 35).  

 

Possible input/output combinations are as follows: 

Input Output 

UHD-2110 SQD-SDI 

SQD-SDI UHD-2110 (& 6G/12G-SDI via SFP)   

UHD-2110 2SI-SDI (pass thru, no re-mapping is required)  

2SI-SDI UHD-2110 (pass thru, no re-mapping is required) 

6G/12G-SDI  UHD-2110 (pass thru, no re-mapping is required) 

UHD-2110 6G/12G-SDI (pass thru, no re-mapping is required) 
 

Remap 2SI to SQD 

Ensure that the IP WAN has been configured before setting up any receivers, and that your SNP is 
configured for Remap personality. 

To configure an SNP program as receiving 2SI video from IP input, and transmitting it out as SQD over 
SDI (which is the only way SNP can output SQD), follow these steps:  

1. Choose the Section Input mode as IP for the section of the processor you're working on.  

2. Click the Program you want to configure to open its Configuration dialog box.   

3. On the Input tab, make WAN-related configurations as appropriate for your network, including the 
following:  

▪ Check the "Video IP Receiver Enable" checkbox. 
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▪ Set the correct Receiver Video Standard. 

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source.  

If the IP address is set to 0.0.0.0 and UDP port is set to zero, no input will be expected on this 
interface. 

4. On the Video tab, remove the check beside Enable Force Video Standard.  

5. On the Output tab under Pixel Format, select Square Division.  

Note: Choosing SQD as the pixel format will disable IP output.  

6. Click Apply to save your changes.  

Your SNP is now ready to convert IP video to output SQD.  
 

Remap SQD to 2SI 

Ensure the IP WAN has been configured before setting up IP transmitters, and that your SNP is 
configured for Remap personality.  

To configure an SNP program as receiving SQD video from SDI input (which is the only place SNP can get 
it from), and transmitting it out as 2SI over IP, follow these steps:  

1. Choose the Section Input mode as SDI for the section of the processor you're working on.  

There will only be one program to choose from, as Remap uses UHD video only. 

2. On the Input tab, under Pixel Format, choose Square Division.  

3. On the  Video tab, uncheck Enable Force Video Standard.  

4. On the Output tab, make the following selections:  

▪ Check Video IP Transmitter Enable under IP Video Configuration. 

▪ Set Transmitter Mode to ST2110-20.  

▪ Make Primary and Secondary WAN settings based on your network.  

The SDI option won't be available as it's in use on the input side.  

5. (Optional) Configure proxy output, as described in Configuring Proxy Output (on page 261).  

6. Click Apply to save the configuration.  

Your channel is now ready to convert SQD to IP (2SI).  
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Configuring a Dual Conversion Personality 
This personality supports 3D LUT Processing and Subtitles. See Color Processing - Built In and Custom 
LUTs (on page 264) and Subtitles on the SNP (on page 306). 

The video conversion personality includes video format conversion and color processor (color 
correction, color space conversion, and dynamic range conversion).  

This is a licensed feature which can be applied to any processor within an SNP. The required license 
option is SNP-PSK-2CONVUHD (Dual UHD Conversion Personality). Each SNP can have up to 4 licenses, 
and two independent conversions can be done per processor (one per section), so each SNP can 
perform up to 8 conversions. See Orderable Part Numbers (on page 35).  

You can output HD, 3G or UHD. Basic frame rate conversion (drop/repeat) is done automatically, if the 
input signal has a different frame rate from the output frame rate. UHD can be carried via quad-link SDI, 
12G-SDI, IP-2110, or IP-2022-2. HD can be carried via SDI or IP-2110 or IP-2022-6.  

When the input is IP, IP Output (UHD-2110) and SDI Output (2SI-SDI) are available concurrently. 
Associated audio and data streams are delayed, processed and synchronized with the output video. If 
SQD-SDI output is enabled, then IP Output (UHD-2110) will not be available. Associated audio and data 
streams are delayed, processed and synchronized with the output video. 2110-40 is supported in this 
mode, with closed captions and OP547 passed from input to output in all video standards and programs.  

Possible Input and Output video standards  Possible Input and Output Interfaces 

• 720p50 

• 720p59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p29.97 

• 1080p/23.98 

• 1080p/24 

• 1080p/25 

• 1080p/50 

• 1080p/59.94 

• 2160p/50 

• 2160p/59.94 

• 2160p/23.98 

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

• HD-SDI 

• 3G-SDI 

• SQD-SDI 

• 2SI-SDI  

• 6G-SDI 

• 12G-SDI  

• 2110-20 

• 2022-6   
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Input Output Valid 

HD HD Yes 

HD UHD-2SI Yes 

HD UHD-SQD Yes * 

   

UHD-2SI HD Yes 

UHD-2SI UHD-2SI Yes 

UHD-2SI UHD-SQD No 

   

UHD-SQD HD Yes * 

UHD-SQD UHD-2SI No 

UHD-SQD UHD-SQD No 

* UHD-SQD input and output are only available on BNCs. 

In Conversion mode, the maximum number of frames of delay will depend on the output format: 

• UHD-SQD output: max delay = 2 frames; min scaler latency = 2 input frames (progressive input), or 2 
input fields (interlaced input). 

• 1080i output: max delay = 2 frames; min scaler latency = 1 input frame (progressive input), or 1 
input field (interlaced input). 

In Conversion mode, there is one data filter that can apply EIA-708 closed captions or OP-47 teletext. 
See Ancillary Data IP Filter (Conversion Mode) (on page 463).  
 

Supported Combinations 

The following process combinations are supported on the Conversion personality: 

Input Conversion Output 

HD (SDI or IP) Convert to different HD HD (SDI and/or IP) 

HD (SDI or IP) Upconvert to UHD UHD (12G, 2SI, and/or IP) 

HD (SDI or IP) Upconvert to UHD UHD (SQD) 
No IP output when in SQD output 
mode 

UHD (12G or 2SI or IP) Downconvert to HD HD (SDI and/or IP) 

UHD (SQD) Downconvert to HD HD (SDI and/or IP) 

UHD (12G or 2SI or IP) Color process and Sync (no 
conversion) 

UHD (12G, 2SI, and/or IP) 
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Configuring IP to IP Routing 

Ensure that the IP WAN has been configured before setting up any receivers or transmitters, and that 
your SNP is configured for Conversion personality. 

To configure an SNP program as receiving video from IP input, and transmitting it out as IP video with a 
video standard conversion, follow these steps:  

1. Choose the Section Input mode as IP for the section of the processor you're working on.  

2. Click the Program you want to configure to open its Configuration dialog box.   

3. On the Input tab, make WAN-related configurations as appropriate for your network, including the 
following:  

▪ Check the "Video IP Receiver Enable" checkbox. 

▪ Set the correct Receiver Video Standard. 

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source. 

If the IP address is set to 0.0.0.0 and UDP port is set to zero, no input will be expected on this 
interface. 

4. On the Video tab, beside Output Video Standard, choose any option in the drop-down menu.  

5. On the Output tab, make the following selections:  

▪ Check Video IP Transmitter Enable under IP Video Configuration. 

▪ Set Transmitter Mode to ST2110-20.  

▪ Make Primary and Secondary WAN settings based on your network.  

When the input is IP, the SDI output is always enabled.  

6. (Optional) Configure proxy output, as described in Configuring Proxy Output (on page 261).  

Input Output  

3G  3G + 1080i proxy 

1.5G main + proxy both 1.5G (proxy will be the same format as main) 

2SI 2SI + 1080i proxy 

7. Click Apply to save the configuration.  

Your channel is now ready to convert IP to IP.  
 

Configuring IP to SDI Video Format Conversion 

Ensure that the IP WAN has been configured before setting up any receivers, and that your SNP is 
configured for Conversion personality. 

To configure an SNP program as receiving video from IP input, and transmitting it out over SDI with a 
video standard conversion, follow these steps:  

1. Choose the Section Input mode as IP for the section of the processor you're working on.  

2. Click the Program you want to configure to open its Configuration dialog box.   
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3. On the Input tab, make WAN-related configurations as appropriate for your network, including the 
following:  

▪ Check the "Video IP Receiver Enable" checkbox. 

▪ Set the correct Receiver Video Standard. 

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source. 

4. On Video tab, beside Output Video Standard, choose any option in the drop-down menu.  

5. On the Output tab under Pixel Format, if your video output is an UHD format, select either Square 
Division or Pixel Interleave; if the IP input is UHD, SQD-UHD is not available.  

This setting will have no effect if your output video format is HD.  

Note: Choosing Square Division format will disable the IP output.  

6. Click Apply to save your changes.  

Your SNP is now ready to convert IP video to the video standard you selected.  
 

Configuring SDI to IP Video Conversion 

Ensure the IP WAN has been configured before setting up IP transmitters, and that your SNP is 
configured for Conversion personality.  

To configure an SNP program to receive video from SDI input, and transmit it out as any format over IP, 
follow these steps:  

1. Choose the Section Input mode as SDI for the section of the processor you're working on.  

The Conversion personality has only one program to choose from.  

2. On the Input tab, make the following selections:  

▪ If your video format is UHD, select either Square Division or Pixel Interleave from the UHD 
Input Pixel Format menu.  

▪ SDI Input Link Select (Options correspond to each of the four connectors associated with this 
program, or all four for UHD)  

3. On the  Video tab, select an Output Video Standard.  

Note:  If the IP output is UHD, only a 2SI-UHD input can be converted (SQD-UHD input is an invalid 
selection). 

4. On the Output tab, make the following selections:  

▪ Check Video IP Transmitter Enable under IP Video Configuration. 

▪ Set Transmitter Mode to ST2110-20.  

▪ Make Primary and Secondary WAN settings based on your network.  

The SDI option won't be available as it's in use on the input side.  

5. (Optional) Configure proxy output, as described in Configuring Proxy Output (on page 261).  

6. Click Apply to save the configuration.  

Your channel is now ready to convert SDI video to any output IP format.  
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Programs Ancillary Data Configuration 

In Conversion mode (dual and quad), the Programs Ancillary Data Configuration section (Configure 
Processor > Output tab) affects baseband processing, and setting it is required if the user expects the 
Ancillary Data to be forwarded to the SDI stream and to the IP TX stream.  

Note that the IP Ancillary Data Stream Configuration filters may only pick-up Ancillary Data that has 
been enabled in the baseband processing and it may only pick-up the data on the respective line 
number. 
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BNC Output 

In case of HD (Dual) Conversion, the SNP now provides copies of the main program on the subsequent 3 
BNCs. 
For example, in this case of Processor A in Dual Conversion Mode, Program 1's HD output is also 
available on BNCs 2,3,4 in addition to the main BNC 1.  

 

In UHD (Dual) Conversion mode, SNP always has 4 outputs for quad-links. 
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Configuring a Quad Conversion Personality 
This personality supports 3D LUT Processing and Subtitles. See Color Processing - Built In and Custom 
LUTs (on page 264) and Subtitles on the SNP (on page 306). 

The Quad Conversion personality supports up to four video conversion operations (per processor) to 
and from the following formats:  

• Supported Formats: 480i/576i/1080i/720p/1080p 

• Supported Standards: SD, 1.5 HD, and 3G HD 

This is a licensed feature that can be applied to any processor within an SNP. The required license option 
is SNP-PSK-4CONV3G (Quad 1080P Conversion Personality).  

Each SNP can have one Quad Conversion license (SNP-PSK-4CONV3G), with up to 4 license tokens for 4 
processors. Four independent conversions can be done per processor, so each SNP can perform up to 16 
conversions. See Orderable Part Numbers (on page 35).  

Inputs 

• Both SDI and IP (ST2022-6 or ST2110) inputs and outputs are supported 

• SDI interfaces can be HD-BNC or Baseband SFP 

• The input format is auto-detected for ST2022-6. For ST2110, the input standard needs to be set by 
the user. 

• Formats up to 1920x1080p 59.94 are supported,  as well as standard definition (525 or 625 
interlaced). 

• Inputs that are 480i/576i/1080i/720p/1080p can be converted to 480i/576i/1080i/720p/1080p 
outputs 

In the Quad-Conversion personality,  the channel will always process signals routed to one of the two 
supported two (SDI or IP) input paths. The ‘None’ option is meant to disable the input to the frame sync 
of the specified channel. There should be no input and no alarm for the channel. Note that the ‘None’ 
option does not disable the BNC port. It only disables the processor of the specified channel. For 
example, if the user selects ‘None’ for channel 1 and the user also selects ‘SDI 1-4’ for channel 5, 
channel 5 will still process the SDI signal of the BNC 1 port. 

Note that UHD is not supported. For UHD, use the dual conversion personality. See Configuring a 
Dual Conversion Personality (on page 135) 

Outputs 
Outputs can be SDI, IP, or both. SDI interfaces can be HD-BNC or SFP. Formats up to 1920x1080p 59.94 
are supported, as well as standard definition (525 or 625 interlaced).  

Any HD-BNCs not used for inputs are assigned as outputs by the SNP.  

▪ If SDI 1-4 is selected as input, SDI 5-8 will be used as output 

▪ If SDI-5-8 is selected as input, SDI 1-4 is used as output 

▪ In case of IP inputs, SDI 1/5 is the first output, followed by SDI 2/6, 3/7, and 4/8. 
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SFPs 

• 3G SFPs are supported 

• HDMI SFPs are not currently supported 

In case of SDI input, with an input SFP, the following input options apply: 

• Programs 1 & 2: Input options include BNC or SFP 1 

 

• Programs 3 & 4: Input options include BNC or SFP 2 
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Also see Programs Ancillary Data Configuration (on page 139) 
 

Configuring IP to SDI Quad Conversion 

Ensure that the IP WAN has been configured before setting up any receivers, and that your SNP is 
configured for Quad Conversion personality. 

 

To configure an SNP program as receiving video from IP input, and transmitting it out over SDI with a 
video standard conversion, follow these steps:  

1. Choose Input mode as IP for the processor 

2. Click the Program you want to configure to open its Configuration dialog box.   

3. On the Input tab, make WAN-related configurations as appropriate for your network, including the 
following:  

▪ Check the Video IP Receiver Enable checkbox 

▪ Select the Receiver Mode: ST2022-6 or ST2110-20 

▪ Set the Receiver Video Standard 

▪ Set the Primary and Secondary WAN selects 

▪ Set the Primary IP address, UDP port, and (optional) Multicast Source 

▪ Set the Secondary IP address,  UDP port, and (optional) Multicast Source 

4. On Video tab, beside Output Video Standard, choose any option in the drop-down menu.  
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5. Click Apply to save your changes.  

Your SNP is now ready to convert IP video to the video standard you selected.  
 

Configuring SDI to IP Quad Conversion 

Ensure the IP WAN has been configured before setting up IP transmitters, and that your SNP is 
configured for the Quad Conversion personality.  

To configure an SNP program to receive video from SDI input, and transmit it out as any format over IP, 
follow these steps:  

1. Choose the Input mode as SDI 1-4 or SDI 5-8 for the processor  

2. Click the Program you want to configure to open its Configuration dialog box.   

3. On the  Video tab, select an Output Video Standard.  

4. On the Output tab, make the following selections:  

▪ Check Video IP Transmitter Enable under IP Video Configuration. 

▪ Set Transmitter Mode to ST2110-20.  

▪ Make Primary and Secondary WAN settings based on your network.  

5. (Optional) Configure proxy output, as described in Configuring Proxy Output (on page 261).  

6. Click Apply to save the configuration.  

Your channel is now ready to convert SDI video to any output IP format.  
 

Configuring SDI to SDI Quad Conversion 

To configure a SNP program to receive video from SDI input, and transmit it out as SDI, follow these 
steps:  

1. Choose Input mode as SDI 1-4 or SDI 5-8 for the processor  

2. Click the Program you want to configure to open its Configuration dialog box.   

3. In the Input tab, make any video and/or audio configuration selections as applicable 

4. In the Video tab, select the applicable Output Video Standard.  

5. On the Output tab, select the appropriate Transmitter Mode as applicable 

6. Click Apply to save the configuration.  

Note:  

If Input mode selection is SDI 1-4, the corresponding SDI outputs will be available at SDI 5-8 respectively 
for that processor. 

If Input mode selection is SDI 5-8, the corresponding SDI outputs will be available at SDI 1-4 respectively 
for that processor 
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SFP Routing 

Note that from an SFP routing perspective, each program supports one SFP channel at the input, and 
both SFP channels on the output side.  

• Status for SFP-A-1 is displayed in the ‘Video Status’ section for Program 1 and Program 2 

• Status for SFP-A-2 is displayed in the ‘Video Status’ section for Program 3 and Program 4 
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Configuring a JPEG-XS Personality 
JPEG-XS Support • The JPEG-XS personalities (Encoder and Decoder) are structurally 

similar to the Sync personality, but perform compression or 
decompression of the video signal in compliance with the JPEG-XS 
(ISO/IEC 21122) standard. 

• Different bit rates can be configured (.8 to 4.2 bits per pixel) for 
compression, depending on the requirement. 

• Both the encoder and the decoder support audio shuffling and VANC 
data filtering. Among other applications, these personalities enable 
inter-facility connection at a reasonable bit rate.  

JPEG-XS Components 
The JPEG-XS personalities include an encoder, and a decoder with 
limited video processing.  See: 

• JPEG-XS Encoder (on page 147) 

• JPEG-XS Decoder (on page 152) 

Currently supported uncompressed 
video source formats: 

• 625i/50  

• 525i/59.94  

• 720p/50  

• 720p/59.94  

• 1080i/50  

• 1080i/59.94  

• 1080p/23.98  

• 1080psf/23.98  

• 1080p/24  

• 1080psf/24  

• 1080p/25  

• 1080p/29.97  

• 1080p/50  

• 1080p/59.94  

• 2160p/24 

• 2160p/25 

• 2160p/23.98 

• 2160p/29.97 

• 2160p/50  

• 2160p/59.94  

JPEG-XS Licensing The required license option is: 

• SNP-PSK-JXSE (JPEG-XS Encoder Personality) for encoding 

• SNP-PSK-JXSD (JPEG-XS Decoder Personality) for decoding. 

 See Orderable Part Numbers (on page 35) 
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JPEG-XS Encoder 

 

Configuration 
(per processor) 

• 2xUHD or 8x1080p  

• 1xUHD + 4x1080p 

Inputs SDI, 2022-6*, or 2110-20  

Processing Audio delay/gain/shuffle, Limited video processing 

Video Output format IP (SMPTE ST 2110-22, VSF TR-08) 

Audio and ANC Output SMPTE ST 2110-30/31/40 

Bit-rate for all source formats 
(SD, HD, 3G, UHD) 

0.8 .. 4.2 BPP 

Other Supports HD-proxy of the transmitted UHD videos 

Note: Proxy 3G output will not work for the TR08 Encoder in 
UHD mode if Proxy Input Select is either Link 2, Link 3 or Link 
4. 

 

* When using ST2022-6 for input or output on the SNP, the actual capacity of a processor may be limited 
by the total bandwidth including overhead of the 2022-6 signals - specifically when operating in 
1080p/59 or 1080p/50 formats, using ST 2022-6, 8x 1080p signals will exceed the 24.95Gbit/sec 
bandwidth ceiling of an SNP processor. 

Compression Options 
The following table provides a snapshot of compressed bit-rates for different coding rates and formats. 
This is configured using the Bit Rate Control parameter in the JPEG-XS section of the Output tab for a 
JPEG-XS Encoder processor.  

• 4 BPP is production quality 

• 2.5 BPP is contribution grade 

• 1.5 BPP and lower is monitoring quality 
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Representative Bit Rates for Typical Formats (Mbps) 

  
Monitoring Quality 

Near Visually Lossless 
(Contribution Quality) 

Visually Lossless 
(Production Quality)  

 1.5 BPP and lower 2.5 BPP 4 BPP 

1080i @ 50 82 Mbps 136 Mbps 218 Mbps 

1080i @ 59 98 Mbps 163 Mbps 261 Mbps 

1080p @ 50 164 Mbps 272 Mbps 435 Mbps 

1080p @ 59 196 Mbps 326 Mbps 522 Mbps 

2160p @ 50 653 Mbps 1088 Mbps 1740 Mbps 

2160p @ 59 783 Mbps 1304 Mbps 2086 Mbps 

See: 

• JPEG-XS Encoding (on page 148) 

• Configuring Encoding - Input (on page 149) 

• Configuring Encoding Output (on page 150) 
 

JPEG-XS Encoding 

For Processors configured as JPEG-XS Encoder, each program's Element view reports ST2110-22 as the 
outgoing standard and reflects the bitrate for the outgoing JPEG-XS compressed video stream. 

 

Most of the tabs contain settings similar to the Sync personality. Details and exceptions are listed below. 

Input Tab 

• Similar to the Sync personality 

Audio Tab 

• Similar to the Sync personality.  

Note: See the Audio Tab (Audio Tab: General Configuration (on page 449)) for some parameters that 
do not apply to the JPEG-XS Encoder personality. 

Video Tab 

• Does not have Output Colorimetry and TCS controls 

• No Color Adjustment controls 

• Input Colorimetry and TCS settings can be overriden 
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Output Tab 

• Since JPEG-XS cannot be encapsulated into SDI, settings related to SDI Outputs are not displayed, 
including VPID and all Audio Embedder related settings 

• In the IP Video Configuration section, Transmitter Mode is pre-set to ST2110-22 and the Packing 
Mode and SD Extended Window Size parameters are not displayed  

• In the IP Video Status section, the SD Starting Line and Picture Height parameters are not displayed 
 

Configuring Encoding - Input 

Input can be either IP (ST2022-6, ST2110-20) or SDI. 

To compress an SNP program from IP/SDI input to to ST2110-22 IP output using JPEG-XS encoding, 
follow these steps:  

1. Choose the Section Input mode as IP or SDI (as applicable) for the section of the processor you're 
working on.  

2. Click the Program you want to configure to open its Configuration dialog box.  

3. (For IP input only) On the Input tab, make WAN-related configurations as appropriate for your 
network, including the following:  

 

▪ Check the Video IP Receiver Enable checkbox. 

▪ Set the correct Receiver Video Standard. 

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source. 

4. On the Video tab, ensure Enable Force Video Standard is unchecked 
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Note: Selecting Enable Force Video Standard forces the output video to conform to a pre-selected 
standard, set in the Video Forced Standard drop down. 

 
 

Configuring Encoding Output 

1. On the Output tab: 

a. Define the JPEG-XS compression details:  

• Set the Bit Rate Control (0.8 to 4.2)  

• Set the Quality Optimization (Visual or PSNR)  
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Note: Changing the Bit Rate or the Quality Optimization settings (during operation) will 
cause a momentary disruption of the outgoing ST2110-22 stream. This, in return, will cause 
the JPEG-XS Decoder to temporarily lose lock, resulting in a loss of video (e.g. black or frozen 
or whatever the so-called Loss of Video Mode is set to at the Decoder). 

 

a. Make the following transmission selections: 

• Check Video IP Transmitter Enable under IP Video Configuration. 

• Make Primary and Secondary WAN settings based on your network. 

• Do the same for the Audio (IP Audio Configuration section) and ancillary data (IP Ancillary 
Data Stream Configuration) sections 

Notes 

• The Bit Rate Preview (Mbps) indicates what the currently selected Bit Rate Control (bpp) would 
result in (in terms of bitrate of the outgoing compressed video) - prior to clicking the 'APPLY' button. 
The Effective Bit Rate (Mbps) indicates the bitrate of the outgoing compressed video, that is 
currently in effect. 

• On the Video tab, the Outgoing Colorimetry and TCS information can be overwritten if the 
information is not available from the source or knowingly wrong, i.e. it doesn't match the actual 
HDR flavor of the source. 
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JPEG-XS Decoder 

 
 

Configuration 
(per processor) 

• 2xUHD or 8x1080p  

• 1xUHD + 4x1080p 

Input Format • IP (SMPTE ST-2110-22, VSF TR-08) 

• PTP locked or asynchronous 

Video/Audio/ANC formats • 2110-22 video (JXS)  

• 2110-30/31 audio 

• 2110-40 ANC 

Processing Audio delay/gain/shuffle, Limited video processing 

Output format SDI, 2022-6*, 2110-20 

Output frame sync Output is frame synchronized to PTP in destination system 

Other Supports HD-proxy of the received UHD videos 

* When using ST2022-6 for input or output on the SNP, the actual capacity of a processor may be limited 
by the total bandwidth including overhead of the 2022-6 signals - specifically when operating in 
1080p/59 or 1080p/50 formats, using ST 2022-6, 8x 1080p signals will exceed the 24.95Gbit/sec 
bandwidth ceiling of an SNP processor. 
 

Decoding JPEG-XS 

When a processor is configured as a JPEG-XS Decoder, the Input mode section is set to IP, and the video 
stream format is set to ST 2110-22.  

 

HD/UHD partitioning options similar to the Sync mode are supported and displayed. The following are 
possible combinations: 

Mode for Section 1 Mode for Section 2 Available Decoders 

Section 1  HD Section 2 HD 8x 2K JPEG-XS Decoders 
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Section 1  UHD Section 2 UHD 2x 4K JPEG-XS Decoders 

Section 1 HD  Section 2 UHD • 4x 2K Decoders (for the HD section) 

• 1x 4K Decoder  (for the UHD section) 

Section 1 UHD Section 2 HD • 1x 4K Decoder  (for the UHD 
section) 

• 4x 2K Decoders  (for the HD 
section) 

 
For Processors configured as JPEG-XS Decoder, each program's 'Element' view displays ST2110-22 as the 
incoming standard and reports the bitrate of the JPEG-XS codestream. 

 

Input Tab 

• In the IP Video Configuration section, 'Receiver Mode is pre-set to ST2110-22 (JPEG-XS) 

• In the IP Video Status section, the JPEG-XS Stream Details section reports status of the decoded 
JPEG-XS stream 
 

Bitrate (in Mbps) Displays the bit-rate 

Compression (bits-per-pixel) Displays the compression 

Profile Displays the Profile 

Level Displays the Video Level 

Video Standard Displays the Video Standard 

Color Depth • 0 – if input stream is missing or not recognized as an 
ST2110-22 stream, carrying JPEG-XS 

• 8 – if a valid ST2110-22 stream is being received, where 
the encapsulated JPEG-XS codestream originates from 
a Video source with 8-bit color depth 

• 10 – if a valid ST2110-22 stream is being received, 
where the encapsulated JPEG-XS codestream 
originates from a Video source with 10-bit color depth 

• 12 - if a valid ST2110-22 stream is being received, 
where the encapsulated JPEG-XS codestream 
originates from a Video source with 12-bit color depth 

Note that the JPEG-XS Decoder cannot process source 
content with an 8-bit or 12-bit color depth, hence an 
Alarm will be triggered (when the corresponding Alarm 
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condition is enabled). 

Color Subsampling • Unknown - if input stream is missing or not recognized 
as an ST2110-22 stream , carrying JPEG-XS 

• 4:2:0 YCbCr – if a valid ST2110-22 stream is being 
received, where the encapsulated JPEG-XS codestream 
originates form a Video source with a 4:2:0 color 
subsampling scheme 

• 4:2:2 YCbCr – if a valid ST2110-22 stream is being 
received, where the encapsulated JPEG-XS codestream 
originates form a Video source with a 4:2:2 color 
subsampling scheme 

• 4:4:4 YCbCr - if a valid ST2110-22 stream is being 
received, where the encapsulated JPEG-XS codestream 
originates form a Video source with a 4:4:4 color 
subsampling scheme 

Note that the JPEG-XS Decoder cannot process source 
content with a 4:2:0 or 4:4:4 color subsampling, hence an 
Alarm will be triggered (when the corresponding Alarm 
condition is enabled). 

Video Colorimetry Displays the Video Colorimetry. 

If for some reason Color Specification is missing in the 
received stream, this field displays "Unknown - Color 
Specification box is missing" 

Video Transfer Characteristics Displays the Video Transfer Characteristics. 

If Include Video Support Box was unchecked in the 
Encoder Program, this field displays "Unknown - Color 
Specification box is missing. 
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Figure 8: Example of a properly received ST2110-22 JPEG-XS stream with all metadata present, 
including colorimetry and transfer characteristics. 

 

Figure 9: Example when stream is missing altogether or its content cannot be deciphered (e.g. ST2110-
22 stream does not carry a standards conform JPEG-XS codestream) 

• All other settings are similar to the Sync personality 
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Video Tab 

• The controls and status information are largely identical to the Sync personality 

• Note that the JPEG-XS decoder supports only non-linear domain color adjustments 

Audio and Output Tabs 

• The Audio and Output tabs and their control/status options are similar to the Sync personality, with 
minor differences 

Notes: 

• The JPEG-XS Decoder accepts accepts ST 2110-22 formatted IP input containing JPEG-XS compressed 
video  

• The JPEG-XS Decoder does not support MADI 

• The JPEG-XS Decoder supports non-linear Color Processor features similar to the Sync personality 
(e.g. Offset, Gain, Hue), but no linear or 3D-LUT operations 
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Configuring a Dual Gateway Personality 
Note: This personality supports MADI. See MADI Support (on page 293). 

 

Dual Gateway Personality Support The Dual Gateway personality runs on both the SNP-XL and the Classic SNP.  

• The Classic SNP only supports UHD mode and automatically runs in this 
mode.  

• The SNP-XL supports both HD or UHD with 4 programs for HD and 1 program 
for UHD per section. Both directions in a section must be either HD or UHD. 

• Similar to other personalities,  there are two sections per processor which 
are independently selectable to be (1) UHD or (four) HD streams. See 
Configuring a Section for HD or UHD (on page 116). 

• Simultaneous VSFP dual-TX and dual-RX support – for 3G, 6G, and 12G 
signals 

• All IP inputs and outputs are ST 2110 (2022-6 not supported) 

Classic SNP  
Bi Directional (SDI to IP and IP to 
SDI) 

• The classic SNP supports two path simultaneously.  

• You can have SDI input to IP output and IP input to SDI output.  

• The SDI input must be from the BNC and the SDI output must be from a 
VSFP TX. 

Note: This is the only supported configuration on a classic SNP. If IP input is 
desired (for example 2110), the output can be from a VSFP. It cannot be from 
SDI output since there is only one set of BNC connectors shared by the input 
and output path. When running the Dual Gateway personality, the BNC is 
occupied by the SDI to IP path, and all the BNC connectors are configured as 
input. Therefore the only way you can get IP input is from the VSFP output. 

SNP-XL - Bi Directional 
(SDI to IP and IP to SDI) 

• The SNP-XL supportS two paths simultaneously.  

• You can have SDI input to IP output and IP input to SDI output.   

• Both SDI input and output can be from either BNC or VSFP. 
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Paths and Channels SDI to IP 

• 8 channels HD SDI input (16 channels audio) 

• 2 channels UHD SDI (16 channels audio) - HD proxy required.  See 
Configuring Proxy Output (on page 261).  

• MADI input supported 

• Output is 2110 

IP to SDI 

• 8 channels 2110 (HD) input (16 channels audio) 

• 2 channels 2110 (UHD) input (16 channels audio) 

• MADI output supported 

• Output is SDI 

 

SFPs • On a Classic SFP: 

• Selection: You can select from Rx and Tx using the SFP Select dropdown 
in the Configure Processor dialog.  

• Status: Combined SFP status for both Rx and Tx (A-D, mapping to 
processors A-D) is shown in the System tab (Configure > Element) 

• On an SNP-XL: 

• Selection: Separate Rx SFP and Tx SFP selection fields let you select Rx 
and Tx SFPs separately since these can be used simultaneously. 

• Status: Separate SFP status for Rx and Tx (A-D, mapping to processors A-
D) is shown in the System tab (Configure > Element) 

Configuring Dual Gateway See: 

• Initial Configuration (on page 160) 

• SDI to IP Path (on page 162) 

• IP to SDI Path (on page 163) 

Dual Gateway Licensing The required license option is SNP-PSK-GW88. It can be run on classic SNP or 
SNP-XL. See Orderable Part Numbers (on page 35).  
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 Possible input and output video standards  
Possible Input and Output Interfaces 

HD section mode 

• 720p/50 

• 720p/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/25 

• 1080p/24 

• 1080psf/24 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 

UHD section mode 

• 2160p/50 

• 2160p/59.94 

• 2160p/23.98 

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

• HD-SDI 

• 3G-SDI 

• 2SI-SDI  

• 6G-SDI 

• 12G-SDI  

• 2110-20 
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Initial Configuration 
1. Click Edit on the Processor, go to the Personality tab,  and set the Personality to Dual Gateway 

 

2. Go to the Configuration tab and set the Section operation modes to HD or UHD as desired. 

Note that this is only an option on an SNP-XL chassis; on SNP chassis, you will not see the Section 
operation modes as UHD is used by default. 
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3. Click the Program you want to configure to open its Configuration dialog box.  

4. Select the IP > SDI or SDI > IP tab depending on what you're configuring 

Within these tabs, parameters are filtered to display specific settings. For example, the IP to SDI 
tab's Input tab contains settings relevant to IP input. And the Output tab contains settings applicable 
to SDI Output. 

 

▪ See SDI to IP Path (on page 162) 

▪ See IP to SDI Path (on page 163) 
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SDI to IP Path 

1. On the Audio tab: 

▪ Audio tracking can be disabled (Off) or enabled with (Frame Sync + Delay) or without delay 
(Frame Sync). 

 

▪ The Pair Word Length can be set to 20, 24, or 16 bits 

 

▪ In the Output Channel Configuration for the Audio, you can choose Input from from DMB (de-
embedded channels), EXP (extended channels), TONES (test tones), or APIN (IP channels). DMB 
is preselected as the Input Type Select, since it represents embedded audio. 

 

2. On the Video tab: 

▪ Set Video Control (Delay), Output, and Test Signal Generator settings 

▪ Proxy options are only supported UHD sections (Note that the classic SNP is always UHD when 
set to the Dual Gateway personality, and can be UHD or HD for SNP-XL). Select: 

• The Proxy Input: UHD, Link 1-4 

• Whether to allow Proxy 3G Output 

3. On the Output tab:  

▪ Check Video IP Transmitter Enable under IP Video Configuration. 

▪ Set Transmitter Mode to ST2110-20.  

▪ Make Primary and Secondary WAN settings based on your network.  

▪ (Optional) Configure proxy output, as described in Configuring Proxy Output (on page 261).  

▪ Make Ancillary Data settings as desired. See Output Tab: Ancillary Data Configuration (on page 
461) 

▪ Make IP Ancillary Data Stream configurations as desired. See Output Tab: IP Ancillary Data 
Configuration (on page 461) 
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IP to SDI Path 

Note: SNP Classic supports two directions: SDI input to IP output, and IP input to SDI output.  The SDI 
input must be from the BNC and the SDI output must be from a VSFP TX. 
 
If IP input is desired (for example 2110), the output can be from a VSFP. It cannot be from SDI output 
since there is only one set of BNC connectors shared by the input and output path.  
 
The IP > SDI path requires a TX SFP configured to output SDI. 

1. On the Input tab, make WAN-related configurations as appropriate for your network, including the 
following:  

▪ Check the Video IP Receiver Enable checkbox. 

▪ Set the correct Receiver Video Standard. 

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source. 

2. On the Audio tab: 

▪ Audio tracking is always enabled in Frame Sync with delay mode (Audio Tracking Mode set to 
Frame Sync + Delay). By itself, Frame Sync isn't supported (on or off).  

 

▪ For a pair configuration, the Pair Word Length is set to 24 bits 

 

▪ In the Output Channel Configuration for the Audio, you can choose Input from from DMB (de-
embedded channels), EXP (extended channels), TONES (test tones), or APIN (IP channels). APIN 
is preselected as the Input Type Select, since it represents IP audio. 

 

3. On the Output tab, make the following selections: 
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▪ Make Output configuration selections 

 

▪ Make SDI Audio Embedding selections. 

▪ Make any Ancillary Data configurations. See Output Tab: Ancillary Data Configuration (on page 
461) 

4. Click Apply to save the configuration.  
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Configuring a TR-07 Personality 

VSF TRF-07 (Video Services Forum Technical Recommendation TR-07) defines profiles for streaming of 
JPEG XS video, and establishes an interoperable method for transporting that compressed video along 
with associated audio and ancillary data in an MPEG-2 Transport Stream.  

The SNP provides support for sending/receiving TR-07 streams via JPEG-XS Encoder/Decoder TR-07 
personalities. There are four TR-07 personalities, including a dedicated Encoder/Decoder to process 
UHD. The main purpose of these personalities is transport, so there's limited processing.   

JPEG-XS (TR-07) Support The JPEG-XS TR-07 personalities (Encoder and Decoder) are structurally 
similar to the Sync and JPEG-XS classic personalities, and perform 
compression or decompression of the video signal in compliance with 
VSF-TRF's TR-07 standard. 

• Different bit rates can be configured (.8 to 4.2 bits per pixel) for 
compression, depending on the requirement. 

• Both the encoder and the decoder support audio shuffling and VANC 
data filtering. Among other applications, these personalities enable 
inter-facility connection at a reasonable bit rate.  

JPEG-XS Components The JPEG-XS TR-07 personalities include: 

• JPEG-XS Encoder (TR-07): Supports HD and 3G encoding 

• JPEG-XS Decoder (TR-07): Supports HD and 3G decoding 

• JPEG-XS Encoder UHD (TR-07): Supports UHD encoding 

• JPEG-XS Decoder UHD (TR-07): Supports UHD decoding 

Support HD Encode and Decode Personalities 

• Video 

• TR-07 Capability Set A with 8 streams of HD/3G (4 per section).  

• The Encoder uses a hard coded PID (Packet Identifier) for the JPEG-
XS transport stream - JXS PID=49. 
 

• Audio 

• TR-07 Capability Set A is partially supported  
(2 instead of 4 Audio PIDs, however, the number of supported 
Audio channels is still 2 x 8 = 16). 

• Encoder: 2 PID with 4 AES3 per PID. 16 channels.  
The Encoder uses the following hard coded PIDs for the ST302 
(Audio) transport streams: 
- Stream #1: PID=50 
- Stream #2" PID=51 

• Decoder: Maximum of 2 ST302 (Audio) PIDs with 1-4 AES3 per PID 
(for a total of 8 Audio stereo pairs = 16 channels). 
 

• ANC 

• Capability Set A supported.  
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• The Encoder uses a hard coded PID for the ST2038 (ANC) transport 
stream: ANC PID=54 
 

UHD Encode and Decode Personalities 

• Video 

• TR-07 Capability Set B with 2 streams of UHD (1 per section). 

• The Encoder uses a hard coded PID (Packet Identifier) for the JPEG-
XS transport stream - JXS PID=49. 
 

• Audio 

• TR-07 Capability Set B supported except limited to 16 channels 

• Encoder: 2 PID with 4 AES3 per PID. 16 channels. 
The Encoder uses the following hard coded PIDs for the ST302 
(Audio) transport streams: 
- Stream #1: PID=50 
- Stream #2" PID=51 

• Decoder: Maximum of 2 ST302 (Audio) PIDs with 1-4 AES3 per PID 
(for a total of 8 Audio stereo pairs = 16 channels). 

• ANC 

• Capability Set B supported 

• The Encoder uses a hard coded PID for the ST2038 (ANC) transport 
stream: ANC PID=54 

Currently supported uncompressed 
video source formats: 

• 720p/50  

• 720p/59.94  

• 1080i/50  

• 1080i/59.94  

• 1080p/23.98  

• 1080psf/23.98  

• 1080p/24  

• 1080psf/24  

• 1080p/25  

• 1080p/29.97  

• 1080p/50  

• 1080p/59.94  

• 2160p/24 (UHD personality only) 

• 2160p/25 (UHD personality only) 

• 2160p/23.98 (UHD personality only) 

• 2160p/29.97 (UHD personality only) 

• 2160p/50 (UHD personality only) 

• 2160p/59.94 (UHD personality only) 
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Control • GUI (Local or remote SMM) 

• RESTFul API  

• NMOS for device connection management (only for ST-2110-x based 
interfaces) 

• SEAM via SDNO for device connection management  

JPEG-XS Licensing TR-07 is enabled by the standard JPEG-XS licensing: 

• SNP-PSK-JXSE (JPEG-XS Encoder Personality) for encoding 

• SNP-PSK-JXSD (JPEG-XS Decoder Personality) for decoding. 

 See Orderable Part Numbers (on page 35) 

Note: SNP's TR-07 personalities comply with the TR-07 specification, with a slight deviation in the audio 
streams. While 16 audio channels are supported, this is done over 2 streams and not 4. The resultant 
output is the same at the receiver end.  
 

TR-07 Encoder 

Configuration 
(per processor) 

• The JPEG-XS Encoder (TR-07) HD/3G personality lets you 
configure four programs per section for a total of 8 
programs, and each program supports a total of 16 audio 
channels.  

• The JPEG-XS Encoder (TR-07) UHD personality lets you 
configure one programs  per section for a total of 2 
programs, and each program supports a total of 16 audio 
channels.  

See Configuring Encoding Input (on page 170) and Configuring 
Encoding Output (on page 173) 

Inputs • SDI (BNCs 1-4)  

• SDI (BNCs 5-8) 

• IP 

• ST 2110-20/30/31/40  

• ST 2022-6 (Only supported in HD/3G personality) 

Note: VSF TR-07 imposes bandwidth limitations for ANC 
services being carried as MPEG2 TS via ST2022-2. It is advised 
not to waste bandwidth by transporting duplicates of services. 
Allowing duplicated ANC services can render unrelated ANC 
services unusable. 

Processing • Video test generation, audio tone generator, OSD, audio 
channel selection 
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Video Output format  
(JXS, Audio & ANC, together 
with program specific 
information, aka PSI). The PSI 
is comprised of a Program 
Association Table (PAT), a 
Program Map Table (PMT) and 
the Program Clock Reference 
(PCR) 

• ST 2022-2 TR-07 IP (no FEC). Unicast or multicast. 
Single-program MPEG2 Transport Stream (per channel) per 
TR07. Stream is also exposed via SEAM  (SDNO support). 

Compression • Operating Range for approximately 1.0 to 4.0 BPP (see 
compression options below) 

Proxy • Both TR-07 UHD flavors (ENC & DEC) support Proxy outputs 
(basically the same Proxies supported in other 
personalities, e.g. SYNC). 

• Note that the TR-07 UHD Encoder does not transmit the 
Proxies via TR-07 (MPEG-2 TS wrapped in ST2022-2). 
Instead, the Proxy outputs are ST2110-20 (or 2022-6 ?) 

• Proxy 3G output will not work for the TR07 Encoder in UHD 
mode if the Proxy Input Select is either Link 2, Link 3 or Link 
4. 

 
Compression Options 
The following table provides a snapshot of compressed bit-rates for different coding rates and formats. 
This is configured using the Bit Rate Control parameter in the JPEG-XS section of the Output tab for a 
JPEG-XS Encoder processor.  

• 4 BPP is production quality 

• 2.5 BPP is contribution grade 

• 1.5 BPP and lower is monitoring quality 

Representative Bit Rates for Typical Formats (Mbps) 

  
Monitoring Quality 

Near Visually Lossless 
(Contribution Quality) 

Visually Lossless 
(Production Quality)  

 1.5 BPP and lower 2.5 BPP 4 BPP 

1080i @ 50 82 Mbps 136 Mbps 218 Mbps 

1080i @ 59 98 Mbps 163 Mbps 261 Mbps 

1080p @ 50 164 Mbps 272 Mbps 435 Mbps 

1080p @ 59 196 Mbps 326 Mbps 522 Mbps 

2160p @ 50 653 Mbps 1088 Mbps 1740 Mbps 

2160p @ 59 783 Mbps 1304 Mbps 2086 Mbps 

See: 

• Configuring Encoding Input (on page 170) 
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• Configuring Encoding Output (on page 173) 

 

Figure 10: TR-07 Encoder Block Diagram 
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Configuring Encoding Input 

To compress an SNP program from IP/SDI input to to ST2110-22 IP output using JPEG-XS TR-07 encoding, 
follow these steps:  

1. Ensure the Processor has been set to JPEG-XS Encoder (TR-07). To do this: 

a. Click the Edit button on the desired Processor and go to the Personality tab. 

a. Select the JPEG-XS (TR-07) Encoder Personality or the JPEG-XS Encoder UHD (TR-07) 
Personality, depending on which one you need. Click Apply Personality. 

 

2. Note that there are 2 sections, with 4 programs each for HD/3G, and 1 one program each for UHD. 

 

3. Choose the Section Input mode as IP or SDI (as applicable) for the section of the processor you're 
working on.  

4. Click the Program you want to configure to open its Configuration dialog box.  
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Note: For Processors configured as JPEG-XS Encoder (TR-07), each program's 'Element' view displays 
ST2022-2 as the standard (indicating program packaging into an RTP transport stream via the 
ST2022-2 standard) and reports the bitrate under it. Unlike the classic JPEG-XS personality, the 
stream container includes not just video, but also audio and ancillary data. All of this is transported 
as a single stream, at the listed bit rate. 

 

5. The Input tab lists options similar to the classic JPEG-XS Encoder personality.  

Note that there is no HDR/color processing due to resource restrictions. 

6. (For IP input only) On the Input tab, make WAN-related configurations as appropriate for your 
network, including the following:  

 

▪ Check the Video IP Receiver Enable checkbox. 

▪ Set the correct Receiver Video Standard or Receiver UHD Video Standard (in case of UHD)/  

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source. 

7. On the Video tab, ensure Enable Force Video Standard is unchecked 
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Note: Selecting Enable Force Video Standard forces the output video to conform to a pre-selected 
standard, set in the Video Forced Standard drop down. 

 

8. Proxy options are only supported on the UHD personality. Select: 

▪ Whether to force Proxy Output from the Main Program Color Space to SDR-709 

▪ The Proxy Input: UHD, Link 1-4 

▪ Whether to allow Proxy 3G Output 

 

9. The Audio tab is similar to the classic JPEG-XS Encoder personality, minus any Dolby audio controls. 

10. Next, see Configuring Encoding Output (on page 150). 
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Configuring Encoding Output 

1. The Output tab's JPEG-XS section is similar to the classic JPEG-XS where you define compresssion 
settings. Note that the Bit Rate here refers to just the video portion, not the whole stream. 

 

▪ Set the Bit Rate Control (0.8 to 4.2)  

▪ Set the Quality Optimization (Visual or PSNR)  

Note: Changing the Bit Rate or the Quality Optimization settings (during operation) will cause a 
momentary disruption of the outgoing ST2110-22 stream. This, in return, will cause the JPEG-XS 
Decoder to temporarily lose lock, resulting in a loss of video (e.g. black or frozen or whatever 
the so-called Loss of Video Mode is set to at the Decoder). 

2. In the IP Video Configuration section: 

 

▪ Check Video IP Transmitter Enable under IP Video Configuration. 

▪ Enter the multicast IP address. Note that this is a single IP, since everything goes out in a single 
stream/container. 
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3. In the IP Audio Configuration section, select one of the channel configuration options - no audio, a 
single stream with 4 or 8 channels, or 2 streams with 4 or 8 channels: 

 

▪ None: The outgoing container will not contain any audio 

▪ 1 Audio Stream, 4 Channels 

▪ 1 Audio Stream, 8 Channels 

▪ 2 Audio Streams, 4 Channels per Stream 

▪ 2 Audio Streams, 8 Channels per Stream 

Note: The above options comply with ST302 which is limited to 8 channels per stream. The streams 
are configured using an MPEG-2 transport stream, but JPEG-XS is compression is used instead of 
MPEG. There is no section for a dedicated multicast address for audio since it all goes on out one 
stream, defined in the IP Video Configuration section.  

4. In the Ancillary Data TS Stream Configuration section, select ANC Data Enable to include ancillary 
data, uncheck to exclude it. 

 

Note: There is no section for a dedicated multicast address for ancillary data since it all goes on out 
one stream, defined in the IP Video Configuration section.  
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TR-07 Decoder 

Configuration 
(per processor) 

• 4 programs per section (HD/3G) 

• 1 program per section (UHD) 

Input Format • VSF TR-07 Transport Stream (via ST2022-2) 

Processing Frame Sync, Video Test generator, Audio tone generator, OSD, 
Audio channel section 

Output format SDI, ST 2110-20/30/31/40 IP or ST 2022-6  

See: 

Decoding TR-07 (on page 176) 

 

Figure 11: TR-07 Decoder Block Diagram 
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Decoding TR-07 

To decode an SNP TR-07 program, follow these steps:  

1. Ensure the Processor has been set to JPEG-XS Decoder (TR-07) or JPEG-XS Decoder UHD (TR-07). To 
do this: 

a. Click the Edit button on the desired Processor and go to the Personality tab.  

a. Select the JPEG-XS Decoder (TR-07) or JPEG-XS Decoder UHD (TR-07) Personality. Click Apply 
Personality. 

 

2. The Section Input mode is set to IP. Click the Program you want to configure to open its 
Configuration dialog box.  

Note: For Processors configured as JPEG-XS Decoder (TR-07), each program's 'Element' view displays 
ST2022-2 as the incoming standard (indicating program packaging into an RTP transport stream via 
the ST2022-2 standard) and reports the bitrate of the JPEG-XS codestream. Note that ST-2022-2 is 
pre-set, as this is the only accepted input format for a TR-07 Decoder. The sole purpose of the TR-07 
Decoder is to work with TR-07 input streams, therefore none of the other formats are supported 
including JPEG-XS classic. If you attempt to input any of these, you will see 0 on the input for 
incoming data, and output would be frozen or black depending on what is set. 
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3. The Input tab lists options similar to the classic JPEG-XS Encoder personality. There are no PTP 
controls (locked, async, etc.) because TR-07 streams are always regarded to be asynchronous.  

4. Receiver Mode is set to ST2022-2 (JPEG-XS) as this is what a TR-07 encoder produces, which is the 
only valid input for this Decoder. 

 

5. In the IP Video Configuration section, specify a single multicast address. This is the IP address for 
the 2022-2 container. 

6. The IP Video Status section, JPEG-XS Stream Details, lists TR-07 status information: 

▪ TR07 Demux Status: A basic status field that displays PIDs for all PSI packets that don't have a 
preassigned PID (e.g. PMT and PCR) and PIDs of all so-called essence services, if present (JXS, 
Audio, ANC). 

For example, when receiving a TR-07 stream originating from the TR-07 Encoder (with 2 Audio 
PIDs), the Decoder displays: 

TR07 Demux Status: OK PMT:48 PCR:63 JXS:49 A1:50 A2:51 ANC:54 

▪ TR07 Audio Status: Displays mapping options (depending on what was selected) . For example. 
A1 and A2 denote 2 streams, and each stream contains 8 channels, and then the channels within 
those streams (for example, 0-7 and 8-15) 

▪ TR07 Ancillary Data Status: Reports Anc OK if transmission is as expected. 

▪ TR07 Audio PCM Status: Reports if the audio is PCM or non-PCM (for example, Dolby). 

The other Video settings are similar to the TR-07 encoder. Note that there is no HDR/color 
processing due to resource restrictions. 

7. In the Audio tab for the Decoder, Dolby header alignment can be set if required. The rest of the 
audio tab is similar to the classic JPEG-XS. 

8. The Output tab is similar to classic JPEG XS. The uncompressed output can be sent out as ST2022-6 
or ST2110. 
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9. In case of the UHD personality, if desired, proxy output settings can be defined in Proxy IP Video 
Configuration 

 

Note: ST302 (Audio) transport streams with a lower PID will be mapped into the lower audio output 
stereo pairs first unless the channel configuration (number_channel and 

channel_identification) in AES3 header indicates otherwise. When switching ST302 streams 

with different channel configurations, the audio output re-mapping will happen after the switch. In such 
cases, momentary audio glitches at the output are expected. 
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Configuring a Simple Transparent Asynchronous Transport 
(STAT) Personality 
STAT Personality The Simple Transparent Asynchronous Transport (STAT) personality lets 

you transport SDI or IP signals over an IP network, and output as SDI or 
IP.  

Inputs • There are eight inputs per processor (4 per section), similar to the 
Sync personality.  

• Input is transported asynchronously over IP without any modification, 
processing, or conversion.  

• The IP/SDI input becomes 2022-6/7 on the network, and the 2022-6/7 
from the network becomes the SDI/IP output. 

• You can configure up to 4 STAT personalities on a single SNP unit 

Inputs/Outputs • For inputs/outputs, you can have: 

• All SDI input (both sections) 

• All IP input (both sections) 

• Mixed SDI and IP input (one section SDI, the other IP) 

Supported Formats 
• All typical SDI formats up to 1080p are supported 

• The IP format is ST 2022-6 with 2022-7 redundancy 

• The Operation Mode is currently limited to HD 

Supported SDI Formats • 720p/50 

• 720p/59.94 

• 625i/50 

• 525i/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/24 

• 1080psf/24 

• 1080p/25 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 
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STAT with SDI Input 

The program configuration tabs for STAT input are similar to the SYNC personality, with the following 
differences: 
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Input Tab 

 

• The Audio De-Embedder, SDI Audio Routing, Audio SRC Config/Status and Audio Channel 
Config/Status sections are not displayed 
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Video Tab 
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• Delay/Phasing, Force Freeze, Force Black controls are not displayed 

• Input Colorimetry and TCS Override and Output Colorimetry and TCS is set to Auto 

• The Color Adjustment section is not displayed 

• The Video Status section is not displayed 

• If you enable TSG, you will not get any audio output because there is no audio embedder after the 
TSG. 
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Output Tab 

 

• In the IP Video Configuration section, Transmitter Mode is set to ST-2022-6 

• The Packing Mode and SD Extended Window Size parameters is not available 

• In the SDI section, VPID Output and VPID Aspect Ratio Select controls are not displayed 

• IP Audio Configuration, IP Audio Status, IP Ancillary Data Stream Configuration, IP Ancillary Data 
Stream Status, SDI Audio Embedder sections are not displayed 
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STAT with IP Input 

Input Tab 

• Clock Domain Next Switch Stream is set to Asynchronous 

• In the IP Video Configuration section, Receiver Mode is fixed at ST-2022-6 

• Timestamp Offset and SD Height parameters are not available 

• IP Audio Configuration, IP Audio Routing, IP Audio Status, Audio SRC Config Status, Audio Channel 
Config/Status, IP Ancillary Data Stream Configuration, IP Ancillary Data Stream Status sections are 
not displayed 

The other tabs are similar to STAT with SDI Input (on page 180). 
 

STAT Licensing 

The STAT personality is enabled by the SNP-PSK-SYNC (SYNC/REMAP/STAT personality) license. See 
Orderable Part Numbers (on page 35). 

Note: If you do not have a Sync/Remap/STAT license, but still assign this personality to a processor, 
output will be disabled and forced to black. 
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Master Control Lite (MCL) Personality 

The Master Control Lite (MCL) Personality provides the following features:  

• Mixing/switching between two Program (PGM) / Background inputs (A and B)  

• Keying other video signals over the Program (PGM) Mixer’s output  

• Generating internal Logo Key/Fill signals, Audio Over mixer for inserting Voice Over and/or External 
Key Audio 

Note: Audio from the internal logo files not supported in this release.  

When you set a processor to the MCL Personality, the Configure Processor dialog displays an additional 
MCL tab with configuration settings. See: 

• MCL Tab (on page 202) 

• Configuring the SNP with the MCL Personality (on page 198) 

Key Features 

External Key/ Fill inputs The MCL provides up to three independent External Key/ Fill 
inputs, up to four Master Control playout channels or eight 
downstream Keyers in one SNP unit. 

Inputs (currently supported) IP (ST-2110 & ST-2022-6) and SDI 

Video Formats UHD (2160p50/59.94), HD (1080p50/59.94), and 1080i50/59.94) 

Extended Processors Only the Sync and Dual Conversion personalities can be set as 
Extended Processors to the MCL personality, only when the MCL is 
operating in UHD mode.  The Extended Processors can be used to 
provide Bus A, Bus B, Key and Fill inputs. 

Keyers The Keyer superimposes a Fill / Foreground signal over the 
Program (PGM) signal 

The MCL contains 4:2:2, Cb:Y:Cr, 10-bit Keyers with a 12-bit 
internal video processing path 

Keyer Modes Each Keyer can be configured for internal or external graphics 
signals.  When the signals are provided externally,  the keyer can 
be configured to accept an external alpha and external fill, or can 
generate the alpha from the provided fill (self-key)." 

Mixing/Keying Requirements The Program (PGM) Mixer consists of video and audio signal 
mixers. When keying or mixing video signals, the video signals 
must be the same resolution, frame rate, dynamic range, and 
colour gamut, for the final composited video output to appear 
"look" correct.   

Input Frame Synchronizers All inputs are synchronized to an analog reference input or IEEE-
1588/ST-2059 Precision Time Protocol (PTP) reference.  The MCL's 
outputs are clean and quiet; the MCL looks after input signal 
synchronization and timing alignment. 
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Figure 12: Example of four keys/logos over Colour Bar background 

 

Figure 13: SNP Key Layer Ordering 

Note: MCL combines four video layers, one Background layer and four Keyer layers from separate 
sources into a single composited image. 
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MCL Licensing 

Go to Configure > Licenses to ensure that the SNP has MCL licenses installed and available, and to assign 
the licenses to the required processor(s). 

• The Master Control Lite Personality provides HD mode MCL functionality 

• The Master Control Lite UHD Personality provides UHD mode MCL functionality (can also be used 
for HD) 

 

Apply the desired licensing to the required processors. Click Save. 

Once licensing has been applied, you can set a processor to MCL Mode: 

1.  Click Edit on a Processor.  

2. Set the Processor Personality to Master Control Lite Personality. Click Apply Personality. 
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Notes:  
 
- With a UHD license, the MCL can function in UHD or HD mode. 
- When in MCL UHD mode, if the Master Control Lite Personality license is removed after the processor 
is already operating in UHD mode, the processor will automatically switch to HD mode.  
- When in MCL HD mode, attempting to select a UHD resolution without the Master Control Lite 
Personality UHD license results in an error. 
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HD Mode 

Note: MCL functions in HD mode if a Master Control Lite HD license has been applied. See MCL 
Licensing (on page 188). 

 

Inputs  IP, SDI, mixed 

Outputs IP and/or SDI subject to connector or VSFP availability 

Video Formats 1080i50, 1080i59, 1080p50, 1080p59 

A/B Mixer & Keyer Engine One per processor 

Expansions None 

 

Figure 14: MCL High-level functional diagram in HD Mode 

 

Figure 15: MCL Signal Connections in HD Mode 
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UHD Mode 

Note: MCL functions in UHD mode if a Master Control Lite UHD license has been applied. See MCL 
Licensing (on page 188). Note that with this license, you can also choose to function in HD Mode (see HD 
Mode (on page 190)). 

 

Inputs IP or SDI, 12G or 2SI (can be mixed) 

Note: 4-wire SQD input is NOT supported on the MCLU. 

Outputs IP and/or SDI subject to connector or VSFP availability. 

Note: SDI output can be 12G or 4x3G(2SI).  SQD output 
is NOT supported. 

Video Formats 2160p50, 2160p59 

External Key/Fill inputs from adjacent 
Processors 

IP or SDI input  
 
External K/F through adjacent processor running as an 
extension to the MCLU. Only the Sync and Dual 
Conversion can be Extensions to the MCL personality. 

In KFAB, KFABKF, and KFABKFKF modes: In AB, ABKF, ABKFKF, and ABKFKFKF modes, the Bus A 
and Bus B inputs come into the MCLU on the base 
processor, and the Extended Processors provide the 
Key and Fill inputs.  In KFAB, KFABKF, and KFABKFKF 
modes, the Bus A and Bus B inputs come into the first 
Extended Processor, the Key 1 and Fill 1 inputs come 
into the MCLU on the base processor, and the 
additional Key and Fill inputs come into the other 
Extended Processors. 

 

Figure 16: MCL High-level functional diagram in UHD Mode 
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Figure 17: MCL Signal Connections in UHD Mode  (AB mode) 

 

Figure 18: MCL Signal Connections in UHD Mode  (ABKF mode) 

 

Figure 19: MCL Signal Connections in UHD Mode  (ABKFKF mode) 
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Figure 20: MCL Signal Connections in UHD Mode  (ABKFKFKF mode) 
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Operation Modes 

The MCL personality offers two major operating modes: 

• As a Master Control Switcher (MCL Mode) 

• As a Dual Downstream Keyer (Dual-DSK Mode) 

The following are details of operation modes, supported inputs, and outputs for the MCL personality: 

Operation Modes • Master Control Switcher mode (MCL) 

• Dual Downstream Keyer mode (Dual-DSK) 

Parameter to set Mode (MCL Mode parameter). See Setting the MCL Mode 
(on page 195). 

MCL Mode • A/B Background Mixer is enabled 

• Allows for Transitions (such as V-fade, Cut-fade, etc) 
to be performed on the A and B inputs.  

Dual-DSK Mode • A/B Background Mixer is disabled 

• Transitions on the A and B inputs are not permitted 

MCL Mode/Dual-DSK Mode Inputs Bus A, Bus B, Key1, Fill1, Key2, Fill2, Key3, Fill 3  

MCL Mode Outputs 
• Program 

• Preset 

In MCL Mode, you have the Program Output and the 
Preview Output. 

Dual-DSK Mode Outputs • Program1 

• Program2 

In Dual-DSK Mode, there are two main outputs: 
Program 1 and Program 2 
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Setting the MCL Mode 

Once a processor has been set to the MCL Personality, the MCL Mode can be set by going to: 
Configure > Processor > Configuration tab > General > MCL Mode.  

 

The MCL Mode parameter can be set to: 

• Dual DSK: In this mode, there are two independent Program outputs and a set of controls for each. 
Keys can be taken on and off each program separately. 
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In Dual DSK Mode, the MCL Tab (Configure Processor > MCL) displays 2 sections, one for the 
Program 1 Output and another for the Program 2 Output.  The TAKE1 and TAKE2 buttons can be 
used to start Keyer transitions on each Program Output separately.. 

 

• MCL: This is the true master control mode. In MCL Mode: 

▪ The Program Out is the main output and is what goes on air 

▪ The Preset Output is a 'next event' preview output.  It shows what will be displayed on the 
Program Output after the TAKE button is pressed, at the end of the transition. 
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In MCL Mode, the MCL Tab (Configure Processor > MCL) displays one section for Program Transition 
Controls, and one for Preset Transition Controls 
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Configuring the SNP with the MCL Personality 
1. Go to Configure > Licenses to ensure that the SNP has MCL licenses installed and available, and to 

assign the licenses to the required processor(s).  

▪ The Master Control Lite Personality license provides HD mode functionality 

▪ The Master Control Lite UHD Personality license provides UHD mode functionality (as well as 
HD mode) 
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2.  Click Edit on a Processor, go to the Personality tab, and set the Processor Personality to Master 
Control Lite. Click Apply Personality. 

 

3. HD and UHD Mode: Note that the mode the MCL functions in (HD or UHD) is determined by the 
output standard set (see Step 8a and 9a ). The SNP should also have a UHD license to function in 
UHD mode. 

4. Go to the Configuration tab and set the MCL Mode to Dual DSK or MCL.  

 

For more details, see Setting the MCL Mode (on page 195). 

5. Set the Default Audio IP Tx Packet Time. Range is 1 to 500 ms. 

Note: Since 125us or 500us transmit packet timing creates a large number of very small packets, it is 
strongly preferred to stick with 1ms when possible.  500us or 125us operation can be selected for 
individual audio streams that require it (see Output Tab: IP Audio Configuration (on page 457)) even 
when this default setting is 1ms. 

6. If using an SFP, select it in the SFP Select dropdown. 

7. Set Force MAB Mode if desired 

Note: When checked, the switch mode is set to Make After Break. Otherwise, the switch mode will 
depend on whether there's available bandwidth to do a Make Before Break switch. This can help to 
avoid oversubscribing the switch. 

8. Set the MCL Output Colorimetry and TCS to one of the following: 

▪ SDR-709 

▪ SDR-601 
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▪ SDR-2020 

▪ HLG-2100 

▪ PQ-2100 

▪ SLOG3-2020 

This selection controls the colorimetry/TCS of the output signal from this converter. 

9. Follow these steps for HD mode: 

a. Set the MCL Output Video Standard to one of the following: 

• 1080i/50 

• 1080i/59.94 

• 1080p/50 

• 1080p/59.94 

b. Set the Frame Delay, VPhase, and HPhase parameters to the same value on each Processor 
(Configure Processor > Video Tab) 

c. All four Processors can be configured with the MCL in Base mode when operating in HD mode, 
to provide four independent MCL channels 

10. Follow these steps for UHD mode: 

Note: The MCL personality can be loaded on any Processor. 

If using the MCL personality with an Extended Processor, the MCL can be loaded on Processor A or 
Processor C.  For example, SNP does not support Processor B configured with the MCL and Processor 
C configured with Sync or Dual Conversion set to Extended mode. For extended processors, the 
HPhase, VPhase, and Frame Delay values must be set to zero. 

Some example configurations that are supported: Processor A set to MCL and Processor B set to 
Dual Conversion with Extended mode enabled, and Processor C and D set to MCL.  This 
configuration would provide three Playout channels in MCL mode. 

When using Extended Processors with the MCL, the UHD Input Routing parameter is used to specify 
which Processor the Bus A, Bus B, Key, and Fill inputs come in on. 

Extended Processors are always the Processor with a higher letter.  For example, if Processor A is set 
to MCL, Processors B, C, and D can be extended to Processor A.  Another example, if Processor A and 
C are set to MCL, the Processor B can be extended to Processor A, and Processor D can be extended 
to Processor C; in this example Processors B and D can be used to provide external key /fill inputs to 
the respective MCL processors. 
 
Also see Extending MCL Functionality for UHD Operation (on page 222). 

a. Set the MCL Output Video Standard to one of the following: 

• 2160p/50 (can be applied with a UHD license, and this output standard puts the MCL in UHD 
mode) 

• 2160p/59.94 (can be applied with a UHD license, and this output standard puts the MCL in 
UHD mode) 

b. Set the Frame Delay, VPhase, and HPhase parameters to zero on all Programs on the Processor 
(Configure Processor > Video Tab) 

c. Go to the MCL tab (Configure > Processor) > MCL Configuration > Miscellaneous Configuration 
section, set the UHD Input Routing Configuration parameter to the number of External Key and 
Fill inputs that you are connecting to the MCL. 
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For more details on the  UHD Input Routing Configuration parameter, see the MCL 
Configuration section MCL Configuration (on page 211). 

 

11. Set the Video Black Level. Range is 0-700 and default is 0. 

12. Set the Video White Level. Range is 0-700 and default is 700. 

Note: We strongly recommend leaving the Video Black and White Level parameters are their default 
values to avoid on-air issues with the video level. 

13. Set the Transition Controls (see Program Transition Controls (on page 203)) 

14. Set the Keyer Controls (see Keyer Controls (on page 208)) 
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MCL Tab 

The Configure Processor dialog displays an MCL tab if MCL personality is applied to a Processor. 

 

The MCL Tab contains the following sections: 

In This Section 

Program Transition Controls .................................................................. 203 
Keyer Controls ........................................................................................ 208 
MCL Configuration ................................................................................. 211 
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Program Transition Controls 

The MCL tab contains the Program Transition Controls sections, which display the following buttons and 
status (Tally) parameters: 

 

Figure 21: Program Transitions in Dual DSK Mode (with Hot Punch disabled) 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 204 

 

 

Figure 22: Program and Preset Transitions in MCL Mode 

Reset Gain  
(Program Transition) 

This button restores PGM Master Gain to unity gain. 

Master Gain 
(Program Transition) 

Used to adjust the program audio level.  Note that this gain value will 
track with the current program source going forward.  When the program 
is transitioned to another source, the program gain will switch to the 
value for that source.   

The range for the audio gain control is -72 dB to +18 dB.  The default is 0 
dB. 

Source Reports the Program Source (Bus A, B) 

Reset Gain  
(Preset Transition) 

In MCL and Dual-DSK modes, the Reset Gain control sets the audio gain to 
0 dB for the Source routed to the Preset/Program 2 output. 

Master Gain 
(Preset Transition) 

Used to adjust the audio gain between -72 dB to +18 dB, in 0.1 dB steps, 
for the Source routed to the Preset/Program 2 output. 
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Transition Rate Both Program 1 and Program 2 have separate Transition Rate parameters. 
This parameter is used to select the Transition Rate to use for all video 
and audio transitions. Options are: 

• Fast 

• Medium 

• Slow 

• Automation 

The actual frame rate used is specified in the Fast Transition Rate, 
Medium Transition Rate, and Slow Transition Rate parameters, as 
applicable.  

When Automation sets the transition rate to a value which does not 
match one of the pre-configured Transition Rates: Fast, Medium, and 
Slow, the Transition Rate is switched to Automation. 

Transition Type Both Program 1 and Program 2 have separate Transition Type 
parameters. This parameter sets how the Program Background Video 
Mixer transitions when transitioning from A to B or vise-versa.  
 
Options for Program 1 are: 

• Cut 

• V-Fade 

• Cut-Fade 

• Fade-Cut 

• X-Fade 

NOTE: in Dual-DSK mode, the Transition Type for Program 1 shows all 
available options however only Cut and X-Fade are valid.  In MCL mode, all 
Transition Types are valid. 

Options for Program 2 are: 

• Cut 

• X-Fade 

Source Reports the Program Source (Bus A, B) on the Preset Bus. 

Key 1-Key 4 Each of these are toggle buttons for key layers, and the action taken on  
clicking them is determined by the Hot Punch parameter (at the bottom 
of the MCL Configuration section).  

• If Hot Punch is enabled, clicking any of the buttons (Key 1 to Key 4) on 
Program 1 or 2 takes that key to air immediately. This provides quick 
access to transitioning individual Key Layers without having to select 
the Preset Transition Enable controls and pressing the TAKE button to 
transition a specific Key Layer On or Off.  

• When the Hot Punch parameter is not enabled, the KEY buttons are 
used to pre-select which Keyer Layers to transition on or off the 
Program Output when the TAKE button is pressed. 

• In MCL mode: pressing the "TAKE" (live) button triggers the: 
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Background Video and Audio Mixers, and/or Keyers, and/or Audio 
Over Mixers to start transitioning; depending upon which: 
Background, PSTx KEY, and PST AUDIO OVER parameters are 
enabled.   

• In Dual-DSK mode, pressing the 'PGM 1 TAKE' "live button triggers 
the: Keyers and/or Audio Over Mixer to start transitioning on the 
Program 1 output; depending upon which: PGM 1 KEYx and PGM1 
AUDIO OVER parameter are enabled. 

The Tally indicator above each KEY button, when illuminated, indicates 
that this Keyer Layer is on the Program Output. The Tally is illuminated 
red, indicating that key layer is on. When the Tally is blinking red, this 
means the Key should be on the Output but has been taken off by 
software because a Loss of Video condition has been detected on either 
the Fill and/or Alpha sources. 

 

AO This refers to Audio Over or Voice Over for mixing audio from one of the 
Alpha inputs with the Background audio. 

In both (MCL and Dual-DSK with Hot-Punch enabled) modes: 

• if AO is selected, the Audio Over is immediately cut to be ON the 
Program Output.  

• If AO is unselected (OFF) the Audio Over is cut to be OFF the 
Program/Program1 Output.  

 
This provides quick access to transitioning the Audio Over to be ON or 
OFF the Program/Program1 Output, without having to select the Audio 
Over Preset Transition Enable control and pressing the TAKE button to 
transition the Audio Over ON or OFF. 
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Fade to Black The Fade button (PGM1 FTB and PGM2 FTB) refers to fading video to 
black and/or fading audio to silent, and is controlled by settings in the 
Fade to Black Configuration section of the MCL tab.  

 
The Fade to Black settings can be individually enabled or disabled per 
program, and can be set to fade just video, just audio, or both video and 
audio. For example, if Fade to black is set to video, and the PGM1 FTB 
button is clicked, the Program 1 output will be faded to video black. Fade 
to black needs to be enabled in order to use the FTB buttons. 

 

Hold 
The (Program) Hold buttons are displayed under Program Transition 
Controls, and labeled as: 

• MCL Mode: HOLD  

• Dual DSK ModeL PGM1 Hold and PGM2 Hold   

The Hold buttons are essentially separate sets of controls for each of the 
program outputs. When the system is controlled via automation controls 
(such as ADC or D-Series automation), Hold pauses the SNP from 
accepting commands from automation, in order to perform a different 
action. For example, if a commercial needs to run for 10 seconds at a 
certain time, before going back to standard control.  

• In MCL mode, when PGM1 AUTO HOLD is selected (ON), the SNP Host 
rejects any Automation control messages destined for this MCL 
channel; only manual control from a Control Panel or SNP GUI are 
allowed. 

•  In Dual-DSK mode: the SNP Host rejects any Automation control 
messages destined for this Program Output. 

BKGD (Only available when operating in MCL Mode) 
This control shows under Preset Transition Controls. 

• When selected, it specifies that the Background Program and Preset 
video mixers will transition when the Take parameter is selected.  

• When Off, the Background video mixers are not transitioned when the 
Take parameter is selected.  
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The transition parameters control transitions, for example, from a program to a commercial. For each 
program, you can opt to do a cut or fade, and then choose the rate which is, if it will slow, fast, or 
medium. For more details, see MCL Tab 
 

Keyer Controls 

The MCL tab provides several Keyer Control parameters to let you control the appearance of the Key 
over the Background signal.  
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Keyer Controls 

Key Gain Gain applied to the key signal (after the application of the Key Offset 
value). 

Range -20 to 20. Default is 1.0 for unity gain. Imagine Communications 
strongly recommends that this control be left at its default value. 

Key Offset The Key Offset (or Clip), sets the black level of the key signal, and is 
subtracted from the key signal input. DC shifts the key signal down. 

Range -40 to 760, increments in steps of 1.  Default is 64 (0x40).  Imagine 
Communications strongly recommends that this control be left at its 
default value. 

Keyer Mode Used to control how the Background and Fill signals are mixed/combined 
together.  

• Normal - both the Background and Fill signals are multiplied with the 
Alpha signal.  The Default is Normal mode. This is also referred to as 
unshaped or multiplicative keying. 

• Additive - (also referred to as Shaped keying). Character Generators 
(CGs) typically produce this type of Fill signal. The Alpha and Fill signals 
are pre-shaped (bandwidth limited). The Background is multiplied with 
the Alpha signal and the Fill is added to the resulting signal. The Fill 
input signal must have a black background. 

Key Invert Used to invert the polarity of the key signal. Set to Normal or Inverted. 

• Normal means the key signal is used without modification. 

• When Inverted, the key video signal is inverted. 

Self Key  Used to select the source of the key video signal which 'cuts' the hole in 
the Background video and where the Fill video is inserted into. 

Values are:  

• Alpha Luma (also referred to as External Key) uses the Alpha's Luma 
signal to cut the hole (Default setting). 

• Fill Luma (also referred to as Self Key or Luma Key or Auto-keyed) uses 
the Fill's Luma signal to cut the hole 

Transparency Sets the transparency of the Fill/Foreground video. 0% transparency 
means the Fill is completely “off”. 100% transparency means the Fill is 
completely “on” (opaque).  Default is 100%. 

Range 0-100 
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Source Select • No Key 

• External 

• If .mg3 Logo files have been uploaded to the SNP unit, then the 
names of those uploaded files will be displayed under the Source 
Select parameters. See Creating a Logo File (on page 232), Uploading 
a Logo (.mg3 graphics file) to an SNP (on page 233), and Selecting an 
Internal Logo for a Keyer Layer (on page 235). 

SNP will only display .mg3 files whose video format matches the MCL's 
Output Video Standard setting. 

Logo ID Reports the Logo ID assigned when creating the logo. 

When the Source Select is set to External, the Logo ID field will report -1. 

NOTE: .mg3 files with a Logo ID of zero (0), will not be selectable by 
Automation.  Only .mg3 files with Logo IDs within the range of 1 to 998 
are selectable by Automation. 

Source Select Error Reports any errors if the requested Source Select could not be executed. 
Types of Logo Select Errors which can be reported are: "Could not open 
file", "File has no image data", "Not enough memory for file", "File is 
truncated".  In the GA 2.2 release, these error states are not reported to 
the MCL Hardware Panel. 

X Offset Range is 0-3840. Increments in steps of 1. Used to position the internal 
logo horizontally.  0 is the most right position of the Active Picture Area; 
first active pixel. 

Y Offset Range is 0-2160. Increments in steps of 1. Used to position the internal 
logo vertically.  0 is the top most  line of the Active Picture Area. 

Audio Enable Select to enable External Key Audio; audio from the Fill program input.. 

Keyer Layers 1 to 3 support External Key Audio.  When the Keyer is 
enabled, the External Key Audio will then be mixed with the Background's 
audio. 

Duck Level Set the Duck Level.  

Range 0-100. 

0% means the Program Audio level is not reduced at all.  

100% means the Program Audio level is fully removed and the Audio Over 
source is fully on the Program Output. 

Key Audio Gain (dB) Used to amplify or attenuate the External Key Audio's PCM audio 
channels. 

Range -36 to 36. 

Audio Over 

Audio Over Source Select Used to select which Alpha input to use as the source of the Audio Over, 
.i.e. ‘Voice Over’ 

Options include: Alpha1, Alpha2, Alpha3 

Default value: Alpha1  
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Duck Level Set the Duck Level.  

Range 0-100. 

0% means the Program Audio level is not reduced at all.   

100% means the Program Audio level is fully removed and the Audio Over 
source is fully on the Program Output. 

Audio Over Gain (dB) Used to amplify or attenuate the Logo Audio or External Key Audio 
channels. 

Range -36 to 36. 

Reset Gain When the Reset button is pressed, reset the Key Audio Gain parameter to 
0 dB. 

Options: off, on 

Default value: off 
 

 

MCL Configuration 

 Fade to Black Configuration 

PGM 1/2 Fade to Black 
Configuration 

Define whether fade to black is enabled or disabled, and if enabled, 
define whether it applies to video, audio, or both. Options are: 

• Disabled (default) 

• Video Only 

• Audio Only 

• Video and Audio 

 Miscellaneous Configuration 

UHD Input Routing 
Configuration 

This parameter is used to specify where the Background A and B sources, 
and Keyer Layer 1 to 3 sources come from. 

Note that SNP 2.2 officially supports AB, ABKF, and KFAB. 

Options are: 

• AB – A and B are sourced from the Base Processor.  There are no 
External Key/Fill inputs; only Internal Logo.  Allows up to 4 MCL 
channels in UHD mode in one SNP unit. 

• ABKF – for one Base Processor and one Extended Processor.  One 
External Key/Fill pair enabled.  A and B are sourced from the Base 
Processor.  The first Key and Fill pair are sourced from the Extended 
Processor. 

• ABKFKF – for one Base Processor and two Extended Processors.  Two 
External Key/Fill pairs are enabled.  A and B are sourced from the Base 
Processor.  The Key and Fill pairs are sourced from the Extended 
Processors. 

• ABKFKFKF – for one Base Processor and three Extended Processors.  
Three External Key/Fill pairs are enabled.  A and B are sourced from the 
Base Processor.  The Key and Fill pairs are sourced from the Extended 
Processors. 
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• KFAB - for one Base Processor and one Extended Processor.  One 
External Key/Fill pair enabled.  A and B are sourced from the first 
Extended Processor.  The first Key and Fill pair are sourced from the 
Base Processor. 

• KFABKF - for one Base Processor and two Extended Processors.  Two 
External Key/Fill pairs enabled.  A and B are sourced from the first 
Extended Processor.  The first Key and Fill pair are sourced from the 
Base Processor.  The second Key and Fill pair are sourced from the 
second Extended Processor. 

• KFABKFKF - for one Base Processor and three Extended Processors.  
Three External Key/Fill pairs enabled.  A and B are sourced from the 
first Extended Processor.  The first Key and Fill pair are sourced from 
the Base Processor.  The second Key and Fill pair are sourced from the 
second Extended Processor, and the third Key and Fill pair are sourced 
from the third Extended Processor. 

Post Transition Behavior This parameter specifies what happens at the end of a transition to the 
Preset output, Background, and PST KEY transition control parameters.  

• Keep enabled 

• In MCL mode: The Background and PGM KEY/PST KEY transition 
control parameters remain enabled, if previously enabled. The Preset 
output shows any Keyers enabled by the PST KEY parameters. 

• In Dual-DSK mode: PGM and PST KEY transition control parameters 
remain enabled, if previously enabled. Program 1/2 output show the 
Keyers which were enabled by the PGM KEY and PST KEY 
parameters. 

• Disable when transition completes 

• In MCL Mode: The Background and PST KEY parameters are 
automatically disabled, when the transition completes, causing the 
Keys on the Preset Output to no longer be visible, means that the 
Keys will remain on-air if the TAKE button is pressed again. 

• In Dual-DSK Mode: The PGM1 and PGM2 KEY buttons are 
automatically disabled, if previously enabled. The Program 1/2 
output show the Keyers which were enabled by the PGM1 and PGM2 
KEY parameters. 

Hot Punch This parameter is only displayed in Dual DSK mode. 

If Hot Punch is enabled, pressing any of the Key 1-4 buttons on Program 1 
or 2 Outputs, takes that key on/off air immediately.  

Note: If Hot Punch is enabled, the Post Transition Behavior parameter is 
hidden in Dual DSK mode, and the TAKE buttons are hidden in the 
Program Transition Controls. 

 Transition Rate Configuration 

Fast Transition Rate Set how many video frames to use, when the 'Transition Rate' parameter 
is set to 'Fast'. 

The range is 5 to 255 (default is 5) 
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Medium Transition Rate Set how many video frames to use, when the 'Transition Rate' parameter 
is set to 'Medium'. 

The range is 5 to 255, default is 16. 

Slow Transition Rate Set how many video frames to use, when the 'Transition Rate' parameter 
is set to 'Medium'. 

The range is 5 to 255, default is 30. 

Automation Transition Rate When Automation sets the transition rate to a value not matching one of 
the existing Fast, Medium, or Slow transition rates, this field will display 
Automation transition rate value. 

Clean Feed Configuration 

Clean Feed Output (1-6) Select the source to route to the Clean Feed output. For more details, see 
Clean Feed Outputs (on page 214). 

Options include: 

• Bkgd Mix/ Pgm1 In 

• Pgm/Pgm1 Keyer 1 Out 

• Pgm/Pgm1 Keyer 2 Out 

• Pgm/Pgm1 Keyer 3 Out 

• Pgm/Pgm1 Keyer 4 Out 

• Pgm/Pgm1 final Out 

 Router Configuration 

See Routing with Magellan Control System  (on page 218). 

 MCL Audio Configuration 

Audio Mixer Layer Select the layer to mix with the Background Audio channels. Options are 
Keyer 1, Keyer 2, Keyer 3, Keyer 4, or Audio Over. Default value is Keyer 1. 

Background Audio Channel Select the Background Audio Channel to configure for the 'Audio Mixer 
Duck Behavior' parameter. Choose from Channels 1-16. Default value is 
Channel #1. 

Audio Mixer Duck Behavior Select from the following: 

• Duck Only - this pair of PCM audio channels is reduced to the Duck 
Level but not mixed.  For example, the Rear surround and Low 
Frequency Effects (LFE) audio channels are attenuated but not mixed.  
Master Gain and Fade-to-Silence (FTS) can be applied to these pairs. 

• Duck and Mix - this pair of PCM audio channels is reduced in level and 
mixed with External Key Audio or Voice Over Audio.  For example, Voice 
Over Audio is mixed with the the Front Left, Front Right and Front 
Center audio channels.  Master Gain and FTS can be applied to these 
pairs. The default value for this parameter is Duck and Mix. 

• Unity - this pair of audio channels is not processed by the: Background 
Audio Mixer, Audio Over Mixers, Fade-to-Silence Audio Mixer, and 
Master Gain.  This setting is used for audio pairs carrying non-PCM 
audio or audio channels not to be processed.  Cut only transitions 
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applied to these audio channels.  Master Gain and FTS is not applied to 
these pairs. 

Audio Channel Mix 
Assignment 

Only adjustable (greyed out otherwise) when the ‘Audio Mixer Duck 
Behavior is set to ‘Duck and Mix’. Assigned per Audio Mixer Layer per 
Background Audio Channel. 

Background Audio Channels which are set to ‘Duck Only’ or Unity are not 
mixed with anything. 

The default value for this parameter is 1-to-1.  For example, Background 
channel #1 is attenuated and mixed External Key Audio or Audio Over 
channel #1. 

Logo Audio Configuration 

Background Audio Channel This control parameter is not operational in the GA 2.2 or earlier releases. 

Logo Audio Channel Mix 
Assignment 

This control parameter is not operational in the GA 2.2 or earlier releases. 

 

 

Clean Feed Outputs 

Clean Feed outputs provide additional outputs from the MCL’s video and audio processing pipeline. 
These outputs can be selected from any processing stage, i.e., after the Background A/B Mixer, after any 
Keyer Layers, and the final Program Output.  

Mode MCL (HD or UHD) 

Outputs Program Output 

Source for Clean Feed Outputs • Various points along the Program Output path  
(Up to 6 Clean Feed Outputs) 

• Duplicate Program outputs or the Background A/B 
Mixer’s output can be sent to any Clean Feed output. 

Mode Dual DSK (HD or UHD) 

Outputs Program1 and Program2  

Source for Clean Feed Outputs 1-3 Program1 Output path 

Source for Clean Feed Outputs 4-6 Program2 Output path 

When operating in UHD mode, if Clean feed outputs are desired, an Extended Processor must be used. 
This is becasue all outputs on the Base Processor are used by the Program/Program1 and 
Preset/Program2 outputs.   

For example: 

• If ProcA is MCL  

• ProcB should be SYNC or CONV in Extended mode 

Then specifically in Dual-DSK mode and UHD  mode, Proc B will provide: 

• Cleanfeed Output 1 = Program1 Cleanfeed 1 
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• Cleanfeed Output 2 = Program2 Cleanfeed 1 

If Proc C and Proc D are also Extended, then the signal mapping is: 

• Cleanfeed Output 3 = Program1 Cleanfeed 2 

• Cleanfeed Output 4 = Program2 Cleanfeed 2 

• Cleanfeed Output 5 = Program1 Cleanfeed 3 

• Cleanfeed Output 6 = Program2 Cleanfeed 3 

Note: In MCL Mode, Clean Feed Outputs #1 to #6 are restricted to selecting the audio signals from the 
Program/Program1 path. 

 

Figure 23: MCL Mode - Clean Feed Outputs 

The Dual-DSK mode supports up to 3 Clean Feed outputs per Program output. 

Note: 
- Clean Feed #1 and #3 are restricted to selecting the audio signals from the Program/Program1 path. 
- Clean Feed #4 and #5 are restricted to selecting the audio signals from the Preset/Program2 path. 

 

Figure 24: Dual DSK Mode - Clean Feed Outputs 

- For Clean Switching, when the IP Receivers are configured to receive 1080p59 ST-2022-6 streams, the 
number of streams is limited to six.  This limits the number of Key and Fill inputs when receiving 
1080p59 ST-2022-6 streams. 
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- The number of 1080p59 ST-2022-6 which can be transmitted is limited to 7 streams.  This limits the 
number of Clean outputs when transmitting 1080p59 ST-2022-6 streams. 
 

MCL Audio Processor - Functional Block Diagram 

 

Audio Inputs  

Background  (Bus A and Bus B), Fill and Alpha 

Signal type Embedded audio in SDI or ST-2022-6, ST-2110-30/31;  -30 for PCM audio, -31 for 
non-PCM audio 

Audio Inputs Comes from either the Base processor or the Extended Processor (Sync or Dual 
Conv), i.e. ABKF, KFAB, ABKFKF, KFABKF, … modes 

Background Audio, 
Bus A and Bus 

Comes from either the Base (HD mode) or Extended Processor (UHD mode) 

Voice Over  Brought into the SNP on the Alpha Inputs;  Alpha inputs from either the Base 
(HD mode) or Extended Processor (UHD mode) 

External Key Audio, 
audio associated with 
the external 
Alpha/Fill video 
source 

Brought into the SNP on the Fill Inputs;  Fill inputs from either the Base (HD 
mode) or Extended Processor (UHD mode). 

Audio Outputs Program/Program1, Preset/Program2 

Signal types Embedded audio in SDI or ST-2022-6, ST-2110-30/31 
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Master Control Panel Devices 

See MCL Hardware Panel (on page 489). 

 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 218 

 

Routing with Magellan Control System  

The  Magellan Control System integrates with the Selenio Network Processor (SNP), and can process 
inputs from the SNP (sources in  Magellan Control System) as well as push outputs to it (destinations in  
Magellan Control System). For detailed information on how to set up the SNP in  Magellan Control 
System, see  the main SNP User Manual or the Magellan Control System User Manual. 

MCL Routing parameters are defined in the MCL tab, in the Routing Control section. The following 
parameters need to be defined: 

 

Source Name Table  

Source Number The index of the Source. Range is 1 to 16.  Default is 1.  MCL can be 
configured to select (route) to 16 different sources to the Bus A or Bus B 
inputs. 
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Logical Source Name Enter the Router Logical Source Name. This name must match the Source 
name used in the Magellan Control System database. 

Note: The source entered here is validated against the configured  
Magellan Control System Server (see below). An error will be displayed if it 
is not found. 

Presentation Name Enter the Local presentation name for the Router Logical source name 

Note: This name will be displayed on MCL Hardware panels and is a 
maximum of 16 characters. If left blank, the Router Database Logical 
Source Name will be used. 

Source Audio Gain The audio gain value associated with each Source is tracked by MCL, so 
when that Source is selected again the audio gain value is applied to that 
source.  Range is -72 to +18 dB, in 0.1 dB steps.  Default is 0 dB. 

 Routing Control 

Bus A/B Destination Name Router destination name of Bus-A/B 

Note: The destination entered here is validated against the configured  
Magellan Control System Server (see below). An error will be displayed if it 
is not found. 

Program Follow Router destination name of the Shadow Program. A shadow program is a 
router destination that the MCL will keep updated with the current 
program input source - effectively a cuts-only version of the program.  this 
can be useful for tally systems to monitor what source is on-air at any 
time. 

Program Follow can be either a real or virtual Destination. It is up to the 
user to configure the Destination in the Magellan Control System 
database. The MCL doesn't need to know. Whenever a source is routed to 
the program output, then MCL will route the same source specified by the 
Program Follow destination. 

Note: The destination entered here is validated against the configured  
Magellan Control System Server (see below). An error will be displayed if it 
is not found. 

Preset Follow Router destination name of the Shadow Preset. Similar to the shadow 
program, this named router destination will take the source of the preset 
bus every time the preset bus changes sources. 

Preset Follow can be either a real or virtual Destination. It is up to the 
user to configure the Destination in the Magellan Control System 
database. The MCL doesn't need to know. Whenever a source is routed to 
the preset output, then MCL will route the same source specified by the 
Preset Follow destination. 

Note: The destination entered here is validated against the configured  
Magellan Control System Server (see below). An error will be displayed if it 
is not found. 
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AUX Destination Name Router destination name of the AUX Bus. Currently only selectable in the 
SNP GUI and not by the MCL Hardware Panel.  The Aux Destination Name 
must match the Magellan Control System Destination Name. 

Note: The destination entered here is validated against the configured  
Magellan Control System Server (see below). An error will be displayed if it 
is not found. 

Program Source Select The LRC source to be routed to the Program 

Preset Source Select The LRC source to be routed to the Preset. Used to select 1 of the 16 
possible Source Numbers, configured in the Source Name Table section, 
to route to either the Program Output.  MCL keeps track of whether to 
route to the Bus A or Bus B Destination. 

AUX Source Select The LRC source to be routed to the AUX bus. Used to select 1 of the 16 
possible Source Numbers, configured in the Source Name Table section, 
to route to the Auxiliary (AUX) destination. 

User ID The LRC User ID. This ID is associated with the routing actions taken by 
the MCL, and logged in the Magellan Control System logging subsystem. 

The LRC User ID is used for route protection or locking. The default LRC 
User ID is 0 for unlocked.  The user ID should be set to a non-zero value to 
ensure that the routes are properly locked or protected.  Range is 0 to 
65535. 

Routing Status 

Program Status LRC status for what Source is routed to the Program. 

The 'Program Status' indicates the current source routed to the Program 
Output. If the connection is not successful, then the 'Program Status' will 
show the ID of the last source. If there is a connection problem to the  
Magellan Control System, then a  Magellan Control System connection 
alarm should be active. If the  Magellan Control System rejects the 
connection (ie. the route is locked), then the last source is still connected 
and is shown in the GUI. 

A Break-away Source is shown in parentheses. For example, the break-
away 'Channel 123' source is shown as '(Channel 123)' in the 'Program 
Status' field.  

Preset Status LRC status for what Source is routed to the Preview 

AUX Status LLRC status for what Source is routed to the AUX 

 

To enter the Magellan Control System Server IP Address, go to Configure > Element > SNP 
Management, and enter it in the LRC Server IP Address field. 
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For MCL functionality including source selection and shadow buses, it is mandatory to integrate the MCL 
with a Magellan Control System  server.  The MCL (and SNP-MV) applications use the Magellan Control 
System API to access the Magellan Control System routing database and validate names and actions.  
LRC protocol is then used to make routes within the Magellan Control System, getting the right source 
to the right inputs.  The LRC Server IP Address must be the address of a Magellan Control System server. 

 
 

For MCL specific routing alarms, see MCL Alarms (on page 225). 
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Extending MCL Functionality for UHD Operation 

When operating in HD mode, the MCL processor is self-contained and does not require (or allow) any 
extension.  However, for UHD operation, the MCL can be extended using neighboring SYNC or CONV 
personalities, bringing in Key/Fill inputs (or in some cases A/B bus inputs) and returning clean feed 
outputs. This is only for UHD mode. 

Once a processor has been set to the MCL personality and operating in UHD mode, it can be extended to 
a Sync or Dual Conversion personality, if these two conditions are fulfilled: 

1. The processor adjacent to the MCL is a Sync/Conversion processor, and is in UHD mode. 

2. The preceding processor is either an MCL-UHD processor or an MCL-extended processor (Sync or 
Dual Conversion with Processor Mode set to Extended). 

You can effectively have a Base MCL processor extended to a maximum of 3 other processors. Video and 
audio signals can be routed from an Extended MCL Processor to a Base MCL Processor to provide 
External Alpha/Fill inputs and/or Bus A and Bus B inputs. 

Note: For extended processors, the HPhase, VPhase, and Frame Delay values must be set to zero. 

 
 

Extension Example 

The following example shows a potential extension scenario, with Processor A set to MCL, and Processor 
B/C set to Sync. 
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Pre-Requisites 

• All processors must be in UHD mode. 

• A Master Control Lite UHD Personality license should be available 
for assigning to the Base MCL processor. 

 
Steps on Processor A: 

1. Click Edit on Processor A, go to the Personality tab and set to Master Control Lite 

 

2. Ensure Processor A is in UHD mode. To do this : 

a. Go to Configure > Licenses and ensure the Master Control Lite UHD Personality license is 
available and assigned to Processor A 

b. Click Edit on Processor A, and in the Configuration tab, set the MCL Output Video Standard to 
2160p/50 or 2160p/59.94 

Note: Also see UHD Mode (on page 191). 

Steps on Processor B: 

1. Click Edit on Processor B, go to the Personality tab and set to Sync 

 

2. Go to the Configuration tab and set Operation Mode to UHD. Click Apply Config. 
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3. Once the mode has been changed to UHD, you will see a Processor Mode parameter that enables 
you to set to Base or Extended. Set to Extended. Click Apply Config. 

 

Steps on Processor C: 

Repeat all the same steps performed on Processor B. 

The setup now contains a base MCL Processor A, with Processors B and C as Extended. 
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MCL Alarms 

Type Alarm Description 

Input MCL Input Standard Mismatch  Video Input Standard does not match the MCL 
Output Video Standard. 

Input MCL Input Colorimetry and TCS 
Mismatch 

Video Input Colorimetry and TCS does not match 
the MCL Output Colorimetry and TCS. 

Routing Master Control Lite Proc (X) Router 
Connection Error 

MCL Proc (X) Router Connection Error. 

Note: This alarm is triggered if the SNP cannot 
download the Magellan Control System 
database OR if it cannot send a routing 
command to the  Magellan Control System . In 
general, this alarm indicates a failure  
communicating with the Magellan Control 
System . 

Routing Master Control Lite Proc (X) Invalid 
Destination/Source Name Error 

Displays the errored source or destination 
name. 
 

Note: The MCL Tab > Router Configuration 
section contains source/destination name fields 
(Logical Source Name, Bus A/B Destination 
Name, Program/Preset Follow, and AUX 
Destination Name). On clicking Apply MCL, these 
are validated against the actual names in the 
configured Magellan Control System Database. 
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SNP Graphics Prep Tool 
 

Graphics Prep Tool - Overview 

The SNP Graphics Prep Tool is a standalone application that allows for defining static or animated logos 
to include in your program output. The SNP Graphics Prep Tool is used to convert many industry 
standard graphics file formats such as the Bitmap (.bmp), Portable Network Graphics (.png), QuickTime 
File Format (.mov), etc. to Imagine Communication's proprietary graphics file format, .mg3.  The .mg3 
graphics format supports: uncompressed video, 10-bits per component, High Dynamic Range (HDR), and 
Wide Colour Gamut (WCG). From a workflow standpoint, first go to the SNP Graphics Prep tool to define 
a logo, and then go to the SNP UI to apply it. 

 Steps on the SNP Graphics Prep Tool  Steps on the SNP 

STEP 1 Installing the SNP Graphics Prep Tool 
(on page 226) 

 

STEP 2 Running the Graphics Prep Tool (on 
page 227) 

SNP Graphics Prep Tool - Parameters 
(on page 229) 

STEP 3 Creating a Logo File (on page 232) 

 STEP 4 Uploading a Logo (.mg3 graphics file) to an SNP (on page 
233) 

STEP 5 Selecting an Internal Logo for a Keyer Layer (on page 235) 

 
 

Installing the SNP Graphics Prep Tool 

1. The Graphics Prep tool is a Java application that requires Oracle JRE installed in order to work.  

Note: Oracle's JRE license for commercial use has significantly changed since the release of jre-8u-
202 version. More information here: https://www.java.com/en/download/release_notice.jsp 

Oracle® and Java are registered trademarks of Oracle and/or its affiliates. 

We recommend you install the jre-8u-202 version. See: https://www.oracle.com/ca-
en/java/technologies/javase/javase8-archive-downloads.html 

2. Once Java is installed open a Command shell, and at the prompt type 'java -version'.  Verify 

that the 64-bit version is installed. 

Note: If the Java path hasn't been set in the system, go to the folder that contains Java (for example, 
C:\Program Files (x86)\Common Files\Oracle\Java\javapath), and the run the 

'java -version' command. 

The command shell should display something similar to the below: 
 java version "1.8.0_321" 

        Java(TM) SE Runtime Environment (build 1.8.0_321-b07) 

        Java HotSpot(TM) 64-Bit Server VM (build 25.321-b07, mixed mode) 

3. Go the folder where the  Graphics Prep tool package was extracted and run the 
gfxConvert<version> application (exe). 
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Running the Graphics Prep Tool 

The SNP Graphics Prep Tool UI is displayed on running the gfxConvert-x.x.x.xx application (exe). 

 

• See SNP Graphics Prep Tool - Parameters (on page 229) for a description of the parameters that can 
be set 

• See Creating a Logo File (on page 232) for details on how to create a logo file in this tool 

• See Uploading a Logo (.mg3 graphics file) to an SNP (on page 233) for details on how to input the 
logo file into the SNP 

• See Selecting an Internal Logo for a Keyer Layer (on page 235) for detail on how to assign the logo in 
a Keyer Layer 

 

Running the Graphics Prep tool via Command Line 

The Graphics Prep Tool also offers a command line interface using which you can automate conversion 
of graphics files to .mg3 file format. 

The Command-Line Arguments are as follows: 

-nw No Window will be created, action will be driven by the command line 
arguments 

-p <file> Load the named json "project" file and all the media it points to.   
This "file" is a text file that can describe any feature the gfxConvert tool has. 

One approach to scripted operation is to create the project file in the interactive 
tool, and then modify it via scripts with different filenames or other properties.  



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 228 

 

-m <file> Load the named existing MG3 file. 

-s <file> Load the named still file.  This argument can be used multiple times for multiple 
frames 

-h <id> Use the indicated Logo ID number in the output file.  The Logo ID number is used 
by Automation to reference a specific Logo file.  Valid Logo ID numbers are 1 to 
998.  Do not use 0 or 999.  999 is reserved for External Key inputs.  0 cannot be 
selected by Automation. 

-format <format> Indicates the video format for the file - default is HD1080P. 

Choices are HD1080INT, HD1080P, HDP2020, UHD709, UHD2020. 

-o <file> Indicates where to write the mg3 output file. If missing, nothing will be 
generated. 

Command-Line Format  
C:\test>gfxConvert-0.24.4.24.exe -nw -format <format> -s 

<gfx_filename_1.png> -s <gfx_filename_2.png> -s <gfx_filename_3.png> -

s <gfx_filename_4.png> -o <out_filename.mg3> -h <Logo_ID_number> 

Example of a single static logo: 
c:\test> gfxConvert-0.24.4.24.exe -nw -format <HD1080INT> -s 

stationlogo.png -o id42_stationlogo.mg3 -h 42 

Example of a multiple static logos used to create a two frame animation: 
c:\test> gfxConvert-0.24.4.24.exe -nw --format <HD1080P> -s 

btsport.png -s icLogo.png -o nbcTest.mg3 -h 47 

 

 

 
 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 229 

 

SNP Graphics Prep Tool - Parameters 

Parameter Name Parameter Description 

Read Project Select this option to load a previously saved Project file. Project files are in json format.  The 
Project Name is displayed in the User Interface (UI). The project file includes references to all 
the graphics, the cropping and offset information, and details of the display sequence. 

Save Project Select to save all of the project parameter settings to a Project file, a json file. Imagine 
Communications strongly recommends saving a .json Project file, especially for graphics used 
for UHD formats. 

Save Project As Select to save all of the project parameter settings to a Project file with a new filename, a json 
file.    

Read MG3 Select to open a previously saved .mg3 file.  The .mg3 filename is displayed in the UI.  When 
reading-in a previously saved .mg3 file, the image data is passed though the image processing 
algorithms; this can result in image degradation.  Save a project file to avoid this. 

Start New Project Select this option to create a new Project.  All previous project settings are reset to their 
factory default values and any unsaved changes are lost. 

Add Render Step Use this option to manually create an animation sequence from individual image files or a 
sequence of files. 

Remove Render Step Remove the currently selected Render Step. 

Add Still frames Select this option to import a single image file (for static Logos), or multiple image files of an 
animation sequence (for animated Logos). 

If you specify multiple image files, they must be in the same directory, be of the same size and 
type, and have an ascending numeric sequence as part of their name. The numeric part of the 
file name must have the same number of digits. 

For example, the following sequence specifies a 240 frame animation in the Targa format: 

• myAnim0001.tga 

• myAnim0002.tga 

• myAnim0003.tga 

• myAnim0004.tga 

• myAnim0005.tga 

• … 

• myAnim0238.tga 

• myAnim0239.tga 

• myAnim0240.tga 

Note: Supported Formats for Still files: 
SVG, WMF, BMP, CUR, ICO, PNG, GIF (as still), JPG, TGA, TIFF, BigTiff,  and potentially others. 

Add Video Sequence Select this option to import single files which contain animation sequences such as QuickTime 
File Format (.mov).  Adds a sequence of frames from a video file.  You will be prompted to 
choose the maximum number of frames to add, and also can skip a number of frames from the 
file before adding. 

Supported Formats: 
Motion codecs: Most 8-bit codecs (MP2, H.264, etc) when contained in MOV wrapper.  Also 
supports QuickTime RLE encoding including 10-bit QTRLE with or without alpha channel. 
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First Frame Use this option to specify which image frame is the first frame of an animation sequence.  
Useful for trimming an animation sequence, i.e., the starting frame. Note that frame 
numbering starts at 0. 

Last Frame Use this option to specify which image frame is the last frame of an animation sequence.  
Useful for trimming an animation sequence, i.e., the end frame. 

Step Duration Used to specify how many video frame the current image frame must be played for 

Fade Style Options are: 

• NONE - Play the current Step as normal 

• FADEUP - Fade-up the current Step, in steps of 1/'Step Duration' for each video frame. 

• FADEDOWN - Fade-down the current Step, in steps of 1/'Step Duration' for each video 
frame. 

Use this option when manually building an animation sequence from still images. 

Loop Style Options are:  

• STILL - specifies that the current Step is a still image (default) 

• LOOP - specifies that the current Step is to be looped on 

• PLAYFIT - specifies that the current Step is fit to the Step Duration 

What Next Options are:  

• CONTINUE - Go to the next step in the sequence 

• WAITFORKEYOFF - Repeat the current Step, until the Key has been turned off.  The whole 
Step is repeated.  If the key is turned off while this Step is in progress, the Step either runs to 
completion, or concludes immediately, depending upon the 'What if Key Turn Off' 
parameter is set to. 

What if Key Turns Off • End Step Early - If the key is turned off while this Step is in progress, then end this Step 
immediately 

• Finish Step - If the key is turned off while this Step is in progress, continue this Step to 
completion before proceeding. 

Input crop size x Used to specify how much horizontal crop to apply to the image 

Input crop size y Used to specify the vertical crop to apply to the image 

Input crop offset x Used to specify how much horizontal crop offset to apply to the image 

Input crop offset y Used to specify the vertical crop offset to apply to the image 

Display offset x Used to specify the horizontal position offset of the cropped or non-cropped image.  The 
original of the image, (0,0), is the top-left corner of the screen. 

Display offset y Used to specify the vertical position offset of the cropped or non-cropped image 
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If no alpha If no Alpha channel is embedded with the Fill channel, this parameter specifies how to 
generate the Alpha channel data. Options are: 

• BLACK_CLEAR 

• WHITE_CLEAR 

• OPAQUE 

• LUMA 

Use the three controls to the right to define offset values to apply when creating an alpha 
channels based on thresholding the white or black part of the image. 

• Synthesized Alpha Offset - Offset value applied when creating an alpha channel based on 
thresholding the white or black part of the image. 

• Synthesized Alpha Erosion/Dilation - Iterations of Erosion (if a positive value) or Dilation (if a 
negative value), to apply to the synthesized alpha channel prior to filtering. 

• Synthesized Alpha Filter - iltering level applied after creating an alpha channel synthetically.  
A value of zero means no filtering is applied.       

Video Format Used to specify the target video format and color space of the .mg3 file. Options are: 

• HD720 – for progressive 1280 pixels x 720 lines resolutions in BT.709 HD SDR. Format not 
supported by MCL. 

• HD1080INT – for interlaced 1920 pixels x 1080 lines resolutions in BT.709 HD SDR 

• HD1080P – for progressive 1920 pixels x 1080 lines resolutions in BT.709 HD SDR 

• HDP2020 – for progressive 1920 pixels x 1080 lines resolution in BT.2020 HD HDR/WCG 

• UHD709 – for progressive 3840 pixels x 2160 lines in BT.709 HD SDR 

• UHD2020 – for progressive 3840 pixels x 2160 lines in BT.2020 UHD HDR/WCG 

Preview Frame The frame number that will be used to represent the sequence when it is displayed on the 
preset bus.  For rendered graphics with a fade-in, it is often helpful to choose a preview frame 
that fully reveals the graphic for use as the preview frame. 

NOTE: the preview frame does not need to be part of the active graphic.   

Logo ID Enter an ID for the logo. 

If using Automation, unique Logo IDs must be assigned to each .mg3 graphics file. Automation 
uses these IDs to recall .mg3 graphics files. It is recommended to track Logo IDs in use. 

Write MG3 Output Select this button to render the final MG3 formatted image file - this is the file that is uploaded 
to the SNP in the next step.  Be sure to select the correct target video format before rendering 
the output, as the file's format must match the operating format of the SNP MCL. 

We also recommend saving a project file to facilitate future edits to the graphics project. 

"Graphics Prep Tool 
status" 

General display area for messages generated by the tool 

REV Select this button to step back one frame in an animation sequence 

FWD Select this button to move forward one frame in an animation sequence 
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PLAY Select this to play the animation sequence from the currently selected frame on the 
‘Animation Slider Bar’.  Press the PLAY button to stop the animation sequence from playing. 

"PLAY status" Information about the current image frame being displayed in the UI is displayed in this area 

"Graphics Display 
Mode" 

Options are: 

• ORIGINAL – select this mode to view the original image file 

• CROPPED – select this mode to view the cropped image file 

• IN_FRAME – select this mode to view the cropped or non-cropped image file at the specified 
Horizontal and Vertical Display Offsets 

BKG This option allows to you select a different UI Background color to preview the Logo image 
over.  Depending upon the colours and brightness in the original Logo image, where it may be 
difficult to distinguish the UI Background color from the Logo image. 

 

 

Creating a Logo File 

1. Create a new project by clicking Start New Project 

2. Click the Add Still frames button 

▪ If creating a static logo, select a single file (frame)  

▪ If creating an animated logo, select multiple files/frames by bulk selecting  

3. Click Add Video sequence if adding one file which contains the entire animation sequence. When 
adding frames from a video file, you will be prompted in a pop-up to specify the number of frames 
to import, and also be able to skip a number of frames off the front of the file before importing. 

4. Click the background button if required to adjust the background color so the logo shows correctly 
(depending on the colors in the logo) 

5. In case of a static logo, the First Frame and Last Frame parameters will show as 0 

6. In case of an animated logo, the First Frame parameter will show as 0, and the Last Frame 
parameter will increment to show the final frame 

Note: Animation sequences can also be trimmed by altering the first and last frames of the render 
steps.  when the final output is rendered into MG3, only frames that actually appear in the render 
steps are put into the final file.  

7. Set the Step Duration - This refers to the number of video frames the current image frame must be 
played for 

8. Set the Fade Style - This option applies if creating an animated sequence from still images. Choose 
from Fadeup, FadeDown, or None 

9. Set the Loop Style - Choose whether the logo is a still image or an animation. Options are: 

▪ Still: Specifies that the Render Step is a still image 

▪ Loop: Specifies that the Render Step is to be looped on 

Note: When first importing content, if there are no render steps then the tool will automatically 
create a step that displays the imported content.  Feel free to edit or replace this step with more 
steps that perform the desired sequencing. 
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10. Select the Target Format or the Output format. Choose from: HD 1080P, HDP2020, HD1080P, 
1080INT, or 720P (720P not currently supported) 

 

11. Click the Write MG3 Output button at the bottom. Enter a filename and select a location for the 
logo file. This creates an output file, specially formatted for the selected output, that can then be 
inputted into the SNP system on a Key Layer. 

 

12. Click Save Project. This saves the logo file project, a JSON file, for future use or editing. 

See: 

• Uploading a Logo (.mg3 graphics file) to an SNP (on page 233) 

• Selecting an Internal Logo for a Keyer Layer (on page 235) 
 

Uploading a Logo (.mg3 graphics file) to an SNP 

Note: Ensure that a .mg3 logo file is available. This is created using the SNP Graphics Prep Tool. See 
Creating a Logo File (on page 232). 

1. Log into the SNP UI 

2. Go to Configure > Graphics 
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3. Input the previously created logo by clicking the Browse button. Local graphics name is the name 
that operators will see when selecting this graphic - this is useful in case the file names are not the 
operator names. 

 

4. Once selected, click Import. Progress is indicated as the file uploads. 

5. Once imported, the file is displayed in the Existing Graphics section, from where it can be 
downloaded to the local machine or deleted. 

 

Note: .mg3 graphics files are stored on the SNP file system’s sub-directory: /mnt/ssdu/snp-
media. 

The logo will now be available in the SNP system, and can be set on a Keyer Layer. See Selecting an 
Internal Logo for a Keyer Layer (on page 235). 
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Selecting an Internal Logo for a Keyer Layer 

1. Ensure the desired Processor has been set to the MCL personality and then go to the Configure > 
Processor > MCL Tab 

2. Scroll down to the Keyer Controls section 

3. Select the desired Keyer Layer and in the Source Select field, select the recently added logo (mg3 
file) 

Note: The Source Select list is a filtered list for the applicable logos for the selected MCL Output 
Video Standard. 

 

Note that this is a Live parameter so the selection is immediately applied without the need to click 
Apply MCL. The graphics logo or animation will then be played on the selected layer and displayed 
on the program output.  

A spinning icon will be displayed for large .mg3 files which take a long time to load.  When the logo 
loading completes, the spinning icon will disappear. 

.mg3 Logo files are loaded from the mSATA drive into real-time memory. 

Note: When the X Offset plus Logo width, or Y Offset plus Logo height exceed the Active Picture Area 
edges the Logo will break up. 

 

 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 236 

 

SNP-MCL and Automation 

MCL can be controlled by automation using a variation of the IconMaster protocol. For more details, see 
the IconMaster Automation Interface Protocol User Manual. 

MCL automation was tested against Imagine's Automation Device Controller (ADC) automation system 
version 12, using its IconMaster driver.  The MCL expects the protocol to arrive over a TCP/IP socket, and 
many automation systems supply the protocol on a serial port.  In our testing we used a MOXA adapter 
in the ADC system to convert the serial port from automation into a TCP/IP socket for interfacing with 
the MCL. 
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Configuring a Multiviewer Personality 

SNP Multiviewer and Multiviewer Portrait Mode are additional Processor "Personalities" for the SNP. 
These can be mixed and matched with the other SNP personalities.  

SNP-MV processors have two modes: Base and Extended. When individual SNP-MV processor is 
assigned Base mode, it supports output of two UHD canvases and nine PiPs. Any or all SNP-MV 
processors can be assigned this way, and each one will have two UHD canvases and nine PiPs. After one 
SNP-MV processor has been assigned as Base mode, an upper-adjacent processor can also be assigned 
to Extended mode. These processors do not support any UHD canvases, but instead each provide nine 
more PiPs to the related SNP-MV base, for the following possibilities:  

• Two Processors Together: Two UHD canvases, 18 pips 

• Three Processors Together: Two UHD canvases, 27 pips 

• Four Processors together: Two UHD canvases, 36 pips 

The canvases are always rendered as 12G-UHD, and also output 1080i or 1080p down-sampled versions. 
Canvases can be output as IP and/or SDI and/or HDMI. The UHD Canvas can be rendered in SDR or HDR, 
and 1080i or 1080p versions can be mapped to SDR.  

PiPs are organized into Layouts, which can also have digital clocks, titles, tallys, and audio meters. 
Layouts are created in the Layout Designer application. See your Layout Designer manual for complete 
information. 

The first Processor in an SNP device that is assigned a Multiviewer personality must be assigned Base 
mode. Subsequent processors can be assigned as Base or as Extend. When a Processor assigned as 
Multiviewer personality is in Extend mode, it provides extra PiPs to the Base processor, which can then 
use them as additional inputs to the output UHD displays.  

Each processor that is assigned to Multiviewer personality has eight BNC inputs plus one from the video 
SFP for SDI inputs, or nine IP inputs.  If the BNC and SFP are not used for inputs, the rendered display is 
available through them (and also over IP). 

Each of the nine input channels is assigned to one of the displays based on the number of PiPs used in 
each of the current layouts.  Therefore, if you have a MV Base but no extend processors, you can have a 
single UHD output with up to nine PiPs, or you can have two displays that divide those nine between 
them.  

Adding a single Extended mode processor makes nine more PiPs available to be divided between those 
two UHD outputs, for a total of 18 outputs. A third Extended mode processor adds 9 more PiPs for a 
total of 27, and a fourth means a total of 36 outputs on those two UHD outputs.  

The extend processor(s) must directly follow the Base processor, so if Processor A is the base, then 
Processor B, C, and D can be assigned as extend in that order. If only one extend is to be assigned to the 
base, it must be processor B in that case.  The processors can be configured as Base and Extended, in the 
following configurations:  

Proc A Proc B Proc C Proc D Number of 
Multiviewers 

Number of PiPs per Display 

base base base base 4 4x (9 across 2 displays) 
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Proc A Proc B Proc C Proc D Number of 
Multiviewers 

Number of PiPs per Display 

base base base extended 3 2x (9 across 2 displays), and  
1x (18 across 2 displays) 

base base extended base 3 2x (9 across 2 displays), and  
1x (18 across 2 displays) 

base extended base base 3 2x (9 across 2 displays), and  
1x (18 across 2 displays) 

base base extended extended 2 1x (9 across 2 displays), and  
1x (27 across 2 displays) 

base extended base extended 2 2x (18 across 2 displays) 

base extended extended base 2 1x (9 across 2 displays), and  
1x (27 across 2 displays) 

base extended extended extended 1 1x (36 across 2 displays) 

 

Note: If the number of PIPs in a display exceeds the available ports, an error message - There are not 
enough input ports available for the requested layout - will be displayed. This error message is seen 
even if you switch to a layout in another display where the total PIPs equal the available ports. As a 
workaround, either republish the PiP layout on the affected display OR switch to another layout and 
then switch back to the affected display - this should resolve the issue. 
 

TSL5 Configuration 

It is recommended to configure the SNP-MV unit(s) as TSL server and the controller as client device. 
When the SNP unit is configured for multiple MV personalities, multiple TSL servers should be added to 
each frame with the host IP address of 0.0.0.0 and unique port numbers. 

The example below is based on SNP unit configured for two MV personalities. 

SNP Unit MV Name IP Address Port 

SNP 1 SMV1-1 0.0.0.0 4003 

 SMV1-2 0.0.0.0 4004 

SNP2 SMV2-1 0.0.0.0 4003 

 SMV2-2 0.0.0.0 4004 
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1. From the Tools > Configure Element > IP WAN option, add the TSL V5 devices.  
The conceptual drawing is shown below: 

 

2. Select Views > Element option. 

3. Select the Multiviewer mode [Base] > Edit option. 

4. In Configuration > External Devices, select the proper TSL server port device. 
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Configure a Multiviewer Personality 

When a Processor's mode (on the Personality tab) is set to Multiviewer, the following options will 
appear on the Configuration tab. 

 

General 

Multiviewer Mode 
There are two options:  

• Base: This processor appears in Layout Designer as a device to which output 
devices (display monitors) are connected and layouts can be assigned.  

• Extended: This processor has no display monitors of its own. It  provides 
additional PiPs to the related Base processor, forming a single multiviewer 
from the perspective of the Layout Designer application. 

Cascade Output Select Only displayed on Processor A of a Processor in Multiviewer Mode. Lets you set 
Cascade Output to BNC/SFP or unused. See Multi-Unit Cascading (on page 473).  

Cascade Input Select Only displayed on Processor D of a Processor in Multiviewer Mode.  Lets you set 
Cascade Input to BNC, SFP, or unused. See Multi-Unit Cascading (on page 473).  

Cascade Level  
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Display (1 - 2) Layout 
The layout name in this field is the layout that is currently assigned to the 
specified display.  

Choose a layout from the menu. Selecting immediately publishes that layout to 
the display.  

This menu is populated with all layouts that have been published to this 
particular display output from Layout Designer. 

Display Video 
Standard 

The SNP Multiviewer provides two 3840x2160 (UHD) rendered displays. Both 
displays are the same video format. The video format options are:  

• 2160p/50 

• 2160p/59.97 

Enable 9th Receiver 
In cases where the Multiviewer cannot receive 9 IP input signals due to input 
bandwidth limitations, you can choose to include or exclude the 9th pip  
(in the process of optimally mapping layout pips to physical receivers).  

This setting is disabled by default. 

The 9th pip cannot be used under the following conditions: 

1.  If there are eight 1080p59 signals in use (or planned to be in use) 

2. If the first or second section is UHD and the other is using (or planning to use) 
4x 1080p59 signals 

3. If the first and second sections are both UHD  

Note that in this case (both sections UHD), the SNP treats the 9th pip control as if 
it had been disabled, and this setting is greyed out/unavailable. 

Display Colorimetry 
and TCS 

Set Display Colorimetry and Transfer Characteristics Override. 

• SDR-709 

• SDR-601 

• SDR-2020 

• HLG-2100 

• PQ-2100 

• SLOG3-2020 

Decimation Filter 
Sharpness 

The SNP Multiviewer supports a set of filter coefficients that are allocated to PiPs 
according to the PiP size. This setting offers you control over a sharper or harder 
filter. The larger the value, the higher the sharpness. Smaller or negative values 
are less sharp.  

The value set here applies to all PiPs in the multiviewer. 

Values: -10 to +10 (default is zero) 
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Set Audio Meter 
Background Color 

Set the background color for Audio Meters as desired. Options are: 

• Transparent 

• black 25% opacity 

• black 62.5% opacity 

• black 

• blue 

• green 50% opacity 

• green 

• purple 

• black 50% opacity 

• red 

• orange 

• yellow 

• grey 25%  

• grey 50% 

• grey 75%  

• white 

Set to Transparent if meters need to be placed on top of video. 

Set Audio Meter Scale 
Color 

Set the color for the Audio Meter scale as desired.   

Note: A scale is displayed on an audio meter if enabled in the audio meter 
properties in Layout Designer. 

Options are: 

• Transparent 

• black 25% opacity 

• black 62.5% opacity 

• black 

• blue 

• green 50% opacity 

• green 

• purple 

• red 50% opacity 

• red 

• orange 

• yellow 

• grey 25%  

• grey 50% 

• grey 75%  

• white 
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SFP Select Choose the type of SFP that SNP should be expecting in this position. Options 
include:  

• Unused 

• 2RX 3G 

• 2RX 12G 

• RX HDMI 

• 2TX 3G 

• 2TX 12G 

• TX 12G HDMI 

Note: SFP orientation is different depending on the slot the SFP is inserted into. 
See Configure SFPs for more information. The 2 means dual.  

Force MAB Mode 
When checked, the switch mode is set to Make After Break.  

Otherwise, the switch mode will depend on whether there's available bandwidth 
to do a Make Before Break switch. This can help to avoid oversubscribing the 
switch. See Make-Before-Break (MBB) Video Switching (on page 470) 

Section 1/Section 2 

Operation Mode • HD 

• UHD 

External Devices 

The 'External Devices' group contains the communication parameters for TSL, Plura, and Masterclock 
devices. These parameters are available when the 'Multiviewer Mode' parameter is set to 'Base'. Plura 
and TSL V5 devices are defined per SNP device.  

• See Configuring Plura and TSL V5 Devices for use with the Multiviewer  (on page 244) 

• See Masterclock Devices (on page 373) 

TSL V5 Provides Tally data for multiviewers. TSL must also be selected on tallies etc. in 
Layout Designer for this data to be transmitted/received.  

Clocks/Timers Provides Clock/timer data for multiviewers (Masterclock and Plura devices).  

Select a configured Plura or Masterclock devicefrom the drop-down menu, or 
leave as "unused" if not using Plura or Masterclock. 

If using Plura, note that Plura must be specified on any clocks in Layout Designer 
for data to be transmitted/received.  
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Configuring Plura and TSL V5 Devices for use with the Multiviewer  

From the main menu, choose Tools > Configure Element, and then click on the SNP Management tab. 
Scroll down to the External Devices section.  

 

There is a table that lists configured TSL V5 Devices, and another that lists all configured Plura devices.  

• To add a TSL V5 or Plura device, click + for that device type.  See TSL V5 (UMD Devices) (on page 
369) and Plura Devices (on page 371).  

• To remove a device, click Delete (under Actions).  

• To modify an already-defined device, click Edit.  

To commit changes, click Apply SNP Config. 

 
 

Configuring Masterclock Devices 

From the main menu, choose Tools > Configure Element, and then click on the SNP Management tab. 
Scroll down to the External Devices section.  

 

There are tables that list configured TSL V5 Devices, configured Plura devices, and Masterclock Devices 

• To add a Masterclock device, click + for that device type.  See Masterclock Devices (on page 373) 

• To remove a device, click Delete (under Actions).  

• To modify an already-defined device, click Edit.  

To commit changes, click Apply SNP Config. 
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Configuring Multiviewer Inputs 

Ensure that the IP WAN has been configured before setting up any receivers, and that your SNP is 
configured for Multiviewer (Base or Extend) personality.  

When configured as part of a multiviewer, each section can receive either IP streams or SDI input.  

To configure an SNP program as receiving video from IP input, follow these steps:   

1. Choose the Section Input mode as IP for the section of the processor you're working on.  

2. Click the Program you want to configure.  

3. On the Input tab, make WAN-related configurations as appropriate for your network, including the 
following:  

▪ Check the Video IP Receiver Enable checkbox. 

▪ Set the correct Receiver Video Standard. 

▪ Set the Primary and Secondary WAN selects. 

▪ Set the Primary IP address, UDP port, and (optional) multicast source. 

▪ Set the Secondary IP address,  UDP port, and (optional) multicast source. 

To configure an SNP program as receiving video from SDI input, choose the Section Input mode as SDI 
for the section of the processor you're working on.  

Ninth input:  

On SNP-MV processors only (both Base and Extend), you will see below the HD Section 3 Input Mode 
section, the following:  

  

This ninth input is configured the same as the other eight. The ninth input gets its SDI input from the SFP 
port only.  
 

Configuring Multiviewer Outputs 

Configuration options for Multiviewer (Base) Processor Outputs are on Program 1 and Program 5. 
Extended Multiviewer mode processors do not have Output tabs on any program.  

These UHD canvases are rendered as either SDR or HDR, output as IP and/or SDI and/or HDMI. 
Additional 1080i or 1080p proxy outputs can be mapped to SDR.  

1. Click Edit for the Multiviewer mode (base) Processor and choose one of the following under SFP 
Select: 

▪ Unused  

▪ 2TX 3G 

▪ 2TX 12G 
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2. To configure Display 1, open the Configure Processor dialog box for Program 1.  

3. On the Output tab, make the following selections:  

▪ Make a selection for Proxy 3G Output Enable.  

• Unchecked: the Proxy output format is 1080i (interlaced).   

• Checked: the Proxy output format is 1080p (progressive).   

The Proxy output frame/field rate follows the Multiviewer’s Display frame rate. 

▪ Under SDI, choose either UHD (12G) or UHD (2SI 4x 3G-SDI)  under SDI UHD Output Link Select, 
depending on the type of monitors you are using  

▪ Your options under SFP Output, will vary depending on your choice under SFP Select (above): 

• If you chose Unused, SFP Output will be unavailable. Make your selecting under IP Video 
Configuration 

• If you chose 2TX 3G, make your video output selections under Proxy IP Video Configuration 

• If you chose 2TX 12G, Main SDI will also be available 

4. Repeat steps 2 and 3 for Program 5 (Display 2).   

5. Click Apply to save the configuration.  

Now, when you connect to the SNP-MV device in Layout Designer and publish a layout to the associated 
display, it appears on the connected output.  

Or, if layouts have already been created and assigned for the display, click Edit for the Processor, and 
choose a layout from the Display 1 layout or Display 2 layout menu. 
 

Connecting to Layout Designer (Multiviewer Personality)  

Layout Designer recognizes the hardware device it is connected to, so if you have EPIC-MV devices and 
SNP-MV devices,  

1. To install Layout Designer, double-click the PlatinumSXHybridDesigner-20xx-xx-xx-xx.exe file (where 
X denotes a variable number).  

Layout Designer uses an InstallShield Wizard. Follow the instructions that appear on the screen. All 
required plug-ins and extensions are installed as part of the executable procedure.  

2. When installation is complete, launch Layout Designer.  
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3. In the Multiviewers palette that appears by default in the upper right of the screen, click Device 
Manager.  

 
4. In the Device Manager screen, click Add Device and enter a name and IP address for your SNP-MV.  

 
5. Select the display number.  

For SNP-MV devices, the Display column defines which display you want to publish to.   

SNP Processor  Display #1 Display #2 

A Display 1  Display 2 

B Display 3 Display 4 
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SNP Processor  Display #1 Display #2 

C Display 5 Display 6 

D Display 7 Display 8 

6. To test the connection, click Test.  

A green check appears in the Connected column for successful connections.  

If there is no SNP-MV Base device at the selected processor, your connection will be rejected and a 
red X will appear.  

For SNP-MV devices, you can have several displays at the same IP address. These are the various 
displays on that device. You will make a Device row for each display you want to publish to. 
Connections made the Extended SNP-MV processors will be rejected, as the Extended SNP-MV does 
not output displays, but provides video feeds for other (Base) SNP-MV devices.  

7. Click Save.  

The SNP-MV appears in the Multiviewers list, and the Device Manager dialog box closes.  

8. Click on this device.  

If there are layouts assigned to the device, they appear in an alphabetized list underneath it in this 
dialog box.  

9. Do either of the following:  

▪ To modify a layout, click on it to open it in the canvas.  

Note: You cannot use an existing EPIC-MV layout as the starting point for an SNP-MV layout. 

▪ To create a new layout, choose File > New Blank Layout or File > New Layout using Layout 
Creation Wizard.  

See your Layout Designer manual for complete information on how to develop layouts.  

Each PiP in a layout has its source defined by Magellan Control System and routed through the SNP-
MV processor(s). Create a window for each PiP or it will not be shown on the output.  

Each channel is allocated to one of the two displays. PiPs are populated on Display 1 of a processor 
starting from 1. PiPs are populated on Display 2 starting from the highest number available -- so, if 
you have a Base processor that is extended by one Extend processor, the PiPs on Display 2 will start 
with PiP 18, then PiP 17, etc. When creating layouts, ensure that the layouts of the two displays do 
not ask for more inputs than the processors can supply.  If the two layouts contain more PiPs than 
are available, the PiPs are filled in increasing order within each display, but the missing PiPs (which 
will render as blank) could be on either display depending on the sequence of layout selections.  

10. When your layout is complete, click File > Save.  

11. To publish your layout to the SNP-MV, click Publish.  

The layout appears in the XML file list on the Configuration tab for the Processor in the SNP web 
interface.  

Note about Digital Clock 

The Layout Designer options of Internal Clock and External PTP both show the ‘SNP system time’.  Note 
that both types of clocks are not supported simultaneously. 

NTP Server Configured PTP Configured SNP System Time 

No No Indeterminate 
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NTP Server Configured PTP Configured SNP System Time 

No Yes PTP time 

Yes No NTP time 

Yes Yes NTP time 
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Configuring a Multiviewer Portrait Mode Personality 

The Multiviewer Portrait Mode Personality is similar to the Multiviewer personality, but with the ability 
to rotate the multiviewer's display.   

For all details and configuration options, see Configuring a Multiviewer Personality (on page 237). Note 
that two differences include support for a single display, and the Output tab only being available in 
Section 1. For more details, see: 

 

In This Section 

Portrait Mode: Display Output Rotation ................................................ 251 
Portrait Mode: Support for a Single Display .......................................... 251 
Portrait Mode: Output Configuration .................................................... 251 
Portrait Mode: Key Features .................................................................. 251 
Portrait Mode: Layout Designer Configuration ..................................... 252 
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Portrait Mode: Display Output Rotation 

The display output can be rotated clockwise or counter clockwise, by either 90 or 270 degrees, 
depending upon how the monitor is mounted.  

 

 
 

Portrait Mode: Support for a Single Display 

The Multiviewer Portrait Mode supports a single display (as compared to the Multiviewer landscape 
mode) which allows for 2 displays. 

Portrait Mode: Output Configuration 

For this personality, the output set in Section 1 is automatically applied to Section 2. Section 2 does not 
have it's own Output tab and will match the output (for SDI, etc.) of Section 1. 
 

Portrait Mode: Key Features 

The following are some of the features of this personality: 

• Rotation Support: Portrait mode provides support for rotating a single UHD 3840x2160p50/59.94 
image (one display) 

• PIP Width: The Portrait mode is limited to support up to a maximum of two large PIPs with sizes 
greater than 1920x1080 – regardless of the input signal (HD or UHD) 

• Outputs: Portrait mode outputs are available over SDI and IP (ST2110-20) 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 252 

 

• Proxy Output: Proxy output is available in Portrait mode.  Proxy outputs are available over SDI and 
IP (ST2110-20 and ST2022-6) 

• Video Input and Output formats: 3840x2160p50/59.94 2SI. 

• Audio: Embedded Audio is de-embedded, delayed by 1 video frame, and then re-embedded 

• Extension: Portrait mode can also be extended similar to the regular MV personality. 
 

Portrait Mode: Layout Designer Configuration 

In Layout Designer, the Properties window > Layout tab displays orientation settings - Landscape and 
Portrait. On connecting to a multiviewer, the assigned mode orientation is auto detected. 

 

Layouts can also be created using the wizard (which now has a portrait selection). To do this: 

1. Go to File > New Layout Using Layout Creation Wizard 

2. Provide a Name for your Layout 

3. Select the Resolution and Orientation 

 

4. Select the component type (Window or PiP) 

5. If Window, then select a window from the library 

6. If PiP, select a PiP 

7. Select a Layout style 

8. Click Finish to complete 
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SDI Inputs to SDI Outputs within a Program 
The SNP can be used for both SDI inputs and outputs. Each program within a processor can directly 
provide an SDI output locally, without the need for IP domain connectivity. 

Each processor personality allows SDI inputs and SDI outputs, by using the available HD-BNC 
connections as inputs or outputs. See more details on personalities. 

Important: 12G SDI input will not work if Section 1 is configured as SDI 5-8 input mode or if Section 2 
is configured as SDI 1-4 input mode. 

Note: In addition to the SDI outputs, IP outputs can also be available simultaneously from any given 
program within a processor. Depending on your configuration, some sections may provide IP outputs 
only because the SDI connections are used in other ways. 
 

SDI Input/Output Assignments 

Each of the SNP's processor section's input mode selections will determine which group of four SDI BNCs 
will operate as outputs.  It is important to note that if either of SDI 1-4 or SDI 5-8 are not selected as the 
section's input mode, then that group of four SDI BNCs will be assigned as outputs for the section that is 
native to the SDI BNCs. 

SDI 1-4 is native to Section 1 and SDI 5-8 is native to Section 2. 

Examples: 

1. If Section 1's Input mode is set to SDI 5-8 and Section 2's Input mode is set to IP, then SDI 1-4 BNCs 
will be assigned to Section 1's program outputs. 

2. If both Section 1 and Section 2's input modes are set to IP, then SDI 1-4 BNC outputs will be 
assigned to Section 1 and SDI 5-8 BNC outputs will be assigned to Section 2. 

The following table illustrates the SDI 1-4, SDI 5-8 and IP input mode selections and SDI BNC output 
assignments. 

Section 1 Input Mode Section 2 Input Mode Section 1 Output Section 2 Output  

SDI 1-4 SDI 1-4 IP only SDI 5-8 and IP 

SDI 1-4 SDI 5-8 IP only IP only 

SDI 5-8 SDI 5-8 SDI 1-4 and IP IP only 

SDI 5-8 SDI 1-4 IP only IP only 

SDI 1-4 IP IP only SDI 5-8 and IP 

IP SDI 1-4 IP only SDI 5-8 

SDI 5-8 IP SDI 1-4 and IP IP only 

IP SDI 5-8 SDI 1-4 and IP SDI 5-8 and IP 

IP IP SDI 1-4 and IP SDI 5-8 and IP 
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For the Quad-Conversion personality, since there is only a single section, the following table illustrates 
the SDI BNC input and output assignments: 

Section 1 Input Mode Section 1 Output 

SDI 1-4 SDI 5-8 

SDI 5-8 SDI 1-4 

IP SDI 1-4 and SDI 5-8 
 

 

SDI Inputs and Outputs 

When selecting the Input in the UI, three options are available for each section. You can pick either SDI 
1-4 or SDI5-8 for both sections. 

Note that SDI output is only possible if the input mode SDI selection is the same in both sections. For 
example: if SDI 5-8 is selected in Sections 1 & 2, SDI 1-4 will automatically be configured as SDI outputs 
which will be available for the corresponding programs in Section 1. 

If an IP input is selected, the associated SDI port is an output port. In general, if the SDI port is not 
selected as an input port, then it becomes an output port.  

Note: Input overrides output so the SDI output is only available if neither section is using those 
connectors for input.  

 

 

• SDI 1-4 

• SDI 5-8 

• IP 
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For example, if you select SDI 1-4 in Section 1 and SDI 5-8 in Section 2, you won't have any BNC  
connectors available for output, so IP output would be the only option. But if you select just SDI 1-4  in 
one or both sections, you would still have SDI 5-8 available for output (and vice versa). SDI Output is 
configured in the Output tab for a Processor, under the SDI section. 

 
 

Silencing Input on a Channel 

Unused inputs can have their SDI Input Link Select set to NONE. This is done in the Input tab > Video 
Configuration section for a Processor. 

The ‘None’ option is meant to disable the input to the frame sync of the specified channel. There should 
be no input and no alarm for the channel. Note that the ‘None’ option does not disable the BNC port. It 
only disables the processor of the specified channel. For example, if the user selects ‘None’ for channel 1 
and the user also selects ‘SDI 1-4’ for channel 5, channel 5 still processes the SDI signal of the BNC 1 
port.  

There is no SDI input signal when the ‘None’ option is selected for any given program. 

 
 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 256 

 

SDI Audio Routing 

Incoming audio can be routed to a given SDI output regardless of whether that audio came in as IP or 
SDI (embedded). 

• IP Input: If you're receiving IP audio, you have options to route it to SDI. This is done in the Output 
tab for a Processor. 
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• SDI input: Audio, if any, is embedded. In case of SDI input routed to SDI output, audio is configured 
in the Input tab for a Processor, under the SDI Audio Routing section.  

 

Audio Shuffling 

The SNP supports basic audio shuffling for SDI inputs. Note that you can shuffle the base audio but not 
the extended audio (see note about MADI below).  

To shuffle the base audio: 

1. Go to to the Input tab, SDI Audio Routing section 

 

2. In the Audio Processor Channel dropdown, select from 16 base audio channels, and in the Input 
Channel dropdown, pick the source.  

Note that you do this only if you want to shuffle. Leave the 1-to-1 mapping if you don't want to 
shuffle. 

Note: You cannot shuffle extended channels that come from MADI (MADI RX SFP). Currently, you cannot 
process these extended channels in any way, other than routing into IP or SDI. For base channels, you 
can fix delay etc.  
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Sync Personality 

Outputs 

If used as output, the following SDI outputs are available: 

• Section 1: HD-BNC SDI Outputs 1-4  

• Section 2: HD-BNC SDI Outputs 5-8  

Inputs 

HD Operation Mode 

Section 1: Input Mode: SDI 5-8 • This configures the program for SDI input on 
5/6/7/8 and SDI output on 1/2/3/4 from Section 
1. 

• Section 2 can still be used as IP-to-IP if required. 

Section 2: IP or none 

 

Section 1:Input Mode: IP or None • This allows SDI input on 1/2/3/4 and SDI output 
on 5/6/7/8 from Section 2 

• Section 1 can still be used as IP-to-IP if required. Section 2: Input Mode: SDI 1-4 

 
VSFPs, if present, optionally can be used as alternate inputs to programs, or outputs. When the VSFP-RX 
is selected, the corresponding BNC port becomes an output port. This feature is especially important for 
the dual-conversion and REMAP personalities, since it allows 2 distinct SDI to SDI streams per processor 
instead of 1. 

UHD Mode 

Functions similar to HD mode in terms of user settings. For VSFP the dual-RX VSFP can be used for 12G 
input even as the HD-BNC are used for 2SI (or 12G) output - and conversely same with dual-TX 12G VSFP 
while all HD-BNCs are used for inputs. 
 

Dual Conversion Personality 

Similar to Sync Personality (on page 258).  

VSFPs 

• Using VSFPs: VSFPs can be used as additional inputs or outputs  

• Dual-RX VSFP (upconversion): VSFPs can be used as input, and HD-BNC as output for all modes, 
both sections 

• Dual-TX VSFP (downconversion): VSFPs can be used as output, and HD-BNC as input for all modes, 
both sections 
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Remap Personality 
• With an input or output VSFP: You can use the VSFP for one of 12G input or output, and  HD-BNC 

for the other. Applies to both sections. 

• In case of no VSFP:  user sets the section 2 "SDI Connector Mode" to "Section 1 Outputs", and can 
use any feature available, but only on section 1 (in SDI-to-SDI) with SDI outputs on 5/6/7/8.  section 
2 can be used but only IP-to-IP. 

 

Multiviewer/Multiviewer Portrait Mode Personality 

In Multiviewer mode, the options are just SDI or IP. 
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Configuring for Unicast 
You will need to configure both the transmitting and receiving devices.  

To configure the transmitting SNP: 

1. Open the Configure Processor dialog box for the Program that will be transmitted.  

2. On the Output tab, enter the Primary IP address on the Primary WAN of the remote device, and the 
Secondary IP address on the Secondary WAN of that same device. 

3. Enter a number for the Primary and Secondary UDP port.  

Normally these will be the same number.  

To configure the receiving SNP:  

1. Open the Configure Processor dialog box for the Program that will be received.  

2. On the Input tab, enter 0.0.0.0 for both the Primary IP address and the Secondary IP address.  

3. Enter the same numbers for the Primary and Secondary ports that were entered on the transmitter 
side.  
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Configuring Proxy Output 
Proxy output provides UHD signal monitoring at a lower resolution (minimizing the required bandwidth 
and processing by a multiviewer, for example).  The proxy consists of video only, with audio and ancillary 
data not handled. 

Proxy video output (1080i) is at the same frame rate as input. Proxy video is 709 color space and SDR, 
and 2110-20 only.  

Proxy output requires the SNP-PSK-DOWNHD (HD Downsample Feature) license  which enables dual 
proxy video per processor. Each SNP can have up to four licenses, so that an SNP could provide up to 
eight proxy outputs. In HD mode, Proxy can be enabled on the first program of every section.  

Parameters for controlling proxy video output appear in the following locations: 

• Configuration (Video)  

▪ UHD Proxy Input Select -- (choose to monitor one of the four links or all four) 

▪ Proxy Output Force SDR-709 

▪ Proxy 3G output enable 

• Output Tab: Proxy IP Video Configuration (on page 456) 

• Output Tab: Proxy IP Video Status (on page 457) 

When the baseband processor output is configured as UHD-SQD (in both Remap and Conversion 
personalities), the proxy is configured to monitor the input signal of the baseband processor instead of 
its output. As a consequence, the proxy output will not reflect any adjustments made to video TSG, 
force freeze, or force black settings.  

 

Main and Proxy Processing Paths When using Pixel Interleave Output Formats 
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Main and Proxy Processing Paths When using Square Division Output Format 

Note: In addition, when the HDR Adjustment feature license is enabled for this program, HDR color 
conversion is available on the proxy.  

Proxy Output in the Multiviewer Personality 

Proxy output is available on the 4th BNC of a section if the SDI UHD Output Link Select is set to UHD 
(Single Link), which is 12G. In this case, since the output goes out on a single link, the 4th BNC can be 
used as a proxy. This applies in case of Multiviewer Mode and Multiviewer Portrait mode. 

Proxy Output in the TR-07 and TR-08 Encoders 

Proxy 3G output will not work for TR07 or TR08 Encoder in UHD mode if Proxy Input Select is either Link 
2, Link 3 or Link 4. 
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Configuring HDR conversion  
The SNP provides a Color Space Processor (CSP) for each available video program.  The SNP CSP has the 
ability to convert between different color gamuts or Standard Dynamic Range for SD and HD video and 
High Dynamic Range (wide color gamut) for HD and UHD video.  

The SNP offers user controls for selecting both the input colorimetry and transfer characteristics and the 
expected outgoing colorimetry and transfer characteristics.  When the selected input and output color 
spaces are different, the SNP CSP will perform a conversion transformation as per the various 
standards.  The supported colorimetry and transfer characteristics are: 

SDR-709 Specified in Rec. 709 

SDR-601 Specified in Rec. 601 

SDR-2020    Specified in Rec. 2020 

HLG-2100 Specified in Rec. 2100 

PQ-2100  Specified in Rec. 2100 

SLOG3-2020 Specified by Sony 

Licensing option (SNP-PSK-HDR) must be purchased for the CSP to be enabled. 

 
 

Configuring for 12G UHD 
When using 12G UHD as your input source, if the video channel/section supports UHD input on BNC, you 
can configure the first BNC (SDI In) for either 12G or 3G/HD. If you select the 12G option, the channel 
will receive the UHD stream as a 12G signal from the first BNC connector and all other three BNC inputs 
will be ignored. If the 3G/HD option is selected, the channel will receive the UHD stream as a Quad-Link 
from all four BNC connectors. 

When using 12G UHD as your input source, if the video channel/section supports UHD output on BNC, 
you can configure the first BNC (SDI Out) for either 12G or 3G/HD. If the 12G option is selected, the 
channel will output the UHD stream on the first BNC connector only as a 12G signal. If the 3G/HD option 
is selected, the channel will output the UHD stream on all 4 BNC connectors as a Quad-Link (2SI or SQD).  

12G specific settings appear in the following areas of the interface:  

• For input 12G UHD, Input Tab (SDI): Video Configuration (on page 400) 

• For output 12G UHD,  Output Tab: SDI (on page 453) 
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Color Processing - Built In and Custom LUTs 
The SNP offers built-in color processing, settings for which are defined in the Video tab: Color 
Adjustment. See Video Tab: Color Adjustment (on page 415). 

 

Users also have the option to upload their own 3D cube LUT which may be used instead of the built-in 
"Linear Domain" color processing.  

Note:  
- LUT processing is supported on the Dual-UHD and Quad-1080P conversion personalities (only)  
- Customers need to generate their own custom 3D LUT files to import to the SNP system. 
- LUT Files must be in the 33-point 3D CUBE LUT format (.cube).  Other LUT format files are currently not 
supported. 
- Use of 3D LUTs is only supported in the following personalities: 
 * Dual Conversion 
 * Quad Conversion 

Once generated, to use a custom LUT in the SNP, follow these steps: 

1. Step 1: Load the LUT to the system and define metadata 
See Loading Custom LUT Files to the SNP System and Defining Metadata (on page 265) 

2. Step 2: Use the LUT when processing 
See Using Custom LUT Files when Processing (on page 269) 

Also see: 

• LUTs on the Remote SMM (on page 271) 

• General Notes about LUTs (on page 272) 
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Loading Custom LUT Files to the SNP System and Defining 
Metadata 
1. Go to Tools > Configure 3D LUTs 

 

2. In the Configure 3D LUTs dialog displayed, browse and select the 3D LUT from your local PC 

3. On selecting a LUT, its name is populated in the Destination 3D LUT Name field, but the name can 
optionally be changed 

Note that this name will be used to refer to the LUT file elsewhere in the SNP operating interface. 

 

4. Next, associate metadata for input/output colorimetry and TCS of the LUT. Make the appropriate 
selections in the following fields based on your LUT details: 

Note: For example, if the conversions defined for your 3D LUT are PQ-2100 to HLG-2100, select 
those two options in the LUT’s metadata section for the Input and Output Colorimetry and TCS 
respectively. 

▪ Input Colorimetry and TCS: Options are: 

• SDR-709 

• SDR-601 

• SDR-2020 

• HLG-2100 

• PQ-2100 

• SLOG3-202 

See Using Custom LUT Files when Processing (on page 269), 3D LUT Operating Mode, Auto, for 
details on how this metadata is used. 

▪ Output Colorimetry and TCS: Options are the same as Input Colorimetry 

▪ LUT Input: Options are:  

• Full/Wide Signal Range  
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• Nominal/Narrow Signal Range 

The following diagram illustrates how the "Full/Wide" and "Nominal/Narrow" SDI signal ranges, 
map to the input of the LUT: 

 

▪ LUT Output: Options are the same as LUT Input 

The following diagram illustrates how the LUT output maps to "Full/Wide" and 
"Nominal/Narrow" SDI signal range: 
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5. Click Import to complete the LUT import process 

6. The imported LUT will then be displayed in the Existing 3D LUTs section. From here, you can 
download or delete a LUT. 

 

Note: The name of the LUT displayed in the Exisiting 3D LUTs section is per the name provided in 
the Destination 3D LUT Name field. The original filename is maintained and used when the file is 
downloaded. 
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Editing Metadata for LUTs (Optional) 

Do the following to edit metadata for a LUT in the system and resave it to the system: 

1.  Go to the Edit Metadata tab 

2. Browse and select a LUT file 

 

3. Fields are populated with the original settings. These settings can be changed as required.  

 

4. Click Update once done to resave the LUT's metadata to the SNP system. 

Note: The SNP system currently supports a maximum of 30 LUTs. Once this limit has been reached, no 
additional LUTs may be imported. Delete any unused LUTs to make room for any new LUTs. 

This completes adding a LUT to the system.  
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Using Custom LUT Files when Processing 
Note: LUT processing is supported on the Dual-UHD and Quad-1080P conversion personalities (only) and 
requires the SNP-PSK-HDR (HDR Adjustment Feature) license. 

1. Click on a program and go to the Video tab 

2. Go to the 3D LUT Control and Status section 

 

▪ 3D LUT Select: This dropdown contains a listing of LUTs in the system and UNITY - a default LUT. 
Select the LUT to use. 

Note: If using the Remote SMM, the list of LUTs displayed here differs from the LUTs in the Tools 
> Configure 3D LUTs dialog. The list displayed in the Tools > Configure 3D LUTs dialog is what's 
on the remote SMM. The list here (Video tab) is what's on the SNP. 

▪ 3D LUT Operating Mode: There are three options here:  

 

• ColorProc Force: This option (the default) uses the SNP’s non-linear and linear domain 
mathematical pipelines and does not route the signal through the selected LUT 

• LUT Forced: This option uses the SNP’s input (non-linear) domain color processing engine, 
followed by the user selected LUT, regardless of whether the colorimetry or transfer 
characteristic of the input signal are appropriate for the selected LUT 

• Auto: This option uses the SNP’s input (non-linear) domain color processing engine, 
followed by an automated selection of: 
(A) The selected LUT or  
(B) The SNP’s linear domain mathematical pipeline 
The automated selection is based on the colorimetry and transfer characteristic (TCS) and 
colorimetry of the incoming signal, and the requested colorimetry and TCS of the 
converter’s output.  If the input and output TCS match the metadata of the selected LUT, 
then the selected LUT will be used, otherwise the SNP linear domain pipeline will be used. 

▪ Pre-3D LUT RGB Clip Mode: The clipping mode of the RGB values prior to 3D LUT processing. 
Select from Hue Preserving and Per component. 

▪ 3D LUT Status: Displays the effective 3D LUT operating mode. 
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3. Scroll up to the Colorimetry/TCS Control and Status section and set the following fields: 

 

▪ Set Input Colorimetry and TCS Override: In the case of SDI inputs, the Colorimetry/TCS is 
detected from the Payload ID (VPID) on the SDI.  If the VPID is not detected an assumption is 
made based on the video standard.  In the case of IP signals, the Colorimetry/TCS is set by the 
control system as part of switching between different IP signals.  In either case, there is the 
possibility that the value is not actually correct for the signal.  This control allows the user to 
override the automatic detection with a manual setting. 

▪ Set Output Colorimetry and TCS: This selection controls the colorimetry/TCS of the output 
signal from this converter.  “Auto” (the default) will choose an SDR value based on the output 
video standard.  Note that HDR conversion and HDR LUT/Linear processing requires the HDR 
conversion license key. 

Note: The Effective Input and Output Transfer Characteristics and Colorimetry status fields will 
reflect the current values chosen by the SNP in response to the currently applied user controls 
above.  After Applying any changes to the selections above, these fields may update.  The values 
of these effective input and output TCS and colorimetry status parameters are used in 
controlling the automatic LUT switching feature. 

4. Click Apply to save changes 

5. LUT Status is displayed in the 3D LUT Control and Status section. Use this to validate your settings. 

Note: The LUT status contains three fields separated by commas.  The first field indicates whether 
the selected LUT is currently being used (Enabled) or not (Disabled).  The second and third fields 
reflect the metadata of the selected LUT, used in controlling the automatic LUT switching feature. 
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LUTs on the Remote SMM 

On the Remote SMM, Tools > Configure 3D LUTs displays tabs and settings similar to what is displayed 
on the local SMM. In addition, it has one extra tab - Copy 3D LUT.  

 
 

LUTs on the Remote SMM vs the Local SNP 

When a user works with the local SNP, they upload the LUT file to the local SMM. When working with a 
remote SMM, the LUT file is uploaded to the remote SMM and not an SNP. To use a LUT with a specific 
SNP, transfer the LUT to the SNP. 
 

Copying a LUT from the Remote SMM to an SNP 
1. On the Remote SMM, go to Tools > Configure 3D LUTs > Copy 3D LUT 

 

2. Select a LUT in the Source LUT Name dropdown 

3. Select the Destination Element (or SNP) to copy the LUT to 

4. Click Copy 

Note: If the SNP contains the maximum allowable LUTs (30), the copy will fail with an error message. 
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General Notes about LUTs 
• 3D LUT files are not included with the SNP, except for the default 'UNITY' LUT. Customers will be 

required to generate their own custom 3D LUT files to input to the SNP system 

• LUT files used with the SNP must be in the 33-point (N=33) 3D CUBE format as specified in section 7 
of the cube lut file specification from Adobe – found at 
https://wwwimages2.adobe.com/content/dam/acom/en/products/speedgrade/cc/pdfs/cube-lut-
specification-1.0.pdf  
The domain of the LUT table must be within the bounds [0.0, 1.0] as required in section 8. 

• LUT processing is supported on the Dual-UHD and Quad-1080P conversion personalities (only) 

• LUT processing requires the SNP-PSK-HDR (HDR Adjustment Feature) license 

• A maximum of 30 LUTs are supported on the SNP system. The remote SMM as well supports a 
maximum of 30 LUTs. 

• When using the Remote SMM, the list of LUTs displayed in the Tools > Configure 3D LUTs dialog 
(uploading LUTs) differs from the list in Video tab for a program (applying LUTs) . Tools > Configure 
3D LUTs displays LUTs on the remote SMM and the Video tab displays LUTs on the local SNP. 
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LRC Routing 
This feature puts routing in the layout, so that every time you apply a given layout, it routes those 
signals. The layout contains the routing information and it sends LRC commands to the configured 
control system (Magellan Control System) to establish the routes. 

To set this up, do the following: 

1. Open Layout Designer and load your layout 

2. For each PiP, select the channel and source to put on the PiP in the layout 

a. Select a PiP 

b. Go to the PiPs tab in Properties pane.  

c. In the Source and Format section, select Source from the dropdown lists 

d. Repeat for each PiP in your layout 

e. Save and publish the layout 

 

3. Go to the SNP 
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4. Go to Configure Processor > Configuration Tab 

5. Select the layout for the Display Layout 

 

6. Click Apply Config 

On selecting the layout in the SNP and applying, the routes take place automatically. 

Note: It could take a while to route depending on how many channels you have. 
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Advanced Audio Processing 
DTS Neural audio products are manufactured under license from DTS Licensing Limited. DTS and the 
Symbol are registered trademarks & the DTS Logos are trademarks of DTS, Inc. 

Dolby and the double-D symbol are trademarks of Dolby Laboratories. Copyright 1998–2008 Dolby 
Laboratories. All rights reserved. 

 

 Supported Personalities See Functions supported on various Personalities (on page 275) 

AAP Overview The SNP offers a wide variety Advanced Audio Processing options, via DTS 
Neural technology and Dolby technology. These options enable advanced 
audio processing for high-definition and surround sound programming using 
5.1 and stereo sources.  

Creating AAP Sessions All existing SNPs contain two Digital Signal Processors (DSPs) that are capable 
of providing this advanced audio functionality. Once licensed, as you enable 
functions (such as UpMix, DownMix, Dolby E Encoding/Decoding, etc.) AAPs 
are automatically configured by the system. See: 

• Creating AAP Sessions (on page 290)  

• AAP Settings/Parameters (on page 292) 

AAP Licensing See AAP Licensing (on page 287) for Advanced Audio Licensing.  

For DTS, license allocation is dynamic, using a flexible token system to allow 
users to change the type of processing without purchasing additional licenses. 
For more details, see DTS Credits (on page 289). 

Special Notes •  Each processor can have a maximum of 5 AAP sessions. 

• AAP cannot be combined with the Automatic Change-Over  
(see Automatic Change Over (ACO) on the Sync Personality (on page 124)) 
operation. 

 

 

Functions supported on various Personalities 
Personality AAP – UpMix/DownMix/MM/LC AAP-Dolby E  ENC / DEC 

SYNC Yes Yes 

DUAL-UHD-Conversion Yes Yes 

Quad-1080p-Conversion Yes Yes 

REMAP No No 

STAT No No 

Multiviewer No No 

Master Control Lite MCL No No 
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JPEG-XS ENC (TR-08) No No 

JPEG-XS DEC (TR-08) No No 

JPEG-XS ENC (TR-07) No No 

JPEG-XS DEC (TR-07) No No 

Dual Gateway No No 
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DTS Processing 

The SNP currently implements UpMix, DownMix, MultiMerge, and Loudness Control AAP functions, and 
offers the following processing options:  

Single Codes Combination Codecs 

DTS Neural Surround UpMix (on page 278) DTS Neural UpMix+Loudness (on page 282) 

DTS Neural Surround DownMix (on page 
279) 

DTS Neural DownMix+Loudness (on page 283) 

DTS Neural MultiMerge (on page 280) DTS Neural MultiMerge+Loudness (on page 
284) 

DTS Neural Loudness Control (on page 281)  

DTS license allocation is dynamic, using a flexible token system to allow users to change the type of 
processing without purchasing additional licenses. For more details, see DTS Credits (on page 289). 

DTS Neural audio products are manufactured under license from DTS Licensing Limited. DTS and the 
Symbol are registered trademarks & the DTS Logos are trademarks of DTS, Inc. 
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DTS Neural Surround UpMix 

The DTS Neural Surround UpMix renders any two channel audio source (stereo, matrix encoded stereo, 
LtRt, or DTS Neural Surround LwRw) as surround sound. The DTS Neural Surround UpMix can 
simultaneously position individual elements within the surround field, creating high levels of image 
stability and granularity. 

The UpMix technology avoids taking "artistic license" with content by placing audio exactly where it 
would be heard in a professional LEDE (Live End Dead End) listening environment. For example, mono or 
pan-pot stereo will image in front of the listener, whereas stereo containing depth information will 
surround the listener. 

You can use the DTS Neural Surround UpMix as a stand-alone unit to monitor stereo production, or you 
can use it in tandem with the DTS Neural Surround DownMix as a complete 5.1 transport solution. The 
following figure shows an UpMix taking a two-channel audio source (stereo, matrix encoded stereo, LtRt 
or DTS Neural Surround LwRw) and rendering a 5.1 multi-channel mix. 

 

To configure UpMix on your SNP, see AAP Tab: Parameters (UpMix) (on page 430). 
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DTS Neural Surround DownMix 

The DTS Neural Surround DownMix enables 5.1 surround sound to be transported through any stereo 
infrastructure. The DownMix process is based upon the principle that both natural stereo and 5.1 
content are two-dimensional; both contain width and depth spatial attributes. 

The DTS Neural Surround DownMix can represent six channels of discrete audio sources in a stereo 
downmix by transforming the sources into pure intensity and coherence encoding. By correcting 
overlaps of the signal sources in intensity, time, coherence, polarity, and phase before the six channel 
are combined, the DTS Neural Surround DownMix accounts for the problems suffered in traditional 
matrix encode systems—such as comb filtering, spatial location distortion, etc. 

The proprietary Neural Audio "watermark process" faithfully reproduces surround information when it is 
rendered by the DTS Neural Surround UpMix or any LtRt system. In brief, the DTS Neural Surround 
DownMix produces a stereo downmix that accurately represents the original content whether 
monitored in mono, stereo, matrix or DTS Neural 5.1 Surround Sound. 

The following figure shows a DownMix taking a multi-channel audio source. The DownMix creates two 
channel audio source using the Neural Audio approach of embedding a watermark signal within the 
stereo audio signal patch. The watermark signal contains spatial and steering positioning information. 
The resulting stereo audio signal is also known as LwRw. 

 

To configure DownMix on your SNP, see AAP Tab: Parameters (DownMix) (on page 431). 
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DTS Neural MultiMerge 

The DTS Neural Surround MultiMerge enables broadcasters to transition from stereo to 5.1 surround 
sound, providing viewers with a 24/7 surround sound experience. With MultiMerge inline, 5.1 original 
content is passed unaffected to the viewer while original stereo content is upmixed to a 5.1 surround 
sound image. This provides the viewer with a consistent surround experience. 

The transition between 5.1 and stereo occurs seamlessly without the need of operator intervention. By 
offering a 24/7 5.1 signal, AC3 metadata does not transition between 2/0 and 3/2 mode. This prevents 
audio clicks, pops, and dropouts. The process also avoids taking "artistic license" with content by placing 
audio exactly where it would be heard in a professional LEDE (Live End Dead End) listening environment. 
For example, mono or pan-pot stereo will image in front of the listener, whereas stereo containing 
depth information, or LtRt encoding, will surround the listener. 

You can use MultiMerge in combination with the DTS Neural Surround DownMix device to pass 5.1 
through stereo-only facilities and therefore eliminate the need for costly master control upgrades. 

The following figure shows how the MultiMerge takes a two-channel audio source (stereo, matrix 
encoded stereo, LtRt or DTS Neural Surround LwRw) and renders a 5.1 multi-channel mix; in 
combination with taking original multi-channel content and creating a stereo downmixed signal, 
depending on the input configuration and content source used. 

 

To configure MultiMerge on your SNP, see AAP Tab: Parameters (MultiMerge) (on page 432). 
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DTS Neural Loudness Control 

Neural Loudness Control options manage loudness levels within a specific desired volume range. 
Advanced psychoacoustic and signal processing techniques detect and regulate the perceived loudness, 
for example to maintain audio perceived loudness between programming and commercials. 

Neural Audio’s perceptual loudness measurement tool treats each audio channel (L, R, C, LFE, Ls, Rs, Lb, 
Rb) as a separate mono channel. The tool accounts for spectral and density differences and temporal 
overlaps in modeling how the human ear perceives the loudness of the audio content. DTS Neural 
loudness measurement accommodates both stereo and multi-channel audio equally well. 

After measurement, DTS Neural Loudness Control applies gain or attenuation to achieve the target 
loudness level (Dial Norm) while preserving the spectral balance of the original signal. It adapts the 
frequency response of the low and high frequencies to compensate for level differences within the 
original signal. You can use DTS Neural Loudness Control in the following roles: 

• Protection—only affecting content that falls aggressively outside the desired target 

• Management—tightly controlling loudness to guarantee intelligibility without the distracting side 
effects of traditional volume management solutions 

The following Loudness Control configurations are supported: 

Loudness 1.0 1 instance of mono loudness control 

Loudness 2.0 1 instance of stereo system loudness control 

Loudness 5.1 1 instance of surround system loudness control 

Loudness 7.1 1 instance of surround system loudness control (includes Lb and Rb 
channels) 

Loudness 2x1.0 2 separate instances of mono loudness control 

Loudness 8x1.0 8 separate instances of mono loudness control 

Loudness 4x2.0 4 separate instances of stereo system loudness control 

Loudness 5.1 + 2.0 2 separate instances of loudness control - one for the 5.1 system and the 
other for the 2.0 system. 

To configure Loudness Control on your SNP, see: 

• AAP Tab: Parameters (Loudness Control) (on page 435) 
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DTS Neural UpMix+Loudness 

This is a combination codec and combines UpMix and Loudness Control functions. See DTS Neural 
Surround UpMix (on page 278) and DTS Neural Loudness Control (on page 281). 

 

To configure UpMix+Loudness on your SNP, see AAP Tab: Parameters (UpMix+Loudness Control). 
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DTS Neural DownMix+Loudness 

This is a combination codec and combines DownMix and Loudness Control functions. See DTS Neural 
Surround DownMix (on page 279) and DTS Neural Loudness Control (on page 281). 

 

To configure DownMix+Loudness on your SNP, see AAP Tab: Parameters (DownMix+Loudness Control) 
(on page 441). 
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DTS Neural MultiMerge+Loudness 

This is a combination codec and combines MultiMerge and Loudness Control functions. See DTS Neural 
MultiMerge (on page 280) and DTS Neural Loudness Control (on page 281). 

 

To configure MultiMerge+Loudness on your SNP, see AAP Tab: Parameters (MultiMergeMix+Loudness 
Control) (on page 444). 
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Dolby E Processing 

The SNP currently supports Dolby E Encoding and Decoding.  

Each SNP can have a max of 4 Dolby E Encoders or max of 8 Dolby E Decoders using these licenses (SNP-
ASK-DEE and SNP-ASK-DED) See Orderable Part Numbers (on page 35). 

Dolby and the double-D symbol are trademarks of Dolby Laboratories. Copyright 1998–2008 Dolby 
Laboratories. All rights reserved. 

For Dolby E parameters, see: 

AAP Tab: Parameters (Dolby E Encoder)  
(on page 423) 

Dolby E Encoder Parameters 

AAP Tab: Parameters (Dolby E Decoder)  
(on page 429) 

Dolby E Decoder Parameters 

Video Tab: Video Control (on page 405) See Dolby E A/V Align parameter 

Audio Tab: General Configuration (on 
page 449) 

See Dolby E Header Alignment and Dolby E Line Position parameters 

 

 

Dolby E Encoding 

The SNP has two DSP cores, and each core can support up to two Dolby E Encoding sessions for most 
video formats, or up to four Dolby E Decoding sessions.  The SNP Dolby E encoder supports a selection 
of fixed metadata formats.  Dynamic (externally input) metadata is not currently supported. 

 

To configure Dolby E Encoding, see AAP Tab: Parameters (Dolby E Encoder)  (on page 423). 
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Dolby E Encoder Latency 

Encoder Latency 58ms + 1.25 Dolby Frame 

AV Aligned 

 

p50/p59 6 Video Frames 

 Others  3 Video Frames 
 

 

Dolby E Decoding 

Dolby E signals must be decoded for any audio processing tasks (such as voice-over or mixing) in any 
other audio elements. 

 

To configure Dolby E Decoding, see AAP Tab: Parameters (Dolby E Decoder)  (on page 429) 
 

Dolby E Decoder Latency 

Decoder Latency  58ms + 1 Dolby Frame 

 AV Aligned 

 

p50 5 Video Frames 

p59 6 Video Frames 

Others 3 Video Frames 
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AAP Licensing 
Note: You need the SNP-PSK-ADVAUD license to enable advanced audio processing, the SNP-ASK-
DTOKEN license for DTS token credits, and SNP-ASK-DEE/SNP-ASK-DED for Dolby E Encoding/Decoding. 
See Orderable Part Numbers (on page 35) for AAP license options.  

Follow these steps to set up AAP Licensing: 

1. Go to Configure > Licenses  

2. Ensure the SNP unit is enabled for Advanced Audio Processing  

 

3. Go to the Advanced Audio tab 
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4. Input the Advanced Audio license key by clicking Enter New License 

 

5. Once the license has been accepted, the Audio Licenses section below will display the DTS Audio 
and/or Dolby E Encoding/Decoding Credits. 

6. Go to the Major Features tab 

7. In the Feature List section, Advanced Audio Processing Feature should show as Enabled 

Once enabled, Advanced Audio can now be configured on specific processors. See: 

• Creating AAP Sessions (on page 290) 

• AAP Reporting 

• AAP Settings/Parameters (on page 292) 
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DTS Credits 

The number of credits determines how many DTS functions are available. The following table provides 
the number of credits required for each DTS function. 

Session Algorithm Latency Setting Latency (ms) % Utilization Credits 

UpMix 2.0 to 5.1/7.1 

 

Low Latency 80 24% 

 

 3 

 Standard Latency 101 

DownMix 5.1/7.1 to 2.0  53 13% 3 

MultiMerge (automatic 
UpMix/DownMix) 

Low Latency 80  32% 

 

 4 

 
Standard Latency 101 

Loudness + Upmix  Low Latency 128 30% 

 

 4 

 
 Standard Latency 149 

Loudness + Downmix  112 19% 4 

Loudness + MultiMerge Low Latency 128 52% 

 

 8 

  Standard Latency 149 

Loudness 1.0  112 12% 1 

Loudness 2.0  112 13% 1 

Loudness 5.1  112 21% 2 

Loudness 7.1  112 24% 3 

Loudness 2x1.0  112 17% 1 

Loudness 8x1.0  112 41% 3 

Loudness 4x2.0  112 31% 3 

Loudness 5.1+2.0  112 27% 3 

You can have a maximum of 32 credits. For example, a combination of UpMix and DownMix will require 
6 credits (3+3). Credits are flexible. Available credits can be used for different functions at different 
times.  
 

Dolby E Credits 

The number of credits determines how many Dolby E functions are available. The following table 
provides the number of credits required for each function. 

Algorithm Latency  % Utilization Credits 

Dolby E Encode 58ms + 1.25 Dolby 
frames 

40% 1 

Dolby E Decode 58ms + 1 Dolby frame 21% 1 
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Creating AAP Sessions 
Note: Ensure AAP is enabled and licensed (see AAP Licensing (on page 287)) before creating a session.   

To use Advanced Audio Processing (AAP) functions, create an AAP session. 

1. Go to Configure > AAP 

2. Go to the Floor Plan Tab. Under Sessions, add a new Processing Session 

Note: Each processor can have a maximum of 5 AAP sessions. 

 

3. In the New Session dialog displayed, do the following: 

a. Click Enable 

b. Select an Algorithm from the drop-down list, depending on the type of audio function to be 
performed. Options are: 

• UpMix 

• DownMix 

• MultiMerge 

• UM+Loudness 

• DM+Loudness 

• MM+Loudness 

• Loudness 1.0 

• Loudness 2.0 

• Loudness 5.1 

• Loudness 7.1 

• Loudness 2x1.0 

• Loudness 8x1.0 

• Loudness 4x2.0 

• Loudness 5.1 + 2.0 
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• Dolby E Encode 

• Dolby E Decode 

Note: The Loudness Control options follow the “Audio_System”  or “Num” x “Audio_System” 
format. 
 Where “Num” represents the instances created 
 And “Audio_System” is one of mono (1.0), stereo (2.0), or surround (5.1, 7.1). 
 
For example, selecting Loudness 4x2.0 implements 4 separate instances of stereo system loudness 
control. 
Selecting Loudness 5.1+2.0 implements 2 separate instances of loudness control - one for the 5.1 
system and the other for the 2.0 system. 

c. Select the DSP. In the current release, the DSP is auto-assigned. 

d. Select the Program 

e. Click Submit 

 
4. The selected AAP function is then displayed in the Configure Advanced Audio Processing dialog. 

Select it to enable it, and click Apply. 

Processing sessions can be enabled/disabled via this tab by using the enable check box and the 
Apply button.  

Note: If you intend to disable some sessions and enable others, first disable any sessions and apply 
the setting and then enable any sessions that fit within the 100% utilization limit of either "On Board 
DSP", i.e. "OB-1 DSP" or "OB-2 DSP". 
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AAP Settings/Parameters 

Once AAP has been enabled (see Creating AAP Sessions (on page 290)), an AAP tab is displayed on 
clicking a Program. See Program Configuration: AAP Tab (on page 420). 

Note: The AAP tab is hidden if there are no associated AAP sessions for a program. 

To configure AAP: 

1. In the program's AAP tab, choose the signal that feeds the AAP process by selecting the following: 

 

▪ The Processing Session 

▪ The Algorithm Input Channel 

▪ The Input Channel Select (where the input comes from) 

See AAP Tab: Input Routing and Gain (on page 421) 

2. Define the AAP settings. This section displays parameters for the selected algorithm (for example, 
DownMix). See Program Configuration: AAP Tab (on page 420). 

3. On the Output side, you can choose which channels are in the Program Audio Output.  

 

▪ Go to the Audio Tab > Output Channel Configuration and select the channels  
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MADI Support 
Note: MADI is supported on Sync, Remap, and Quad Conversion personalities. 
This is a licensed feature enabled by the SNP-PSK-MADIEXP (+128 Audio/MADI Feature) license. See 
Orderable Part Numbers (on page 35). 

SNP can be configured to send and receive MADI streams, to extract audio channels from the MADI 
streams and send them as 2110-30 streams, and also receive 2110-30 streams and output the audio as 
MADI. 

The SNP supports MADI audio via MADI SFPs listed in Video/Audio Expansion Interface Supported SFPs 
(on page 39). 

MADI support is via SFP per processor. Any given processor will accept either a MADI TX SFP or a MADI 
RX SFP in its assigned SFP slot. 48kHz MADI signals are supported. MADI signals are assumed to be PCM 
audio. 

MADI Inputs and Outputs 

• MADI audio inputs/outputs are in addition to, and independent of, the audio channels from/to the 
SDI interfaces. In other words, these are additional audio channels to be supported, not a 
replacement of other channels. 

• In addition to the 16 base mono audio channels, via a MADI-Rx SFP you can route up to 128 
extended mono channels (64/port x 2 ports). See Audio Expansion  (on page 303)and MADI 
Extended Channels (on page 302) 

• Similarly, 128 extended mono channels can be output via the MADI-Tx SFP. 
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• MADI channels from a given Processor can only be transmitted via IP on the same Processor. 
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MADI Licensing 
Note:  MADI is supported on Sync, Remap, and Quad Conversion personalities. 

The SNP-PSK-MADIEXP (+128 Audio/MADI Feature) license key enables dual (2) MADI processing which 
can be either both Tx or both Rx depending on the SFP installed. The license is per Baseband processor 
and SNP supports up to 4 licenses.  See License Management (on page 44) for instructions. SFPs to be 
ordered separately. 

The Licenses dialog allows for assignment of the license to the processors intended for MADI processing. 
By default, no processor assignments are made. 
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Receiving MADI (Inputs) 
Note: When an RX MADI SFP is inserted in the SFP slot for a processor, and configured (via the SFP 
Select option), that processor can receive MADI streams, extract audio channels from the MADI streams 
and send them as 2110-30. 

Once you configure an RX MADI SFP (by clicking the Edit button for a Processor, and then selecting the 
SFP via the SFP Select drop down in the Configuration tab), the Configure Processor dialog displays an 
Audio Expansion tab that provides details of the incoming (expanded) audio.  

 

Within a program, you cannot currently perform processing on these extended channels (like gain, 
delay, etc.) like you can on the base channels, but you can route these extended channels into IP or SDI. 
The SDI Audio Routing section in the Input tab lets you define audio processing. The Audio Processor 
Channel control lets you select the audio processor channel to route to, including the expansion channel 
routed to. 

Processing Audio 

Note: MADI is received via IP, so the Processor Section input mode should be set to IP. 

• The IP Audio Routing section in the Input tab lets you define audio processing. You can define the 
following: 

▪ Audio Processor Channel: The audio processor channel to route to (within the same processor, 
for example, APIN 1-1:1 to APIN 1-1:16). This includes the expansion channel routed to within 
the 16 channels. 
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▪ Source Stream: The audio stream receiver the channel comes from (1-6) 

▪ Source Channel: The Channel within the incoming audio stream (1-8) 

 

On the Output side, routing to IP audio channels is configured in the Output tab.   

• In the IP Audio Configuration section, select the Audio Stream 
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• In the Routing Control section, select the channels. You can include both base channels (APOUT 1-
16) and extended channels (MADI 1:128). 

 

IP streams generated from MADI channels, like other SNP audio streams, are available as IP sources, 
assuming appropriate licenses are available and assigned.  
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Transmitting MADI (Outputs) 
Note: When a TX MADI SFP is inserted in a SFP slot, the 128 channels in the two MADI output signals can 
be composed of any combination of the 16 main channels from each program section, and the 128 
extended channels.  Since there is no MADI input SFP, these extended channels can come from the IP 
receivers. 

In order to transmit MADI audio, a MADI transmitter (Tx MADI) appropriately configured in the 
Configure Processor dialog, is required. 

 

Once a MADI Transmitter (TX SFP) has been selected, the Configure Processor dialog displays an Audio 
Expansion tab.  

• Audio can be routed into MADI SFP channels (MADI TX Routing Controls). Select from: 

▪ MADI 1 : 0-63 

▪ MADI 2: 0-63 

 

• Pick the source in the MADI TX Source drop down. Options include: 
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▪ Any of the dembedded channels (DMB 1-1:1 to 1-2:16) 

▪ Any of the IP channels (APIN 1-1:1 to 2-4:16) 

▪ Any the extended channels (EXP 1-128) 

▪ Test tones (400 Hz, 1 kHz, 2 kHz, Mute) 
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MADI Parameters 

MADI features appear in parameter lists whether or not a MADI license is currently assigned to the 
processor. When a preset that includes MADI settings is applied to a processor that does not have a 
MADI license available, the default settings for that parameter are assigned instead.  

In the input routing dialogs, the terminology X1..X128 is used to refer to the 128 “extended” channels 
enabled in the synchronizer by the MADI license.  For MADI input, these are populated directly by the 
MADI input; however if no MADI input is configured, then the X1..X128 channels in the syncrhonizer can 
come from the existing audio IP receivers, through the input channel routing controls.  Likewise, the 
terminology X1..X128 is used in the output routing controls for both IP and MADI outputs, to refer to the 
128 extended channels in the synchronizer when composing output streams or output MADI signals. 

 

MADI Input (via MADI SFP)  

 

MADI Output (via MADI SFP)  

 

Without MADI SFPs 

MADI SFPs are defined on the Configure Processor dialog box. See Configure SFPs (on page 115) and 
Audio Expansion  (on page 303) for more information. 

if you don’t have a MADI input or output configured, but you have a MADI license applied, then you can 
use the 128 extended channels in the synchronizer for IP input and IP output.   
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MADI Extended Channels 

The Routing Control section (Output tab) lets you select: 

• Up to 16 Base Channels  

• Up to 128 Extended Channels (prefixed by EXP) 
 

If 2RX MADI is selected in  the SFP Select drop down, EXP1-EXP128 represents the MADI inputs from 
the SFP 

EXP1-X64 Port 1 MADI channels 1-64 

EXP65-X128 Port 2 MADI Channels 1-64 

If anything other than 2RX MADI is selected in the SFP Select dropdown, X1-X128 comes from the 
Expansion IP audio channels 

Channels Source Location 

EXP1-EXP16 IP audio streams Program 1 

EXP17-EXP32 IP audio streams Program 2 

EXP113-EXP128 IP audio streams Program 16 

 
Extended Channel Configuration 

Channels EXP1-EXP16 are configured by the Audio Processor Channel, Expansion Source Stream, and 
Expansion Source Channel controls on Program 1, where: 

 

• Audio Processor Channel controls which of the APIN1-1 :1 -16 is being configured (In additional to 
the IP channel used by the program for the specified channel) 

• Expansion Source Stream controls which IP stream to use for the selected expansion “Audio 
Processor Channel” 

• Expansion Source Channel controls which channel within the IP stream to use for the selected 
expansion “Audio Processor Channel” 

Note: The same applies to Program 2, 3, etc., except for each subsequent program, Audio Processor 
Channel 1-16 represents EXP17-EXP32, EXP33-EXP48 etc.up to EXP113-EXP128.  
 
Expansion Source Stream and Expansion Source Channel parameters only matter in case of Expansion 
IP Audio Channels and have no effect if 2RX MADI is selected in the SFP Select drop down. 
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Audio Expansion  
Note: Starting SNP 1.7, MADI is only supported on Sync and Remap personalities. 

The following MADI settings apply to all programs in both Sections on the Processor. After SFPs have 
been defined within the Processor's Configuration settings, an Audio Expansion tab is displayed on the 
same dialog box. Depending on whether the SFP is RX MADI or TX MADI, the tab will appear differently.  

 
 

RX MADI Parameters 

When you select an RX MADI SFP, the Audio Expansion tab has a MADI Rx Status Parameters menu. 
From this menu, choose index 1 or 2 to view status indicators for that index.  
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Status parameters include the following:  

• Sample Rate (should be 48kHz)  

• Number of Channels (56 or 64)  

• C-Bit Detection for each channel 

• V-Bit Detection for each channel 

• Channel Format for each channel  

Input receivers X1 - X128 are only operational when the receiver is not selected. In all other cases, extra 
IP receivers are available.  
 

Audio SRC Config/Status 

Audio Pair Each audio pair is configured independently. Choose the audio pair, from 1 
- 64, for which the rest of the parameters in this group will apply.  

Input Pair SRC Control These controls configure the operation mode of the selected sample rate 
converter. Options are Engage, Auto, and Bypass.  

When an SRC Control parameter is set to Auto, the Audio Channel Status 
bits determine whether the audio data is PCM or non-PCM, and whether 
the audio data is passed through the Audio Sample Rate Converters (SRC). 
The Engage option always forces the audio data through the audio SRC, 
and Bypass always forces the audio data around the audio SRC.  

SRC Pair Engage Status  Feedback parameter that indicates the SRC status for this pair as Yes or 
No. 

 

 



Selenio™ Network Processor 

User Guide  Configuring Processors 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 305 

 

TX MADI Parameters 

When you select a TX MADI SFP, the Audio Expansion tab has  the following options:  

 

• From the MADI TX Audio Routing Controls menu, choose the destination you want to modify. 
Options are 1 - 128. Indexes 1 - 64 go to MADI Tx port 1, and Indexes 65 - 128 go to MADI Tx port 2 

• From Channel Select choose the source for that destination. If you are operating with 56 channels of 
output, channels 57 to 64 are not routed. The list also includes test tones at 400 Hz, 1 kHz, 2 kHz, 
and 4 kHz.  

• MADI Transmitter Control: Choose 1 or 2, and then for that index, select the Number of  Channels 
(56 or 64).  
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Subtitles on the SNP 
Subtitles are supported on Conversion (Dual and Quad) as well as Sync and Multiviewer Personalities.  

For details on configuring subtitles for a Multiviewer personality, see the Layout Designer 
documentation. 

The SNP accepts and auto-detects subtitle input as either OP-47 or SMPTE ST-2031. It also supports 
outputting subtitles as OP-47 or SMPTE ST-2031. A combination of the two - for example, OP-47 input 
and ST-2031 output - is also supported. 

See: 

• Receiving Subtitles (on page 306) 

• Outputting Subtitles (on page 307) 
 

Receiving Subtitles 

If your input stream contains subtitle information (OP47 or SMPTE ST-2031), the Program's Input tab 
will display the following: 

• Input Tab > Program's Ancillary Data Status will indicate subtitle presence under one of the 
following: 

▪ ANC CC/TT Present 

▪ ANC SMPTE 2031 Present 
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Outputting Subtitles 
1. Go to the Program's Output tab 

2. In the Program's Ancillary Data Configuration section, select either CC/TT Enable or SMPTE 2031 
Enable, as applicable 

 

3. Select the SMPTE 2031 Line Number 

Note: On the conversion and quad conversion personality, the program's ancillary data 
configuration has a line number for the user to  select the line to embed the metadata on.  
- For output standard 1080p or 2160p, the full range of lines 9 to 41 applies 
- For output standard 1080i, metadata can be embedded on lines 9 to 20 
- For output standard 720p, metadata can be embedded on lines 9 to 25 

With the quad conversion personality: 
- Output standard 525i/59.94 supports CC on line 21 and AFD metadata can be embedded on lines 9 
to 19 
- Output standard 626i/50 supports TT/AFD embedded on lines 9 to 22. WSS can be embedded on 
lines 9 to 23. 

4. In the IP Ancillary Data Stream Configuration > Ancillary Data IP Filter section, do the following: 

a. Set Filter Rule to Include 
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b. In the Service Select dropdown, select the either Teletext (OP-47) or SMPTE ST 2031 

 

c. In the Line Select drop-down, select Specific Line and enter the line on which subtitles are 
expected to come in on 

 

5. Click Apply 
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Support for SD over 2110 
The SNP now supports SD (480i and 576i) over ST-2110, in addition to ST-2022-6 that was previously 
supported. This support is only available on the Sync, Quad Conversion, and Multiviewer (HD) (Input 
only) personalities, and is enabled by setting the Transmitter Mode or Receiver Mode to ST-2110-20.  

Since SD signals can carry non Ancillary ST-291M data (digitized analog waveform), the Picture Height 
parameter allows non ANC data and ANC data in the Active Picture region or Vertical Blanking region to 
be encapsulated in an ST-2110-20 stream (following the RP-2110-24).  Note that digitized analog 
waveform data cannot be encapsulated in ST-2110-40 streams. 

In addition, some modifications need to be made to the picture size to accommodate and correctly 
process any ancillary data such as closed captions. The following sections highlight settings that need to 
be made on the Transmitter and Receiver side. 

ST-2110 support - IP Transmitter Configuration 

• Transmitter Mode: In the Output tab > IP Video Configuration, set the Transmitter Mode to 
ST2110-20. 

 

• Extended Video Size: On the transmitter side, the SD Extended Video Size parameter in the Output 
tab lets you adjust the height of the image. This backs up the beginning of the image to include 
vertical blanking. This parameter only applies to SD formats. Range is 0-16 lines.  

▪ The default of 0 encapsulates the active image and non Ancillary ST-291 (digitized analog 
waveform data) placed in the active picture region 

▪ To include ancillary data, enter the number of lines, for example, entering 10 extends the height 
of the image by 10 lines per Field or 20 lines in total. In this case, the active picture plus the 
content from the vertical blanking will be encapsulated into the 2110-20 packet. 

▪ Closed Captions: If you leave the default height as 0, note that it does not include closed 
captions (on line 21 by default). Extend the video to include closed captions info in the active 
picture, and higher if you want to include any data in the vertical blanking region. 
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Note: If you're using Magellan Control System, based on your IP Transmitter configuration, SEAM 
info will indicate the actual image height (in the IPVR Stream properties). 

 

Important: When setting the “SD Extended Window Size” parameter to values greater than zero to 
include one or more lines from the VBI, please consider ancillary services present in those lines that will 
be received over the ST 2110-20 stream and make sure they do not conflict with any of the ancillary 
services received over ST 2110-40 streams. All the ancillary packets from the ST 2110-40 streams will be 
embedded into the baseband signal extracted from the ST 2110-20 stream into the target line, which 
could result in either  
a) overwriting an existing VBI service embedded as a waveform, or  
b) duplicating an existing ancillary packet. 

The Picture Height status parameter indicates the height of the image being transmitted.  This value 
can be set on IP receivers to correctly configure the receiver to de-encapsulate the image correctly. 
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ST-2110 Support- IP Receiver Configuration 

• Receiver Mode: In the Input tab > IP Video Configuration, set the Receiver Mode to ST2110-20. 

 

• SD Height: In order to receive the modified image, the IP Receiver needs the actual height of the 
picture. The following parameter in the Input tab lets you modify the picture height. 

Note: This parameter is only displayed if the input is SD, and the default displayed depends on the 
detected resolution (525 or 625). 

 

Parameter Range 

SD Height For 525, the range is 480 to 512 (default is 480) 

For 625, the range is 576 to 608 (default is 576) 

Enter the SD Height on the Receiver based on what you have on the Transmitter side. The Receiver 
will pick up the active picture information and de-encapsulate all the vertical blanking information 
from the lines leading up to the first active picture. 

• The Picture Height status parameter in the Output tab > IP Video Status section displays the result 
of any changes made to the SD Height parameter. If no changes are made, the default is displayed. 
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Color Processing for SD 

In case of SD signals, the Video tab > Color Adjustment section displays two parameters: 

Parameter Range 

525 First AP Line 20-23 (default is 22) 

626 First AP Line 23-26 (default is 24) 

These parameters specify the first line in SD to which color processing controls should be applied. The 
first few lines of the active picture may carry closed captioning, WSS, etc. so to avoid any processing of 
such data (and possible corruption), the first line to be processed can be modified. 

Other Parameters 

When the input is in SD format, certain additional parameters are displayed and some are replaced, and 
these are noted in the parameters section. See Input Tab (SDI): Video Status (on page 400). 
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Support for 8K Workflows 
Also see Support for 8K Clean Switching using IP (on page 315). 

SNP Personalities that support 8K Workflows 

Handling of 8K is supported in the following personalities: 

Personality Input/Output Support 

Sync SDI Input and SDI Output (UHD mode only) 

Remap SDI Input and SDI Output 

Dual Conversion SDI Input and SDI Output 

Multiviewer SDI Input only 

Multiviewer Portrait Mode SDI Input only 

 
The SNP recognizes and accepts 8K (ST 2082-12) SDI input as 12G SDI. In order to support such streams 
on the output side, the SNP allows to mark a 12G UHD output signal as one of four links of an 8K stream 
by inserting the proper 8K Video Payload Identifier (VPID). On the input side, the incoming signal is 
identified as valid UHD (single link 12G input) based on the VPID detected, and the 8K link is treated 
identically to a 12G. 

The 8K stream can be thought of as a quad of 12G streams. Since the four 12G links of an 8K stream 
have a similar marking in VPID, the user has the option to select or flag the output SDI as a link of 8K. 
Essentially, on the output side, the user can choose to output as a normal 12G over UHD or an 8K link. 
For 8K, the user must tag the output with a link ID, basically telling the output that this is one part of an 
8K quad. The VPID embedded in the SDI output will contain Byte1 = D2 (8K stream) and Byte4 = link 
number, per the ST 2082-12 standard. 

To configure handling of 8K workflows, once the rest of your workflow is defined, ensure your Output is 
tagged correctly with the appropriate link ID as follows: 

1. Go to the Output tab 

2. In the SDI section, set SDI UHD Output Link select to the desired option. Select the appropriate 12G 
link (Link 1 to 4) in case of 8K signals. The options include: 

▪ UHD (Quad Link): Normal UHD over four 3G signals 

▪ UHD (Single Link): Normal UHD on a single 12G link 

▪ UHD2 (12G Link 1): Option for signaling the first link of an 8K quad  

▪ UHD2 (12G Link 2): Option for signaling the second link of an 8K quad  

▪ UHD2 (12G Link 3): Option for signaling the third link of an 8K quad 

▪ UHD2 (12G Link 4): Option for signaling the fourth link of an 8K quad 
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3. Repeat for the other 3 Links so that you have Link 1-4 properly tagged. 

4. To validate your output, go to the SNP Processor that this output currently feeds and do the 
following: 

▪ Go to the Input tab and validate that Video is present, that the Video Input Standard is correct 
(should be 2160p/59.94), and that video is not frozen 

▪ In the Input tab, see the VPID parameter status. It should identify an 8K with the proper link 
signaled in byte 4. 

 

Color Processing for 8K 

When working with UHD-2 (8K) signals, users are cautioned that the color processing and conversion 
controls are implemented separately on each link.  This can cause visual artifacts at the seams of the 
quadrants (in SQD) or other peculiar visual effects (in 2SI).   In order to ensure that the color processor is 
fully disabled and the pixels are being organized and transmitted without any alteration, users can 
bypass the color processor using the control below. 
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Support for 8K Clean Switching using IP 
Note: 8K clean switching is supported in the Sync and JPEG-XS Encoder Personalities. 

In this Section 

Step 1 - Pre-Requisites for 8K Clean Switching ...................................... 315 
Step 2: Enabling 8K Mode (IP Receiver) ................................................. 316 
Step 3: Setting up the SDI Output Payload ID ........................................ 317 
Step 4: Switching IP Sources .................................................................. 317 

 
 

Step 1 - Pre-Requisites for 8K Clean Switching 

Ensure the following conditions are met before setting up the SNP for 8K switching: 

• All sections must be configured as UHD 

• All processors must be configured for the same personality (currently, Sync or JPEG-XS Encoder 
personalities are supported) 

• All input modes must be set to IP (for the 4 UHD sections defined by the Enable 8K Mode 
parameter) 

• Force MAB Mode must not be enabled on any of the processors  

The Switch 8K Status parameter (Configure > Element > IP Control) reports whether the system is 
properly configured for 8K switching. If any of the above conditions are not satisfied, the Switch 8K 
status parameter reports Disabled and will not attempt to switch the quad UHD sections 
simultaneously. The following are possible status messages that the Switch 8K Status parameter 
reports: 

Disabled   Feature not enabled 

Config Error  Pre-conditions were not met - four processors in same mode, UHD 
input from IP on one section but not the other, etc. 

Ready  Conditions are met, four receivers are available for next switch 

Switching  In progress 

Switch Done Cutover occurred, waiting for leave delay and/or actual stream 
going away on the old streams 

Switch Partial Four switching commands were not received before the IGMP join 
delay of the first command - a partial switch was performed. 
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Step 2: Enabling 8K Mode (IP Receiver) 

The Enable 8K mode parameter allows for definition of the sections to be used for 8K clean switching 
using IP Rx. To do this: 

1. Go to Configure > Element > IP Control > Rx Setup 

2. Set the Enable 8K Mode parameter to one of the following: 

▪ Processor A/B Section 1/2: Only the first 2 processors will be used for input/output of the 8K 
signal 

▪ Processor A/B/C/D Section 1: Only the first section in each processor will be used for 
input/output of the 8K signal 

▪ Disabled: Disables ganging of the sources for the switch 

When 8K mode is enabled (set to something other than disabled), the other sections not used for 
input/output of the 8K signal are blocked from being enabled. They will be used to perform the clean 
switch.  
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Step 3: Setting up the SDI Output Payload ID 

After deciding on the sections to be used for 8K switching (using the Enable 8K mode parameter), set up 
the payload ID output for SDI on the selected sections.  See Support for 8K Workflows (on page 313) for 
details.  
 

Step 4: Switching IP Sources 

The SNP attempts to time-coordinate the switching of the four UHD signals so that they switch at the 
same frame boundary. In order for this coordination feature to work, the following conditions must be 
fulfilled: 

• The SNP must be configured in a specific way (as defined by the Enable 8K Mode parameter) 

• The four switching requests must come within a reasonable time proximity – ideally within 100ms of 
each other.  

The special configuration is required in order to ensure that four "spare" UHD receivers are available to 
receive the four new signals before switching to them.  

For example, if the Enable 8K Mode parameter was set to Processor A/B Section 1/2, the SNP should be 
configured as follows:  

Processor A  SYNC, UHD Mode, both sections IP input, SDI/IP output 

Processor B   SYNC, UHD Mode, both sections IP input, SDI/IP output 

Processor C SYNC, no IP inputs, SDI-to-IP operation OK 

Processor D  SYNC, no IP inputs, SDI-to-IP operation OK 
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Support for Daktronics Scoreboards 
SNP offers support for Daktronics scoreboards. SNP communicates with external devices via IP, so an 
eBox (Quad Serial/Ethernet/GPI Interface) is used as an intermediate device (to map to serial data from 
Daktronics to TCP).  For more details on eBox, contact Imagine Communications Customer Support. 

The following are high-level steps in configuring the SNP for communication with Daktronics 
scoreboards: 

STEP 1 Configure the eBox with 9600 baud rate 
and no parity. 

 

STEP 2 Add the Daktronics device as an external 
device to the SNP, and select the sport to 
configure. 

See Adding Daktronics Devices to the SNP (on 
page 318). 

STEP 3 Configure a SNP processor as Multiviewer 
and assign the Daktronics device to it. 

 See Assigning the Daktronics Device to a 
Multiviewer Processor (on page 320). 

STEP 4 Create a layout for the Daktronics device. See Creating a Layout for the Daktronics Device 
(on page 321). 

Notes: 

• Each Multiviewer Processor on the SNP supports a single Daktronics device. 

• Labels are used in Layout Designer to configure the data feed. 

• Info Panel indicators are not currently supported. 
 

Adding Daktronics Devices to the SNP 
1. Click Configure Element 

2. Go to the SNP Management tab  

3. In the External Devices section, scroll down to Daktronics Devices 

4. Click + to add a new Daktronics device 
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5. Enter a Name for the device 

6. Select the Sport 

 

Note that in this release, only Football, Hockey, and BasketBall are functional options, even though 
a more extensive list is displayed. 

7. Enter the IP Address - enter the eBox's IP Address in this case, since SNP uses eBox as an 
intermediate device to communication with Daktronics. 

8. Enter the Port - enter the eBox Port 

9. Click Submit 

10. The device is then displayed in the Daktronics Devices section, from where it can be edited or 
deleted by clicking the Edit or Delete button under Actions. 
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Assigning the Daktronics Device to a Multiviewer Processor 
1. Go to a processor that has been set to Multiviewer (Base), or if this has not yet been done, set a 

Processor to the Multiviewer personality 

2. Click Edit on the processor 

3. In the Configuration tab, under External Devices, select the Daktronics device  

 

4. Click Apply Config 
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Creating a Layout for the Daktronics Device 
Note: Layouts are created in the Layout Designer application.  Daktronics Sports are supported using 
labels in Layout Designer. 

1. Run the Layout Designer 

2. Open your layout or create one if a layout does not exist 

3. Insert a label into your layout (Insert > Label) 

4. Select the label, and go to the Labels tab 

5. Select the Score Board field. There are three options to set here: 

 

a. In the first dropdown, select the Sport. Select from Football, Hockey, and BasketBall. 

 

Note that in this release, only Football, Hockey, and BasketBall are functional options, even though 
a more extensive list is displayed. 

b. In the second dropdown, select the Label Text. Commonly used display text is available for 
selection, and you can also define your own. See Sport Labels (on page 324) for a list of available 
text per sport. 
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c. In the third dropdown, select whether to display just the value or the prefix+value on a label 

 

For example, in the layout below, the blue boxes indicate prefix+value and the black boxes are 
value only. 

 

6. Set the background and active colors on labels as desired.  

If you change the active color, ensure it is legible on the background color. 

 

Note that the active color is used to indicate specific things, based on the sport: 

▪ Football: Active color indicates guest/home possession 

▪ Basketball: Active color indicates game status 

▪ Hockey: Active color indicates game status 

7. Save and publish your layout 

8. View the output to validate settings and to ensure everything works correctly. 

Note: If there's any issues with data coming in, labels will display "COM ERROR". 
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Layout Examples 

 

Football Layout Example 

 

Basketball Layout Example 
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Sport Labels 

The following is a list of labels available for different sports: 

Labels for Football 

Label Description 

Game Time Game Clock Time 

Home Name Home Team Name 

Guest Name Guest Team Name 

Home Score Home Team Score 

Guest Score Guest Team Score 

Quarter Quarter 

Ball On Ball On 

Down Down 

To Go To Go 

Home Possession Home Possession Indicator 

Guest Possession Guest Possession Indicator 

Play Time Play Clock Time 

Home Time Outs Home Time Outs Left 

Guest Time Outs Guest Time Outs Left 

 

Labels for Basketball 

Label Description 

Game Time Game Clock Time 

Game Status Game Clock Status 

Shot Time Shot Clock Time 

Home Score Home Team Score 

Guest Score Guest Team Score 

Home Fouls Home Team Fouls 

Guest Fouls Guest Team Fouls 

Home T.O. Full Home Time-Outs Left -Full 

Home T.O. Partial Home Time-Outs Left -Partial 

Home Time Outs Home Time-Outs Left -Total 

Guest T.O. Full Guest Time-Outs Left - Full 

Guest T.O. Partial Guest Time-Outs Left - Partial 

Guest Time Outs Guest Time-Outs Left - Total 
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Period Period 

Time Out Time-Out Time 

 

Labels for Hockey 

Label Description 

Game Time Game Clock Time 

Game Status Game Clock Status 

Home Score Home Team Score 

Guest Score Guest Team Score 

Home Time Outs Home Time Outs Left 

Guest Time  Outs Guest Time Outs Left 

Home S.O.G. Home Shots On Goal 

Guest S.O.G. Guest Shots On Goal 

Period Period 

H. Penalty #1 Player Home Penalty #1 - Player Number 

H. Penalty #1 Time Home Penalty #1 - Player Time 

H. Penalty #2 Player Home Penalty # 2 - Player Number 

H. Penalty #2 Time Home Penalty #2 - Player Time 

G. Penalty #1 Player Guest Penalty #1 - Player Number 

G.Penalty #1 Time Guest Penalty #1 - Player Time 

G. Penalty #2 Player Guest Penalty #2 - Player Number 

G. Penalty #2 Time Guest Penalty #2 - Player Time 
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Support for VPID information into the ST2110-
40 ancillary stream output 
SNP now supports VPID insertion into 2110-40 output streams, and provides users with additional 
controls over how VPID information from incoming signals is used. 

Note:  Transmission of VPID within 2110-40 remains a topic of study and discussion, and as a matter of 
general design, Imagine recommends that systems should NOT depend on the VPID information in the 
2110-40 stream.  However, in order to be compatible with certain industry equipment which unwisely 
depends on the VPID of 2110-40 we have added this feature on the <ProductName's> output. 

The design intent of the ST2110 standards is that the information of the SDP is prevalent and correct. 

Since ST2110-20 streams are video only, ANC information, if any, is in one or more ST2110-40 streams. 
As an informative guide, any VPID received in ST2110-40 streams (program input) is detected and 
displayed on the SNP Program's Input tab under Video Status. See Configuring VPID (on page 327). 

VPID is governed by the SDI standard, and encoding of VPID bytes differs based on the SDI standard. In 
SDI systems, the received VPID is used to determine the Video standard, colorimetry, TCS, and 
sometimes structural information about the incoming video. 

In ST2022-6 systems, the VPID from within the ST2022-6 stream remains vital and is used in a manner 
similar to the SDI VPID.    

However, in ST2110 systems, the relevant technical metadata about image structure and interpretation 
(colorimetry, TCS, frame rate, width, height, etc) are contained in the Session Description Protocol (SDP) 
object relayed through the control system. Some ST2110 systems mistakenly rely on the VPID from a 
related 2110-40 stream to carry TCS and/or colorimetry information.  In order to accommodate these 
systems, SNP provides a mechanism to use the VPID information from a 2110-40 stream to override 
information from the SDP.   

The table below summarizes the default behavior of SNP and how the related control can alter that 
behavior with respect to the VPID -vs- other controls and how they affect overall input signal 
determination. 

Input Type VPID Handling 

SDI  If VPID is present, SNP extracts the VPID from the SDI. If there is no VPID, 
assumptions are made based on the clock rate and structure of the SDI.  

ST2022-6  VPID (if available) is extracted from the encapsulated SDI. If there is no VPID, 
assumptions are made, similar to SDI.  

The Payload Information Source Dominance control can be used to cause 
information from the control system to override the VPID contents  

ST2110  Does not contain VPID information in the ST2110-20 stream, however a VPID 
may be present in the ST2110-40 input stream.  SNP provides a mechanism 
(not default operation) to use this VPID to override information provided 
through the control system via SDP. 
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Configuring VPID 

In the Input tab, the Payload Identification Source Dominance parameter (IP Video Configuration 
section) allows for determining priority for determining Colorimetry and TCS. Select from: 

• Auto 

• SDP 

• VPID 

 

The following table describes how VPID dominance is determined: 

Rx Mode Auto SDP VPID 

SDI 1. VPID 
2. Internal Algorithm 

1. VPID 
2. Internal Algorithm 

1. VPID 
2. Internal Algorithm 

ST2022-6 1. VPID 
2. SDP 
3. Internal Algorithm 

1. SDP 
2. VPID 
3. Internal Algorithm 

1. VPID 
2. SDP 
3. Internal Algorithm 

ST2110-20/40 1. SDP 
2. VPID 
3. Internal Algorithm 

1. SDP 
2. VPID 
3. Internal Algorithm 

1. VPID 
2. SDP 
3. Internal Algorithm 

The VANC filter settings for 2110-40 ancillary data streams have been updated to include the ability to 
select Payload Identification in the filter configurations. See Ancillary Data IP Filter (Remap and Sync 
modes) (on page 462) and Ancillary Data IP Filter (Conversion Mode) (on page 463). 
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VPID Status 

The VPID received from the ANC data status is displayed in the Input tab > IP Video Status section > 
Video Input Payload ID parameter.  
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Source ID Processing 
The SNP recognizes and processes ancillary packets in video signals, carried as a VANC packet in SDI. On 
the input side, if the input video contains a special identifier field (Source ID) in the ancillary packet, it is 
recognized and reported. On the output side, each SNP Program can be configured to process 
(pass/insert/override) the Source ID.  
 

Personality Support 

This functionality works as follows on various personalities: 

SYNC, REMAP, MCL, JPEG-XS, 
Conversion 

Source ID is detected on the input, and passed from input to output. 
See Enabling Source ID in the Program Output (on page 329). 

MultiViewer/MultiViewer Portrait Source ID is captured and displayed on-PiP. For more details, see the 
Layout Designer User Manual. 

 

Enabling Source ID in the Program Output 

When enabled, the Source ID, if present in the incoming video is processed, and embedded into the SDI 
and/or 2022-6 output. 

To enable Source ID processing: 

1. Go the Program's Output tab 

2. In the Ancillary Data Configuration section, set the following: 

 

a. Check the Source ID Enable checkbox. This enables processing/passing of the source ID from 
input to output OR inserting it if absent. 

b. In the Source ID Line Number, set the line on which the Source ID should be carried. The range 
depends on the Output standard, for example, in case of 1080p, the range is 9 to 41 and the 
default is 15. 

Note: The Line number setting will be effective only if there is no input source ID packet already 
coming in on a specific line. 
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c. Select the Source ID Embedding Mode. Options include: 

 

• Pass only: If present, the Source ID is passed through to the output. This is the default 
setting. 

• Pass or add User SID: If present, Source ID is passed through to the output. If not present, 
the string in the Source ID Data field will be used. 

• Force User SID: Source ID even if present, will be be overridden in the output by the string 
set in the Source ID Data field. 

 

Note that the Force User SID setting replaces the contents of identifier text in the packet, and 
not the line number. The Line number set in the Source ID Line Number setting will be effective 
only if there is no input source ID packet coming in. 

d. Source ID Data: The string entered here overrides any identifier text present in the packet OR 
inserts it if there no incoming Source ID. 

 

Source ID Status 

Any incoming Source ID is reported in a Program's Input tab, in the Program Ancillary Data Status 
section. 
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If the Source ID is not found, the Source ID field reports Not Present. 
 

Overriding Source ID 
Note: These instructions force the Source ID to a user inputted string, and Source ID present in the input 
(if any) will be replaced. The Source ID can be overridden on any personality other than on TR-07 and 
Multiviewer/Multiviewer Portrait. 

1. Go to the Program's Output tab 

2. In the Ancillary Data Configuration section, enable Source ID Enable 

3. Set the Source ID Embedding Mode to Force User ID 

4. In the Source ID data field, enter the string to be used 
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Using Magellan Control System with SNP 
SNP requires Magellan Control System version 3.0 or higher.  

Configure the SNP independently via the SNP Manager UI. Specific SNP settings that the  Magellan 
Control System requires are covered here. 

Note:  Magellan Control System only supports multicast routing.  

For the purposes of the  Magellan Control System, an SNP transmitter channel is a source, because it is 
receiving SDI and its output is IP. An SNP receiver channel is a destination, because it is receiving IP and 
its output is SDI.  

 Magellan Control System 2.6 and up support reading and setting source addresses for SNP. This 
functionality is useful when using Source Specific Multicast as the method of routing multicast signals; 
for example, if you have SNP in your  Magellan Control System, you can now route their signals via  
Magellan Control System in an SSM environment.  

As of  Magellan Control System 2.5, the source address is read from the transmitting device and 
written/populated onto the receiving device channel that corresponds with the multicast group being 
requested. When a Take operation is performed, the Primary Mcast Src 2 address is set to the 
transmitter’s secondary stream source address and the Secondary Mcast Src 2 address is set to 0.0.0.0 .  

Also see Selenio™ Network Processor Devices (on page 333) 
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Selenio™ Network Processor Devices 
The SNP integrates with the Selenio Network Processor (SNP), and can process inputs from the SNP 
(sources in the SNP ) as well as push outputs to it (destinations in the SNP ).  

If you have Selenio™ Network Processor (SNP) Devices in your SDNO: 

1. Configure the Selenio™ Network Processor independently, following the instructions in the Selenio™ 
Network Processor documentation 

2. Define a Logical Template that has the required signals (Video/Audio/Data) or use an existing one. 
See Creating a Logical Template for your SNP Sources/Destinations (on page 334) 

3. Add the Selenio™ Network Processor as an Endpoint Device. See Adding a Selenio Network 
Processor Device (on page 336) 

4. Set up your Sources/Destinations. See Sources and Destinations for SNP 

Also see: 

• SDNO Routing Database Editor Configuration Summary (on page 341) 

• Configuring for Switching (on page 342) 

• Configuring Magellan Control System for Multiviewer Mode (on page 343) 

• Configuration Examples (on page 344) 
 

Special Note for SNP 

Transmitters in SNP correspond to Sources in the SNP, and Receivers in the SNP correspond to 
Destinations in the SNP.  
 
The SNP setup must be as follows in order to be correctly recognized by the SNP: 

• For Sources: Input Mode should be set to SDI (which defines the section as a transmitter) 

▪ For Video: Ensure that Video IP Transmitter Enable (in the Output tab) is enabled 

▪ For Audio: Ensure that Audio IP Transmitter Enable (in the Output tab) is enabled 

▪ For Data: Ensure that ANC Data IP Transmitter Enable (in the Output tab) is enabled 
 

• For Destinations: Input Mode should be set to IP (which defines the section as a receiver) 

▪ For Video: Ensure that Video IP Receiver Enable (in the Input tab) is enabled 

▪ For Audio: Ensure that Audio IP Receiver Enable (in the Input tab) is enabled 

▪ For Data: Ensure that ANC Data IP Receiver Enable (in the Input tab) is enabled 

Note: To avoid multicast stream over-subscription, when defining your logical templates, configure your 
UHD stream sources and destinations on a different level from your HD/3G sources and destinations. 
This will prevent SNP from routing UHD IP steams to a HD receiver channel (or vice versa), which could 
cause network over-subscription problems. 
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Creating a Logical Template for your SNP Sources/Destinations 
1. Go to the Logical Templates Editor (Database Foundry > Logical Templates Editor). 

2. Click the New button to create a logical template in the Logical Templates pane. 

 

3. Go to the Add Signal Template on the right of the Editor and do the following: 

a. Select the number of (signal) instances to add 

b. Select if this is a DA signal 

c. Select the Signal Type (HD Video, HD Embedded, etc.) 

d. Select the number of Audio Channels (if applicable) 

e. Select whether to break away audio or do a mono breakaway (if applicable) 

f. Select the level to start at 

g. Click the Add to Selected Logical Template button 

4. Repeat to add any additional signals to the logical template 

Note: To avoid multicast stream over-subscription, configure your UHD stream sources and 
destinations on a different level from your HD/3G sources and destinations. This will prevent SNP 
from routing UHD IP steams to a HD receiver channel (or vice versa).  

When a transmitter changes between HD and UHD video (e.g. SNP), you should also change the IP 
address. To simplify the process, consider configuring a preset to perform the switch, instead of 
changing multiple parameters manually at the same time.  

5. In the middle (Logical Template Details) pane, make any required changes: 

a. You can change the Route Type for a signal - from Assigned to Disconnected or Unassigned  
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b. You can change Levels as required 

 

c. You can link signals (see Linking Signal Templates) 

6. Click Save when done 
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Adding a Selenio Network Processor Device 
1. Go to System Configuration > Device Foundry > Endpoint Device 

 

2. Click the Add Device button 

3. In the Add Endpoint Device dialog, enter the following: 

▪ Name: Enter a label for the device 

▪ Vendor: Select Imagine Communications 

▪ Type: Select SNP 

 

▪ IP Address: Enter the IP Address 

▪ Redundancy IP: Enter a redundant IP Address (if applicable) 
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▪ To Range: For IP Address and Redundancy IP, optionally specify a To Range - if adding devices 
with sequential IP addresses, can bulk add a range of addresses in one go by entering the last 
octet in the To Range field.  

 

▪ Username (optional): Enter the username 

▪ Password (optional): Enter the password 

Note: Providing user credentials to access the SNP device is optional, but it is required if you 
intend to use the System Snapshot utility to capture or restore system configuration (that 
includes the SNP device). Provide an Administrator/Operator credential here to ensure full SNP 
device configuration can be saved and restored. Snapshot capture or restore for the SNP device 
will fail if the user credential is not provided. See Capturing Selenio Network Processor Devices. 

4. Click OK to add the device 

 

Sources and Destinations from SNP Devices 

Once your Selenio Network Processor device has been independently configured and set up as an 
endpoint device, source/destination definition is done via the Database Foundry. 

Note: You need one or more logical template definitions before using the Database Foundry to add 
sources/destinations. 

See Adding Sources and Destinations for the SNP (on page 338) 
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Adding Sources and Destinations for the SNP 
ADD SOURCES/DESTINATIONS 

• Go to the Sources or 
Destinations tab in the 
Database Editor 

• Click the Add button 

• Enter number of 
Sources/Destinations to 
create 

• Enter a Name, Alias, Long 
Name, Description, and 
select whether to Use 
Name Index. 

 

SELECT ROUTING DEVICE/ENDPOINT DEVICE/LOGICAL TEMPLATE 

Select the appropriate Logical 
Template.  

In the Routing Device drop-
down, select the IPVR 
frame/device set up for the 
SNP. 

In the Endpoint Device drop-
down, select the SNP Endpoint 
device.  

 

SELECT IO TYPE 

Once you select an SNP 
endpoint device, the IO Type 
dropdown is displayed. Select 
from: 

• Generic: Use this to define 
your own settings within 
the available ranges 

• Quad Conversion: Select if 
you SNP is in Quad 
Conversion mode 

 

 SELECT IO TYPE  
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Enter the following for Video 
Channels: 

• Processor: A, B, C, D on the 
SNP map to 1, 2, 3, 4 on the 
SNP 

• Section: Enter 1 or 2 
depending on your SNP 
configuration  

• Program: Enter the starting 
program index 

• Video/Audio/Data: Enter 
the SNP index: 

• 2 = HD/3G 

• 3 = UHD 

• 4 = Proxy 

• First# and Last#: The first 
and last fields determine 
the index advancing range. 
There are default values for 
these fields, but you can 
change them. 

 

SAVE 

Once complete, save changes 
and close the Database Editor. 
See Final Steps (on page 339) 

 

 
 

Final Steps 
1. Publish your database. 

2. To check that your routing is correct,  

a. On the SNP Manager, select a Processor, Section, and Program, and click to open the 
Configuration window. On the x tab, scroll down to the Status section.  

b. On the SNP Soft Panel, and with the SNP Manager open, select a source and a destination and 
Take.  

c.  In the SNP Manager, the status updates to recognize the change.  

You can also view the SNP monitor output to view the change.  

Note: When routing from one source to multiple destinations in one operation on the same processor 
from the control panel, routing is processed sequentially. It can take a few seconds for the operation to 
complete.  
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Bulk Adding/Updating Sources/Destinations for Selenio 
Network Processor 

When adding sources/destination for the Selenio Network Processor, it is recommended you add all the 
audio sources at the same time, then the video sources, and then do the same thing for the 
destinations. The benefit of doing it this way is you can bulk add up to 32 video channels and 512 audio 
channels, which will then be present sequentially in the Database Editor. Any updates can also easily be 
done in bulk since the entries will be sequential.  

For example, you can configure your SNP in four easy steps: 

1. Go to the Sources Tab. Click the Add button and choose to add as many video sources as required 
(up to 32) 

 

2. Next, choose to add add as many audio sources as required (up to 512) 

 

3. Go to the Destinations tab and create your audio destinations and your video destinations 
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4. When you need to update, bulk select the audio or video sources/destinations and click the Update 
button 

 
 

SDNO Routing Database Editor Configuration Summary 
SNP Video Channel configuration SDNO Router DB configuration 

Personality Tx/Rx Channel Type Direction CH Indexing SDNO Database Editor Configuration  

Sync SDI In, IP Out HD/3G Source 2 Configure HD video source, video CH Index = 2  

  SDI In, IP Out UHD Source 3 Configure HD video source, video CH Index = 3 

  SDI In, IP Out Proxy Source 4 Configure HD video source, video CH Index = 4 

  IP In, SDI Out HD/3G Destination 2 Configure HD video destination,  video CH Index = 
2  

  IP In, SDI Out UHD Destination 3 Configure HD video destination,  video CH Index = 
3 

  IP In, SDI Out Proxy Source 4 Configure HD video source, video CH Index = 4 

  IP In, IP Out HD/3G Source 2 Configure HD video source, video CH Index = 2  

  IP In, IP Out UHD Source 3 Configure HD video source, video CH Index = 3 

Remap SDI In, IP Out UHD Source 3 Configure HD video source, video CH Index = 3 

  SDI In, IP Out Proxy Source 4 Configure HD video source, video CH Index = 4 

  IP In, SDI Out UHD Destination 3 Configure HD video destination,  video CH Index = 
3 
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SNP Video Channel configuration SDNO Router DB configuration 

Personality Tx/Rx Channel Type Direction CH Indexing SDNO Database Editor Configuration  

  IP In, SDI Out Proxy Source 4 Configure HD video source, video CH Index = 4 

Conversion SDI In, IP Out HD/3G or 
UHD 

Source 2, 3 Configure 2 HD video sources for this program, one 
video CH Index = 2, one video CH Index = 3 

  SDI In, IP Out Proxy Source 4 Configure HD video source, video CH Index = 4 

  IP In, SDI Out HD/3G or 
UHD 

Destination 2, 3 Configure 2 HD video destinations for this 
program, one video CH Index = 2, one video CH 
Index = 3 

  IP In, SDI Out Proxy Source 4 Configure HD video source, video CH Index = 4 

  IP In, IP Out HD/3G or 
UHD 

Source 3 Configure 2 HD video sources for this program, one 
video CH Index = 2, one video CH Index = 3 

 

 

Configuring for Switching 
Note: To avoid multicast stream over-subscription, configure your UHD stream sources and destinations 
on a different level as the HD/3G sources and destinations. This will prevent Magellan Control System 
from routing UHD IP steams to a HD receiver channel.  

SNP does not support clean switch between two different audio types, for example switching between 
sources with stereo and monitor audio. Quiet switching, which mutes down, then switches, then 
unmutes, can switch between various types of audio.  

The Conversion personality supports both HD and UHD sources and destinations at the same time. The 
last one used will be the one that is updated on the soft panel control.  

Note: If you switch to an empty multicast stream, the output video will freeze or go to black depending 
on the setting for the Loss of Video (LOV) mode parameter. If it is set to freeze, the previous stream's 
content will not be preserved.  
 

Magellan Control System Indexing 

Programs in the SNP Manager GUI are indexed 1 to 4 per section. A popup lists the Magellan Control 
System video stream indexes for the different types of video streams (3G, UHD, and Proxy) in the header 
for each of the following sections: 

• IP video Rx 

• IP video Tx (as below) 
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• IP proxy Tx 

 
 

Configuring Magellan Control System for Multiviewer Mode 

SNP-MV destinations in Magellan Control System are associated with the Base processor of the 
multiviewer. Even the inputs of the Extended processors are associated with the Base processor when 
building the SNP database for SNP-MV. Where the other SNP personalities have Sections, the 
multiviewer uses the Section address to refer to a display. In a fully extended (Base plus three 
Extensions) SNP-MV, the Magellan Control System would have entries for [processor 1, section/display 
1, program 1] through [1, 1, 36] and then also similar entries for [1, 2, 1] through [1, 2, 36]. Magellan 
Control System will only allow routes to PiPs that are active on the display - so if all 24 PiPs are on 
display 1, and 12 on display 2, then the destinations associated with the others will not accept routes.  
This dynamically changes as different layouts with different numbers of PiPs are loaded.  
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Configuration Examples 

Example 1: Configuring SNP Processor A in HD Mode 

 

1. Create an HD Video logical template 

2. In the Database Editor, click Add Sources 

3. Enter number of sources to create as 8 (corresponding to 8 HD channels in the SNP processor) 

4. Enter Processor=1 (leave First# and Last# default settings - 1 and 4) 

5. Enter Section=1 (leave First# and Last# default settings - 1 and 2) 

6. Enter Programs=1 (leave First# and Last# default settings - 1 and 4) 

7. Enter Video=2 (set First# and Last# to 2 and 2) 

8. Click OK 
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This creates 8 (1.5G or 3G) sources on Processor A - 4 for Section 1 (Programs 1-4) and 4 for Section 2 
(Programs 1-4) 

 
 

Example 2: Configuring SNP Processor A in UHD Mode 

 

1. Create an HD Video logical template 

2. In the Database Editor, click Add Sources 

3. Enter number of sources to create as 2 (when configured as UHD, there are 2 channels in SNP) 

4. Enter Processor=1 (leave First# and Last# default settings - 1 and 4) 

5. Enter Section=1 (leave First# and Last# default settings - 1 and 2) 

6. Enter Programs=1 (set First# and Last# to 1 and 1) 

7. Enter Video=3 (set First# and Last# to 3 and 3) 

8. Click Add Rows 

This creates 2 UHD sources on Processor A - one for Section 1 and one for Section 2  
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Example 3: Configuring Proxy Video for UHD Channels on Processor A 

 

1. Create an HD Video logical template 

2. In the Database Editor, click Add Sources 

3. Enter number of sources to create as 2  

4. Enter Processor=1 (leave First# and Last# default settings - 1 and 4) 

5. Enter Section=1 (leave First# and Last# default settings - 1 and 2) 

6. Enter Programs=1 (set First# and Last# to 1 and 1) 

7. Enter Video=4 (set First# and Last# to 4 and 4) 

8. Click Add Rows 

This creates 2 proxy video sources on Processor A - one for Section 1 and one for Section 2.  
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Example 4: Configuring 8 Mono Audio Channels on Processor A (Section 1, 
Program 1) 

 

1. Create a logical template with Mono Audio 

2. In the Database Editor, click Add Sources 

3. Enter the required number of sources 

4. Enter Processor=1 (leave First# and Last# default settings - 1 and 4) 

5. Enter Section=1 (leave First# and Last# default settings - 1 and 2) 

6. Enter Programs=1 (leave First# and Last# default settings - 1 and 4) 

7. Enter Audio=1 (set First# to 1 Last# to 8) 

8. Click Add Rows 

Audio sources are added per your definition. In this example, we have 8 audio sources (Audio 1-8), all 
for Section 1, Program 1.  
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Example 5: Configuring Data for Processor A (Section 1) 

 

1. Create a logical template with Data 

2. In the Database Editor, click Add Sources 

3. Enter number of sources to create 

4. Enter Processor=1 (leave First# and Last# default settings - 1 and 4) 

5. Enter Section=1 (leave First# and Last# default settings - 1 and 2) 

6. Enter Programs=1 (leave First# and Last# default settings -1 and 4) 

7. Enter Data=1 (set First# and Last# to 1 and 1) 

8. Click Add Rows 

Data sources are added per your definition. In this example, we have 4 data sources, programs 1-4.  
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Configure Menu 
In This Section 

Configuring an Element ......................................................................... 350 
Configuring Presets ................................................................................ 377 
Configuring MCL Panels ......................................................................... 379 
Configuring 3D LUTs ............................................................................... 379 
Configuring AAP ..................................................................................... 379 
License Management ............................................................................. 381 
Configuring SNP Manager (Remote SMM only)  .................................... 383 
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Configuring an Element 
When using remote SNP Manager you can configure any SNP device connected to the SNP Manager. 
Select an SNP from the Configure menu (Configure > Element).  The Element field displays the IP 
address of the device currently primed for configuration. You can switch devices by choosing from the 
drop-down menu. The menu displays all devices that have been Added to the remote SNP, but you can 
only select those devices that are currently connected and powered on.  

Choosing this menu item from a local SNP Manager always opens the Configuration page for the local 
device, with the following tabs: 

 

In this Section 

Configuring Reference for SNP - Genlock .............................................. 351 
Configuring Reference for SNP - PTP ..................................................... 351 
Configuring Reference for SNP (XL only) - RTC ...................................... 354 
Configuring IP WAN for SNP  .................................................................. 355 
Configuring IP Control for SNP  .............................................................. 359 
System .................................................................................................... 363 
SNP Management .................................................................................. 368 
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Configuring Reference for SNP - Genlock 

Genlock comes in and optionally loops through via two HD-BNC connectors; see item 7 in Back Panel (on 
page 49).  

Configuration  

Output Frame Rate Currently supported options are 25/50 Hz and 29/59 Hz, with 25/50 Hz 
as the default.  

Genlock Sync Out Mode Select Options are Loop and Generator. The default is Loop. 

Click Apply Genlock for the changes to take effect. If you do not click Apply Genlock and click Close to 
navigate away from the page, your changes will be lost.  

Status  

GenLock Locked Displays Yes or No.  

Genlock Sync Input Present Displays Yes or No.  

Genlock Input Video Standard Displays the standard, or Unknown.  
 

 

Configuring Reference for SNP - PTP 

Configuration  

Having an inappropriate master can create strange network behavior for other devices.See Connecting 
to a PTP Source (on page 485). 

Manual PTP Domain The PTP domain number that the SNP will listen to. Choose a domain from 
0 - 255 with a default of 127. Clocks that share a domain are synchronized 
to each other.  

Announce Interval  The announce interval is 2 to the power of this value in seconds. For 
example, 0 is one second. The full range is -3 to 4, presented as follows:  

• 8 Hz(-3) 

• 4 Hz(-2) 

• 2 Hz(-1) 

• 1 Hz(0) 

• 0.5 Hz(+1) 

• 0.25 Hz(+2) 

• 0.125 Hz(+3) 

• 0.0625 Hz(+4) 

 The default is 0. 

For the ST2059-2 profile, the range is -3 to +1 
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Manual Announce Receipt 
Timeout 

The number of announce Intervals that have to pass, before declaring a 
timeout. The range is from 2 to 10, with a default of 3. The lower the 
value, the faster SNP will failover to a redundant master. Select a higher 
value for a stable clock regardless of network conditions.  

PTP Timeout = AnnounceReceiptTimeout * announceInterval (in seconds 
as defined above).  

Network from 
master/boundary clock 

Compensates the OWD based on the network configuration from the PTP 
master or boundary clock to the SNP. Options include:  

• 100M->1G->100G  

• 100M->100G  

• 1G->100G  

• 10G->100G  

• 100G->100G (default)  

Note that the control makes an assumption based on how the switch 
normally behaves internally. Use the OWD Offset parameter (below) to 
manually compensate.  

OWD Offset (microseconds) Enter a compensation value to adjust the OWD setting that comes from 
the Network From Master/Boundary Clock parameter (above). The range 
is from -1000 to 1000 microseconds, with a default of 0. See Connecting to 
a PTP Source (on page 485) for more information.  

Negotiated PTP Unicast 
Interface 

When configured for Negotiated Unicast, you must select the interface to 
receive timing data. Options are the four primary and four secondary IP 
WANs, with IP WAN 1 Primary as the default.  

Negotiated PTP Unicast 
Master IP 

When configured for negotiated Unicast, you must enter the IP address of 
the PTP master device.  

PTP Unicast Mode By default, SNP uses Multicast mode. To reduce network traffic, you can 
configure it to instead use Mixed or Unicast mode. When Negotiated 
Unicast (Unicast mode) is enabled, you must select a single source IP for 
the PTP data, and the specific IP WAN to receive it. In Non-Negotiated 
Unicast (Mixed mode), SNP will use the first one it finds exclusively. 

Options are:  

• Disabled (default)  

• Non-Negotiated Unicast  

• Negotiated Unicast  
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PTP Locking Mode  Options are: 

• PTP Only: System timing and frequency locking are based on ST 2059-1 
signal in the IP network. Operating in this mode, due to the IP network 
and ST 2059-1 tolerances, you may see a few microseconds of wander 
on the SNP's SDI outputs. There is no operating impact of such wander 
in a modern SDI facility, as all receivers will be able to lock and track to 
such signals. However, if there is any concern then use another mode as 
described below. 

• PTP with Black Assist: This mode uses analog black reference input for 
the frequency locking and PTP for the time. Network time will be 
adjusted so outputs are 0 phased to analog black. If the external analog 
black is not zero phase-aligned to ST 2059-1, then PTP locking status will 
report unlocked. If PTP is not present, SNP can still operate in this 
mode maintaining all outputs aligned to the analog black reference.  

PTP Mode Options are: 

• Slave Only  

• The SNP will be in Slave mode. 

• Master/Slave 

• When a device is set to master/slave mode, it first determines if there 
is a master on any interface (including VLAN) that it should listen to by 
using the best master algorithm. Once it determines the best master 
on an interface, it becomes a slave on that interface. It becomes 
master if it is the best master. 

Click Apply PTP for the changes to take effect. If you do not click Apply PTP and click Close to navigate 
away from the page, your changes will be lost.  

PTP Master Parameters 

The following are parameters that need to be set if your SNP is a Master (PTP Mode set to 
Master/Slave).  

Priority 1 The priority 1 value when master. Lower the value, higher the priority. 

Priority 2 The priority 2 value when master. Lower the value, higher the priority. 

PTP Step Select Preset to Two Step  

Sync Interval The range for an ST2059-2 profile is "-7 to -1".  Sync interval is 2 to the 
power of this value in seconds. 

LogMinDelayReq Interval Adj PTP Delay Request message interval adjustment from Sync Interval. It 
specifies the minimum permitted mean time interval between PTP Delay 
Request messages (2 to the power of (SyncInterval + 
logMinDelayReqIntervalAdj)) 

PTP Master Communication 
Model 

The PTP Master Communication mode. Set to Multicast for Master/Slave 
mode. 
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PTP Profile The PTP Profile to use. Set to SMPTE ST 2059-2 for Master/Slave mode. 

Status 

These items are displayed for informational purposes only.  

PTP State Reports the following options:  

• Locked 

• Locking 

• Unlocked 

PTP Mode Status Reports if Master or Slave 

Master Present Reports if a remote master is presently being listened to.  

Master IP Address IP address of the master being listened to.  

Master Interface IP Address IP address of the local interface of the master being listened to.  

Grandmaster UUID Universally Unique Identifier for the grandmaster 

Master Delay The transmission latency for a message in one direction.  

Master Offset  The time difference between the master and the SNP. A positive value 
indicates that the SNP is ahead of the master.  

UTC Time Reports the UTC time.  

Clock Identity Universally Unique Identifier to uniquely identify the current SNP 
 

 

Configuring Reference for SNP (XL only) - RTC 
Note: This section is only displayed for SNP-XL. 

Configuration  

RTC Time - Set now The benefit of setting the RTC time is that once set, even if the unit is 
powered donw, the time is still valid since the real time clock contains a 
capacitor to retain the time. 

This is a two-step process: 

• First set the data and time for the real time clock chip in in YYYY-MM-
DD hh:mm:ss format.  

• Then click the Set RTC Time now button. 

Status 

RTC Time and Date Reflects the RTC Time and Date in YYYY-MM-DD hh:mm:ss format. 
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Configuring IP WAN for SNP  

This tab contains parameters for configuring the following:  
 

PHY 

QSFP FEC Configuration  

QSFP A/B FEC Control Lists Forward Error Correction controls that are applied per QSFP. Options 
are:  

• Auto 

• On 

• Off 

FCS Configuration  

FCS Error Threshold Lets you set the FCS error counter threshold for alarm activation. 

FEC settings will not be activated until you click Apply PHY.  
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WAN 

The SNP has four IP WANs. Each IP WAN has the same parameter options, and they can be configured 
independently. To access the IP WAN settings, select Tools > Configure Element from the main menu, 
and click the IP WAN tab.  

 

Primary and Secondary WAN 

Choose the IP WAN to configure from the WAN dropdown menu.  

Enable Primary DHCP and Enable Secondary DHCP allow you to set the respective IP addresses.  

The changes you make are reflected in the IP Transmitter and IP Receiver parameters, and therefore 
change those configurations. The settings have both Primary and Secondary values.  

Before configuring the values in the primary and secondary IP WANs, ensure that you are aware of the 
following conditions:  

• All of the IP Addresses must be unique.  

• An IP Address value of 255.255.255.255 is invalid.  
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• The primary IP WAN subnets and Subnet Masks must be different than the secondary IP WAN 
subnets and Subnet Masks.  

• The VLAN ID numbers must be different for each primary interface set (IP WAN 1, IP WAN 2, IP WAN 
3, etc.), but you can re-use those primary VLAN ID numbers in the secondary interface set.  

IP WAN settings will not be activated until you click Apply WAN.  
 

DNS 

User-Defined Host Name 
By default, the SNP host name is automatically generated using:  
SNP-<serial>. This default setting ensures that names are unique on the 
network by default when nothing else is configured. 

You can also enter a custom hostname. Ensure that the name is unique 
within the system and that it is a different name than the "System Name 
Tag" field (Naming your SNP (on page 65))   

Also see User Defined Host Name (on page 469). 

Status  

Host Name Displays the SNP host name 

Primary DNS The address of this device as assigned by the network administrator 

Alternate DNS An alternate address also assigned by the network administrator 
 

 

Interface 

Primary and Secondary Status  

Below the IP WAN settings, a status list indicates the following information for both Primary and 
Secondary IP WANs:  

Ethernet Mac Address Imagine Communications Customer Service may request these numbers for 
licensing purposes.  

Tx Packets The number of packets sent since the Counter Reset was last clicked 

Tx Rate The current rate of transmission, measured in Gbps 

Rx Packets The number of packets received since Counter Reset was last clicked 

Rx Rate The current receive rate, measured in Gbps 

Rx FCS Errors The number of FCS errors since Counter Reset was last clicked 

Switch Info Reports Data switch information (address and speed) that the specified 
data port is connected to.  

Port Info Reports port information for the data switch that the specified data port is 
connected to.  
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Bandwidth Status  

Tx Configured  This number should be similar to the Primary Tx Rate (above), which is 
configured on the individual processors. If the bandwidth goes over what 
the system is capable of transmitting, then IP Proxy Output may be 
disabled.  

Processor Tx Configured  The transmission bandwidth configured for each processor. From left to 
right, four numbers refer to Processors A, B, C, and D 

Primary Rx Configured  This number should be similar to the Primary Rx Rate (above)  

Processor Rx Configured  The total receiver bandwidth configured for each processor. From left to 
right, four numbers refer to Processors A, B, C, and D. 

When this number exceeds approximately 21K for any processor, that 
processor will be configured to Make After Break mode when switching. 
See General (IP Video Input Status) for more information 

Status Counters 

Press Counter Reset to reset the status counters for the Primary, Secondary, and Bandwidth Status 
items above. When reset is clicked, the counters are reset for this element only, and all SNP Manager 
devices connected to this SNP will see the change.  
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Configuring IP Control for SNP  

Divided into Rx Setup and Tx Setup, these settings define how input and output will operate when set to 
IP mode.  

Rx Setup 

Configuration 

Playout Delay  This parameter sets the desired nominal delay, with a range of 4 - 120 ms 
(8 ms is the default).  

The maximum playout delay that can be set/configured is 120ms 
regardless of the personality. However, it will be internally restricted to a 
maximum value of 35ms for non-JPEG-XS TR-07/08 Decoder personalities, 
despite the GUI displaying up to 120ms. 

The Playout Delay value should be greater than or equal to or the 
Minimum Required Playout Delay (ms) status value.  

The Minimum Required Playout Delay (in the Status section below) is the 
sum of the maximum network jitter and the network path differential. 
Keep the Playout Delay above the Minimum Required Playout Delay for 
proper operation of IP receivers. 

Note: The Playout Delay should be greater than or equal to 8 ms in an 
asynchronous system. 

IGMP Leave Delay (ms)  When in Make After Break Switch Mode, as set on the Program 
Configuration: Input Tab (on page 385), this value (measured in 
milliseconds) is how long this device will wait for the current stream to 
leave before timing out on the Next Source switch.  

Check with the network switch documentation to determine how long the 
switch will take to perform an IGMP leave. 

IGMP Join Delay  When in Make Before Break Switch Mode, as set on the Program 
Configuration: Input Tab (on page 385), this value (measured in 
milliseconds) is how long this device will wait for the current stream to join 
before timing out on the Next Source switch.  

Check with the network switch documentation to determine how long the 
switch will take to perform an IGMP join. 

MAB Leave Check When enabled, MAB switches are rejected if leave fails. 

When disabled, a failed leave will not prevent the switch which may lead 
to overbandwidth issues. Only disable if overbandwidth is not an issue. 

Enable 8K Mode  Allows for definition of sections to be used for 8K clean switching using IP 
Rx. 

See Step 2: Enabling 8K Mode (IP Receiver) (on page 316) 

Status 
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Minimum Required Playout 
Delay (ms)  

This read-only parameter reports the minimum required playout delay 
level in milliseconds.  

Switch Duration The Switch Duration indicates now long a switch will take to perform a 
change from one multicast stream to another.  This value is affected by 
the Playout Delay as well as the IGMP join & leave Delay values. 

Async. Clock Domain Switch 
Duration 

The length of time an asynchronous switch will take.  

Primary/Secondary Largest 
measured IGMP Leave 

Reports the largest measured IGMP leave in milliseconds 

Primary/Secondary Largest 
measured IGMP Join 

Reports the largest measured IGMP join in milliseconds 

Switch 8K Status Reports whether the system is properly configured for 8K switching. For 
more details, see Step 1 - Pre-Requisites for 8K Clean Switching (on page 
315). 

Tx Setup 

General 

Generate SSRC ID Enables or disables insertion of an automatically generated 
Synchronization Source (SSRC) ID. SSRC is a 32-bit numeric identifier, 
carried in the RTP header. 

 

• When disabled, the SSRC ID field will be set to 0. 

• When enabled, the inserted SSRC is unique for each RTP stream, 
generated by an SNP, however, the upper 22 bits are common for all 
streams, that originate from the same SNP. 

 

The lower 10 bits are encoded as follows: 

• Bits[9:8] identify the Processor (i.e. A, B, C D), a stream originates from 

• Bits[7:5] identify the Program, a stream belongs to 

• Bits[4:0] are used to identify individual essence services, that make up a 
program (e.g. Video, Audio, ANC)  

 
Note that the SSRC is ignored by SNP receivers, but a 3rd party receiver 
might require each stream to have a unique SSRC value. 

Video 

Video IP DSCP  

 

This field allows you to choose the Differentiated Services Code Point (DSCP) value. 
Options include:  

• Default Forwarding: best effort traffic  

• Expedited Forwarding: low-loss, low-

• AF12  

• AF13  

• AF41  

• AF42  
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latency traffic  

• Voice Admit: the same as default 
forwarding, except with a call-admission 
control that prevents oversubscription 

• AF11   

• AF21  

• AF22  

• AF23  

• AF31  

• AF32  

• AF33  

• AF43  

• CS1  

• CS2 

• CS3 

• CS4 

• CS5 

The twelve Assured Forwarding (AF##) options present twelve separate DSCP 
encoding classes that create a traffic priority. Higher first digit and lower last digit 
are higher priority.  

Video IP Time to Live  (1 - 255)  

ST 2110-20 RTP 
Payload Type 

Sets the Payload ID for video, with a Range of 77 - 127.  
Default: 96 

ST 2110-22 RTP 
Payload Type 

Sets the Payload ID for e.g. JPEG-XS compressed video, with a Range of 96 - 127. 
Default: 102 

Join IGMP for Tx 
Streams 

Enables Join IGMP for all Tx Streams 

Audio 

Audio IP DSCP  Options include:  

 
• Default Forwarding  

• Expedited Forwarding  

• Voice Admit  

• AF11  

• AF12  

• AF13  

• AF21 

• AF22  

• AF23  

• AF31  

• AF32  

• AF33  

• AF41  

• AF42 

• AF43  

• CS1 

• CS2 

• CS3 

• CS4 

• CS5 

Audio IP Time to 
Live  

(1 - 255)  

ST 2110-30 RTP 
Payload Type 

Sets the Payload ID for ST 2110-30 audio, with a Range of 77 - 127.  
Default: 97 

ST 2110-31 RTP 
Payload Type 

Sets the Payload ID for ST 2110-31 audio, with a Range of 77 - 127.  
Default: 101 

Ancillary Data  

Ancillary IP DSCP  Options include:  

 
• Default Forwarding  

• Expedited Forwarding  

• Voice Admit  

• AF11  

• AF12  

• AF22  

• AF23  

• AF31  

• AF32  

• AF33  

• AF43  

• CS1 

• CS2 

• CS3 

• CS4 
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• AF13  

• AF21  

• AF41  

• AF42  

• CS5 

Ancillary IP Time to 
Live  

(1 - 255)  

ST 2110-40 RTP 
Payload Type  

Sets the Payload ID for ancillary data, with a Range of 77 - 127.  
Default: 100 
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System 

This tab contains parameters for configuring the following:  
 

HDR Matching White Gain 

The following are global HDR gain matching parameters, when converting between SDR and HDR. 

SDR to HLG range -20.0 to +20.0, step 0.1, default 0dB 

SDR to PQ 
range -20.0 to +20.0, step 0.1, default 0dB 

SDR to SLOG3 range -20.0 to +20.0, step 0.1, default 0dB 

• When going from SDR to HDR, the appropriate global gain value is added to the channel-specific 
gain adjustment and then applied in the conversion 

• When going from HDR back to SDR, the appropriate global gain value is subtracted from the 
channel-specific gain value and then applied in the conversion 

• When going from HDR to a different HDR the values are used in combination to determine the 
matching gain 

 

HDR Mapping Mode Defaults 

SDR-709 Mapping Mode When the Mapping Mode parameter (see Video Tab: Color Adjustment (on 
page 415)) is set to Auto, When in Auto mode, set the SDR-709 Mapping 
Mode parameter to indicate how SDR-709 signals should be handled. 

 
 

Timecode Jamsync 

The following parameters allow you to jam the timecode generator. 

Jam Timecode to PTP Click this button to jam timecode generator time to PTP 

Jam timecode Time 
Click this button to jam timecode generator time to a specified time (in 
HH:MM:SS format) 

 
 

QSFP Status 

QSFP Status parameters are listed separately for QSFP A and QSFP B.  

For a list of supported QSFPs, see DATA QSFPs (on page 39) 

Present  Reports if a QSFP has been inserted in the slot and is available 

Data Valid Reports whether the data is valid from the specified QSFP 

Power Measurement Type Reports the optical power measurement type as either Average or OMA 
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Link (1 - 4) Rx Power Reports the Rx power measurement for links 1, 2, 3, and 4 in dBm 

Link (1 - 4) Tx Power  Reports the Tx power measurement for links 1, 2, 3, and 4 in dBm 

Note: If installed QSFPs do not support Tx power measurements, the GUI 
will display "N/A" in the QSFP Tx power readings. 

 

Temperature  Reports the QSFP temperature in degrees Celsius 

FEC ON/OFF Control Indicates whether FEC is currently on or off. FEC is set on the IP WAN tab. 
See PHY (on page 355). 

Vendor Name Reports the QSFP Vendor name 

Vendor Part Number Reports the QSFP Part number 

Vendor Serial Number Reports the QSFP Vendor serial number 

Current Tx EQ The Tx Equalization in effect for all links 

Note: Link power does not display for CQSFP-100G-AOC5M cables.  
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SFP Status 

Note: For a list of supported SFPs, see Video/Audio Expansion Interface Supported SFPs (on page 39) 

 

Note: Rx SFPs display Rx power, Tx SFPs display Tx power, and HDMI SFPs do not display power. 

The SFP Status section displays status for each of the four SFP sockets (A-D) and indicates the following 
information:  

Present Reports if an SFP has been inserted in the slot and is available 

Power Measurement Type Reports the optical power measurement type as either Average or OMA 

Rx (1-2) Power Reports the optical Rx power measurement for channel 1 and 2 in dBm 

Tx (1-2) Power Reports the optical Tx power measurement for link 1 and 2 in dBm 

Temperature Reports the SFP temperature in degrees Celsius 

Vendor Name Reports the SFP Vendor name 

Vendor Part Number Reports the SFP vendor part number 

Vendor Rev Reports the SFP revision 

Vendor Serial Number Reports the SFP serial number 
 

 

SFP Rx/Tx Status (SNP-XL only) 

Note: This section is only displayed for SNP-XL. 
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Note: For a list of supported SFPs, see Video/Audio Expansion Interface Supported SFPs (on page 39) 

 

Note: In case of SNP-XL, you can select the Rx and Tx SFPs. Rx SFPs display Rx power, Tx SFPs display Tx 
power, and HDMI SFPs do not display power. 

SFP Status for SNP-XL is divided into SFP Rx Status and SFP Tx Status sections, that display status for 
each of the four Rx and Tx SFP sockets (A-D):  

Present Reports if an SFP has been inserted in the slot and is available 

Power Measurement Type Reports the optical power measurement type as either Average or OMA 

Rx (1-2) Power Reports the optical Rx power measurement for channel 1 and 2 in dBm 

Tx (1-2) Power Reports the optical Tx power measurement for link 1 and 2 in dBm 

Temperature Reports the SFP temperature in degrees Celsius 

Vendor Name Reports the SFP Vendor name 

Vendor Part Number Reports the SFP vendor part number 

Vendor Rev Reports the SFP revision 

Vendor Serial Number Reports the SFP serial number 
 

 

FPGA Status  

The following information is displayed for the IP FPGA, and for each of Baseband FPGA 1-4.  

FPGA Temperature The temperature of the FPGA in degrees Celsius. 

FPGA Fan Status The current status of the FPGA fan.  
 

 

Power Supply Status  

The following power supply information is displayed:  
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Power Supply Type This field indicates:  

• Non hot swappable  

• Hot swappable  

Power Supply (A-B) Present When the power supply type (above) is hot swappable, these parameters 
display whether or not a power supply is in the indicated slot.   

This parameter does not appear if the power supply is Non hot swappable.  

Power Supply (A-B) Enabled Reports the enabled or disabled status of the specified power supply.  

Power Supply (A-B) Fan On When the power supply is Non hot swappable, these parameters report 
the On/Off status of the indicated fan. 

This parameter does not appear if the power supply is Hot swappable. 

Note: If one power supply is working, both fans will run (unless a fan is in a failed state).  
 

Miscellaneous Status  

The following information is displayed:  

Front panel Fan (1-4)  

 Status  Displays OK or not.  

 Speed Displays the fan speed in RPM 

Chassis 

 Chassis Type Displays the chassis type. Either Classic or SNP-XL. 

Boards  

 Main Board Ambient 
Temperature 

Displays the temperature in degrees Celsius.  

 I/O Board Ambient 
Temperature 

Displays the temperature in degrees Celsius.  

 Rx I/O Board Ambient 
Temperature 

SNP-XL only 
Displays the temperature in degrees Celsius.  

 Tx I/O Board Ambient 
Temperature 

SNP-XL only 
Displays the temperature in degrees Celsius.  

 Expansion Board 1 
Ambient Temperature 

SNP-XL only, if an expansion board is used. 
Displays the temperature in degrees Celsius.  

 Expansion Board 2 
Ambient Temperature 

SNP-XL only, if an expansion board is used. 
Displays the temperature in degrees Celsius.  

 

 

Unit Name 

Unit Name Tag Lets you provide a name for your SNP. This name appears on the browser 
tab when SNP is accessed and the the top of the SNP UI. 
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Security 

Disable CCSP Port Disables Port Access for the Magellan Control Panel (version 4.6 or later). If 
disabled, the SNP will not be discoverable by the Magellan Control Panel. 

Disable if not using Magellan Control Panels, to prevent any security 
issues. 

 
Leave enabled if using Magellan RCP control panels that need to connect 
to the SNP via CCSP protocol (TCP/IP connection mode).  

Disable SEAM Port Disables SEAM access. Leave enabled if using the Magellan Control System 
which uses SEAM for router switches. 

Disable LD Port Disables the Layout Designer application from reaching the SNP. 

Disable Icon Master Port Disables the Icon Master Control port and related Icon Master 
functionality. 

 
 

Date and Time 

Adjust for daylight saving time When enabled, an hour is added to the time display to account for daylight 
saving time. 

 
 

SNP Management 

This tab contains parameters for configuring the following external devices:  

In This Section 

NMOS ..................................................................................................... 369 
LRC ......................................................................................................... 369 
NTP ......................................................................................................... 369 
TSL V5 (UMD Devices) ............................................................................ 369 
Image Video (UMD Devices) .................................................................. 370 
Plura Devices .......................................................................................... 371 
Masterclock Devices .............................................................................. 373 
SQM Global Defaults .............................................................................. 376 
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NMOS 

NMOS Configuration 

Operation Mode This parameter has the following options:  

• Off: No NMOS running 

• Read-only: Registers the SNP into an IS-04 registry and exposes the IS-04 
node and IS-05 connection management APIs, but does not allow 
connections to be changed. 

• Full: Registers the SNP into an IS-04 registry and exposes the IS-04 node 
and IS-05 connection management APIs. 

Registry Server Override Overrides the DNS-SD discovered registry servers. If this is blank, use DNS-
SD to find the registries, and use the TXT record priorityto choose which 
one to use if both are available. If this override string is present, then it 
contains the list of allowed registries ignoring DNS-SD. Order entries in this 
string by priority. Format is <IP Address>:<Port Number> 

NMOS Status 

Registration Server List of detected NMOS registration servers (IP address and port)  

Connected Server  Displays the IP address and port of the server this  node is connected to 

System Server  List of detected NMOS system servers (IP address and port)  
 

 

LRC 

LRC Configuration 

LRC Server IP Address Enter the IP address of the router controller. 

Also see LRC Routing (on page 273). 
 

 

NTP 

NTP Configuration 

NTP Server IP Address Enter the IP address of the NTP Server. 
 

 

TSL V5 (UMD Devices) 

TSL V5 devices provide UMD/Tally data to layouts output by SNP-MV. There is a row for each configured 
TSL V5 device.  

• To add a TSL V5 device, click + 

• To remove a TSL device, click Delete (under Actions) 

• To modify an already-defined TSL device, click Edit.  

Note: Each SNP-MV processor can receive inputs from a single TSL V5 device. See Configure a 
Multiviewer Personality (on page 240). 
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When you click + beside UMD Devices, the following dialog box opens:  

 

 

Name Enter a descriptive name for the device 

Protocol Set to TSL V5 

Type Select TCP or UDP 

IP Address Enter the IP address for the TSL device or leave it at 0.0.0.0. 

IP Port Enter the port; the default is 0, 4001-4004 is recommended. 

When you click Submit, the TSL V5 device appears in the list of UMD devices on the SNP Management 
screen.  
 

Image Video (UMD Devices) 

Image Video devices provide UMD/Tally data to layouts output by SNP-MV. The TSI Image Video Tally 
Controller collects information from signal routing and processing equipment to operate displays and 
tallies as directed by its internal configuration information. There is a row for each configured Image 
Video device.  

• To add an Image Video device, click + 

• To remove an Image Video device, click Delete (under Actions) 

• To modify an already-defined Image Video device, click Edit 
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To add an Image Video Device, click + beside UMD Devices. The following dialog box opens:  

 

Complete the fields to describe the device:  

Name Enter a descriptive name for the device 

Protocol Select Image Video 

Type This is typically TCP 

IP Address Enter the IP address for the TSI device or leave it at 0.0.0.0. 

IP Port Enter the port;  the default is 0, 9800-9803 is recommended. 

When you click Submit, the Image Video device appears in the list on the SNP Management screen.  

 
 

Plura Devices 

Plura devices can be used to provide clock information on layouts output by SNP-MV. There is a row for 
each configured Plura device.  

• To add a Plura device, click + 

• To remove a Plura device, click Delete (under Actions) 

• To modify an already-defined Plura device, click Edit 

Note: Each SNP-MV processor can receive inputs from a single Plura device. See Configure a Multiviewer 
Personality (on page 240). 
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When you click + beside Plura Devices, the following dialog box opens:  

 

Complete the fields to describe the device:  

Name Enter a descriptive name for the device 

IP Address Enter the IP address for the device 

TCP Port Enter the TCP port; the default is 8851 

When you click Submit, the Plura device appears in the list on the SNP Management screen.  
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Masterclock Devices 

The SNP-MV provides support for the Masterclock Timer Protocol. Masterclock devices can be used to 
provide clock information on layout outputs by SNP-MV. You can set up multiple concurrent clocks, 
using different layouts or the same one. Follow these steps to define masterclocks: 

1. Masterclock Layout 

To define your masterclock in Layout Designer, add a Label and set its source to Master Clock. Set 
the number and ensure that you set the same number when defining the clock in the SNP (see step 
3). Each defined Masterclock has a different ID. You can control the color, background, font color, 
and size on the label. Once complete, publish your layout to your SNP. 

 

2. Enabling Masterclock usage in SNP 

In the SNP, go to Configure > Processor, and under External Devices, set Clocks/Timers to 
Masterclock. 
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Note that if this is not configured, the MV will display a flashing --:--:-- on the Masterclock label. 

3. Defining a Masterclock in the SNP 

In the SNP, to add a masterclock, go to: 

Configure Element > Tools > SNP Management > Masterclock devices  

• To add a masterclock device, click + 

• To remove a masterclock device, click Delete (under Actions) 

• To modify an already defined masterclock device, click Edit 

 

When you add a new Masterclock Device, provide the following info: 

 

▪ Name: A relevant name for your clock 

▪ Clock number: A unique Clock number 

▪ Multicast group: The IP address of the multicast group that the clock is streaming from 

▪ Source IP: The IP address of the masterclock device 

▪ Port #: The port number that the stream comes from 

▪ Device ID (Formerly Control Source ID): The last 2 digits of the MAC address of your clock 
device.  

▪ Channel: A/B/C or 0 (default) from the current device (dual channel) 

Note: If there's a loss of connection to the masterclock, the last data received is shown frozen on the 
label, and it flashes. 
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Note for RC500/600 Masterclocks 
If implementing an RC500/600 into an Imagine SNP Multiviewer, the steps are slightly different (from 
RC1000) since the protocol used by RC500/600 is different. Follow these steps: 

For an RC500/600 Masterclock, when adding the device via the Configure > Element > SNP Management 
> Master Clock Devices, set the Channel value to 0 (or edit an existing Masterclock device to set the 
value to 0). 

 
In the Layout Designer, set the Master Clock to 3. 

 

Daktronics Devices 

See Adding Daktronics Devices to the SNP. 
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SQM Global Defaults 

Parameter Description Range 

Video Black Threshold (%)  0 to 100, default is 95 

Video Black/Freeze Threshold  0 to 30, default is 5 

Black Luma Threshold  0 to 940, default is 72 

Video Freeze Sensitivity Level  High, Medium, Low, Truly Static 
Image, Default is Medium 

Number of Frozen Zones (%)  0 to 100, default is 95 

Audio Low Threshold (dBFS)  -100 to -20, default is -90 

Audio High Threshold (dBFS)  -20 to 0, default is -2 

Audio Filter Window(s)  0 to 40, default is 30 

Anc Packet (1-4) DID   

Anc Packet (1-4) SDID   

Anc Packet (1-4) Detect 
Timeout(s) 

 0 to 100, default is 60 

 

 



Selenio™ Network Processor 

User Guide  Configure Menu 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 377 

 

Configuring Presets 
Presets are used to save an entire configuration of an SNP for later use, or for use on another SNP.  A 
preset includes parameter and alarm settings. When a preset is applied, the entire configuration of that 
SNP is replaced with that contained in the preset. 

Presets are specific to the device they are created on. A preset can be transferred from one 
HARDWARENAME to another when you are using a remote SNP Manager. However, if you want to 
transfer presets from one HARDWARENAME to another while using local SNP Manager, you should use 
Save Preset and then Import Preset to the other device.  

The Configure Presets dialog is accessed by going to Tools > Configure Presets (under Element Tools) 
and is divided into 3 tabs:  

Save Preset (on page 377) 

 
 

Save Preset 
The Save Preset tab lets you save settings from an SNP to create a preset. To do this: 

1. Select an Element as Source to copy its current settings  

Note: This field is only shown if using a Remote SMM. On a local SMM,  this field is not displayed 
since the Element itself is considered as source. 

2. Provide a Name for the Preset. Names are case-sensitive. 

3. Click Add to create the Preset. 
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All created presets are displayed in the Existing Presets section of the Configure Presets dialog, with an 
option to delete or download them. To load any of these presets, see Load Preset (on page 378). 

The SNP device can store a maximum of 20 presets. When using remote SNP Manager, the maximum is 
200 presets.  

Note: Presets are saved to the SNP Manager database, so they can be loaded to other SNP devices via 
the Load Preset tab, when using a remote SNP Manager only. Loading a preset erases any current 
configuration and starts new processes on that SNP. Presets are saved in .prst format and can be 
opened in a text editor like Notepad. When a preset involves licensed features, licenses are applied on a 
first come, first served basis. An error message will be displayed if the preset requires a license that is 
not available.  

You can also save a preset to file by doing the following: 

• Click the Download icon in the Action column against a preset in the Existing Presets list. 

• Re-import it from the Import Preset tab. 
 

Load Preset 
Note: For SNP, a reboot is required to load a preset. Always click Load + Reboot to load a preset. Note 
that there could be unexpected behavior without a reboot, so ensure that this is done. 

The Load Preset tab allows you to select from existing presets in the Source Preset drop down list. To 
load a preset: 

1. Select a Preset from the Source Preset drop down. 

2. Select the Destination Element (IP Address) to load the Preset to 

Note: This field is only shown if using a Remote SMM. On a local SMM, the preset is loaded to 
the current Element. 

3. Click Load + Reboot. 

A spinning icon on the element indicates that a preset is being loaded.  
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If a preset cannot be loaded onto an element, a descriptive error message will appear in the bottom 
right corner of the dialog box. A preset may not load, for example, if the element has insufficient 
licenses for the settings being applied.  

Preset loading will appear in system log files. See Configuring SNP Manager (Remote SMM only)  (on 
page 383).  
 

Import Preset 

Use this option if you've previously saved a preset to file. 

The Import Preset tab allows you to Import a preset from a file by doing the following: 

1. Browse and select the source preset file 

2. Optionally, give a present a new name 

3. Click Import 

Note: After you've imported a preset, you still need to load it. See Load Preset (on page 378). Licenses 
are applied on a first come, first served basis, and if the license is not available you'll see an error.  
 

Configuring MCL Panels 
See Configuring MCL Panels (on page 502) 
 

Configuring 3D LUTs 
See Color Processing - Built In and Custom LUTs (on page 264) 
 

Configuring AAP 
For more details on Advanced Audio Processing (AAP), see Advanced Audio Processing (on page 275). 
 
AAP is supported on the following personalities: 
- Dual/Quad Conversion 
- Sync 

The Configure Advanced Audio Processing dialog contains two tabs: 

The Floor Plan tab displays the following: 

• DSP Utilization: Provides a quick overview of the current DSP utilization including what is active or 
actually enabled and running, and what is planned (but not yet enabled). The Floor Pan tab allocates 
functions to each DSP.  
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▪ DSP1 supports processors A&B 

▪ DSP2 supports processors C&D 

As Advanced Audio functions are enabled, the SNP keeps track of DSP utilization and reports the 
current total. Reviewing these percentages as workflows are configured will help understand how 
much processing is utilized by currently defined configuration and settings, how much is available 
for additional processing, and whether any limits have been reached. 

• Sessions: Allows for creation of Processing Sessions. For more details. see Creating AAP Sessions (on 
page 290) 

 

The License Status tab displays the following: 

• Audio Licenses: Reports on available audio licenses and usage. For more details, see AAP Reporting 
and AAP Licensing (on page 287). 
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License Management 
See License Management (on page 44). 
 

Acquiring Licenses 

To add or remove licenses, follow these steps:   

1. Login to the SNP Manager Web interface.  

2. Select Configure > Licenses from the menu bar at the top of the screen.  

3. The License Management dialog is displayed with feature license details. This dialog contains 2 tabs: 
Major Features and Advanced Audio licenses. See License Management (on page 44). 

 

4. Provide Imagine Communications with the Serial Number, the licenses that you require, and the 
current license key displayed in the License Key field. 

Imagine Communications Customer Service has a form to facilitate this process. 

5. Obtain the new license key numbers from Imagine Communications.  
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Customer Service will provide a device-specific license key.  

6. On the License Management dialog box, click Enter New License and and enter the license key in the 
field provided.  

7. Click Submit. 

The new license(s) appear in the Feature List.  

Title Names of various feature licenses available 

Tokens Shows the limit for license tokens that can be assigned to processors 

Usage Shows the currently assigned usage of licenses on processors 

ProcA/B/C/D Allows you to assign feature license tokens to specific processors 

To free up a license for usage elsewhere on the device, select away from the feature on the Processor 
where it is currently assigned and click Save. 

Licensing Notes 

• SNP 1.7 onwards enforces licensing 

• License tokens must be assigned to a processor for that feature to function 

• In case of unassigned licenses (tokens not applied to a processor), functionality will available but the 
output may be forced to black or the audio muted 

• Licenses are not saved in SNP presets 

Note: If the REST API is used to set license values, note that partial configuration (for example, just the 
Conversion license) will result in license information being wiped out in the GUI. If using the the REST 
API to set licenses, ensure that the complete structure is sent - all 7 unique keys and 4 x 7 tokens must 
be set. 

Behavior when a Licensed Feature is not Assigned to a Processor 

Processor Behavior 

Dual Conversion Personality Program outputs black video, system license alarm 

Multiviewer Personality Program outputs black video, system license alarm 

Sync/Remap Personality Program outputs black video, system license alarm 

Quad Conversion Personality  Program outputs black video, system license alarm 

HD Downsample Feature Program outputs black video, system license alarm 

HDR Adjustment Feature Program output HDR setting has no effect, system license 
alarm 

+128 Audio/MADI Feature Program audio output muted, system license alarm 
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Configuring SNP Manager (Remote SMM only)  
The SNP Manager dialog box provides tools to collect and download SNP Manager system logs.  

Note: To view logs for a specific SNP, see Configure Local Host - Download Logs (on page 98).  

 

Collect: Collates recent system events into log files.  

Download: Downloads the recently created log files onto a local PC, where they can be reviewed. If no 
logs have been saved, the Download button will not be available. 
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Configuring Programs 
Programs appear in the Elements screen of the dashboard. For a general overview of this screen, see 
Controlling a Device (on page 88).  

 

In Sync Mode, each Processor section has one (UHD) or four (HD) programs. In Remap and Conversion 
mode, each Processor section has one program. Each program has a tile that displays general overview 
information for that program.  

 

 

The program's tile displays the BNC(s) used by the video and the 
formats of both the incoming and outgoing video.  

Click the program's tile to open a Configuration page for that program.  

• Use the Apply button at the bottom of the GUI page to apply the change.  

• Changes to the controls that are marked with the green LIVE tag will be sent to the device 
immediately without clicking the Apply button.  
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Program Configuration: Input Tab 
Depending on the mode for the section (group of four inputs in the section), different options will 
appear.  

• Input Tab: IP Input Mode (on page 385) 

• Input Tab: SDI Input Mode (on page 398) 
 

Input Tab: IP Input Mode 

When a Section/Channel is in IP Input Mode, parameters will be available, divided into the following 
groups:  

In this Section 

Statistical Counters ................................................................................ 386 
Input Tab: Program Name ...................................................................... 387 
Input Tab: Clock Domain Next Switch Stream ....................................... 388 
Input Tab: Clock Domain Status ............................................................. 389 
Input Tab: Pixel Format .......................................................................... 389 
Input Tab: IP Video Configuration .......................................................... 389 
Input Tab: IP Video Status ...................................................................... 391 
Input Tab: IP Audio Configuration ......................................................... 393 
Input Tab: IP Audio Routing ................................................................... 394 
Input Tab: IP Audio Status ...................................................................... 395 
Input Tab: Audio Status .......................................................................... 395 
Input Tab: Audio SRC Configuration and Status .................................... 396 
Input Tab: Audio Channel Configuration and Status ............................. 396 
Input Tab: IP Ancillary Data Stream Configuration (IP Input)  ............... 396 
Input Tab: IP Ancillary Data Stream Status ............................................ 397 
Input Tab: Ancillary Data Status ............................................................. 397 
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Statistical Counters 

Missing Packet and Out-of-Range Packet statistics counters are reported by the 2022-7 component. 
There are three each of these parameters, described in the following topics:  

• Input Tab: IP Video Status (on page 391) 

• Input Tab: IP Audio Status (on page 395) 

• Input Tab: IP Ancillary Data Stream Status (on page 397) 

The Missing Packet statistics counters have a higher order of precedence than the Out-of-Range statistic 
counter. 

These are the conditions for a packet to be considered as missing from an IP Receiver Stream (video, 
audio, or ANC): 

• if both Ethernet ports are present, it has to be missing on both Primary and Secondary ports 

• if only the Primary Ethernet port is connected, it is missing from the Primary port 

• if only the Secondary Ethernet port is connected, it is missing from the Secondary port 

A missing packet’s time label exceeds not only the Playout Delay value (the Receiver’s programmable 
buffer depth) but also the physical hardware buffer size.  All RTP packets are written into the Receiver’s 
buffer and marked with a time label, which is derived from the local PTP clock.  Under normal 
operations, packets read from the Receiver’s buffer will have a time label which is less than the physical 
hardware buffer size.  If a packet is read from memory and it has an old time label, then it’s considered 
to be missing. 

The Out-of-Range statistic counter increments when the time label exceeds the Playout Delay value plus 
some margin of error. 
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Input Tab: Program Name 

Program Name Allows for setting a custom program name. There is a 50 character limit for 
the Program Name. 

 
This program name then shows in place of the default Program 1/2/3/4. 

 
If left blank, the Program shows the default name (for example, Program 
1, Program 2, etc.).  
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Input Tab: Clock Domain Next Switch Stream 

Clock Domain Next Switch 
Stream 

 

This parameter facilitates clean switching for untimed/not-phase-aligned 
2022-6 and 2110-20 signals. For best results, use the "Freeze" option for 
the "Loss of Video Mode" control parameter. Options are:  

• Auto Clock Select - (Requires SDNO)  
SNP receives the Grand Master ID of the Transmitter, and if it matches 
the SNP's Grand Master ID,  and is expected to be synchronous (clean 
and without freeze). In this mode, SNP sets the receiving mode based 
upon analyzing the received essence packet. 

• If SNP receives a 2110-20 stream with the same PTP master and it is 
PTP phase-aligned with the receiver, it will choose Sync mode. 

• If SNP receives a 2110-20 stream with a different PTP master, it will 
choose Async mode. 

• If SNP receives a 2022-6 stream, it works the same as 2110-20 if the 
SDNO provides a PTP Master. If it doesn't, the default clock mode is 
Async  

• SNP Sync - The next stream will have the same PTP Grand Master ID as 
the SNP  

• Asynchronous - The next stream is expected to  have a different PTP 
Grand Master ID from the SNP and will freeze for up to two frames.  

• Force Sync- Allows the video and all associated audio streams to use 
synchronous mode with never falling back to asynchronous mode. 

Clean Switching 

• All 2110-20 streams, synchronous and asynchronous, will be cleanly 
switched 

• All 2022-6 streams are switched cleanly when the ‘Loss Of Video Mode’ 
parameter is set to "Freeze".  One video frame will be lost during the 
switch however with the SNP set to “Freeze” mode, the video output 
will be clean. 

• The Proxy Video outputs are not clean switched 

• The SNP Multiviewer does not support clean switching 

Asynchronous Clean Switching 

The SNP IP Receivers can switch cleanly between source streams that are 
asynchronous relative to the SNP Receiver’s ST 2059/PTP Domain for the 
following use cases: 

• Switching between source streams which originate from a different ST 
2059/PTP Domain, that are synchronized to each other 

• Switching between source streams which originate from a different ST 
2059/PTP Domain, that are frequency locked to each other but are 
phase offset from each other 

• Switching between source streams which originate from a different ST 
2059/PTP Domain, that are sliding relative to each other.  Each source 
stream has either a faster or slower video clock relative to the SNP 
Receiver’s PTP locked video clock. 



Selenio™ Network Processor 

User Guide  Configuring Programs 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 389 

 

A source stream is composed of a group of streams: 1 video IP stream, 16 
audio IP streams, and 4 ancillary data IP streams.  For the SNP IP Receiver 
to be able to receive the group of video, audio, and ancillary IP streams, 
the streams must be synchronous to each other, i.e. belong to the same ST 
2059/PTP Domain. 

Note: Switch cleanly means no video glitches/distortion or audio 
pops/clicks/distortion, and no disruption to video and audio timing 

 
 

Input Tab: Clock Domain Status 

Clock Domain Status Allows IP Receivers to display the status of incoming signals: whether 
signal is synchronous or asynchronous. 

 
 

Input Tab: Pixel Format 
This section only appears when the Processor is in Remap or Conversion mode.  

UHD Quad Input Pixel Format 
Select 

If the input is UHD, this selection determines how incoming video is 
interpreted:  

• Square Division 

• Pixel Interleave 

The Square Division option is only available when the Input Mode is SDI.  

This selection only has an effect when using Quad inputs; 12G is always 
interleave.  

UHD Input Pixel Format Used This status is only available in Conversion mode.  

This read-only parameter indicates Yes (indicating a mismatch) when both 
input and output are configured to UHD and either one is set to SQD in 
Conversion mode. This setting is independent of the real input/output 
standard, which can be HD.  

UHD Pixel Format 
Mismatched 

Reports if the pixel format is mismatched 

 

 

Input Tab: IP Video Configuration 

Video IP Receiver Enable Enables this receiver 

Receiver Mode  
Choose the video receiver mode for this input.  

• ST 2110-20 (preset to 2110-22 in case of JPEG-XS decoder) 

• ST 2022-6 (only available when the standard is HD)  

Note: When in 2022-6 mode, due to a bandwidth routing limitation, you 
should not configure more than six channels in a Processor to receive at 
1080p/50 or 1080p/59, or the switch mode will revert to Make After Break 
mode resulting in non-clean switches.  
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2022-6 Mode Audio Source This parameter appears when the Receiver mode (above) is ST 2022-6 
only. Options are:  

• ST 2110-30/31 

• ST 2022-6 Audio  

2022-6 Mode Anc Source This parameter appears when the Receiver mode (above) is ST 2022-6 
only. Options are:  

• ST 2110-40 

• ST 2022-6 Anc 

Receiver Video Standard  

Note: Sync and Multiviewer(s) 
modes only. HD Mode. 

Selects the input video standard. Options include the following:  

• 525i/59.94 

• 625i/50 

• 720p/50 

• 720p/59.94 

• 1080i/50  

• 1080i/59.94  

• 1080p/23.98 

• 1080p/24 

• 1080psf/23.98 

• 1080psf/24 

• 1080p/25 

• 1080p/29.97 

• 1080p/50  

• 1080p/59.94  

Receiver UHD Video Standard  

Note: Always available in 
Remap mode and available in 
Sync and Multiviewer(s) mode 
when the section is configured 
as UHD.  

Selects the input video standard. Options include the following:  

• 2160p/23.98 

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

• 2160p/50 

• 2160p/59.94 

Payload ID Source Dominance Allows for determining priority for determining Colorimetry and TCS. 
Select from:  

• Auto  

• SDP  

• VPID  

Also see Configuring VPID (on page 327). 

Timestamp Offset Specifies the RTP timestamp offset for this channel. The offset is measured 
in video samples.  
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Primary and Secondary 

The following parameters appear for both the Primary and Secondary networks.  

WAN Select Specifies the WAN for this channel. Choose from WAN 1 - 4.  

This field also displays the IP address and VLAN defined in the Element's IP 
WAN menu.  

IP Address Specifies the IP address for the channel.  

 

UDP Port Specifies the UDP port for the channel.  

Multicast Source Specifies the source address for multicast assignment.  

 

Note: For a Primary or Secondary interface, if the IP address is set to 0.0.0.0 and the  UDP port is set to 
zero, no input will be expected. 
 

Input Tab: IP Video Status 

Switch Mode  This read-only parameter displays the switch mode for the selected 
channel.  

In Make Before Break mode, the "Next Source" stream is acquired by IGMP 
Joins. The previous stream is removed after a clean transition of video and 
audio by IGMP Leaves. There must be enough bandwidth remaining on the 
100G Ethernet Links to have the "Next Source" stream to be present 
alongside the current stream.  

In Make After Break mode, the current stream is lost by IGMP Leaves. If 
you receive an error message under "Switch Error" indicating that the 
switch failed due to timeout, change the IGMP Leave Delay parameter 
value as described in Configuring IP Control for SNP  (on page 359), then 
perform the switch again by clicking Take. Assuming the timeout does not 
occur, after waiting for the delay indicated in the IGMP Leave Delay 
parameter and for the current stream to be lost, the "Next Source" stream 
will be acquired by IGMP joins. There will not be a clean transition of video 
and audio in this switch mode.  

Make After Break will only work if the amount of bandwidth being received 
by the device can dynamically change due to IGMP Leaves/Joins or with 
SDNO. Otherwise Make After Break will always fail with a timeout 
message.  

Switch Status  This read-only parameter confirms the success of the switch to the next 
source. The possible values are: Ready, Switching, Switch Complete, and 
Switch Failed.  

Switch Error Indicates whether an error has occurred on the recent switch.  
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Video Standard  • 625i/50 

• 525i/59.94 

• 720p/50 

• 720p/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/24 

• 1080psf/24 

• 1080p/25 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 

• 2160p/23.98 

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

• 2160p/50 

• 2160p/59.94 

• Not Present 

Video Input Colorimetry The input colorimetry used for conversion. Without SDNO, this will always 
indicate "Unknown".  

• Rec 601 

• Rec 709 

• Rec 2020/2100 

• Unknown 

Video Input Transfer 
Characteristics 

Without SDNO, the input TCS will always display "Unspecified".  

• SDR-TV 

• HLG 

• PQ 

• Unspecified/SLOG3 

Video Input Payload ID Reports on the presence of VPID if received from the ANC data. Also see 
VPID Status (on page 328) 

Switch Count  Indicates how many switches have taken place since the last reboot.  

Video Packet Count Total packets counted since counting started. This is reset to 0 with Clear 
Packet Counters (below).  

Video Missing Packet Count Reports the number of video packets missing since the last time the Clear 
Packet Counters button was clicked.  
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Video Out of Range Packet 
Count 

Reports the number of video packets out of range since the last time the 
Clear Packet Counters button was clicked.  

Counters are explained more in Statistical Counters (on page 386). 

Clear Packet Counters Click to clear all of the counters for this IP Receiver channel, including  

• Video Packet Count 

• Video Missing Packet Count 

• Video Out of Range Packet Count 

Video Network Path 
Differential  

Reports the delay between receiving the same packet from path 1 and path 
2 for seamless protection (in milliseconds).  

Video Seamless Protection 
Status  

Reports whether redundant video is available for seamless protection.  

Picture Height Reports the picture height 

Primary and Secondary 

The following parameters appear for both the Primary and Secondary networks.  

Current (Primary/Secondary) 
IP Address 

This read-only parameter displays the IP address values that you entered 
in one of two places:  

• If the configuration is unicast, the values entered in the IP WAN table 
appear here.  

• If the operation is multicast, the Next Address value appears here.  

Current (Primary/Secondary) 
UDP Port 

This read -only parameter reports the Primary or Secondary IP address of 
the associated IP Receiver channel.  

 

 

Input Tab: IP Audio Configuration 

Audio Stream Choose an audio stream from the drop-down menu. The rest of the 
controls will affect the selected audio stream only.  

General  

Audio IP Receiver Enable Select On or Off to enable or disable this Audio IP Receiver stream. Each 
audio IP Receiver must be enabled separately. 

Note: Each SNP device can receive a maximum of 256 mono audio 
channels across all processors.  

Receiver Mode Choose the audio receiver mode for this stream. Options are: 

• ST2110-30 

• ST2110-31 

Bit Width Bit width options depend on the Set Rx Mode setting. The full set of 
options are:  

• 16 bits 

• 24 bits  
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Number of Channels Indicates the number of audio channels present in this stream. For ST2110-
31, must be a multiple of 2.  

Timestamp Offset  Specifies the TRP timestamp offset for this channel, measured in video 
samples.   

Packet Time Set the packet time for incoming audio channels:  

• Auto (default)  

• 125 us 

• 250 us 

• 333 us 

• 1 ms 

• 4 ms 

• 500 ms 

Primary/Secondary 

The following parameters appear for both the Primary and Secondary networks.  

WAN Select Specifies the WAN for this stream. Choose from WAN 1 - 4.  

This field also displays the IP address and VLAN defined in the Element's IP 
WAN menu.  

IP Address Specifies the IP address for the stream.  

UDP Port Specifies the UDP port for the stream.  

Multicast Source Specifies the source address for multicast assignment.  
 

 

Input Tab: IP Audio Routing 

As you select a channel and streams, a field updates to show the SDNO stream, slot, port etc.  

 

Audio Processor Channel Choose a channel from 1 - 16, applies to the routing controls below.  

APIN is an internal, virtual routing point for use in the AAP and Audio TABs. 

Source Stream Selects the IP audio receiver stream (within this program) which will supply 
this channel 

Source Channel  Selects the channel within the selected input stream  
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Input Tab: IP Audio Status 

Switch Error Indicates whether an error has occurred on the recent switch.  

Switch Count  Indicates how many switches have taken place since the last reboot.  

Packet Count Reports the total number of packets since the last time Clear Packet 
Counters were reset. 

Out of Range Packet Count Reports the number of audio packets out of range since the last time Clear 
Packet Counters were reset.   

Counters are explained more in Statistical Counters. 

Missing Packet Count Reports the number of audio packets missing since the last time Clear 
Packet Counters were reset.  

Clear Packet Counters This button resets the following counters to 0:  

• Switch Count 

• Audio Packet Count 

• Audio Missing Packet Count 

• Audio Out of Range Packet Count  

Network Path Differential  Reports the delay between receiving the same packet from path 1 and 
path 2 for seamless protection (in milliseconds).  

Seamless Protection Status  Reports whether redundant audio is available for seamless protection.  

Packet Time Reports the audio packet interval time in milliseconds.  It will report 
"Unsupported" if the packet time can't be determined.  

This status correlates to the packet time set in the Transmitter - see Packet 
time in Output Tab: IP Audio Configuration (on page 457). 

Primary and Secondary 

These parameters are read-only and for informational purposes only.  

Current (Primary and 
Secondary) IP Address  

This read-only parameter displays the IP address values that you entered 
in one of two places.  

If the configuration is unicast, the values entered in the IP WAN table 
appear here.  

If the operation is multicast, the Next Address value appears here.  

Current (Primary and 
Secondary) UDP Port  

These read-only parameters report the Primary and Secondary IP 
addresses of the four IP Receiver channels.  

 

 

Input Tab: Audio Status 

Channel Quick View  

Audio V-bit Status  

Audio Format Status  

Channel Full View  

Source Channel  
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Input PCM Status  
 

Input Tab: Audio SRC Configuration and Status 

Audio Pair Each audio pair is configured independently. Choose the audio pair, from 1 
- 8, for which the rest of the parameters in this group will apply.  

Input Pair SRC Control These controls configure the operation mode of the selected sample rate 
converter. Options are Engage, Auto, and Bypass.  

When an SRC Control parameter is set to Auto, the Audio Channel Status 
bits determine whether the audio data is PCM or non-PCM, and whether 
the audio data is passed through the Audio Sample Rate Converters (SRC). 
The Engage option always forces the audio data through the audio SRC, 
and Bypass always forces the audio data around the audio SRC.  

SRC Pair Engage Status  Feedback parameter that indicates the SRC status for this pair as Engaged 
or Bypassed.  

 

 

Input Tab: Audio Channel Configuration and Status 

Source Channel  Each audio channel is configured independently. Choose the audio 
channel, 1 - 16, for which the rest of the parameters in this group apply.  

Input PCM Status  Indicates whether the audio data for this channel is PCM or non-PCM.  
 

 

Input Tab: IP Ancillary Data Stream Configuration (IP Input)  

Data Stream Choose a stream from the drop-down menu. The rest of the controls will 
affect the selected data stream only.  

General  

ANC Data IP Receiver Enable Select On or Off to enable or disable this data IP Receiver stream. Each 
data IP Receiver must be enabled separately. 

Timestamp Offset  Specifies the TRP timestamp offset for this channel, measured in video 
samples.   

Primary/Secondary 

The following parameters appear for both the Primary and Secondary networks.  

WAN Select Specifies the WAN for this stream. Choose from WAN 1 - 4.  

This field also displays the IP address and VLAN defined in the Element's IP 
WAN menu.  

IP Address Specifies the IP address for the stream.  

UDP Port Specifies the UDP port for the stream.  

Multicast Source Specifies the source address for multicast assignment.  
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Input Tab: IP Ancillary Data Stream Status 

Switch Error Indicates whether an error has occurred on the recent switch.  

Switch Count  Indicates how many switches have taken place since the last reboot.  

ANC Data Packet Count Reports the total number of packets since the last time Clear Packet 
Counters were reset. 

ANC Data Out of Range Packet 
Count 

Reports number of data packets out of range since the last time Clear Packet 
Counters were reset.  Counters are explained in Statistical Counters. 

ANC Data Missing Packet 
Count 

Reports the number of data packets missing since the last time Clear Packet 
Counters were reset.  

Clear Packet Counters This button resets the following counters to 0:  

• Switch Count 

• Data Packet Count 

• Data Missing Packet Count 

• Data Out of Range Packet Count  

ANC Data Network Path 
Differential  

Reports the delay between receiving the same packet from path 1 and path 
2 for seamless protection (in milliseconds).  

ANC Data Seamless Protection 
Status  

Reports whether redundant data is available for seamless protection.  

Primary and Secondary 

These parameters are read-only and for informational purposes only.  

Current (Primary and 
Secondary) IP Address  

This read-only parameter displays the IP address values that you entered in 
one of two places. If the configuration is unicast, the values entered in the IP 
WAN table appear here.  

If the operation is multicast, the Next Address value appears here.  

Current (Primary and 
Secondary) UDP Port  

These read-only parameters report the Primary and Secondary IP addresses 
of the four IP Receiver channels.  

 

Input Tab: Ancillary Data Status 

CC/TT This read-only parameter reports if closed captions or teletext is present, and 
what line it is on 

SMPTE 2031  This read-only parameter reports on the presence of SMPTE ST-2031 subtitles 

EDC This read-only parameter reports if Evertz Dreamcatcher is present 

AFD This read-only parameter reports if active format description is detected 

SCTE-104 Splicing  This read-only parameter reports if SCTE-104 Splicing is detected 

ATC  This read-only parameter reports if Ancillary Timecode (SMPTE-12M) is 
detected (currently displayed for Conversion Personalities) 

Source ID This read-only parameter reports if Source ID is present. 

BrandNet This read-only parameter reports if BrandNet triggers are present. 
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Input Tab: SDI Input Mode 

Below the Pixel Format settings described in Input Tab: Pixel Format (on page 389), you will find Input 
SDI options divided into the following groups:  

 

In this Section 

Input Tab (SDI): Program Name ............................................................. 399 
Input Tab: Pixel Format .......................................................................... 399 
Input Tab (SDI): Video Configuration ..................................................... 400 
Input Tab (SDI): Video Status ................................................................. 400 
Input Tab (SDI): Audio De-Embedder ..................................................... 402 
Input Tab (SDI): Audio Status ................................................................. 403 
Input Tab (SDI): Audio SRC Configuration and Status ............................ 403 
Input Tab (SDI): Ancillary Data Status .................................................... 403 

 
 



Selenio™ Network Processor 

User Guide  Configuring Programs 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 399 

 

Input Tab (SDI): Program Name 

Program Name Allows for setting a custom program name. There is a 50 character limit for 
the Program Name. 

 
This program name then shows in place of the default Program 1/2/3/4. 

 
If left blank, the Program shows the default name (for example, Program 
1, Program 2, etc.).  

 

 

Input Tab: Pixel Format 
This section only appears when the Processor is in Remap or Conversion mode.  

UHD Quad Input Pixel Format 
Select 

If the input is UHD, this selection determines how incoming video is 
interpreted:  

• Square Division 

• Pixel Interleave 

The Square Division option is only available when the Input Mode is SDI.  

This selection only has an effect when using Quad inputs; 12G is always 
interleave.  
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UHD Input Pixel Format Used This status is only available in Conversion mode.  

This read-only parameter indicates Yes (indicating a mismatch) when both 
input and output are configured to UHD and either one is set to SQD in 
Conversion mode. This setting is independent of the real input/output 
standard, which can be HD.  

UHD Pixel Format 
Mismatched 

Reports if the pixel format is mismatched 

 

 

Input Tab (SDI): Video Configuration 
Options in this section will vary depending on the mode the Processor is in.  

SDI Input Link Select  
(UHD only)  

Determines which SDI input to use. Options will vary depending on the 
processor mode. 

• 1st Link (TL) top left  

• 2nd Link (TR) top right 

• 3rd Link (BL) bottom left  

• 4th Link (BR) bottom right 

• UHD (Quad Link) (Convert mode only)  

• UHD (12G) Across all personalities except Sync when in HD mode, 1st 
BNC 

• SFP 1 (if an SFP module is installed; see Configure SFPs (on page 115).)  

• SFP 2 (if an SFP module is installed) 

Note: If the SFP module is HDMI This option will only appear in the second 
section, but will be routed to both sections when chosen.  

 

 

Input Tab (SDI): Video Status 
The contents of this tab may vary depending on the Processor Section setting. See Configuring a Section 
for HD or UHD (on page 116) for more information.  

• When the Section is set to HD, the display will show the options for the one BNC associated with this 
SDI input.  

• When the Section is set to UHD, most of these parameters will appear four times, once for each of 
the associated inputs. These parameters will also repeat for input SFP (i.e., SFP-B-1) on Channels 1, 
5, 9, etc. 

Video Input Present  
(UHD mode only)  

This read-only parameter indicates Yes there is UHD video present or No 
there is not.  

BNC-# or SFP-# Displays the number of the BNC or SFP for which the following parameters 
are relevant. This option will appear once when the Processor Section 
mode is HD, or four times when in UHD mode.  

Video Present 
(HD mode only)  

Indicates presence or absence of video on the designated input.  
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Video Input Standard Indicates the input standard for video, which can be any of the following:  

• 625i/50 

• 525i/59.94 

• 720p/50 

• 720p/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/24 

• 1080psf/24 

• 1080p/25 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 

• 2160p/23.98 

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

• 2160p/50 

• 2160p/59.94 

Input C CRC Status Counts the CRC (cyclic redundancy check) errors on input C. 

Input Y CRC Status Counts the CRC errors on input Y. 

AP EDH Errors When the input is SD-SDI, this parameter replaces the Input C CRC 
parameter 

FF EDH Errors When the input is SD-SDI, this parameter replaces the Input Y CRC 
parameter 

EDH Present When the input is SD-SDI, the EDH Present parameter replaces the Input C 
CRC Status and Input Y CRC Status parameters which are hidden (since 
these parameters would display "0" and could be misleading in case of a 
bad input signal) 

Video Input Payload ID The unique ID assigned to the payload based on the video input standard.  

Video Input Colorimetry The input colorimetry used for conversion, the SDI status is derived from 
VPID.  

• Rec 709 

• Reserved 

• UHDTV 

• Unknown 
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Video Input Transfer 
Characteristics 

SDI TCS status is derived from VPID.  

• SDR-TV 

• HLG 

• PQ 

• Unspecified/SLOG3 

Clear CRC Errors Clears the input video CRC errors.  

Clear EDH Errors When the input is SD-SDI, this parameter replaces the Clear CRC Errors 
parameter 

 

 

Input Tab (SDI): Audio De-Embedder 

General Configuration 

Ignore Checksum Error Determines whether the Channel will respond when there are checksum 
errors in the incoming stream. 

Ignore ECC Error Determines whether the Channel will respond when there are ECC errors 
in the incoming stream.  

Ignore Parity Error Determines whether the Channel will respond when there are parity errors 
in the incoming stream.  

Group (1 - 4) Error Control Determines the group response when errors are received, when Ignore is 
not selected for that type of error (above). Options are: 

• Mute 

• Repeat 

Group (1 - 4) DBN Error Ignore Determines whether the group will respond when there are DBN errors in 
the incoming stream.  

General Status 

Demux V-bit status Lists the status for each of the 16 channels as EEEE EEEE EEEE EEEE where 
E indicates present and = indicates absent.  

Group (1 - 4) Present Indicates whether the specified group is present.   

Group (1 - 4)  Checksum Error Indicates an error in the Checksum category.  

Group (1 - 4) DBN Error Indicates an error in the Data Block Number category. 

Group (1 - 4) Parity Error Indicates an error in the Parity category.  

Group (1 - 4) ECC Error Indicates an error in the Error Correction Code category.  

Group (1 - 4) Active Channel Lists the active channel in the demux group.  

Group (1 - 4) Sample Rate  Indicates the sample rate for the demux group.  
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Input Tab (SDI): Audio Status 

Channel Quick View  

Audio V-bit Status  

Audio Format Status  

Channel Full View  

Source Channel  

Input PCM Status  
 

 

Input Tab (SDI): Audio SRC Configuration and Status 

Audio Pair Choose the audio pair to configure,  can be 1 - 8. Other controls on this 
page will then just configure that pair.  

Input Pair SRC Control These controls configure the operation mode of the sample rate 
converters. Options are Engage, Auto, and Bypass.  

When an SRC Control parameter is set to Auto, the Audio Channel Status 
bits determine whether the audio data is PCM or non-PCM, and whether 
the audio data is passed through the Audio Sample Rate Converters (SRC). 
The Engage option always forces the audio data through the audio SRC, 
and Bypass always forces the audio data around the audio SRC. 

SRC Pair Engage Status  The characters in this read-only parameter each represent an audio 
sample rate converter. Yes = Engaged and No = Bypassed. Both the left and 
right audio channels of an audio pair are either Synchronized (Engaged) or 
not Synchronized (Bypassed). Non-PCM audio data must be Bypassed 
around the Audio Synchronizer; otherwise it will be corrupted.  

 

 

Input Tab (SDI): Ancillary Data Status 

CC/TT This read-only parameter reports if closed captions or teletext is present, 
and what line it is on 

SMPTE 2031  This read-only parameter reports on the presence of SMPTE ST-2031 
subtitles 

EDC This read-only parameter reports if Evertz Dreamcatcher is present 

AFD This read-only parameter reports if active format description is detected 

SCTE-104 Splicing  This read-only parameter reports if SCTE-104 Splicing is detected 

ATC  This read-only parameter reports if Ancillary Timecode (SMPTE-12M) is 
detected (currently displayed for Conversion Personalities) 

Source ID This read-only parameter reports if Source ID is present. 

BrandNet  
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Program Configuration: Video Tab 
This tab contains different options depending on whether the Processor section is configured for UHD or 
HD mode. See Configuring a Section for HD or UHD (on page 116).  

Note: This tab does not appear on Processors configured for Multiviewer mode.  

This tab contains the following sub-sections:  

 

In This Section 

Video Tab: Video Control ....................................................................... 405 
Video Tab: Output .................................................................................. 407 
Video Tab: Test Signal Generator .......................................................... 411 
Video Tab: Video Status   ....................................................................... 412 
Video Tab: Colorimetry/TCS Control and Status .................................... 412 
Video Tab: 3D LUT Control and Status ................................................... 414 
Video Tab: Color Adjustment ................................................................. 415 
Video Tab: Scaler Configuration ............................................................ 419 
Video Tab: On Screen Display ................................................................ 419 
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Video Tab: Video Control 

Parameters with a LIVE indicator will update on the actual stream as you change them, without the 
Apply button being pressed.  

Note: These three parameters are 4 x 1080p when in UHD mode.  

When in UHD mode (i.e., 4 x 1080p), delay parameters are applied to each individual frame quadrant. 

Frame Delay (frames)  Note: This parameter is disabled when in Low Latency mode. See 
Configuring a Processor (on page 113).  

The Frame Delay parameter compensates for other external processes by 
providing a delay of the video signal in one-frame increments. The 
amount of achievable delay is based on the video input standard. Note 
that the actual frame delay shown on the GUI is the maximum frame 
delay plus the minimum latency for the conversion, which is 2 
frames/fields for SQD formats and 1 frame/field for all other formats. 

The following are the Max frame delays depending on personality and 
format: 

• MCL, TR07/TR08, Dual/Quad Conversion 

•  5 frames (interlaced/psf inputs) 

• 10 frames (progressive input) 

• SYNC, REMAP 

• 10 frames 

• Dual Gateway 

• 30 frames 

Vphase (lines)  Adjusts the vertical phase of the frame sync from 0 to 1124 with units of 
"lines" and precision of 0 decimal places. 

• 720p (0 to 749) 

• 1080p/i (0 to 1124) 

• 525i - (0 to 524)   

• 625i - (0 to 624) 

This parameter is unavailable when in Low Latency mode and when IP 
Video Tx is enabled. See Configuring a Processor (on page 113).  
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Hphase (µs)  Adjusts the horizontal phase of the frame sync, with a precision of three 
decimal places. The range varies depending on the video standard and 
frame rate:  

• 625i/50 (0 to 63.963) 

• 525i/59.94 (0 to 63.519) 

• 720p/50 (0 to 26.653) 

• 720p/59.94 (0 to 26.653) 

• 1080i/50 (0 to 35.542) 

• 1080i/59.94 (0 to 29.646) 

• 1080p/23.98 (0 to 37.061) 

• 1080psf/23.98 (0 to 37.061) 

• 1080p/24 (0 to 37.061) 

• 1080psf/24 (0 to 37.061) 

• 1080p/25 (0 to 35.542) 

• 1080p/29.97 (0 to 29.646) 

• 1080p/50 (0 to 17.771) 

• 1080p/59.94 (0 to 14.823) 

UHD section mode 

• 2160p/23.98 (0 to 37.024)  

• 2160p/24 (0 to 37.024) 

• 2160p/25 (0 to 35.542) 

• 2160p/29.97 (0 to 29.646) 

• 2160p/50 (0 to 17.771) 

• 2160p/59.94 (0 to 14.823) 

This parameter is unavailable when in Low Latency mode and when IP 
Video Tx is enabled. See Configuring a Processor (on page 113).  

Dolby E A/V Align Dolby E header alignment control  (See the Dolby E header alignment 
parameter in the Audio Tab: General Configuration (on page 449) tab) 
delays Dolby E audio to ensure the Dolby E gets embedded on the right 
line number. This causes a mismatch in A/V sync between Dolby E and 
Video as Video will now be early. To resolve this, 1 Dolby E frame 
equivalent delay is added to Video to ensure Dolby E to Video A/V is 
aligned at the output. Video delay can be 1 or 2 video frames (for 
p50/59). 

Also see Dolby E Encoder Latency (on page 286) and Dolby E Decoder 
Latency (on page 286). 
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Video Tab: Output 

Parameters with a LIVE indicator will update on the actual stream as you change them, without the 
Apply button being pressed.  

Loss of Video Mode  Selects the behavior when Loss of video (LOV) happens. Options are: 

• Pass: Continues to output bad signal (default) 

• Black: Outputs a black signal 

• Freeze: Outputs a still frame 

• Off: The output is turned off  

• Freeze, then X:  This mode freezes the output when there is an input 
glitch, and if the glitch persists then the output follows the Delayed 
LOV mode after Freeze setting.  

Note: Use this setting if you don't want the output to go to black as a 
result of input glitches that are very short, and then to go to one of 
Black/pass/off/TSG (to indicate something is wrong) if the glitch lasts 
longer.  

Pass settings are more useful when commissioning a system and 
detecting unreliable sources.  Freeze, being less noticeable, may be more 
desirable on a live system. 

Delayed LOV mode after 
Freeze 

This setting is displayed if Loss of Video Mode is set to Freeze, then X. 
It lets you determine what to do after the defined time (Delayed LOV 
Time) has elapsed and there is still a persistent input glitch. Options are: 

• Black: Outputs a black signal 

• Pass: Continues to output bad signal 

• Off:The output is turned off  

• TSG: Outputs the set TSG  

Note: If set to TSG, TSG needs to be preconfigured as desired, but does not 
need to be enabled explicitly (LOV enables TSG when LOV occurs). 

Delayed LOV Time This setting is displayed if Loss of Video Mode is set to Freeze, then X. 
This is the the period of time (in seconds) to tolerate any input glitches 
and have it not affect the output.  

 
The range is 1-10 seconds and the default is 2 seconds. 

Force Black Forces the output video to black when checked.  

Force Freeze Forces the output video to freeze when checked.  
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Output Video Standard Note: This parameter only appears in Conversion mode.  

The standard the video will be converted to. Options are:  

• 720p/50 

• 720p/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/24 

• 1080psf/24 

• 1080p/25 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 

• 2160p/23.98    

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

• 2160p/50 

• 2160p/59.94 

Note: The 2160p standards are invalid when the input is UHD-SQD.  

Output Video Standard 
(Quad Conversion) 

The standard the video will be converted to. Options are:  

• 625i/50 

• 525i/59.94 

• 720p/50 

• 720p/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/24 

• 1080psf/24 

• 1080p/25 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 
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Freeze Mode Note: This parameter appears  in Sync mode only. 

Sets the type of frozen output video. Options are:  

• Field1 

• Field2 

• Frame (default) 

Enable Force Video Standard  Note: This parameter does not appear in Conversion modes. 

Forces the output video to conform to a pre-selected standard (selected 
in the Video Forced Standard parameter below) when checked.  

Video Forced Standard Note: This parameter does not appear in Conversion modes.  

The standard the video will conform to when Enable Force Video 
Standard is selected. Options are:  

• 625i/50 

• 525i/59.94 

• 720p/50 

• 720p/59.94 

• 1080i/50 

• 1080i/59.94 

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/24 

• 1080psf/24 

• 1080p/25 

• 1080p/29.97 

• 1080p/50 

• 1080p/59.94 

UHD section mode 

• 2160p/23.98    

• 2160p/24 

• 2160p/25 

• 2160p/29.97 

• 2160p/50 

• 2160p/59.94 
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Proxy Output Force SDR-709 
If this parameter is enabled and the main video is 1080p59 or 2160p59, 
the proxy output will be 1080p59. If the main video is 1080p50 or 
2160p50, the main video will be 1080p50.  If this parameter not enabled, 
the proxy will be 1080i59 or 1080i50 for those inputs. 

For other main video resolutions  like 1080i/720p/SD, the proxy video will 
always be the same as main video regardless of whether the checkbox is 
enabled or not.  

Note: The processor can only support up 8 x 1080p main video + 1 x 
1080p59 proxy, the second proxy will be disabled due to bandwidth. 

Proxy Input Select  Selects the source for the proxy output. Output will be 1080i for 3G 
signals, or whatever the input is for lower bandwidth signals. This option 
only appears when the Processor Section is set to UHD. Options are:  

• Link 1 

• Link 2 

• Link 3 

• Link 4 

• UHD (Quad Link in Conversion mode, 12G across all personalities 
except Sync when in HD mode, 1st BNC) 

Proxy 3G Output Allow 
Enables up to 3G for proxy output. If the SNP is not licensed for proxies, 
there is no proxy output.  

When this parameter is checked: 

• If input is UHD, proxy is 3G 

• if input is 3G, proxy is 3G 

• if input is 1.5G or SD, proxy is same as input 

When this parameter is not checked: 

• if input is UHD, proxy is 1.5G 

• if input is 3G, proxy is 1.5G 

• if input is 1.5G or SD, proxy is same as input 

Note: Proxy 3G output will not work for TR07 or TR08 Encoder in UHD 
mode if the Proxy Input Select is either Link 2, Link 3 or Link 4. 
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Video Tab: Test Signal Generator 

Parameters with a LIVE indicator will update on the actual stream as you change them, without the 
Apply button being pressed. 

TSG Enable Activates or deactivates the test signal generator.  

TSG Pattern Selects the test pattern to display. 
HD Options are:  

• Black 

• Color Bars 75% 

• Horizontal Sweep Y-only 

• Horizontal Sweep 

• White 

• Cross Hatch 

UHD options are:  

• Black 

• White  

• COLOR BARS 75 UHD 

• Horizontal Sweep Y-only 

• Horizontal Sweep 

• Cross Hatch 

Bouncing Box Enable Note that TSG Enable must be 
checked for this option to be 
enabled. 

Selecting this moves a square along 
the screen and off the edges and 
allows you to determine if your 
pictures are updating. 

This option is useful for debugging 
purposes, and useful in cases where 
you don't have a live signal, just a 
test pattern, but want motion. 

Note that this option is only 
currently available on the Sync 
personality. 

• Enable 

• Disable 

Bouncing Box Size Sets the size of the bouncing box. Range is 10-28 
Default: 28 

Bouncing Box Speed Sets the speed of the bouncing box. Range is 1-31 
Default: 7 

Bouncing Box Color (Y) Sets the Y parameter YCrCb scale of 
the bouncing box. 

Range is 0-255 
Default: 235 

Bouncing Box Color (Cr) Sets the Cr parameter YCrCb scale of 
the bouncing box. 

Range is 0-255 
Default: 128 

Bouncing Box Color (Cb) Sets the Cb parameter YCrCb scale 
of the bouncing box. 

Range is 0-255 
Default: 128 
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Video Tab: Video Status   
Video Input Present  Indicates whether the frame sync is operating on this processor and 

channel.  

Video Input Standard  Indicates the standard of incoming video for this processor and channel.  

Video Output Standard  Indicates the standard of output video for this processor and channel.  

Frozen Status Indicates whether the frame sync is frozen.  

Close Captions/Teletext 
Present 

Indicates if closed captions or teletext is detected. 

Close Captions/Teletext 
Present Line 

Reports the video line number of closed captions or teletext if detected. 

 

 

Video Tab: Colorimetry/TCS Control and Status 

The following status parameters indicate what coloversion is being used, which is especially useful when 
Auto override is selected for Colorimetry and TCS parameters. 

Input Colorimetry and TCS 
Override 

Configures input override of colorimetry and transfer characteristics of 
video for input color conversion. 

• SDR-709 

• SDR-601 

• SDR-2020 

• HLG-2100 

• PQ-2100 

• SLOG3-2020 

• Auto (default) 

For SDI input, the colorimetry information is taken from the stream 
unless it is set by SDNO. If SDNO is not configured, input colorimetry will 
not be auto-detected, because it may not be part of the stream.  

• When the input is unknown, and the video input standard is SD – the 
effective input Colorimetry/TCS is SDR-601 

• When the input is unknown, and the video input standard is HD or 3G 
– the effective input Colorimetry/TCS is SDR-709 

•  When the input is unknown, and the video input standard is UHD – 
the effective input Colorimetry/TCS is SDR-2020 

For IP input, the colorimetry information is provided by SDNO. If SDNO 
is not configured properly, the input colorimetry will not be auto-
detected, because it may not be part of the IP stream.  

• When the input is unknown, and the video input standard is SD – the 
effective input Colorimetry/TCS is SDR-601 

• When the input is unknown, and the video input standard is HD or 3G 
– the effective input Colorimetry/TCS is SDR-709 

• When the input is unknown, and the video input standard is UHD – 
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the effective input Colorimetry/TCS is SDR-2020. 

Note: If you had a setting of "SLOG3" for this parameter and were using 
firmware earlier than 1.2, after upgrading to the latest firmware and 
restarting the SNP, you must re-select this option, but as "SLOG3-2020". 

Output Colorimetry and TCS Configures override of colorimetry and transfer characteristics during 
output video color conversion.  

• SDR-709 

• SDR-601 

• SDR-2020 

• HLG-2100 

• PQ-2100 

• SLOG3-2020 

• Auto (default) 

In Sync and Remap modes, the colorimetry will follow the input 
override. In Conversion mode, SDR-709 is used for HD/3G converted 
output video standard, and SDR-2020 is used for UHD output.  

Note: If you had a setting of "SLOG3" for this parameter and were using 
firmware earlier than 1.2, after upgrading to the latest firmware and 
restarting the SNP, you must re-select this option, but as "SLOG3-2020". 

Note: This parameter is only available when the SNP-PSK-HDR (HDR 
Adjustment Feature) license is enabled for this program. 

Note: This parameter is not displayed for the JPEG-XS personality 

Effective Input Colorimetry Indicates the input colorimetry used for conversion, one of: 

• Rec 601 

• Rec 709 

• Rec 2020/2100 

• Unknown 

Effective Input Transfer 
Characteristics 

Transfer characteristics used for the input conversion 

Effective Mapping Mode Indicates the mapping mode actually in use based on user defined settings 
and other considerations. See the Mapping mode parameter (Video Tab: 
Color Adjustment (on page 415)) 

Effective Output Colorimetry The output colorimetry used for conversion: 

• Rec 601 

• Rec 709 

• Rec 2020/2100 

• Unknown 

 
Note: This parameter is not displayed for the JPEG-XS personality 
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Effective Output Transfer 
Characteristics 

Transfer characteristics used for output conversion.  

• SDR-TV 

• HLG 

• PQ 

• Unspecified/SLOG3 

 
Note: This parameter is not displayed for the JPEG-XS personality 

 

 

Video Tab: 3D LUT Control and Status 

Parameters with a LIVE indicator will update on the actual stream as you change them, without the 
Apply button being pressed.  

3D LUT Select Select the LUT to use. The dropdown contains a listing of LUTs in the 
system and UNITY - a default LUT. 

3D LUT Operating Mode • ColorProc Force: This option (the default) uses the SNP's non-linear and 
linear domain mathematical pipelines and does not route the signal 
through the selected LUT  

• LUT Forced: This option uses the SNP's input (non-linear) domain color 
processing engine, followed by the user selected LUT, regardless of 
whether the transfer characteristic or colorimetry of the input signal are 
appropriate for the selected LUT  

• Auto: This option uses the SNP's input (non-linear) domain color 
processing engine, followed by an automated selection of: (A) The 
selected LUT or (B) The SNP’s linear domain mathematical pipeline The 
automated selection is based on the transfer characteristic (TCS) and 
colorimetry of the incoming signal, and the requested TCS and 
colorimetry of the converter’s output. If the input and output TCS match 
the metadata of the selected LUT, then the selected LUT will be used, 
otherwise the SNP linear domain pipeline will be used.  

Pre-3D LUT GBR Clip Mode 
Clipping mode of the GBR values prior to 3D LUT processing. Options are: 

• Hue Preserving 

• Per Component 

3D LUT Status 
Displays LUT status. The LUT status contains three fields separated by 
commas.  

• The first field indicates whether the selected LUT is currently being used 
(Enabled) or not (Disabled) 

• The second and third fields reflect the metadata of the selected LUT, 
used in controlling the automatic LUT switching feature. 
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Video Tab: Color Adjustment 
Note: This section is not displayed for the JPEG-XS personality. 

Parameters with a LIVE indicator will update on the actual stream as you change them, without the 
Apply button being pressed.  

Bypass the Color Processor  Bypasses the Color Processor 

SD-525 First AP Line These parameters specify the first line in SD to which color processing 
controls should be applied. The first few lines of the active picture may 
carry closed captioning, WSS, etc. so to avoid any processing of such 
data (and possible corruption), the first line to be processed can be 
modified. 

• For 525, the range is 20-23 (default is 22) 

• For 626, the range is 23-26 (default is 24)  

SD-625 First AP Line 

Return to Neutral This button restores all color processing controls for the related 
channel back to their neutral/default values.  

Input Domain  

Black Level Adjusts the black level of the video input across a range from -100.0 to 
100.0 with units of "mV" and precision of 1 decimal place.  

Cb Offset / Cr Offset Adjusts the offset of the respective component of the video. The range 
is -100 to 100 mV.  

Hue  Adjusts the hue phase of the input across a range from -180.00 to 
179.90 with units of "deg" and precision of 2 decimal places. 

Luma Gain Adjusts the luminance gain of the video input across a range from -6.00 
to 6.00 with units of "dB" and precision of 2 decimal places. 

Chroma Gain Adjusts the chrominance gain of the video input across a range from -
6.00 to 6.00 with units of "dB" and precision of 2 decimal places.  

Cb Gain / Cr Gain Adjusts the gain of the respective component of the video. The range is 
-6.00 to 6.00 dB.  

G Offset / B Offset / R Offset Adjusts the offset of the respective component of the video. The range 
is -100 to 100 mV.  

G Gain / B Gain / R Gain Adjusts the gain of the respective component of the video. The range is 
-6.00 to 6.00 dB.  

Linear Domain  
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Mapping Mode Select from: 

• Display Light 

• Scene Light 

• Scene Light (AIM) 

• Auto 

Auto is the default setting for Mapping Mode. When the input or the 
output Colorimetry is SDR-709, this control selects the default mapping 
mode behavior for the programs with Auto selected in the program’s 
Video Color Mapping mode.   
 
If the Proxy Output Force SDR-709 parameter (Video Tab: Output (on 
page 407) section) is selected, the Auto mode is used in that 
conversion. 

When in Auto mode, set the SDR-709 Mapping Mode parameter 
(Configure Element > System > HDR Mapping Mode Defaults) to 
indicate how SDR-709 signals should be handled. 

General rules for conversion with automatic mode  

• Scene-Light conversion is used in general, except in case of the 
below 

• If the input/output format is SDR-709, the user-specified SDR-709 
control value is used 

• If the input/output format is PQ-2100, Display-Light conversion is 
used 

• The Effective Mapping Mode parameter (Video Tab: 
Colorimetry/TCS Control and Status (on page 412)) indicates the 
mapping mode actually in use 

This parameter is displayed for Sync, Remap, and Conversion 
personalities. SNP-MV personalities do not display the Mapping Mode 
parameter but use the Auto setting internally. 
 
SNPs with older versions of the firmware that have been upgrade to 1.7 
and beyond will not have Auto as the default mapping mode in the 
programs unless the user resets his configuration. 

GBR Gamma  

Optical G / B / R Offset Set the G, B, or R offset 

Optical G /B / R Gain Set the G, B, or R gain 

Optical Cb / Cr Gain Set the Cb or Cr gain 

Saturation Set the saturation level 

Optical White Gain Adjust the gain of the video in the linear (optical) domain. The default 
is 0, and the range is -9.00 to 9.00 dB.  
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Optical White Knee Adjusts the point at which the white stretch is applied to the white 
portion of the video. The range is 50-3200 nits.  

Optical White Knee Contour Adjust the white knee contour percentage 

Optical White Stretch Adjusts the amount of white knee applied to the video.  

White knee determines the amount of additional gain applied to the 
white end of the RGB transfer functions in the look-up tables.  

The value displayed is a percent of the available correction.  

A positive white knee increases the slope of the last 15% of RGB values, 
and decreases the slope of the preceding 15%.  

The figure below displays increased and decreased white slope.  

 
The default is 0, and the range is ±100.  

Optical Black Knee Adjusts the point at which the black stretch is applied to the black 
portion of the video. The range is 0-50 nits.  

Optical Black Knee Contour Adjust the black knee contour percentage 

Optical Black Stretch Adjusts the amount of black knee applied to the video.  

Black knee determines the amount of additional gain applied to  the 
black end of the RGB transfer functions in the look-up tables. 

The value displayed is a percent of the available correction.  

A positive black knee parameter will increase the slope of the first 15% 
of the transfer function by the amount entered and decrease the slope 
of the next 15%, to return to the unmodified transfer function. 

The figure below displays increased and decreased black knees.   
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The default is 0, and the range is ±100.  

Output Domain  

GBR Clip Enable Check to enable the following sliders to control Green/blue/red 
clipping. These sliders aren't visible until enabled.  

  
Both parameters are measured in mV.  

GBR Black Clip Level The range is -100 to 100mV with a default of 0.   

GBR White Clip Level The range is650-770mV with a default of 700.  

Black Clip Enable Check to enable the Black Clip Level slider. This slider isn't visible 
otherwise.  

Black Clip Level The range is -100 to 100mV.  

White Clip Enable Check to enable the White Clip Level slider. This slider isn't visible 
otherwise. 

White Clip Level The range is 640 to 770mV. 

Chroma Clip Enable Check to enable the Chroma Clip Level slider and Chroma Clip Mode 
setting 

Chroma Clip Level Set the Chroma Clip Level. Range is 400 to 800 mV 

Chroma Clip Mode Set the Chroma Clip Mode. Select from Independent Cb/Cr or Locked 
Cb/Cr 
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Chroma Anti-Alias The Chroma anti-alias setting allows for control over chrominance 
filtering ringing. Options are: 

• Bypass - No filtering 

• Default - Highest cutoff, sharpest roll-off 

• 2-7 - Decreasing cutoff (7 is lowest) and roll-off (7 is gentlest) 
 

 

Video Tab: Scaler Configuration 
Note: These parameters are only displayed for Conversion personalities. 

This section includes sharpness controls for down conversion. These parameters have a LIVE indicator 
and will update on the actual stream as you change them, without the Apply button being pressed. 

Horizontal BW Adjusts the horizontal bandwidth across a range from -20 to +20 with 0 as 
the default. In case of 1080p-to-1080i conversion, the range is 20 to -35. 

Vertical BW Adjusts the vertical bandwidth across a range from -20 to +20 with 0 as the 
default. In case of 1080p-to-1080i conversion, the range is 20 to -35. 

Reinterlace BW Adjusts the reinterlace bandwidth across a range from -10 to 2. 
 

 

Video Tab: On Screen Display 

On Screen Display (OSD) provides a simple overlay text on the output for signal identification or 
downstream stream signal flow troubleshooting. These parameters are found on the Configure 
Program's Video tab.   

Transparency Range 0 - 15 

Label Enable Turns on the label.  

Label Text  Enter text for the label to display. This field can contain up to 19 characters.  

Label Position X  The horizontal starting position of the text. The range varies depending on 
your video standard:  

• 1080 standards: 0-57 

• 720 standards: 0-49 

• 2160 (SQD): 0-114 

• 2160 (2SI): 0-57 

Label Position Y The vertical starting position of the text. The range varies depending on your 
video standard:  

• 1080 standards: 0-15 

• 720 standards: 0-15 

• 2160 (SQD): 0-30 

• 2160 (2SI): 0-15 
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Program Configuration: AAP Tab 
This tab contains parameters for Advanced Audio Processing operations. 

Note: This tab is only displayed if AAP has been enabled. See Creating AAP Sessions (on page 290).  
 
AAP is supported on the following personalities: 
- Dual/Quad Conversion 
- Sync 
 
Only these Personalities display the AAP tab. The AAP tab is hidden if there are no associated AAP 
operations for a program. 

In This Section 

AAP Tab: Advanced Audio Processing ................................................... 421 
AAP Tab: Input Routing and Gain........................................................... 421 
AAP Tab: Parameters (Dolby E Encoder)  ............................................... 423 
AAP Tab: Parameters (Dolby E Decoder)  .............................................. 429 
AAP Tab: Parameters (UpMix) ............................................................... 430 
AAP Tab: Parameters (DownMix) .......................................................... 431 
AAP Tab: Parameters (MultiMerge) ....................................................... 432 
AAP Tab: Parameters (Loudness Control) .............................................. 435 
AAP Tab: Parameters (UpMix+Loudness Control) ................................. 438 
AAP Tab: Parameters (DownMix+Loudness Control) ............................ 441 
AAP Tab: Parameters (MultiMergeMix+Loudness Control) .................. 444 
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AAP Tab: Advanced Audio Processing 
Processing Session Select the desired function (subject to what has been licensed/enabled on 

the processor): UpMix, DownMix, etc. 

Options seen here depending on configuration include: 

• UpMix 

• DownMix 

• MultiMerge 

• UM+Loudness 

• DM+Loudness 

• MM+Loudness 

• Loudness 1.0 

• Loudness 2.0 

• Loudness 5.1 

• Loudness 7.1 

• Loudness 2x1.0 

• Loudness 8x1.0 

• Loudness 4x2.0 

• Loudness 5.1 + 2.0 

• Dolby E Encoder 

• Dolby E Decoder 

For more details, see DTS Processing (on page 277) and Dolby E Processing 
(on page 285). 

 
 

AAP Tab: Input Routing and Gain 

The settings in this section apply to all audio channels in the selected processor.  

Algorithm Input Select the Algorithm input. Options displayed here depend on the selected 
algorithm. For example, for Loudness 7.1, the following is displayed: 

• 1(L) 

• 2(R) 

• 3 (C) 

• 4 (LFE) 

• 5 (Ls) 

• 6 (Rs) 

• 7 (Lb) 

• 8 (Rb) 
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Input Type Select Select the source input type to the AAP algorithm input. Options are: 

• APIN 

• MADI 

• TONES 

Based on the selection made, the Input Channel Select parameter is 
populated. 

Input Channel Select Select the source input channel, within the type of source, to the AAP 
algorithm input. 

The options displayed here depend on what is selected in the Input Type 
Select parameter. 

• If Input Type Select is APIN 

• APIN is an internal, virtual routing point for use in the AAP and Audio 
TABs, fed by input audio channels configured on the Program's Input 
Tab. Choose an audio processor channel from 1 - 16. 

• If Input Type Select is MADI 

• 1-128 extended channels are displayed for selection 

• If Input Type Select is TONES: The following tones are displayed for 
selection: 

• 400 Hz 

• 1 kHz 

• 2 kHz 

• Mute 

Channel Gain Set the gain for the audio input channel 

Channel Invert Select to invert the selected audio input channel to correct phase errors 

Channel Mute Select to enable muting for the selected audio input channel 
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AAP Tab: Parameters (Dolby E Encoder)  

These parameters are displayed if Dolby E Encoder is selected. 

Dolby E Encoder Status 

Dolby E Frame Rate The reference frame rate for the Encoder. 

Dolby E Encoder  

Dolby E Frame Bit Depth Sets the Bit Depth of the Dolby E audio stream to 16-bit or 20-bit. To use 
all eight audio channels, set the Bit Depth to 20. A Bit Depth of 16 allows 
reduced bandwidth (Dolby E-2000k instead of Dolby E-2400k) but only 
supports a maximum of six audio channels.  

• 16 Bits 

• 20 Bits (default) 

Program Configuration Sets the Dolby E audio program mix. Options include: 

• 5.1+2 (default) 

• 5.1+2x1 

• 4+4 

• 4+2 

• 3x2+2x1 

• 2x2+4x1 

• 2+6x1 

• 8x1 

• 5.1 

• 4+2 

• 4+2x1 

• 3x2 

• 2x2+2x1 

• 2+4x1 

• 6x1 

• 4 

• 2x2 

• 2+2x1 

• 4x1 

Metadata Source Sets the source for audio metadata. Currently limited to Internal. 

Metadata Reversion Mode Defines what to do if  an interruption in the Metadata Source is detected. 
The response can be set to: 

• Last Used (if available)  

• Internal (internal generator) 
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Metadata Controls Per Program  

Program Select the Program for metadata control 

Audio Coding Mode Sets the audio coding mode: 

• 1/0 (C) 

• 2/0 (L, R) 

• 3/0 (L, C, R) 

• 2/1 (L, R, S) 

• 3/1 (L, C, R, S) 

• 2/2 (L, R, Ls Rs) 

• 3/2 (L, C, R, Ls, Rs) 

Bitstream Mode Describes the audio service contained within the Dolby  bitstream. A 
complete audio program may consist of a main audio service (a complete 
mix of all the program audio), an associated audio service comprising a 
complete mix, or one main service combined with an associated service. 
To form a complete audio program, it may be (but rarely is) necessary to 
decode both a main service and an associated service using a maximum 
total bit rate of 512 kbps.  

Select from: 

• Complete Main (default) 

• Music and Effects 

• Visually Impaired 

• Hearing Impaired 

• Dialogue 

• Commentary 

• Emergency 

• Voiceover  

• Karaoke  

LFE Channel Indicates whether an LFE (Low Frequency Effects) Channel is present 
within the bitstream. Select from: 

• LFE Channel nor present  

• LFE Channel present 
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Dialogue Normalization (dBFS) Sets the average dialogue level. If the source of this encoding is Loudness 
Control processing, the value of Dialog Normalization should match the 
Target Loudness Level setting. 

Dialogue Level is also known as dialogue normalization or dialnorm. When 
received at the consumer’s Dolby Digital decoder, this parameter setting 
determines a level shift in the decoder that sets, or normalizes, the 
average audio output of the decoder to a preset level. This aids in 
matching audio volume between program sources. 

A proper setting of Dialogue Level ensures that the consumer receives a 
standard listening level, so switching channels or watching a program 
through the commercial breaks doesn’t require adjusting the volume. 
Using the same standard for all content, whether conveyed by broadcast 
television, DVD, or other media, enables the consumer to switch between 
sources and programs while maintaining a comfortable and consistent 
listening level. 

The proper setting of the Dialogue Level parameter also enables the 
Dynamic Range Control profiles chosen by the content producer to work as 
intended in less-than optimal listening environments, and is essential in 
any content production. 

Range -31 to -1 ( -27 default) 

Audio Production Information Indicates whether the mixing level and room type values are valid. If Yes, 
then a receiver or amplifier can use these values. If No, then the values in 
these fields are invalid. In practice, only high-end consumer equipment 
implements these features.  

Select from: 

• Audio production information exists 

• Audio production information does not exist 

Mix Level (dB SPL) Sets the Dolby acoustic sound pressure level used during final audio 
mixing. The Mix Level control is only active if the Audio Production Info 
control is enabled. 

Range 80 to 111 (105 default) 

Room Type Sets the type and calibration of the mixing room used for the final audio 
mixing session. The Room Type controls are only active if the Audio 
Production Info control is set to Yes. 

Select from: 

• Not Indicated 

• Large room, X-Curve monitor 

• Small room, flat monitor 

Copyright Bit Sets whether the encoded bitstream is copyright protected. It has no 
effect on Dolby decoders and its purpose is purely to provide information. 

Select from: 

• Copyright protected 

• Not Copyright protected 
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Original Bitstream Sets whether the encoded Dolby bitstream is the master version or a copy. 
It has no effect on Dolby decoders and its purpose is purely to provide 
information. 

Select from: 

• No 

• Yes 

Extended Bitstream 
Information Present 

Dolby E encoders always transmit Extended Bitstream Information values. 

Preferred Stereo Downmix 
Mode 

Specifies the preferred downmix to be used by a decoder with fewer 
speakers than the number of encoded channels.  

Select from:  

• Not Indicated (no preference specified during the encoding process) 

• Lt/Rt downmix preferred (the decoder should favor Left total/Right total 
or “Pro Logic” downmix) 

• Lo/Ro downmix preferred (the decoder should favor a Left only/Right 
only “simple stereo” or mono downmix).  

This control is enabled when Extended Bitstream Information is set to 
Enable and Coding Mode is greater than 2-0. 

Lt/Rt Center Mix Level Sets the center mix levels for Left total/Right total downmixing. 

Lt/Rt Surround Mix Level Sets the surround mix levels for Left total/Right total downmixing. 

Lt/Ro Center Mix Level Sets the Extended Lo-Ro (Left-Only/Right Only) Center Mix levels to 3.0 dB, 
1.5 dB, 0.0 dB, -1.5 dB, -3.0 dB, -4.5 dB, -6.0 dB, and -Inf dB 

Lt/Ro Surround Mix Level Sets the Extended Lo-Ro (Left-Only/Right Only) Surround Mix levels to 3.0 
dB, 1.5 dB, 0.0 dB, -1.5 dB, -3.0 dB, -4.5 dB, -6.0 dB, and -Inf dB 

Dolby Digital Surround EX 
Mode 

Indicates if multiple surround channel audio signals have been encoded 
with Extended Dolby Digital Surround EX Mode. 

Select from: 

• Not Dolby Digital Surround EX encoded 

• Dolby Digital Surround EX encoded 

• No Indication 

Dolby Headphone Mode Select from: 

• Not Dolby Headphone encoded 

• Digital Headphone encoded 

• No Indication 

A/D Converter Type Allows audio that has passed through a particular A/D conversion stage to 
be marked as such, so that a decoder may apply the complementary D/A 
process. 

Select from: 

• Standard 

• HDCD 
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Highpass Filter Determines whether a DC-blocking 3 Hz highpass filter is applied to the 
main input channels of a Dolby encoder prior to encoding. This parameter 
is not carried to the consumer decoder. It is used to remove DC offsets in 
the program audio and would only be switched off in exceptional 
circumstances. 

Select from: 

• Filter enabled 

• Filter not enabled 

Bandwdth Lowpass Filter Determines whether a lowpass filter is applied to the main input channels 
of a Dolby encoder prior to encoding. This filter removes high frequency 
signals that are not encoded. At the suitable data rates, this filter operates 
above 20 kHz. In all cases it prevents aliasing on decoding and is normally 
switched on. This parameter is not passed to the consumer decoder. 

Select from: 

• Filter enabled (default) 

• Filter not enabled 

LFE Channel Lowpass Filter This parameter determines whether a 120 Hz eighth-order lowpass filter is 
applied to the LFE channel input of a Dolby Digital encoder prior to 
encoding. It is ignored if the LFE channel is disabled. This parameter is not 
sent to the consumer decoder. The filter removes frequencies above 120 
Hz that would cause aliasing when decoded. 

This filter should only be switched off if the audio to be encoded is known 
to have no signal above 120 Hz. 

Select from: 

• Filter enabled (default) 

• Filter not enabled 

Surround Channel 90-degree 
Phase Shift Filter 

Enables a 90 degree phase shift to the surround channel(s).  

Select from: 

• Filter enabled (default) 

• Filter not enabled 

Surround Attenuation Enables the encoder’s 3 dB attenuation of the surround channel(s). 
Disabled by default. 

Select from: 

• Not enabled 

• Enabled 
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RF Mode Dynamic Range 
Compression Profile 

Select one of six standard dynamic range control profiles used by the 
decoder when producing an output that is suitable for inclusion in an RF 
signal (NTSC baseband). 

Select from: 

• Film Standard 

• Film Light 

• Music Standard 

• Music Light 

• Speech 

Line Mode Dynamic Range 
Compression Profile 

Selects one of six standard dynamic range control profiles to be used by 
the decoder when producing line-out audio. 

Select from: 

• Film Standard 

• Film Light 

• Music Standard 

• Music Light 

• Speech 

Dolby Surround Mode Specifies if the program is a Dolby surround encoded stream. Select from: 

• Not Indicated 

• Not Dolby Surround Encoded 

• Dolby Surround Encoded 
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AAP Tab: Parameters (Dolby E Decoder)  

These sections are displayed if Dolby E Decoder is selected. 

Dolby E Decoder Status 

Dolby E Frame Rate Frame rate of the incoming Dolby E stream 

Dolby E Frame Bit Depth Number of bits per word used to carry the Dolby E stream 

Program Configuration The Program configuration used by the Dolby E frame 

Dolby E Decoder Metadata Status per Program  

Program The Program for which to display metadata status. 

Data Rate(kbps) The data rate used to encode the bitstream associated with the specific 
program. 

Bitstream Mode The mode of the bitstream associated with the program. 

Audio Coding Mode The audio coding mode of the bitstream associated with the program. 

Center Level Mix The center mix level of the bitstream associated with the program. 

Surround Mix Level The suround mix level of the bitstream associated with the program. 

Dolby Surround Mode Indicates if the program is a Dolby Surround encoded stream. 

LFE Channel Indicates whether an LFE (Low Frequency Effects) Channel is present 
within the bitstream. 

Dialogue Normalization The dialnorm level set. 

Audio Production Information Indicates if audio production information exists. 

Mix Level (dB SPL) The mix level set. 

Room Type The room type set. 

Copyright Bit Indicates if the encoded Dolby Digital bitstream is copyright protected. 

Original Bitstream Indicates if the encoded Dolby Digital bitstream is the master version or a 
copy.  

Extended Bitstream 
Information Present 

 Indicates if Extended Bitstream Information is present. 

Preferred Stereo Downmix 
Mode 

The selected stereo downmix mode. 

Lt/Rt Center Mix Level The downmix level of the center channel with respect to the left and right 
channels in an Lt/Rt downmix. 

Lt/Rt Surround Mix Level The downmix level of the surround channels with respect to the left and 
right channels in an Lt/Rt downmix. 

Lt/Ro Center Mix Level The downmix level of the center channel with respect to the left and right 
channels in an Lo/Ro downmix. 
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Lt/Ro Surround Mix Level The downmix level of the surround channels with respect to the left and 
right channels in an Lo/Ro downmix. 

Dolby Digital Surround EX 
Mode 

Indicates if the signal was encoded with Extended Dolby Digital Surround 
EX Mode 

Dolby Headphone Mode Indicates if Dolby Headphone Mode was enabled. 

A/D Converter Type Indicates the type of A/D Converter used. 

Highpass Filter Indicates if Highpass Filter was enabled. 

Bandwdth Lowpass Filter Indicates if Bandwdth Lowpass Filter was enabled. 

LFE Channel Lowpass Filter Indicates if LFE Channel Lowpass Filter was enabled. 

Surround Channel 90-degree 
Phase Shift Filter 

Indicates if  90-degree Phase Shift was enabled. 

Surround Attenuation Indicates if Surround Attenuation was enabled. 

RF Overmodulation Protection 
Function 

Indicates whether RF Overmodulation Protection was used. 

RF Mode Dynamic Range 
Compression Profile 

The selected RF mode dynamic range control profile. 

Line Mode Dynamic Range 
Compression Profile 

The selected line mode dynamic range control profile. 

 

 

AAP Tab: Parameters (UpMix) 

The settings in this section apply to all audio channels in the selected processor.  

Implementation This parameter is currently set to DTS. 

Channel Configuration Select the output channel format. Options include: 

• 2.1 - L, R, LFE 

• 3.1 - L, R, C, LFE 

• 4.1 - L, R, Ls, Rs, LFE 

• 5.1 (default) - L, R, C, Ls, Rs, LFE 

• 6.1 - L, R, C, Ls, Rs, Cb, LFE 

• 7.1 -  L, R, C, Ls, Rs, Lb, Rb, LFE 

• Phantom 6.1 - L, R, Ls, Rs, Cb, LFE 

• Phantom 7.1 -  L, R, Ls, Rs, Lb, Rb, LFE 

Latency Select from: 

• Low Latency Mode  (default) 

• High Latency Mode 

DICE Process Level Set the amount of DICE Processing to apply. This parameter only applies 
when the Mode is set to Digital Music Mode.  

Range is 0 to 1 (default is 0.5). 
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Depth Set the amount of front to back bias to apply to the standard soundstage. 

Range is -1 to 1 (default is 0). 

Front Width Set the amount of widening or narrowing to perform on the front channels 

Range is -1 to 1 (default is 0). 

Surround Width Set the wideness of the surround channels. 

Range is  0 to 1 (default is 1). 

LFE Cutoff (Hz) Set the low pass cutoff frequency (Hz) of the LFE channel after the upmix 
process. Select from: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 

Final Limiters Ceiling (dB) Set the threshold in dB where final limiting on UpMix output occurs. 

Range is  -12 to 0 (default is 0). 
 

 

AAP Tab: Parameters (DownMix) 

The settings in this section apply to all audio channels in the selected processor.  

Implementation This parameter is currently set to DTS. 

L R Encoding Mode Select the encoding mode for left and right channels. Options include: 

• Phantom Center (default) 

• Hard Center 

LFE Cutoff Set the low pass cutoff frequency (Hz) of the LFE channel after the upmix 
process. Options are: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 

Final Limiters Ceiling (dB) Set the threshold in dB where final limiting on UpMix output occurs. 

Range is -20 to 0 (default is 0) 

Active Correction Select to enable correction to the DownMix ICLD, ICPD, and spectrum 
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AAP Tab: Parameters (MultiMerge) 

The settings in this section apply to all audio channels in the selected processor.  

Input Select 

Input Select Mode This parameter specified how input channels are selected. Select from the 
following: 

• Aux 2.0 and multi-channel inputs mixed (default) 

Mixes the auxiliary 2.0 inputs into the multichannel 5.1 inputs 

• Multi-channel inputs only 

Always uses the multichannel 5.1 inputs 

• 2.0 from multi-channel inputs only 

Uses the stereo L/R pair from the multichannel inputs 

• Aux 2.0 inputs only 

Always uses the auxiliary 2.0 inputs 

• Multi-channel inputs if detected, else Aux 2.0 inputs 

Uses multichannel 5.1 inputs if they are active, otherwise auxiliary 2.0 
inputs are used 

• 2.0 from multi-channel inputs if detected, else Aux 2.0 inputs 

Uses the stereo L/R pair from the multichannel inputs if they are active, 
if not, auxiliary 2.0 inputs are used 

• Aux 2.0 inputs if detected, else multi-channel inputs 

Uses the auxiliary 2.0 inputs if they are active, if not, the multichannel 
5.1 inputs are used 

• Multi-channel inputs if detected, or Aux 2.0 inputs if detected, else 2.0 
from multi-channel inputs 

Uses multichannel  inputs if they are active, or uses the auxiliary inputs 
if they are active. If neither is active, it uses the stereo L/R pair from the 
multichannel inputs 

Input Noise Floor Threshold 
(dB) 

Select the level of signal (in dB) required to detect a signal as active 

Range is -80 to -50 (default is -60) 

Input Cross Fade Time (ms) Select the speed (in msec) at which transitions from different Input 
Selection Modes occur. 

Range is 50 to 750 (default is 250) 

 MultiMerge 
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MultiMerge Mode Select the MultiMerge Output mix configuration. Options are: 

• Auto-detect, 2.0 to 5.1, ot 5.1 to 2.0 (default) 

Determines if content is stereo (2.0) or surround (5.1), and adapts to the 
correct UpMix/Passthrough mode for consistent 5.1 output. When in 
Auto, the Threshold parameter controls the noise floor level for the 
detection. Any content above this threshold on the surround channel 
inputs 3-6 (C, LFE, Ls, Rs) is considered surround and MultiMerge will be 
in passthrough mode. 

• Passthrough 

Dorces MultiMerge to always pass through 5.1 content to the 5.1 
outputs untouched, while creating a downmix for the Aux output. 

• Upmix 2.0 channels to 5.1 

Forces MultiMerge to always upmix stereo content on both of the 
Left/Right 5.1 inputs and the Aux 2.0 inputs. 

Input Noise Floor Threshold 
(dB) 

Select the level of signal (in dB) required to detect a signal as active 

Range is -80 to -50 (default is -60) 

Input Cross Fade Time (ms) Select the speed (in msec) at which transitions from different Input 
Selection Modes occur. 

Range is 50 to 750 (default is 250) 

Latency Specifies the latency profile of the multimerge. Select from: 

• Low Latency (default) 

• High Latency  

UpMix Depth Select the amount of front-to-back bias to apply to the standard 
soundstage. 

Range is -1 to 1 (default is 0) 

UpMix Front Width Select the amount of widening or narrowing to perform on the front 
channels. 

Range is -1 to 1 (default is 0). 

Upmix Surround Width Select the wideness of the surround channels. 

Range is 0 to 1 (default is 0). 

UpMix LFE Cutoff (Hz) Select the low pass cutoff frequency (Hz) of the LFE channel after the 
upmix process. Options are: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 
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Downmix LR Encoding Mode Select the encoding mode for left and right channels. Options are: 

• Phantom Center (default) 

• Hard Center 

Downmix LFE Cutoff (Hz) Select the low pass cutoff frequency (Hz) of the LFE channel before the 
downmix process. Options are: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 

Multimerge Final Limiters  
Ceiling (dB) 

Select the threshold (dB) where final limiting on 5.1 output occurs. 

Range is -20 to 0 (default is 0). 

Stereo Final Limiters Ceiling 
(dB) 

Select the threshold (dB) where final limiting on 2.0 output occurs. 

Range is -20 to 0 (default is 0). 
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AAP Tab: Parameters (Loudness Control) 

The settings in this section apply to all audio channels in the selected processor.  

Loudness Instance 
Select the loudness instance in cases where there is more than one 
loudness audio system.  

In case of: 

• Loudness 2x1.0 

• Loudness 8x1.0 

• Loudness 4x2.0 

• Loudness 5.1 + 2.0 

the first number represents the instances created, and Loudness 5.1 + 
2.0 has 2 instances - one for stereo and one for surround. 

For example, Loudness 4x2.0 has 4 stereo instances, so select each one 
from the  dropdown list to configure. 

 

Each instance will have its own settings of the parameters listed 
below. 

Implementation The implementation is currently set to DTS. 

Bypass the processing block Indicates whether or not to bypass the loudness control algorithm and 
this CODEC will behave as a delay only. 

LMS Type Specifies the type of loudness measurement to make prior to 
performing loudness control. Options are: 

• NLM (default) 

• LEQ_1770 

Target Loudness (dBEq) Select the target loudness level that the algorithm will attempt to 
achieve on output.  

Range is -40 to 0 (default is -24) 

Target Ratio  Controls the amount of gain or attenuation that is applied when 
loudness differences are measured.  
 
For example: A setting of 1.00 indicates that for every dB of loudness 
difference measured between the input signal and the target level, 1 
dB of gain or attenuation will be applied. For example, a setting of 0.50 
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indicates that for every dB of loudness difference measured between 
the input signal and the target level, 0.5 dB of gain or attenuation will 
be applied. 

Range is 0 to 1 (default is 1) 

Upper Loudness Threshold (dB) Represents the allowable distance above the Target Level the input 
signal can range before attenuation. If an input signal falls between 
the Upper Thresh and the Lower Thresh in reference to the Target 
Level, no correction will be applied. 

For example: A setting of +4dB indicates that audio content can range 
4 dB above the Target Level before attenuation is applied. Content 
arriving louder than 4 dB above the Target will be appropriately 
attenuated. 

-27 dBFS (Target) + 4 dBFS (Upper Thresh) = -23 dBFS (Upper Thresh 
Value) 

For example: A setting of 0 dB indicates that attenuation will be 
applied to any input signal exceeding the Target Level. 

Range is 0 to 20 (default is 1) 

Lower Loudness Threshold (dB) The Lower Threshold parameter represents the distance below the 
Target Level the input signal can range before gain is applied. If an 
input signal falls between the Upper Thresh and the Lower Thresh in 
reference to the Target Level, no correction will be applied. 

For example: A setting of -5 dB indicates that audio content can range 
5 dB below the target level before gain is applied. Content arriving 
quieter than 5 dB below the Target will be appropriately raised. 

-27 dBFS (Target) + -5 dBFS (Lower Thresh) = -31 dBFS (Lower Thresh 
Value) 

For example: A setting of 0 indicates that gain will be applied to any 
input signal falling below the Target Level. 

Range is -20 to 0 (default is -1) 

Freeze Window (dB) Sets the size of a window in dB where small loudness differences that 
fall within this window are deemed allowable. When loudness 
differences fall outside of this 

allowable window then appropriate gain or attenuation is applied to 
control loudness. The Freeze Window parameter can be effectively 
used to limit the amount of small range gain variability. 

For example: A window setting of 4 dB indicates that when the 
loudness level is measuring within ±2 dB of the target level that no 
further correction is required. When the loudness level becomes 
further than ±2 dB from the target level then appropriate gain or 
attenuation is applied. 

Range is 0 to 10 (default is 1) 
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Quiet Threshold (dB) Prevents increasing the noise floor level. Input signals below the 
threshold are considered too low and are not managed by the 
loudness processing to avoid bringing up the noise level. Input signals 
above the Noise Floor are considered valid and are managed by the 
loudness processing. 

Range is -80 to -20 (default is -40) 

Attack (ms) Controls how quickly the processing will respond to sharp onsets in 
loudness level. Note: A compressor is present after the attack time 
processing to catch any short-term loudness peaks which may pass 
through. 

Range is 5 to 150 (default is 40) 

Release (ms) Controls how quickly the processing will respond to sharp drops in 
loudness level. 

Range is 20 to 500 (default is 120) 

Compressor Threshold (dB) A compressor is present to catch any short-term loudness peaks which 
aren't fully captured by the attack time processing of Loudness 
Control. The compressor threshold parameter is set as the allowable 
short-term peak above the Target Level. 

Range is 0 to 16 (default is 2) 

Compressor Ratio Controls the amount of attenuation that is applied when short-term 
peaks exceed the compressor threshold. 

Range is 0 to 1 (default is 0.5) 

Loudness Shaping Specifies the amount of loudness shaping desired. A value of zero is no 
loudness shaping. 

Range is 0 to 1 (default is 0.5) 

Final Limiter Ceiling (dBFS) A final limiter is present to control the absolute waveform peak level 
for the stereo output. This parameter controls the output peak level in 
dBFS. A value of zero disables limiter. 

Range is -20 to 0 (default is 0) 

Run Final Limiters Select this parameter for final limiters to be applied according to the 
value of the Final Limiter Ceiling (dBFS) parameter. 

Metering Enable Select this parameter to activate real-time meter values in the status 
output. Turning on metering will consume a small amount of DSP 
resources. 
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AAP Tab: Parameters (UpMix+Loudness Control) 

The settings in this section apply to all audio channels in the selected processor.  

Implementation This parameter is currently set to DTS. 

Channel Configuration Select the output channel format. Options include: 

• 2.1 - L, R, LFE 

• 3.1 - L, R, C, LFE 

• 4.1 - L, R, Ls, Rs, LFE 

• 5.1 (default) - L, R, C, Ls, Rs, LFE 

• 6.1 - L, R, C, Ls, Rs, Cb, LFE 

• 7.1 -  L, R, C, Ls, Rs, Lb, Rb, LFE 

• Phantom 6.1 - L, R, Ls, Rs, Cb, LFE 

• Phantom 7.1 -  L, R, Ls, Rs, Lb, Rb, LFE 

Latency Select from: 

• Low Latency Mode  (default) 

• High Latency Mode 

DICE Process Level Set the amount of DICE Processing to apply. This parameter only applies 
when the Mode is set to Digital Music Mode.  

Range is 0 to 1 (default is 0.5). 

Depth Set the amount of front to back bias to apply to the standard soundstage. 

Range is -1 to 1 (default is 0). 

Front Width Set the amount of widening or narrowing to perform on the front channels 

Range is -1 to 1 (default is 0). 

Surround Width Set the wideness of the surround channels. 

Range is  0 to 1 (default is 1). 

LFE Cutoff (Hz) Set the low pass cutoff frequency (Hz) of the LFE channel after the upmix 
process. Select from: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 

Final Limiters Ceiling (dB) Set the threshold in dB where final limiting on UpMix output occurs. 

Range is  -12 to 0 (default is 0). 

Bypass the processing block Indicates whether or not to bypass the loudness control algorithm and this 
CODEC will behave as a delay only. 

Implementation This parameter is currently set to DTS. 
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LMS Type Specifies the type of loudness measurement to make prior to performing 
loudness control. Options are: 

• NLM (default) 

• LEQ_1770 

Target Loudness (dBEq) Select the target loudness level that the algorithm will attempt to achieve 
on output.  

Range is -40 to 0 (default is -24) 

Target Ratio Controls the amount of gain or attenuation that is applied when loudness 
differences are measured.  
 
For example: A setting of 1.00 indicates that for every dB of loudness 
difference measured between the input signal and the target level, 1 dB of 
gain or attenuation will be applied. For example, a setting of 0.50 indicates 
that for every dB of loudness difference measured between the input 
signal and the target level, 0.5 dB of gain or attenuation will be applied. 

Range is 0 to 1 (default is 1) 

Upper Loudness Threshold 
(dB) 

Represents the allowable distance above the Target Level the input signal 
can range before attenuation. If an input signal falls between the Upper 
Thresh and the Lower Thresh in reference to the Target Level, no 
correction will be applied. 

For example: A setting of +4dB indicates that audio content can range 4 dB 
above the Target Level before attenuation is applied. Content arriving 
louder than 4 dB above the Target will be appropriately attenuated. 

-27 dBFS (Target) + 4 dBFS (Upper Thresh) = -23 dBFS (Upper Thresh Value) 

For example: A setting of 0 dB indicates that attenuation will be applied to 
any input signal exceeding the Target Level. 

Range is 0 to 20 (default is 1) 

Lower Loudness Threshold 
(dB) 

The Lower Threshold parameter represents the distance below the Target 
Level the input signal can range before gain is applied. If an input signal 
falls between the Upper Thresh and the Lower Thresh in reference to the 
Target Level, no correction will be applied. 

For example: A setting of -5 dB indicates that audio content can range 5 dB 
below the target level before gain is applied. Content arriving quieter than 
5 dB below the Target will be appropriately raised. 

-27 dBFS (Target) + -5 dBFS (Lower Thresh) = -31 dBFS (Lower Thresh 
Value) 

For example: A setting of 0 indicates that gain will be applied to any input 
signal falling below the Target Level. 

Range is -20 to 0 (default is -1) 

Freeze Window (dB) Sets the size of a window in dB where small loudness differences that fall 
within this window are deemed allowable. When loudness differences fall 
outside of this 
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allowable window then appropriate gain or attenuation is applied to 
control loudness. The Freeze Window parameter can be effectively used to 
limit the amount of small range gain variability. 

For example: A window setting of 4 dB indicates that when the loudness 
level is measuring within ±2 dB of the target level that no further 
correction is required. When the loudness level becomes further than ±2 
dB from the target level then appropriate gain or attenuation is applied. 

Range is 0 to 10 (default is 1) 

Quiet Threshold (dBEq) Prevents increasing the noise floor level. Input signals below the threshold 
are considered too low and are not managed by the loudness processing 
to avoid bringing up the noise level. Input signals above the Noise Floor are 
considered valid and are managed by the loudness processing. 

Range is -80 to -20 (default is -40) 

Attack Controls how quickly the processing will respond to sharp onsets in 
loudness level. Note: A compressor is present after the attack time 
processing to catch any short-term loudness peaks which may pass 
through. 

Range is 5 to 150 (default is 40) 

Release Controls how quickly the processing will respond to sharp drops in 
loudness level. 

Range is 20 to 500 (default is 120) 

Compressor Threshold A compressor is present to catch any short-term loudness peaks which 
aren't fully captured by the attack time processing of Loudness Control. 
The compressor threshold parameter is set as the allowable short-term 
peak above the Target Level. 

Range is 0 to 16 (default is 2) 

Compressor Ratio Controls the amount of attenuation that is applied when short-term peaks 
exceed the compressor threshold. 

Range is 0 to 1 (default is 0.5) 

Loudness Shaping Specifies the amount of loudness shaping desired. A value of zero is no 
loudness shaping. 

Range is 0 to 1 (default is 0.5) 

Final Limiter Ceiling (dBFS) A final limiter is present to control the absolute waveform peak level for 
the stereo output. This parameter controls the output peak level in dBFS. A 
value of zero disables limiter. 

Range is -20 to 0 (default is 0) 

Run Final Limiters Select this parameter for final limiters to be applied according to the value 
of the Final Limiter Ceiling (dBFS) parameter. 

Metering Enable Select this parameter to activate real-time meter values in the status 
output. Turning on metering will consume a small amount of DSP 
resources. 
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AAP Tab: Parameters (DownMix+Loudness Control) 

The settings in this section apply to all audio channels in the selected processor.  

Implementation This parameter is currently set to DTS. 

L R Encoding Mode Select the encoding mode for left and right channels. Options include: 

• Phantom Center (default) 

• Hard Center 

LFE Cutoff Set the low pass cutoff frequency (Hz) of the LFE channel after the upmix 
process. Options are: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 

Final Limiters Ceiling (dB) Set the threshold in dB where final limiting on UpMix output occurs. 

Range is -20 to 0 (default is 0) 

Active Correction Select to enable correction to the DownMix ICLD, ICPD, and spectrum 

Bypass the processing block Indicates whether or not to bypass the loudness control algorithm and this 
CODEC will behave as a delay only. 

Implementation This parameter is currently set to DTS. 

LMS Type Specifies the type of loudness measurement to make prior to performing 
loudness control. Options are: 

• NLM (default) 

• LEQ_1770 

Target Loudness (dBEq) Select the target loudness level that the algorithm will attempt to achieve 
on output.  

Range is -40 to 0 (default is -24) 

Target Ratio Controls the amount of gain or attenuation that is applied when loudness 
differences are measured.  
 
For example: A setting of 1.00 indicates that for every dB of loudness 
difference measured between the input signal and the target level, 1 dB of 
gain or attenuation will be applied. For example, a setting of 0.50 indicates 
that for every dB of loudness difference measured between the input 
signal and the target level, 0.5 dB of gain or attenuation will be applied. 

Range is 0 to 1 (default is 1) 
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Upper Loudness Threshold 
(dB) 

Represents the allowable distance above the Target Level the input signal 
can range before attenuation. If an input signal falls between the Upper 
Thresh and the Lower Thresh in reference to the Target Level, no 
correction will be applied. 

For example: A setting of +4dB indicates that audio content can range 4 dB 
above the Target Level before attenuation is applied. Content arriving 
louder than 4 dB above the Target will be appropriately attenuated. 

-27 dBFS (Target) + 4 dBFS (Upper Thresh) = -23 dBFS (Upper Thresh Value) 

For example: A setting of 0 dB indicates that attenuation will be applied to 
any input signal exceeding the Target Level. 

Range is 0 to 20 (default is 1) 

Lower Loudness Threshold 
(dB) 

The Lower Threshold parameter represents the distance below the Target 
Level the input signal can range before gain is applied. If an input signal 
falls between the Upper Thresh and the Lower Thresh in reference to the 
Target Level, no correction will be applied. 

For example: A setting of -5 dB indicates that audio content can range 5 dB 
below the target level before gain is applied. Content arriving quieter than 
5 dB below the Target will be appropriately raised. 

-27 dBFS (Target) + -5 dBFS (Lower Thresh) = -31 dBFS (Lower Thresh 
Value) 

For example: A setting of 0 indicates that gain will be applied to any input 
signal falling below the Target Level. 

Range is -20 to 0 (default is -1) 

Freeze Window (dB) Sets the size of a window in dB where small loudness differences that fall 
within this window are deemed allowable. When loudness differences fall 
outside of this 

allowable window then appropriate gain or attenuation is applied to 
control loudness. The Freeze Window parameter can be effectively used to 
limit the amount of small range gain variability. 

For example: A window setting of 4 dB indicates that when the loudness 
level is measuring within ±2 dB of the target level that no further 
correction is required. When the loudness level becomes further than ±2 
dB from the target level then appropriate gain or attenuation is applied. 

Range is 0 to 10 (default is 1) 

Quiet Threshold (dBEq) Prevents increasing the noise floor level. Input signals below the threshold 
are considered too low and are not managed by the loudness processing 
to avoid bringing up the noise level. Input signals above the Noise Floor are 
considered valid and are managed by the loudness processing. 

Range is -80 to -20 (default is -40) 
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Attack Controls how quickly the processing will respond to sharp onsets in 
loudness level. Note: A compressor is present after the attack time 
processing to catch any short-term loudness peaks which may pass 
through. 

Range is 5 to 150 (default is 40) 

Release Controls how quickly the processing will respond to sharp drops in 
loudness level. 

Range is 20 to 500 (default is 120) 

Compressor Threshold A compressor is present to catch any short-term loudness peaks which 
aren't fully captured by the attack time processing of Loudness Control. 
The compressor threshold parameter is set as the allowable short-term 
peak above the Target Level. 

Range is 0 to 16 (default is 2) 

Compressor Ratio Controls the amount of attenuation that is applied when short-term peaks 
exceed the compressor threshold. 

Range is 0 to 1 (default is 0.5) 

Loudness Shaping Specifies the amount of loudness shaping desired. A value of zero is no 
loudness shaping. 

Range is 0 to 1 (default is 0.5) 

Final Limiter Ceiling (dBFS) A final limiter is present to control the absolute waveform peak level for 
the stereo output. This parameter controls the output peak level in dBFS. A 
value of zero disables limiter. 

Range is -20 to 0 (default is 0) 

Run Final Limiters Select this parameter for final limiters to be applied according to the value 
of the Final Limiter Ceiling (dBFS) parameter. 

Metering Enable Select this parameter to activate real-time meter values in the status 
output. Select this parameter to activate real-time meter values in the 
status output. Turning on metering will consume a small amount of DSP 
resources. 
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AAP Tab: Parameters (MultiMergeMix+Loudness Control) 

The settings in this section apply to all audio channels in the selected processor.  

Input Select 

Input Select Mode This parameter specified how input channels are selected. Select from the 
following: 

• Aux 2.0 and multi-channel inputs mixed (default) 

Mixes the auxiliary 2.0 inputs into the multichannel 5.1 inputs 

• Multi-channel inputs only 

Always uses the multichannel 5.1 inputs 

• 2.0 from multi-channel inputs only 

Uses the stereo L/R pair from the multichannel inputs 

• Aux 2.0 inputs only 

Always uses the auxiliary 2.0 inputs 

• Multi-channel inputs if detected, else Aux 2.0 inputs 

Uses multichannel 5.1 inputs if they are active, otherwise auxiliary 2.0 
inputs are used 

• 2.0 from multi-channel inputs if detected, else Aux 2.0 inputs 

Uses the stereo L/R pair from the multichannel inputs if they are active, 
if not, auxiliary 2.0 inputs are used 

• Aux 2.0 inputs if detected, else multi-channel inputs 

Uses the auxiliary 2.0 inputs if they are active, if not, the multichannel 
5.1 inputs are used 

• Multi-channel inputs if detected, or Aux 2.0 inputs if detected, else 2.0 
from multi-channel inputs 

Uses multichannel  inputs if they are active, or uses the auxiliary inputs 
if they are active. If neither is active, it uses the stereo L/R pair from the 
multichannel inputs 

Input Noise Floor Threshold 
(dB) 

Select the level of signal (in dB) required to detect a signal as active 

Range is -80 to -50 (default is -60) 

Input Cross Fade Time (ms) Select the speed (in msec) at which transitions from different Input 
Selection Modes occur. 

Range is 50 to 750 (default is 250) 

 MultiMerge 
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MultiMerge Mode Select the MultiMerge Output mix configuration. Options are: 

• Auto-detect, 2.0 to 5.1, ot 5.1 to 2.0 (default) 

Determines if content is stereo (2.0) or surround (5.1), and adapts to the 
correct UpMix/Passthrough mode for consistent 5.1 output. When in 
Auto, the Threshold parameter controls the noise floor level for the 
detection. Any content above this threshold on the surround channel 
inputs 3-6 (C, LFE, Ls, Rs) is considered surround and MultiMerge will be 
in passthrough mode. 

• Passthrough 

Dorces MultiMerge to always pass through 5.1 content to the 5.1 
outputs untouched, while creating a downmix for the Aux output. 

• Upmix 2.0 channels to 5.1 

Forces MultiMerge to always upmix stereo content on both of the 
Left/Right 5.1 inputs and the Aux 2.0 inputs. 

Input Noise Floor Threshold 
(dB) 

Select the level of signal (in dB) required to detect a signal as active 

Range is -80 to -50 (default is -60) 

Input Cross Fade Time (ms) Select the speed (in msec) at which transitions from different Input 
Selection Modes occur. 

Range is 50 to 750 (default is 250) 

Latency Specifies the latency profile of the multimerge. Select from: 

• Low Latency (default) 

• High Latency  

UpMix Depth Select the amount of front-to-back bias to apply to the standard 
soundstage. 

Range is -1 to 1 (default is 0) 

UpMix Front Width Select the amount of widening or narrowing to perform on the front 
channels. 

Range is -1 to 1 (default is 0). 

Upmix Surround Width Select the wideness of the surround channels. 

Range is 0 to 1 (default is 0). 

UpMix LFE Cutoff Select the low pass cutoff frequency (Hz) of the LFE channel after the 
upmix process. Options are: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 

Downmix LR Encoding Mode Select the encoding mode for left and right channels. Options are: 

• Phantom Center (default) 

• Hard Center 
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Downmix LFE Cutoff (Hz) Select the low pass cutoff frequency (Hz) of the LFE channel before the 
downmix process. Options are: 

• 0 

• 60 

• 80 (default) 

• 100 

• 120 

• 140 

Multimerge Final Limiters 
Ceiling (dB) 

Select the threshold (dB) where final limiting on 5.1 output occurs. 

Range is -20 to 0 (default is 0). 

Stereo Final Limiters Ceiling 
(dB) 

Select the threshold (dB) where final limiting on 2.0 output occurs. 

Range is -20 to 0 (default is 0). 

Bypass the processing block Indicates whether or not to bypass the loudness control algorithm and this 
CODEC will behave as a delay only. 

Implementation This parameter is currently set to DTS. 

LMS Type Specifies the type of loudness measurement to make prior to performing 
loudness control. Options are: 

• NLM (default) 

• LEQ_1770 

Target Loudness (dBEq) Select the target loudness level that the algorithm will attempt to achieve 
on output.  

Range is -40 to 0 (default is -24) 

Target Ratio Controls the amount of gain or attenuation that is applied when loudness 
differences are measured.  
 
For example: A setting of 1.00 indicates that for every dB of loudness 
difference measured between the input signal and the target level, 1 dB of 
gain or attenuation will be applied. For example, a setting of 0.50 indicates 
that for every dB of loudness difference measured between the input 
signal and the target level, 0.5 dB of gain or attenuation will be applied. 

Range is 0 to 1 (default is 1) 
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Upper Loudness Threshold 
(dB) 

Represents the allowable distance above the Target Level the input signal 
can range before attenuation. If an input signal falls between the Upper 
Thresh and the Lower Thresh in reference to the Target Level, no 
correction will be applied. 

For example: A setting of +4dB indicates that audio content can range 4 dB 
above the Target Level before attenuation is applied. Content arriving 
louder than 4 dB above the Target will be appropriately attenuated. 

-27 dBFS (Target) + 4 dBFS (Upper Thresh) = -23 dBFS (Upper Thresh Value) 

For example: A setting of 0 dB indicates that attenuation will be applied to 
any input signal exceeding the Target Level. 

Range is 0 to 20 (default is 1) 

Lower Loudness Threshold 
(dB) 

The Lower Threshold parameter represents the distance below the Target 
Level the input signal can range before gain is applied. If an input signal 
falls between the Upper Thresh and the Lower Thresh in reference to the 
Target Level, no correction will be applied. 

For example: A setting of -5 dB indicates that audio content can range 5 dB 
below the target level before gain is applied. Content arriving quieter than 
5 dB below the Target will be appropriately raised. 

-27 dBFS (Target) + -5 dBFS (Lower Thresh) = -31 dBFS (Lower Thresh 
Value) 

For example: A setting of 0 indicates that gain will be applied to any input 
signal falling below the Target Level. 

Range is -20 to 0 (default is -1) 

Freeze Window (dB) Sets the size of a window in dB where small loudness differences that fall 
within this window are deemed allowable. When loudness differences fall 
outside of this 

allowable window then appropriate gain or attenuation is applied to 
control loudness. The Freeze Window parameter can be effectively used to 
limit the amount of small range gain variability. 

For example: A window setting of 4 dB indicates that when the loudness 
level is measuring within ±2 dB of the target level that no further 
correction is required. When the loudness level becomes further than ±2 
dB from the target level then appropriate gain or attenuation is applied. 

Range is 0 to 10 (default is 1) 

Quiet Threshold (dBEq) Prevents increasing the noise floor level. Input signals below the threshold 
are considered too low and are not managed by the loudness processing 
to avoid bringing up the noise level. Input signals above the Noise Floor are 
considered valid and are managed by the loudness processing. 

Range is -80 to -20 (default is -40) 
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Attack Controls how quickly the processing will respond to sharp onsets in 
loudness level. Note: A compressor is present after the attack time 
processing to catch any short-term loudness peaks which may pass 
through. 

Range is 5 to 150 (default is 40) 

Release Controls how quickly the processing will respond to sharp drops in 
loudness level. 

Range is 20 to 500 (default is 120) 

Compressor Threshold A compressor is present to catch any short-term loudness peaks which 
aren't fully captured by the attack time processing of Loudness Control. 
The compressor threshold parameter is set as the allowable short-term 
peak above the Target Level. 

Range is 0 to 16 (default is 2) 

Compressor Ratio Controls the amount of attenuation that is applied when short-term peaks 
exceed the compressor threshold. 

Range is 0 to 1 (default is 0.5) 

Loudness Shaping Specifies the amount of loudness shaping desired. A value of zero is no 
loudness shaping. 

Range is 0 to 1 (default is 0.5) 

Final Limiter Ceiling (dBFS) A final limiter is present to control the absolute waveform peak level for 
the stereo output. This parameter controls the output peak level in dBFS. A 
value of zero disables limiter. 

Range is -20 to 0 (default is 0) 

Run Final Limiters Select this parameter for final limiters to be applied according to the value 
of the Final Limiter Ceiling (dBFS) parameter. 

Metering Enable Select this parameter to activate real-time meter values in the status 
output. Select this parameter to activate real-time meter values in the 
status output. Turning on metering will consume a small amount of DSP 
resources. 

Once metering is enabled, status shows below. 
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Program Configuration: Audio Tab 
This tab contains the following: 

In this Section 

Audio Tab: General Configuration ......................................................... 449 
Audio Tab: Program Configuration ........................................................ 450 
Audio Tab: Pair Configuration ................................................................ 450 
Audio Tab: Output Channel Configuration ............................................ 450 

 
 

Audio Tab: General Configuration 

The settings in this section apply to all audio channels in the selected processor.  

V-Bit Mute Enable Enables automatic muting of PCM outputs when the V-bit is set.  

Audio Fade Enable Enables audio V-fade (clean audio hotswitch). 

Audio Fade Time (s) Adjusts the audio fade rate, with a range of 0 to 10.000 seconds, and a 
default of .500 (half a second).  

Audio Fade Mute time (s) Adjusts the mute time during audio fade, with a range of .010 to 1 
seconds, and a default of .2 of a second.  

Dolby E header alignment Enables Dolby E header alignment processing as normal. 

Also see the Dolby E A/V Align parameter in Video Tab: Video Control (on 
page 405) 

Note: This parameter does not apply in case of the JPEG-XS Encoder 
personality. 

Dolby E Vid Std Select Choose a standard from the menu. Options include:  

Note: This parameter does not apply in case of the JPEG-XS Encoder 
personality. 

 • 525i/59.94 

• 625i/50 

• 720p/50 

• 720p/59.94 

• 1080i/50  

• 1080i/59.94  

• 1080p/23.98 

• 1080psf/23.98 

• 1080p/25 

• 1080p/29.97 

• 1080p/50  

• 1080p/59.94  

Dolby E Line Position  Each video standard has a pre-defined range and default. You can make a 
setting for each video standard, and that setting will apply to all programs 
and sections in the processor.  

Note: This parameter does not apply in case of the JPEG-XS Encoder 
personality. 
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Audio Tab: Program Configuration 
Note: These parameters do not appear when the Processor's mode is Multiviewer. 

Audio Tracking Mode This parameter makes it possible to independently delay the audio track 
separately from the video track, typically to correct delays added by other 
equipment or processing paths. Options are:  

• Off: Disables the Audio Tracking feature 

• Frame Sync: Adds delay from the video frame synchronization, plus 
delay added by the H-Phase and V-Phase parameters 

• Frame Sync + Delay: Adds delay from the video frame synchronization 
plus delay added by the H-Phase, V-Phase, and Frame Delay parameters  

 

 

Audio Tab: Pair Configuration 
Audio Pair Choose a pair to configure. Options are 1/2,3/4,5/6, 7/8, 9/10, 11/12, 

13/14, 15/16 . The following parameter will only affect the selected pair.  

Pair Word Length Adjusts the sample resolution for that audio pair, options are:  

• 24 bits (default)  

• 20 bits 

• 16 bits  
 

 

Audio Tab: Output Channel Configuration 
Note: These parameters do not appear when the Processor's mode is Multiviewer. 

Audio Processor Channel Selects the audio channel (APOUT), from 1 - 16. The rest of the controls on 
this page will then adjust that channel.  

Input Type Select Select the source input type to the Audio processor output channel. 
Options are: 

• APIN: These are the Audio Processor Input channels 

• EXP: These are the expanded MADI channels 

• TONES: These are the Tones 
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Input Channel Select Select the source input channel, within the type of source, to the Audio 
processor output channel. The options displayed here depend on what is 
selected in the Input Type Select field. 

• If  Input Type Select is APIN:  
Select a channel displayed in the "Section-Program-Channel" format. For 
example, 2-4: 12 refers to Section 2, program 4, channel 12. 

• If  Input Type Select is EXP:  
Select an expanded MADI channel from 1-128 

• If  Input Type Select is TONES:  
Select one of the following tones 

• 400 Hz 

• 1 kHz 

• 2 kHz 

• Mute 

Tones are @-20 dBFS 

Channel Gain Adjusts the gain of the selected audio channel.  

Note: This control is applied only if the audio data is PCM. 

Channel Invert Inverts the selected audio channel to correct for phase error.  

Note: This control is applied only if the audio data is PCM. 

Channel Mute Enables muting for the selected audio channel.  

Note: This control is applied only if the audio data is PCM. 

Channel Format Determines the format for the selected audio channel. Options include:  

• Auto 

• ST 2110-30 (PCM) 

• ST 2110-31 (Non-PCM) 

Channel Delay Determines the amount of delay to apply to the specified audio channel, 
with a range from 0 - 1000 ms.  

This parameter is unavailable when in Low Latency mode. See Configuring 
a Processor (on page 113). 
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Program Configuration: Output Tab 
There is always the option to output to IP. If the input is IP, then SDI output is automatically enabled. If 
the input is using the SDI connector, then the SDI output options, Output Tab: SDI (on page 453) and SDI 
Audio Embedder (Output Tab)  (on page 454) will not appear. This page indicates whether SFP output is 
enabled, but configuration for SFP output is handled elsewhere. See Configure SFPs (on page 115).  

IP output settings are always present on this tab. See the following topics:  

• Output Tab: IP Video Configuration (on page 454) 

• Output Tab: IP Video Status (on page 456) 

• Output Tab: IP Audio Configuration (on page 457) 

• Output Tab: IP Audio Status (on page 458) 

• Output Tab: IP Ancillary Data Configuration (on page 461) 

• Output Tab: IP Ancillary Data Status (on page 463) 

HD Proxy options also appear on this tab. See Output Tab: Proxy IP Video Configuration (on page 456) 
and Output Tab: Proxy IP Video Status (on page 457). HD Proxy video is always sent over IP.  

Note: When the Processor is configured for Multiviewer mode, the Output tab is only available for 
Program 1 of Section 1 and Program 1 of Section 2 of the "base" processor. Each section output 
configuration is associated with a display. Output tabs are not available on Multiviewer "extend" 
processors at all.  

 
 

Output Tab: Pixel Format 

This section does not appear when the Processor is configured for Multiviewer Mode.  

UHD Quad Output Pixel 
Format Select  

If the output is UHD, this selection determines how output video is 
interpreted:  

• Square Division 

• Pixel Interleave 

The Square Division option is only available when the Output Mode is SDI. 
This selection only has an effect when using Quad outputs; 12G is always 
Pixel Interleave.  

UHD Output Pixel Format 
Used  

This read-only parameter indicates what pixel format is being output:  

• Square Division 

• Pixel Interleave 
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Output Tab: SDI 
SDI Output Displays Enabled or Disabled.  

Shows as disabled in case of the JPEG-XS Encoder. 

SFP Output Displays Enabled if the output is configured. For non-HDMI SFPs, section 1 
outputs SFP output 1, and Section 2 outputs SFP output 2. For HDMI SFPs, both 
will output the same source, which can be selected on the VSFP Configuration 
page. See Configure SFPs (on page 115).  

VPID Output Determines whether and where VPID is output. Options are:  

• Auto 

• No VPID on HD, include VPID on other formats  

• No C VPID on any formats  

• No VPID on HD and no C VPID on any formats  

Note that VPID in the C data stream will be preceded by other ancillary data such 
as audio, etc. since it is the last embedder block in the chain. 

VPID Aspect Ratio select  If the hardcoded Aspect Ratio VPID is incorrect, you can override it. Options are:  

• 4:3_unknown: Sets the aspect ratio bit in the video payload identification byte 
to 0  

• 16:9: Sets the aspect ratio bit in the video payload identification byte to 1 

• Auto (Default): Sets the bit to the default selection based on the video format   

UHD Output Link Select  

 

Determines which SDI output to use. Options will vary depending on the 
processor's mode. 

Conversion/Sync/Remap/ 
JPEG-XS/MCL mode:  

• UHD (Quad Link) 

• UHD (Single Link) 

• UHD2 (12G Link 1) 

• UHD2 (12G Link 2) 

• UHD2 (12G Link 2) 

• UHD2 (12G Link 4) 

Multiviewer Mode:  

• UHD (2SI 4x 3G-SDI) 

• UHD (Single Link)  

Note: When the "UHD Output Link Select" is set to "UHD (Quad-Link)", then the 
Line number is tracked from the 3G equivalent standard.   

If configured otherwise (i.e. single link), then the line number is tracked from the 
actual 2160 standard. 

UHD (Quad Link): Normal UHD over four 3G signals 
UHD (Single Link): Normal UHD on a single 12G link 
UHD2 (12G Link 1): Signals the first link of an 8K quad 
UHD2 (12G Link 2): Signals the second link of an 8K quad 
UHD2 (12G Link 3): Signals the third link of an 8K quad 
UHD2 (12G Link 4): Signals the fourth link of an 8K quad 
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SDI Audio Embedder (Output Tab)  
Note: These options only appear when SDI output is enabled. They do not appear for the JPEG-XS 
Encoder personality, or when the Processor's mode is Multiviewer. 

General Config 

ADS Clean Clears the audio data space before embedding.  

Grp (1 - 4) Pair (1 - 2) Control Enables embedding of the selected pair in the audio group. By default all 
groups are enabled.  

General Status 

Grp (1 - 4) Append Error Read-only parameter that indicates whether there is an append error on 
the specified embedder group. 

Grp (1 - 4) OverWrite Error Read-only parameter that indicates whether there is an overwrite error on 
the specified embedder group.  

 

 

Output Tab: IP Video Configuration 
Video IP Transmitter Enable Enables this transmitter.  

Transmitter Mode Configures the operational mode of this transmitter. Options are:  

• ST 2110-20 

• ST 2022-6 (only available when the standard is HD; not supported for 
Multiviewers in this release) 

Note: In case of the JPEG-XS personality, Transmitter Mode is pre-set to 
ST2110-20. 

Packing Mode 
Note: This parameter is only available when the Transmitter Mode 
(above) is set to ST 2110-20. This parameter is not available for the JPEG-
XS personality. 

Select one of the following: 

• GPM (General packing mode) - This is the default. This packing mode is 
suitable for general applications of the ST 2110-20:2017 standard. 
When operating in this mode, the Line Continuation (“C”) bit may be 
used in order to pack samples from more than one sample row into the 
current packet, to avoid making packets that are too small.  

• BPM (Block packing mode) - This mode is a constrained subset of the 
General Packing Mode (GPM). When operating in this mode, the Line 
Continuation (‘C’) bit is used in order to pack samples from more than 
one sample row into the current packet, in order to maintain a 
consistent number of 180 octet blocks per packet. 

• GPMC0 - In this mode, the number of pixels per packet is such that 
there is an exact number of packets per line (no packets containing 
video data from adjacent video lines).  Therefore, the Continuation (C 
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bit) is not required. Pixels per packet are as follows: 

• UHD video and 1080p/1080i/1080psf video standards: 480 pixels per 
packet 

• 720p video standards: 320 pixels per packet 

• SD (525i/59.94 and 625i/50) video standards : 360 pixels per packet 

SD Extended Window Size Lets you adjust the height of the image. This backs up the beginning of 
the image to include vertical blanking. This parameter only matters in 
case of SD. Range is 0-16 lines.  

• The default of 0 encapsulates just the active image  

• To include ancillary data, enter the number of lines, for example, 
entering 10 extends the height of the image by 10 lines. In this case, 
the active picture plus the content from the vertical blanking will get 
encapsulated into 2110.  

• Closed Captions: If you leave the default height as 0, note that it does 
not include closed captions (on line 21 by default). Extend the video to 
include closed captions info in the active picture, and higher if you 
want to include any blanking.  

Also see Support for SD over 2110 (on page 309) 
This parameter is not available for the JPEG-XS personality. 
 

Important: When setting the “SD Extended Window Size” parameter to 
values greater than zero to include one or more lines from the VBI, please 
consider ancillary services present in those lines that will be received over 
the ST 2110-20 stream and make sure they do not conflict with any of the 
ancillary services received over ST 2110-40 streams. All the ancillary 
packets from the ST 2110-40 streams will be embedded into the baseband 
signal extracted from the ST 2110-20 stream into the target line, which 
could result in either  
a) overwriting an existing VBI service embedded as a waveform, or  
b) duplicating an existing ancillary packet. 

 

 

The following parameters appear twice, once each for Primary and Secondary.  

WAN Select Use this parameter to set the source WAN IP address for transmitting this 
IP Transmitter's data. Possible options are WAN 1 to WAN 4.  

This field also displays the IP address and VLAN defined in the Element's 
IP WAN menu.  

IP Address Set the address of the destination IP device. The IP address should be 
unique and within the range from 239.0.0.0 to 239.255.255.255 

UDP Port (User Datagram Protocol) Use this field to set the destination port 
number. The range is 1 to 65535.  
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Output Tab: IP Video Status 
Channel Bandwidth Status This read-only parameter reports if the channel is 

disabled due to bandwidth over-subscription.  

Primary Destination MAC 
Address 

This read-only parameter reports the MAC address of 
the receiver's primary SFP+ port. If no destination is 
using this IP Transmitter's Destination IP Address, the 
parameter reports the DST as unreachable. 

Secondary Destination MAC 
Address  

This read-only parameter reports the MAC address of 
the receiver's secondary SFP+ port. If no destination is 
using this IP Transmitter's Destination IP Address, the 
parameter reports the DST as unreachable. 

Starting Line Reports the picture starting line 

Note: This parameter is not available for the JPEG-XS 
personality. 

Picture Height Reports the picture height 

Note: This parameter is not available for the JPEG-XS 
personality. 

 
 

Output Tab: Proxy IP Video Configuration 

These settings are for the HD Proxy transmission channels.   

Proxy Video IP Transmitter 
Enable 

Enables this transmitter.  

Note: this parameter is only available when the SNP-PSK-DOWNHD (HD 
Downsample Feature) license is enabled for this program.  

Transmitter Mode Configures the operational mode of this transmitter. Options are: 

• ST 2110-20  

Packing Mode Selects either General packing mode (GPM), GPM0, or Byte packing mode 
(BPM). GPM is the default.  

The following parameters appear for Primary and Secondary.  

WAN Select Use this parameter to set the source WAN IP address for transmitting this 
IP Transmitter's data. Possible options are WAN 1 to WAN 4.  

This field also displays the IP address and VLAN defined in the Element's IP 
WAN menu.  

IP Address Set the address of the destination IP device.  

UDP Port (User Datagram Protocol) Use this field to set the destination port number. 
The range is 1 to 65535.  
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Output Tab: Proxy IP Video Status 

These settings are for the HD Proxy transmission channels. Parameters in this section appear for both 
Primary and Secondary.  

Channel Bandwidth Status Reports if the channel is disabled due to bandwidth over-subscription. 

Destination MAC Address  This read-only parameter reports the MAC address of the receiver's 
primary or secondary SFP+ port. If no destination is using this IP 
Transmitter's Destination IP Address, the parameter reports the DST 
unreachable.  

 
 

Output Tab: IP Audio Configuration 
Note: These parameters do not appear when the Processor's mode is Multiviewer. 

 

Audio Stream  Choose the audio stream (1 - 16) to configure. The rest of the parameters 
in this section will then apply to that stream.  

Audio IP Transmitter Enable Enables the audio IP transmitter for this stream.  

Transmitter Mode Configures the operational mode of the transmitter on this stream. 
Options include: 

• ST2110-30 

• ST2110-31 (Recommended when routing sources from a Dolby E 
Encoder) 

SDP Channel-Order Used for Controller clients like NMOS registries. Contains information on 
stream contents (stereo, 5.1, mono, etc.) that is propagated to clients.  

This is a text field, and you can enter any data you want to be propagated, 
that best describes your stream. Note that this string becomes part of the 
SDP, and while there is a specific syntax for the channel order string in the 
SDP, the SNP doesn't currently enforce it via the UI. But this is something 
to be aware of when using with a system where it matters. 

Bit Width Sets the sample bit width for this audio transmitter stream. Options are:  

• 16 bits  

• 24 bits  

• 32 bits (ST2110-31 only) 
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Packet Time This setting lets you define the audio packet time at a stream level. The 
audio packet time can also be defined at the processor level (see 
Configuring a Processor (on page 113)). Any stream level settings will apply 
for the stream in question (over the processor level setting). 

Ability to transmit audio streams with the following packet time options: 

• Default 

• 1 ms 

• 125 ms 

• 500 ms  

If Default is selected, the setting in the (Edit > Processor) Default Audio IP 
Tx Packet Time setting is used. 

The following parameters can be set for both Primary and Secondary.  

WAN Select Use this parameter to set the source WAN IP address for transmitting this 
IP Transmitter's data. Possible options are WAN 1 to WAN 4.  

This field also displays the IP address and VLAN defined in the Element's IP 
WAN menu.  

IP Address Set the address of the destination IP device.  

UDP Port (User Datagram Protocol) Use this field to set the destination port number. 
The range is 1 to 65535.  

Routing Control  

Number of Channels Determines the number of channels in this audio stream, which can be 
from 1 to 8. The default is 2. For ST2110-31, must be a multiple of 2.  

Channel Select (1-8) Selects the source for the specified audio channel in this RTP stream.  

If the processor has a RX MADI SFP configured, as described in MADI 
Support (on page 293), MADI channels X1 to X128 will appear in addition 
to the original 16 channel inputs.  

Note: There will be as many channels to select as Number of Channels 
defined above.  

 
 

Output Tab: IP Audio Status 
Note: These parameters don't appear when the Processor's mode is Multiviewer.  

Options in this section appear separately for Primary and Secondary.  

Destination MAC Address  This read-only parameter reports the MAC address of the receiver's 
primary or secondary SFP+ port. If no destination is using this IP 
Transmitter's Destination IP Address, the parameter reports the DST 
unreachable.  
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Output Tab: Program Ancillary Data Configuration 
This section only applies to Conversion personalities. 

 

CC/TT Enable Enables Closed Captions/Teletext ancillary data transmission 

CC/TT Line Number Set the horizontal scan line number that Closed Captions/Teletext is 
transmitted on 

WSS Enable Enables Wide Screen signaling ancillary data transmission 

WSS Line Number Set the horizontal scan line number that WSS is transmitted on. 

WSS Code Overrides the WSS code to transmit 

AFD Enable Enables Active Format Description ancillary data transmission 

AFD Line Number Sets the horizontal scan line number the AFD is transmitted on 

Range is 9 to 41 (23 is default) 

AFD Code Overrides the AFD data stream to transmit. Options include: 

• Pass 

• (4:3) 0000-UNDEF 

• (4:3) 0001-RSVD 

• (4:3) 0010-16:0 top 

• (4:3) 0011-14:9 top 

• (4:3) 0100-gt 16:9 

• (4:3) 0101-RSVD 

• (4:3) 0110-RSVD 

• (4:3) 0111-RSVD 

• (4:3) 1000-4:3 full 

• (4:3) 1001-4:3 full 

• (4:3) 1010-16:9 1 

• (4:3) 1011-14:9 1 

• (4:3) 1100-RSVD 

• (4:3) 1101-4:3 a 14:9 

• (4:3) 1110-16:9 la 14:9 

• (4:3) 1111-16:9 la 4:3 

• (16:9) 0000-UNDEF 

• (16:9) 0001-RSVD 

• (16:9) 0010-16:9 full 

• (16:9) 0011-14:9 cntr 

• (16:9) 0100-gt 16:9 

• (16:9) 0101-RSVD 

• (16:9) 0110-RSVD 

• (16:9) 0111-RSVD 

• (16:9) 1000-16:0 full 



Selenio™ Network Processor 

User Guide  Configuring Programs 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 460 

 

• (16:9) 1001-4:3 p 

• (16:9) 1010-16:9 prtctd 

• (16:9) 1011-14:9 p 

• (16:9) 1100-RSVD 

• (16:9) 1101-4:3 pa 14:9 

• (16:9) 1110-16:9 a 14:9 

• (16:9) 1111-16:9 a 4:3 

SCTE-104 Splicing Enable Enables SCTE-104 Splicing 

SCTE-104 Splicing Line 
Number 

Sets the horizontal scan line number the SCTE-14 splicing is transmitted 
on. 

Range is 9 to 41 (13 is default) 

SMPTE 2031 Enable Enables SMPTE 2031 ancillary data transmission 

SMPTE 2031 Line Number Sets the horizontal scan line number the SMPTE 2031 is transmitted on. 

Range is 9 to 41 (10 is default) 

ATC Enable Enables Ancillary Timecode 

ATC Line Number Sets the horizontal scan line number that the Ancillary Timecode is 
transmitted on 

Range is 9 to 41 (10 is default) 

ATC Ancillary Location Selects the location for embedding the Ancillary Timecode. Options 
include: 

• VANC 

• HANC 

ATC Embedding Mode Sets the mode for embedding Ancillary Timecode. Options include: 

• Copy 

• Generate LTC 

• Generate VITC 

ATC Drop Frame Enable Enables drop frame for Ancillary Timecode. 

ATC Hour Offset Sets the hour offset for the Ancillary Timecode. 

Range is -11 to 12 (0 is default) 
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Output Tab: Ancillary Data Configuration 

When enabled, the Source ID, if present in the incoming video is processed, and embedded into the SDI 
and/or 2022-6 output. The following parameters control Source ID processing: 

Source ID Enable Enables processing/passing of the source ID from input to output OR 
inserting it if absent. 

Source ID Line Number Sets the line on which the Source ID should be carried. The range depends 
on the Output standard, for example, in case of 1080p, the range is 9 to 41 
and the default is 15. 

Source ID Embedding Mode Options include: 

• Pass only: If present, the Source ID is passed through to the output. This 
is the default setting. 

• Pass or add User SID: If present, Source ID is passed through to the 
output. If not present, the string in the Source ID Data field will be used. 

• Force User SID: Source ID even if present, will be be overridden in the 
output by the string set in the Source ID Data field. 

Note that the Force User SID setting replaces the contents of identifier text 
in the packet, and not the line number. The Line number set in the Source 
ID Line Number setting will be effective only if there is no input source ID 
packet coming in. 

Source ID Data The string entered here overrides any identifier text present in the packet 
OR inserts it if there no incoming Source ID. 

 
 

Output Tab: IP Ancillary Data Configuration 
Note: These parameters don't appear when the Processor's mode is Multiviewer. 

Data Stream  Choose the data stream (1 - 4) to configure. The rest of the parameters in 
this section will then apply to that stream.  

The following parameters can be set for both Primary and Secondary.  

ANC Data IP Transmitter 
Enable 

Enables the data IP transmitter for this stream.  

WAN Select Use this parameter to set the source WAN IP address for transmitting this 
IP Transmitter's data. Possible options are WAN 1 to WAN 4.  

This field also displays the IP address and VLAN defined in the Element's IP 
WAN menu.  

IP Address Set the address of the destination IP device.  

UDP Port (User Datagram Protocol) Use this field to set the destination port number. 
The range is 1 to 65535.  
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Ancillary Data IP Filter (Remap and Sync modes) 

In Remap and Sync modes, there are four filters for each ANC channel. These filters allow you to choose 
specific Ancillary data to include or exclude. The rules for each filter are handled in a sequential manner 
from 1 to 4. 

By default, no ancillary data is passed through. In order to have any data to filter, you must first include 
something on Filter 1. This is why there is no Exclude option on Filter 1.  

Example: 

If you set the first filter to Include (Filter Rule) All (Service Select) on All Lines (Line Select), then set 
the second filter to Exclude (Filter Rule) Closed Captions (Service Select) on Line 21 (Specific Line), 
then the second filter will override the first and Line 21 closed captioning will be excluded but all 
other ancillary data will be passed through.  

 

Filter Number  Determines the filter you are currently modifying. There are four filters.  

Filter Rule Defines the function of the filter on the selected elements (below):  

• Exclude (only available for filters 2, 3, and 4; not available on Filter 1)  

• Include  

• Not Used 

Service Select This parameter is displayed when Filter Rule is set to Include. 
Selects the services the filter will apply to:  

• All (default for Filter 1, only available on Filter 1)  

• Active Format Description  

• Ancillary Time Code (default for Filter 2)  

• Closed Captions (EIA-708)  

Note: This option will also read EIA-608 data placed within the EIA-708 packet. 

• Dolby Audio Metadata  

• Film Codes  

• KLV Encoded Metadata  

• Payload Identification  

• Program Description  

• SCTE-104 Splicing  

• Broadcast Flag  

• Broadcast Alert System  

• Local IDentification Inserted Automatically  

• Teletext (OP-47) 

• SMPTE ST 2031 

Line Select Selects where the filter rule will be applied:  

• All Lines (default)  

• Specific Line 

Line Number This field only appears when Specific Line is selected above in the Line Select 
parameter. Choose the line the service is expected on.  
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Ancillary Data IP Filter (Conversion Mode) 

In Conversion mode, there is one data filter, and when applied to Data Stream 1, it is applied to the 
other data streams as well. 

Filter Rule Defines the function of the filter on the selected elements (below):  

• Include  

• Not Used 

Service Select Selects the services the filter will apply to:  

• Active Format Description 

• Closed Captions (EIA-708)  

Note: This option will also read EIA-608 data placed within the EIA-708 
packet. 

• Payload Identification 

• SCTE-104 Splicing 

• Teletext (OP-47)  

• SMPTE ST 2031 

Line Select Select where the filter rule will be applies, All Lines or Specific Line.  

Line Number Choose a number between 9-1125 (inclusive).  

Note: In addition to setting Ancillary Data for Tx mode, these settings also automatically embed 
captioning on SDI outputs.  
 

Output Tab: IP Ancillary Data Status 
Note: These parameters do not appear when the Processor's mode is Multiviewer. 

Options in this section appear separately for Primary and Secondary.  

Destination MAC Address  This read-only parameter reports the MAC address of the receiver's 
primary or secondary SFP+ port. If no destination is using this IP 
Transmitter's Destination IP Address, the parameter reports the DST 
unreachable.  

 

 

Output Tab: Video Control  

Note: These parameters only appear when the Processor's mode is Multiviewer. 

Parameters with a LIVE indicator will update on the actual stream as you change them, without the 
Apply button being pressed.  

Proxy 3G Output Allow When unchecked, the Proxy output format is 1080i (interlaced).  When  
checked, the Proxy output format is 1080p (progressive).  The Proxy 
output frame/field rate follows the Multiviewer’s Display frame rate. 
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Vphase (lines)  

(Live)  

Adjusts the vertical phase of the frame sync from 0 to 1124 with units of 
"lines" and precision of 0 decimal places. 

This parameter is unavailable when in Low Latency mode and when IP 
Video Tx is enabled. See Configuring a Processor (on page 113).  

Hphase (µs)  

(Live)  

Adjusts the horizontal phase of the frame sync, with a precision of three 
decimal places. The range varies depending on the video standard and 
frame rate:  

• 625i/50 (0 to 63.963) 

• 525i/59.94 (0 to 63.519) 

• 720p/50 (0 to 26.653) 

• 720p/59.94 (0 to 26.653) 

• 1080i/50 (0 to 35.542) 

• 1080i/59.94 (0 to 29.646) 

• 1080p/23.98 (0 to 37.061) 

• 1080psf/23.98 (0 to 37.061) 

• 1080p/24 (0 to 37.061) 

• 1080psf/24 (0 to 37.061) 

• 1080p/25 (0 to 35.542) 

• 1080p/29.97 (0 to 29.646) 

• 1080p/50 (0 to 17.771) 

• 1080p/59.94 (0 to 14.823) 

UHD section mode 

• 2160p/23.98 (0 to 37.024)  

• 2160p/24 (0 to 37.024) 

• 2160p/25 (0 to 35.542) 

• 2160p/29.97 (0 to 29.646) 

• 2160p/50 (0 to 17.771) 

• 2160p/59.94 (0 to 14.823) 

This parameter is unavailable when in Low Latency mode and when IP 
Video Tx is enabled. See Configuring a Processor (on page 113).  

TSG Enable (Live)  Enables the test signal generator, which plays the signal displayed below 

TSG Pattern Options are:  

• Black 

• White 

• Color Bars 75% 

• Horizontal Sweep Y-only 

• Horizontal Sweep 

• Cross Hatch  
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General System Configuration 
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Using DHCP with your SNP 
If your SNP is connected to a network switch with a configured DHCP (Dynamic Host Configuration 
Protocol) server, you can opt to use DHCP for the following: 

• For the Control Interface. See Using DHCP for the Control Interface (on page 466) 

• For the Media Network Interface . See Using DHCP for the Media Interface (on page 467) 

• For the SNP Host Name. See User Defined Host Name (on page 469) 
 

Using DHCP for the Control Interface 

Go to the SNP Console (Views > Console or simply enter https://<SNP_IPAddress>/console#/console). 

The SNP has 2 Control interfaces, Control A and Control B, and you can select these interfaces under 
Control Link Configuration. 

Note: The Control Link Bonding offers two modes:  
- Dual Addresses (different addresses for Primary and Secondary) and  
- Bonded Active/Backup which is the SNP default 
If you have the first option selected, Control A and B can be defined separately, and DHCP can be 
enabled or disabled separately on each interface. In case of the latter, only Control A is configurable, 
and the Control A settings will be used across the bonded pair. 

On selecting an interface, you will see: 

• The MAC Address 

• Whether DHCP is currently enabled 

• The Current address 

• The Current netmask 

• The Current gateway 

 

To use DHCP for an interface, click the DHCP On button. This overrides the current IP and the DHCP 
assigns a new IP. 

Note that enabling or disabling DHCP on the control interface will change the IP address  and may 
impact your ability to communicate with the SNP. 
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Using DHCP for the Media Interface 

The SNP's Media Network Interface is defined by going to Configure Element > IP WAN. WAN1 Primary 
and WAN1 Secondary contain settings for IP addresses for the data network; video and audio goes 
through this network. There is a DHCP capability here, both on the primary and the secondary. 

Note: Currently, WAN1 supports DHCP if used as an untagged (VLAN ID = 0) interface.  In this release, 
DHCP is not supported when used with trunk mode (tagged VLANs) and is not supported on WAN2-4. 

To use DHCP for a primary or secondary WAN (WAN1 only): 

1. Select the Enable (Primary/Secondary) DHCP checkbox 

2. Click the Apply WAN button at the bottom of the dialog to assign the DHCP IP address(es) 

3. Reboot the SNP after clicking Apply WAN, for the IP address change to take effect 

 

Note: The Interface section at the bottom of the dialog shows the Primary Status and Secondary Status. 
Note the Primary/Secondary Ethernet IP Address fields. If you had a static IP applied, and enabled 
DHCP, no change will be visible to these status fields on clicking Apply WAN. In other words, the static IP 
is still applied and a reboot is needed for the DHCP IP addresses to be applied. 
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User Defined Host Name 

A custom host name can be set for the SNP via the Configure Element dialog (IP WAN tab, DNS section). 
Note that by default this field is blank, and the SNP host name is automatically generated using:  
SNP-<serial> 

 

This default setting ensures that names are unique on the network by default, when nothing else is 
configured. 

You can choose enter a custom name here by entering it in the User-defined Host Name field. This 
overrides the default SNP-<serial> hostname, however there is one exception. If DHCP is enabled and 
the DHCP Server uses DHCP Option 12 to send a hostname to the SNP, then the SNP will take the 
hostname provided by the DHCP Server instead of the name provided in this field. 

Note: Once you delete a custom name, it goes back to the default of using SNP-<serial>. 
 

Bandwidth/Stream Limitations 
If you configure to transmit and receive more than 7 channels of 3G video at 1080p59 or UHD video at 
2160p59 and more than 64 IP audio streams per processor, you may experience audio pops and glitches 
or no audio.  

To avoid this situation, restrict the video format on one out of eight channels within the same processor 
to 1.5G, disable one video Rx/Tx, or limit the audio IP streams to 64 or less per processor. 

If exceeding these limitations has caused "no audio", after reducing your bandwidth usage you may have 
to reboot to bring audio back.  
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Make-Before-Break (MBB) Video Switching 
When configuring your SNP, if bandwidth is exceeded, switches will become Make After Break. In order 
to maintain Make-Before-Break switching, observe the following configuration limits:  

Signal Limit for Make-Before-Break Switching 

1.5G  No restriction for 32 channels 

3G 7 of 8 channels per processor 

3G (2022-6) 6 of 8 channels per processor 

UHD  You must have one free UHD section on the SNP, which can be one of the 
following:  

• IP input, disconnected 

• UHD Tx 

UHD and 3G on the 
same processor 

Up to 3 channels of 3G + UHD Rx, No limit on UHD Tx 

For best results, use a balanced configuration where each processor has one section configured for input 
and the other section configured for output.  

 

When configured in this way, it is possible to have a 16 x 16 matrix of 3G with MBB (4 x 4 channels of 
UHD with Make-Before-Break, or 4 IP Rx and 4 IP Tx per processor).  

In addition, for each processor you can set Force MAB Mode (Processor > Edit > General). 
 

Processor Channel Capacity 
Bandwidth is limited to 90% of a processor's capacity (25Gbps).  
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Audio IP Stream Channel Support  
Each program can transmit (or receive) up to 16 ST 2110-30 streams, with each stream supporting 
encapsulation of 1-8 mono channels.  

Each program can have a mixture of # channels/streams. For example, you could configure streams 1-10 
as one mono channel per stream, then streams 11-14 as stereo (2 channels) per stream, and then 
streams 15-16 as 8 mono channels per stream with no negative repercussions.  

Audio routing options include the following:  

• Encapsulation into an ST 2110-30 stream 

• De-encapsulation from ST 2110-30 and embedding onto SDI  

• Customized ST 2110-30 to ST 2110-30 with Network address translation 

Each PCM audio can be routed to any and all ST 2110-30 transmitters (similarly, for IP to SDI, or IP to IP). 
Each (mono) audio can go through audio sync and proc for gain and delay adjustments. 
 

Getting to the SDP Object 
NMOS must be turned on for the SNP to get to the SDP object. See NMOS (on page 369) for more 
information. SNP uses RDP.  

You can get the SDP object by going to  

 http://<snp_ip>:8100/info/  

where <snp_ip> is the IP address of your SNP device.  

Each transmitter will have a line similar to the following:   

 

Click the SDP/ link for the stream of interest. 
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Network Recovery 
If your IP network should become unstable due to excessive traffic, SNP may become unavailable.  

If you need to bring up the network controls on the panel to help investigate, and the panel application 
is still running (shows ‘Device Select’ at the top), hold the Exit and Status keys for 5 seconds to bring up 
the Control IP configuration panel support. 

Once you have made your BIOS changes, you will be unable to go back to the Root menu. To exit the 
branch, reboot the SNP.   
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Multi-Unit Cascading 
The SNP supports cascading two or more SNP units (to a maximum of 4) in order to increase the total 
number of UHD PiPs displayed on the SNP Multiviewer output.  

Notes:  

• You can cascade a maximum of 4 SNP units 

• SNPs set to Multiviewer Landscape and Portrait modes can be cascaded 

The following table illustrates the maximum output PiPs depending on your display (HD or UHD) and the 
number of cascaded units: 

# of Cascade Units Mode Orientation Max # of PiPs 

2 cascaded units 

 

HD Portrait/Landscape 72 

UHD Portrait/Landscape 16 

3 cascaded units 

 

HD Portrait/Landscape 96 

UHD Portrait/Landscape 24 

4 cascaded units 

 

HD Portrait/Landscape 144 

UHD Portrait/Landscape 32 

 

In This Section 

Enabling Cascading Input ....................................................................... 474 
Enabling Cascade Output ....................................................................... 474 
Cascading Example ................................................................................. 475 
Cascade Concept/Example Using BNC Connections .............................. 477 
Cascade Concept/Example Using SFP Connections ............................... 479 
2 Unit Cascade Layout Configuration ..................................................... 480 
3 Unit Cascade Layout Configuration ..................................................... 481 
4 Unit Cascade Layout Configuration ..................................................... 481 
Cascading Issues ..................................................................................... 482 
Cascade Alarms ...................................................................................... 482 
Creating Cascade Layouts ...................................................................... 483 
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Enabling Cascading Input 
• Only Processor D of an SNP unit in Multiviewer mode can be set up for Cascade Input 

• In the Configuration tab, General section, set the Cascade Input Select parameter to BNC or SFP. 
Setting it to Unused means the cascade input will not be used. 

 

• When Cascade Input is enabled, the BNC direction is set/forced to Input. Once enabled, the 
downstream SNP gets its Canvas input from an upstream SNP.  

• When Cascade Input is enabled, the selected I/O is set to 12G single link 
 

Enabling Cascade Output 

Cascade Output 

• Only Processor A of an SNP unit in Multiviewer mode can be set up for cascade output 

• In the Configuration tab, General section, set the Cascade Output Select parameter to BNC/SFP. 
Setting it Unused (the default setting) means there is no expected cascade output. 

• Cascade Level: When Cascade Output is enabled on the UPSTREAM Processor, the Cascade Level 
setting is displayed. Ensure you set this as follows: 

▪ For the first UPSTREAM unit, set level to 4 

▪ For the second UPSTREAM unit, set level to 8  

▪ For the third UPSTREAM unit, set level to 12  
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Cascading Example 

The following diagram illustrates a two unit cascading setup.  

• Both SNP units are set to the Multiviewer personality (normal or Portrait) 

• Unit A - the upstream unit - sends cascade output (Processor A) via BNC 

• Unit B - the downstream input - receives unit A's output as cascade input  (Processor D) via SFP 

• This represents a 2 unit cascade, providing either 72 (HD) or 16 (UHD) output PiPs 

• A 3 unit cascade can be created by feeding Unit B's outputs (Processor A) to a third unit (Processor 
D). And similarly, to a fourth unit. 
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The following diagram shows the physical connections for a 2 unit cascade, connected via SFP and BNC: 

Connected through SFP 

 

Connected through BNC 
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Cascade Concept/Example Using BNC Connections 

 

 



Selenio™ Network Processor 

User Guide  General System Configuration Considerations 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 478 

 

 
 



Selenio™ Network Processor 

User Guide  General System Configuration Considerations 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 479 

 

Cascade Concept/Example Using SFP Connections 
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2 Unit Cascade Layout Configuration 
• Divide the layout into two. 

• Put the 1st unit (UPSTREAM – Unit A) layout contents on the left-half of the canvas. 

• Put the 2nd unit (DOWNSTREAM – Unit B) layout contents on the right-half area of the canvas. 
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3 Unit Cascade Layout Configuration 
• Divide the layout into three. 

• Put the 1st unit A layout contents on the left-third of the canvas. 

• The 2nd unit B layout contents in the middle third. 

• The 3rd unit C contents should go into the right- third of the screen. 

 
 

4 Unit Cascade Layout Configuration 
• Divide the layout into 4 quarters. 

• The 1st unit A layout contents should go into the leftmost quarter of the canvas. 

• The 2nd unit B should use the adjacent quarter as shown below. 

• The 3rd unit C should use the adjacent quarter as shown below. 

• The 4th unit D should use the rightmost quarter. 
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Cascading Issues 

In case of missing inputs from a unit, for example, if a unit in the cascade chain is being rebooted or 
upgraded, the Cascade Input from that unit is automatically turned off so as to not have any 
interference from that input. 

In case of configuration mismatches or missing video presence, alarms are asserted. See Cascade Alarms 
(on page 482). 
 

Cascade Alarms 

Cascade alarms are asserted in case of configuration mismatches between the upstream and 
downstream SNPs, so users/operators can make changes to fix the configuration issue. An alarm is also 
asserted in case of video presence missing. 

Note: Ensure that the Output Video Standard, Display Colorimetry and TCS, and Decimation Filter 
Sharpness parameters of an upstream (feeder) unit match those of the downstream (receiver) SNP. 

Configuration Mismatch Alarms 

Configuration mismatches include the following: 

• The Downstream SNP output resolution does not match the Cascade Input video resolution (The MV 
Output Video Standard does not match the Cascade Input Video Standard) 

• No video presence is detected on the Cascade Input (based on type selected: BNC or SFP) 

• Cascade Input Video Standard is not 12G 

Video Presence Alarms 

On Processor D of an SNP enabled for cascading, when the Cascade Input Selection is BNC or SFP and 
the video input presence detector indicates that a signal is not present or an SFP+ module is not present, 
an Alarm is raised for each Cascade input. 

The alarms are applicable for: 

• Processor D, Section 1, Program 1 for MV/MVP 

• Processor D, Section 2, Program 1 for MV 
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Creating Cascade Layouts 

The following are some guidelines/tips when creating layouts for cascaded units: 

2 Unit Cascade 

• Divide the layout into two 

• Put the 1st unit (DOWNSTREAM) layout contents on the left half of the canvas 

• Put the 2nd unit (UPSTREAM) layout contents on the right half area of the canvas 

3 Unit Cascade 

• Divide the layout into three 

• Put the 1st unit layout contents on the left third of the canvas 

• The 2nd unit layout contents in the middle third 

• The 3rd unit's contents should go into the right third of the screen 

4 Unit Cascade 

• Divide the layout into 4 quarters 

• The 1st unit layout contents should go into the leftmost  quarter of the canvas 

• The 2nd unit should use the adjacent quarter (to the right of the first) 

• The 3rd unit should use the adjacent quarter (to the right of the second) 

• The 4th unit should use the rightmost quarter 
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Time Sources 
The SNP offers the following options for using a time source:  

• PTP - See Configuring a PTP Network (on page 485) 

• NTP - See Configuring an NTP Server (on page 484) 

• UTC time - See Configuring UTC Time (on page 484) 

Also see Interaction and Precedence across Configured Time Sources (PTP, NTP, and UTC) (on page 486). 
 

Configuring UTC Time 

The SNP allows you to set the system time to Coordinated Universal time.To do this: 

• Go to  Configure > Element > Reference > UTC time (this option shows when PTP Mode is set to 
Master/Slave). 

 

• Enter the time in the following format: YYYY-MM-DD HH:MM:SS 
 

Configuring an NTP Server 

The SNP allows you to set the system time to an NTP server. To configure an NTP Server: 

• Go to Configure > Element > SNP Management 

• In the NTP Configuration section, enter IP address of the NTP server 
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Configuring a PTP Network 

The SNP can function as a Master or a Slave. See Configuring Reference for SNP - PTP (on page 351) for 
configuration parameters that need to be set as well as status parameters.  

A PTP network normally includes a PTP source such as a Tektronix PTP generator. This, and the SNP and 
switch (such as an Arista switch) need to be correctly configured.  

Note: PTP is required for clock.  
 

Connecting to a PTP Source 

To connect to a Precision Time Protocol (PTP) IEEE-1588 source, note the following: 

 

The 1588 standard assumes symmetrical path delay. If you have different rate paths (E.g. VSG-4MTG at 
100Mbps and SNP at 10G), the One Way Delay (OWD) calculation is incorrect. Two parameters allow 
SNP to compensate for this error: Network from master/boundary clock and OWD Offset, listed in 
Configuring Reference for SNP - PTP (on page 351).  

To configure these parameters, follow these steps in SNP Manager:  

1. From the main menu, choose  Tools > Configure Element.  

2. Select the Reference tab, and under PTP > Configuration, select the Network from 
Master/Boundary Clock option that best describes your network configuration.  

This parameter makes an OWD calculation based on an assumption of how the switch behaves 
internally. Not all switches will always behave this way.  

3. Using a PTP master with a 2059-1 aligned black output, measure the relative timing (in 
microseconds) of the SNP SDI output to the PTP master’s black output. E.g. WFM8300. 
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4. Enter this value in the OWD Offset control, which is also found under Configure Element > 
Reference > PTP > Configuration.  

 

Interaction and Precedence across Configured Time Sources 
(PTP, NTP, and UTC) 
• PTP when configured, takes priority over everything else  

▪ If PTP master is present, the Linux clock is aligned to PTP 

▪ If PTP master is not preset, and the SNP is configured as a PTP master, the PTP time can be 
jammed with a specified UTC time, or jammed with the NTP time if an NTP server is specified 

• UTC time changes the Linux clock to the user-specified time  

▪ It applies the Linux clock to the PTP time 

• NTP when configured syncs the Linux clock to the configured NTP server time.  

▪ Selecting Jam PTP Time from NTP Now pushes the Linux clock to the PTP clock.  

▪ Since the Jam PTP Time from NTP Now parameter jams NTP time on request, when not locked to 
a master, PTP time can still drift from NTP time, as the NTP clock frequency may differ from the 
SNP’s PTP clock.  

▪ If UTC time is jammed, NTP will take a while to resync.  

▪ If NTP time is jammed soon after UTC time is set, the UTC time will likely still be present in the 
Linux clock, jamming UTC time (instead of NTP) to PTP.  

▪ If NTP is configured during bootup, the SNP jams NTP to PTP shortly after startup if PTP is not 
present. 
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Support for Generation and Processing of ATC 
Timecode in Conversion 
The Dual and Quad Conversion personalities support processing and handling of Ancillary Timecode 
(ATC) from input to output. 

Input Side 

• Ancillary timecode packets are auto-detected on the input and reported accordingly  
(Input Tab > Program's Ancillary Data Status > ANC ATC Present) 

 

Output Side 

• On the output, the ATC Embedding mode controls the mode for embedding the ancillary timecode. 

• Copy Mode enables copying the ancillary timecode packets from input to the output without 
alteration. This is particular useful for a post-production environment where the timecode may not 
always increment on a per-frame basis. This mode allows the incoming timecode to be on the 
specified line number of the matching "field" of the output. 
(Output Tab > Program's Ancillary Data Configuration > ATC Enable > ATC Embedding Mode) 
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Note: If the incoming and outgoing frame rates are different, the Copy mode will skip/repeat 
timecode values. In this case, the Generate mode is preferable. 

Also, for interlaced output, the timecode could technically be on the wrong field of the interlaced 
output - but in most applications this is correct since the timecode is labeling the content and can 
still be used to align other content (such as audio) to the video. 

• Generate Mode lets you insert timecode into the output seeded to a specific time when the Jam 
Timecode to Specified Time is selected and set. A new generated timecode is inserted into the 
output, regardless of what was present on the input, and all processors on the same SNP will 
generate the same timecode in their output. 
(Configure > Element > System) 

 

If the Generate Mode is selected, one additional parameter becomes available to allow the selection 
of ancillary timecode packets style (LTC or VITC). 

For more input and output parameters related to ATC timecode, see: 

Output Tab: Program Ancillary Data Configuration (on page 459) 

Input Tab: Ancillary Data Status (on page 397) 
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MCL Hardware Panel 
The MCL Hardware Panel provides a physical control surface for the SNP Master Control Switcher (SNP-
MCL). The panel can be configured via the SNP UI, and it attaches as a client to the panel control service 
application running on the SNP. 

The following sections walk you through configuring the panel itself, as well as adding it to the SNP. 

Note: The MCL Hardware Panel is intended for use with the MCL mode (see Setting the MCL Mode (on 
page 195)). 

In This Section 

Connecting Power to the MCL Hardware Panel .................................... 490 
Connecting the Ethernet RJ-45 .............................................................. 490 
Panel Display .......................................................................................... 491 
Setting up the Panel IP Address ............................................................. 491 
Upgrading Firmware on the MCL Hardware Panel ................................ 494 
MCL Hardware Panel Buttons ................................................................ 496 
Configuring MCL Panels ......................................................................... 502 
Troubleshooting ..................................................................................... 508 
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Connecting Power to the MCL Hardware Panel 
Connect the +12V DC adapter to the panel.  A second DC adapter can be connected to the panel to 
provide power  redundancy. 

 

 

DC power connectors and Ethernet RJ-45 connector on bottom of panel 

 

Connecting the Ethernet RJ-45 
The panel supports 10/100 Base-T Network connection.  Connect the panel's Network port to the same 
Network as the SNPs. 
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Panel Display 
When the MCL Hardware panel is not connected to an SNP, the Touch Display on the panel will show 
the panel’s: Network settings and firmware version. 

 
 

Setting up the Panel IP Address 

In This section 

Entering Local Configuration Mode ....................................................... 492 
Selecting Configuration Item ................................................................. 492 
Exiting Panel Configuration .................................................................... 493 

 
 



Selenio™ Network Processor 

User Guide  MCL Hardware Panel 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 492 

 

Entering Local Configuration Mode 

To enter local configuration mode, press and hold the rotary encoder switch for 5 seconds. After 5 
seconds the LCD updates to display the Panel Configuration screen. 

 
 

Selecting Configuration Item 
• When the Panel Configuration menu is shown, turn the rotary encoder to highlight the required 

configuration item (for example, IP Address) 

• With the required item selected, press the rotary encoder to select the entry mode for that item. 

• On pressing the rotary encoder, the current setting for the item will clear and a cursor will highlight 
the first digit to be entered.  

• Use the numeric key pad displayed to enter the 12-digit IP address. 

Note: To enter an IP Address of 192.10.2.1, enter 192.010.002.001 on the panel.  All fields of the IP 
Address require 3 characters each.  

• To correct any errors, press the rotary encoder to restart the entry.  

• To cancel entry mode, press the rotary encoder twice, if part way through an entry, or once, if at the 
start of an entry. 

Once the 12-digits of the IP address have been entered, entry mode is completed and the new setting is 
held in a temporary storage area. The next configuration item can now be selected and modified if 
required. Repeat this for all network settings. 
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NOTE: The new network settings do not take effect until one of the Save items have been selected.  

 
 

Exiting Panel Configuration 

Once all network items have been modified use one of the following options to exit panel configuration: 

Save & Reset Stores network settings before resetting panel. Once the panel has reset, the new 
network settings take effect. (Recommended option to select). 

Save & Exit Stores network settings and returns to normal panel operation  
NOTE: Changes to network settings are not effective until the next panel reboot. 

Cancel Discards any changes to network settings and returns to normal panel operation. 
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Upgrading Firmware on the MCL Hardware 
Panel 
Note: These instructions are to upgrade the MCL Hardware Panel's firmware to Revision 08.  
 
It is highly recommended that before loading different SNP software versions, to save the ‘Configure 
MCL Panel’ setup by exporting the configuration. See MCL Hardware Panel - Importing and Exporting 
Configurations (on page 506). 

Revision 07 allows the panel's IP address to be changed directly from the panel, without an external 
application to change the IP address. Revision 08 prevents multiple SNP units from trying to control the 
hardware panel at the same time.  

1. Before commencing the upgrade, ensure Mozilla Firefox is installed on the PC. 

2. Create a point to point connection from your PC to the panel. Ensure the PC is on the same network 
IP address range as the panel. 

3. Set the panel's IP address to 192.168.0.100 using the rotary button on the panel. 

4. Run the bootloader batch file to put the panel in bootloader mode. 

5. When the panel is in Bootloader mode, the Touch Display will look as follows: 

 

6. Manually open a Firefox browser tab and enter http://192.168.0.100  (ensure you are not using 
https). 

7. Enter the following credentials:  

User ID = imagine 

Password = kb7744 
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8. Once successfully logged in, click the Browse button and navigate to the appropriate binary file 
DELxxx-x Release.bin.  

Note: Download the DELxxx-x Release.bin. file from the Customer Portal. 

 

9. Click the Upload button. Wait until the firmware upload completes (approximately 10 to 30 
seconds). Once complete, you will receive confirmation that the upload was successful.  

 

10. Click the Reset MCU button. After the panel reboots, the LCD screen on the physical panel will 
display the updated firmware version. 
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MCL Hardware Panel Buttons 
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Buttons Label on 
Diagram 

Details 

Program & Preset Bus Program and 
Preset 

• On the Program bus, the ‘active’ Source button is 
illuminated in Red. 

• On the Preset bus, the ‘active’ Source button is illuminated 
in Green. 

• Unselected source buttons are not illuminated 

 

Misc 1 Transition Rate buttons - Used to select one of the pre-
configured transition rates 

• SLOW  

• FAST  

Note: Only one of these buttons is enabled and selected 
{illuminated} at a time. If the Medium or Automation 
transition rates are selected in the GUI, neither of these 
Transition Rate buttons will be illuminated. 

Background Transition Type buttons - Used to select one of 
the fixed Background Transition Types 

• CUT  

• CUT-FADE  

• FADE-CUT  

Note: Only one of these buttons is enabled and selected 
{illuminated} at a time. If the X-Fade or V-Fade Transition 
Types are selected in the GUI, none of these Transition Type 
buttons will be illuminated. 

 

Misc 5 
When the BKGD or PST KEY[1:4] or PST AO buttons are 
selected, the TAKE button will be illuminated in Green, to 
indicate that a layer will be transitioned when the TAKE 
button is pressed. 
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Buttons Label on 
Diagram 

Details 

 

Misc 6 PGM KEY [1:4] buttons  

• Used to hot-punch (cut) a key layer directly ON or OFF the 
program output.  

• Illuminated when the related key is "active" on the 
program output. 

• Pressing the button triggers state change: 

• if key is on, turn it off from the program bus. 

• if key is off, turn it on the program bus. 

• Illuminated ON at the beginning of the "on" transition 
(when the key starts to appear on the program bus). 

• Illuminated OFF at the end of the "off" transition (when the 
key stops appearing on the program bus). 

PST KEY [1:4] buttons 

• Used to select key layer(s) to transition on pressing TAKE.  

• Illuminated to indicate which key layer will be transitioned 
when the TAKE button is pressed. 

PGM AO button 

• Used to fast-fade Voice/Audio Over on or off air. 

• Illuminated to reflect current state of AO on program bus. 

PST AO button 

• Used to select the Voice/Audio Over, which will be 
transitioned on or off air when TAKE is pressed. 

AUTO HOLD button 

• Automation Hold - When enabled, the Automation 
command will not be processed by the MCL, however MCL 
will still reply to Automation commands. 

• QUERY/STATUS and SUBSCRIPTION available. 

• Illuminated to indicate that Automation commands are 
being ignored by the MCL. 

KEYER button 

• When the KEYER button is pressed, the Touch Display is will 
show four soft-touch KEY buttons.   

• Select a KEY button to change the Source for that Keyer 
Layer.  Options include No Key, External, or previously 
uploaded .mg3 Logo file(s). 

• Note that the Source Select parameter for Keyer #4 can 
only have No Key or internal logos assigned to it. An SNP 
unit, in HD and UHD modes, supports a maximum of 3 
External Keyers. 

• Use the Push-button Knob to select a different Logo file. 

• Press the soft-touch APPLY button to load the Logo file. 
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Buttons Label on 
Diagram 

Details 

• Pressing the KEYER button, moves the menu up one 
layer. 

TIMER button 

• When pressed, the TIMER value will increment up from 
00:00:00. 

• When pressed again, the TIMER value will reset to 00:00:00 
and not increment. 

• Illuminated when the TIMER value is incrementing. 

• The TIMER value is displayed in the Touch LCD. 
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Buttons Label on 
Diagram 

Details 

 

Aux Bus PANEL LOCK button 

• When enabled, users on the panel will not have Control of 
the buttons, except the Panel Lock button. 

• Illuminated when Panel Lock is enabled 

FADE TO BLACK button 

• When enabled, the LCD Button displays a Red background 
color 

• When disabled, the LCD Button displays a Green 
background color. 

CHANNEL GROUP SELECT buttons [1:9] 

• Used to select the Playout Channel Group to monitor and 
control 

• Illuminated to indicate the selected Playout Channel Group 

• The LCD button displays the name of the Playout Channel 
Group 

• Multiple Channel Group Select buttons can be enabled to 
allow for larger groups of channels to be controlled 
(dynamic group creation). 

PST OVER LEVEL button 

• Used to set the Audio Level for the Source selected on the 
Preset Bus. 

• Illuminated to indicate that Preset Source's Audio Level is 
selected and the Touch Display will display the value of the 
Preset Source's Audio Level. 

• The Push-button Knob allows the Preset Source's Audio 
Level to be changed. 

• The RESET GAIN button, displayed in the Touch LCD, can be 
used to set the Preset Gain to 0 dB. 

PGM OVER LEVEL button 

• Used to set the Audio Level for the Source selected on the 
Program Bus. 

• Illuminated to indicate that Program Source's Audio Level is 
selected and the Touch Display will display the value of the 
Program Source's Audio Level. 

• The Push-button Knob allows the Program Source's Audio 
Level to be changed. 

    NOTE: SNP will store 16 Audio Source levels 

• The RESET GAIN button, displayed in the Touch LCD, can be 
used to set the Program Gain to 0 dB. 
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Buttons Label on 
Diagram 

Details 
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Configuring MCL Panels 
This section allows you to configure hardware panels on the SNP for Master Control. Currently, only the 
MCL Hardware Panel is supported. 

Prerequisite: 

• Ensure that at least one of the SNP’s Processors is configured with the Master Control Lite (MCL) 
personality.   

• To use the MCL as a Master Control Switcher, set the ‘MCL mode’ to MCL.  

• Ensure the panels and SNPs are in the same network so they can communicate. 

Follow these steps to configure a MCL Hardware Panel: 

1. Select Configure > MCL Panel 

 

2. The Configure MCL Panel dialog is displayed with two tabs: Edit Config and Statuses.  

See Configure MCL Panel Tab - Edit Config (on page 503) 

See Configure MCL Panel Tab - Statuses (on page 505) 

 

Also see MCL Hardware Panel - Importing and Exporting Configurations (on page 506). 

Note: *.PanelControlService.json files are stored on the SNP file system’s sub-directory: 
/mnt/localfs/config/ 
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Configure MCL Panel Tab - Edit Config 

The Edit Config tab contains the following sections: 

MCL PANEL CONFIGURATION 

Playout Channels This section lets you define playout channels and lists any existing channels. 

To create a new Channel: 

1. Click the + button next to Playout Channels. 

 
2. In the Playout Channel dialog, enter the following: 

 
• Channel Name: Enter a Name for the Channel. 

Note: It is recommended to use short names here, so it fits in the LCD display on the 
panel. The name must be a unique and not in use by another Playout Channel Device. 

• Channel IP Address: Enter an IP Address for the SNP (current or a different one) 
being used to create the playout channel.  

• Channel Processor: Select the Processor (A/B/C/D of a Processor set to MCL 
personality and in MCL mode) in question on the SNP.  
Note: Each Playout Channel Device must be assigned to a unique Processor which is 
not already in use. 

3. Click Submit. 

4. Repeat to create as many Playout Channels as desired. 

Once defined, playout channels are listed in this section along with the Channel Name, 
Channel IP, and Channel Processor. The Actions column lets you Edit or Delete a defined 
channel. 
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Playout Groups Groups let you link Playout Channels together so they can share configurations and be 
controlled in a ganged fashion.  

To create a new Group: 

1. Click the + button next to Groups 

 
2. In the Group dialog displayed, enter: 

 
• Group Name: Provide a name for the group 

Note: It is recommended to use short names that fit in the LCD display on the panel. 
The Group Name must be a unique and not already in use by another Playout Group. 

• Group Channels: Select which of the (previously) defined playout channels should be 
part of this group. 
Note that you can create empty groups without channels. 

3. Click Submit. 

4. Repeat to create as many Groups as desired. 

Once defined, groups are listed in this section along with the Group Name. The Actions 
column lets you Edit or Delete a defined group. 
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Panels 
This section lets you add hardware (currently, MCL Hardware Panel) panels to the SNP: 

To create a new Panel: 

1. Click the + button next to Panels 

 
2. In the Panel dialog, enter the following: 

 
• Name: Provide a unique name for the panel 

• Panel Type: Select Devlin  

• IP Address: Enter the IP address of the panel 

• TCP Port: Enter the Port or leave the default of 2075 (this is the port that 
communicates with the Devlin panel). 

• Groups Supported: Select groups to include (if any). 

3. Click Submit. 

Once defined, panels are listed in this section along with the Name, IP, and Port. The 
Actions column lets you Edit or Delete a defined group. 

 

Apply Settings Click the Apply button at the bottom of the dialog to save settings to the SNP. 
 

 

Configure MCL Panel Tab - Statuses 

This section displays status for: 

• Playout Channels 

• Playout Groups 

• Panels 
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MCL Hardware Panel - Importing and Exporting Configurations 

The Panel Control Service is redundant across SNP devices. The configuration can be exported from one 
SNP and imported onto as many other SNPs as desired, to support the desired redundant setup. 

Exporting Configurations 

To export a configuration: 

1. Click Configure > MCL Panel and go to the Edit Config tab 

2. Under the Import/Export Config section, click the Export button 

3. The Configuration is then exported as PanelControlService.json and can be found in the Downloads 
folder. This configuration can then be imported onto another SNP, following the instructions below. 

Importing Configurations 

To import a configuration: 

1. Click Configure > MCL Panel and go to the Edit Config tab 

2. Under the Import/Export Config section, browse to the location of the PanelControlService.json file 
and select it. 

3. Click the Import button 

4. The Configuration is then imported to the current SNP. 

 
 

Selecting a Logo Source from the Panel 

Logo source selection on the MCL Hardware panel functions differently that it does on the SNP UI. To do 
this from the Panel: 

• Ensure the Panel is connected to the SNP (MCL mode). 
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•  Press or toggle the PST KEY2 button to bring up the logo source selection list on the OLED. 

 

• The current selected logo is highlighted in yellow. Use the knob to select a new logo. 

• Press APPLY button on the OLED, the new logo will be selected. 
 

Selecting Playout Groups and Channels 
1. Select a Playout Group on the panel (assuming one or more Groups containing Playout Channels 

have been defined) 

2. The Touch Display shows the Playout Channels within the selected Group. Enabled Playout Channels 
display a checkmark. 

3. Channels can be added or removed from the group by checking or unchecking using the push-button 
knob on the panel. 

4. On the Touch display, press the TAKE button to save changes. 

Notes: 

• Channels can only be removed from groups that contain more than one channel. 

• If the same Channel is included in more than one Group, but is checked in one and unchecked in the 
other, panel commands will still be sent to the channel in both groups 

• When a Playout Group contains more than one Playout Channel, an individual Playout Channel can 
be taken out of the Playout Group permanently, from the panel, by unchecking it.  If the Master 
Control Operator switches to another Playout Group and then switches back to the modified Playout 
Group, the overridden Playout Channel is remembered for that Playout Group. 
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Troubleshooting 
If the MCL Hardware Panel loses network connection to SNP(s), the panel’s controls: Push-button 
Encoder, Touch LCD, LCD Buttons, LCDs, and RGB Buttons, will still be illuminated.  However, the 
panel’s controls will not respond to button presses or when the Encoder is turned.   

Workaround: If such behavior is seen, check the CLOCK value, in the Touch LCD, to see if it is still 
incrementing.  If it not incrementing, this indicates that the panel is not connected to any SNPs.  
Verify that the SNPs are powered-up, and the panel and SNPs are connected to the network. 

Pressing the PANEL LOCK button to lock the MCL Hardware panel results in inactive 
Buttons/functions (as expected) however the Push-button Knob is still active - on holding down this 
Knob, the "Panel Configuration" (IP Address) menu is seen in the Touch Display. On selecting Cancel, 
the panel correctly exits the "Panel Configuration" state however the panel's buttons and LCD 
buttons are now all blank/empty and do not return to their previous state. 

Workaround: When exiting the MCL Hardware panel's IP Address menu, select the 'Save & Reset' 
option, even when no parameters have been changed. This returns the panel to its default start-up 
mode, where no Playout Channel(s) has been selected. 

When a MCL Hardware panel is connected to an SNP, the Playout Group select buttons will be 
displayed on the panel.  Select one of the Playout Group select buttons, 1 to 9, to change the settings 
of that Playout Group.   
NOTE: a Playout Group may consist on only one Playout Channel. 
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Specifications 

Certifications and Supported Standards 
SNP supports the following SMPTE standards:  

• ST 2022-6   "Transport of SDI over IP" 

• ST 2022-7   "Seamless protection switching of IP streams"  

• ST 2022-8 "Timing of ST 2022-6 Streams in ST 2110 Systems"  

• ST 2110-10   "System Overview" System timing model & Session Description 

• ST 2110-20   "Uncompressed Active Video" Based on RFC 4175 

• ST 2110-21 "Traffic Shaping and Delivery Timing for Video"  

• ST 2110-22 "Constant Bit-Rate Compressed Video over IP networks (e.g. JPEG-XS) 

• ST 2110-30   "PCM Audio"  AES67 

• ST 2110-31   "AES3 Compressed Audio Formats" 

• ST 2110-40   "Ancillary Data" 

SNP claims the following certifications: UL (including CUL), FCC, CE.  
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12G/6G/3G/HD/SD-SDI Input Specifications 

Item Specification 

Number of Inputs 32 (bi-directional port shared with output) 

Connector Type HD-BNC 

Standard • 12G: SMPTE ST 2082-1 and Amendment 1 to SMPTE ST 2082-1 (11.88, 
11.88/1.001 Gb/s) 

• 6G: SMPTE ST 2081-1 and Amendment 1 to SMPTE ST 2081-1(5.94 
5.94/1.001 Gb/s) 

• 3G: SMPTE 424M (2.97, 2.97/1.001 Gb/s) 

• HD: SMPTE 292M (1.485, 1.485/1.001 Gb/s)  

• SD: SMPTE 259M-C, (270Mb/s) 

Formats Supported  • 625i/50, 525i/59.94  

• 720p/50, 720p/59.94  

• 1080i/50, 1080i/59.94  

• 1080p/23.98, 1080psf/23.98  

• 1080p/24, 1080psf/24  

• 1080p/25, 1080p/29.97  

• 1080p/50, 1080p/59.94  

• 2160p/23.98, 2160p/24  

• 2160p/25, 2160p/29.97  

• 2160p/50, 2160p/59.94  

See Note 1 (below table) 

Connector (High-Density) HD-BNC 

Impedance 75 

Signal Level 800 mV ± 10% 

Return Loss • >15 dB, from 5 MHz to 1.485 GHz 

• >10 dB to 3 GHz>,  

• 7 dB to 6 GHz,  

• >4 dB to 12 GHz,  
all typical  

Equalization • 12G: Adaptive cable equalization for >164ft (50m) typical, of Belden 
1694A coaxial cable 

• 6G: Adaptive cable equalization for >262ft (80m) typical, of Belden 
1694A coaxial cable  

• 3G: Adaptive cable equalization for >426ft (130m) typical, of Belden 
1694A coaxial cable 
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Item Specification 

• HD: Adaptive cable equalization for >590ft (180m) typical, of Belden 
1694A coaxial cable 

• SD: Adaptive cable equalization for >900ft (275m) typical, of Belden 
1694A coaxial cable 

Note: All the unused output ports should have 75 terminators. 

 

Note 1: Remap personality supports the following SQD standards for SDI Quad links: 
- 2160psf/23.98, 2160psf/24 
- 2160psf/25, 2160psf/29.97  
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12G/6G/3G/HD/SD-SDI Output Specifications 
Item Specification 

Number of Outputs Up to 32 (bi-directional port shared with input) 

Connector Type (High-Density) HD-BNC 

Standard • 12G: SMPTE ST 2082-1 and Amendment 1 to SMPTE ST 2082-1 (11.88, 
11.88/1.001 Gb/s) 

• 6G: SMPTE ST 2081-1 and Amendment 1 to SMPTE ST 2081-1(5.94 
5.94/1.001 Gb/s) 

• 3G: SMPTE 424M (2.97, 2.97/1.001 Gb/s) 

• HD: SMPTE 292M (1.485, 1.485/1.001 Gb/s)  

• SD: SMPTE 259M-C, (270Mb/s) 

Formats Supported  • 625i/50, 525i/59.94  

• 720p/50, 720p/59.94  

• 1080i/50, 1080i/59.94  

• 1080p/23.98, 1080psf/23.98  

• 1080p/24, 1080psf/24  

• 1080p/25, 1080p/29.97  

• 1080p/50, 1080p/59.94  

• 2160p/23.98, 2160p/24  

• 2160p/25, 2160p/29.97  

• 2160p/50, 2160p/59.94  

See Note 1 (below table) 

Impedance 75 

Return Loss • >15 dB, from 5 MHz to 1.485 GHz 

• >10 dB to 3 GHz,  

• >7 dB to 6 GHz,  

• >4 dB to 12 GHz,  
all typical  

Signal Level 800 mV ± 10% 

DC Offset 0.0V ± 0.5 V 

Rise and Fall Time • 12G: <45 ps (20% to 80%) 

• 6G: <80 ps (20% to 80%) 

• 3G: <135 ps (20% to 80%)  

• HD: <270 ps (20% to 80%) 

• SD: <400 to 1500 ps (20% to 80%)  

Overshoot < 10% of amplitude (all outputs terminated) 
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Item Specification 

Jitter • Timing jitter: 

• 12G: <8 UI peak to peak 

• 6G: <4 UI peak to peak   

• 3G: <2 UI peak to peak 

• HD: <1 UI peak to peak 

• SD: <0.2 UI peak to peak  

• Alignment jitter: 

• 12G: <0.3 UI peak to peak  

• 6G: <0.3 UI peak to peak   

• 3G: <0.3 UI peak to peak  

• HD: <0.2 UI peak to peak 

• SD: <0.2 UI peak to peak  
 

Note 1: Remap personality supports the following SQD standards for SDI Quad links: 
- 2160psf/23.98, 2160psf/24 
- 2160psf/25, 2160psf/29.97  
 

 

QSFP28 Specifications 
Item Specification 

Standard SFF-8665 and SFF-8636.  Electrically compliant with IEEE802.3bm chip-to-
module 100 Gb/s four-lane Attachment Unit Interface (CAUI-4) standard.  

Note: IEEE std 802.3-2015 Clause 91 RS-FEC is always enabled.  

Connector 2x Hot pluggable QSFP28 MSA form factor  

Voltage  3.3V 

Power consumption <4.5W typical. Individual per type used.  

Case operating temperature 
range 

0°C to 70°C 

Compliance RoHS-6 compliant (lead-free) 
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General Purpose Interface (for future use)  
 Item Specification 

Connector DB-9 

Number of inputs/outputs  4 bi-directional, user configurable 

Logic Level  +5 V TTL 

 

 

Genlock 
Item Specification 

Connector Type  2xHD-BNC, user configurable as loop-through or input and output.  

Impedance 75 Ohms 

Return Loss • >40 dB from 25 Hz to 10 MHz (SMPTE 318M-1999) 

Input Level • NTSC/PAL-B/PAL-M: 1V pk-to-pk, -4.0dB to +6.0dB 

• Tri-Level Sync: 600mV pk-to-pk, -4.0dB to +6.0dB 

Standards • NTSC; PAL-B; PAL-M 

• 1080i: 60/59.94/50 

• 1080p: 30/29.97/25/24/23.98 

• 1080psf: 24/23.98 

• 720p: 60/59.94/50 
 

 

LAN 
Item Specification 

Number of Connectors 2 

Connector Type  RJ-45 

Type 10/100/1000 Base-T Ethernet as defined by IEEE 802.3-2008 

Note: Shielded (screened) Ethernet cable should be used with this product. 
 

RS-232 (for future use)  
Item Specification 

Number of Rx Ports  1 
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Item Specification 

Number of Tx Ports 1 

Standard  Electrical specification EIA-232-C 

Connector DB-9 
 

 

Propagation Delay 
The minimum system latency for the SNP is 1 frame, based on the following:  

SNP #1 SDI input > SNP #1 SFP+ Tx > SNP #2 SFP+ Rx > SNP #2 SDI output.  
 

Tx Available Bandwidth 
The software currently limits  enabling any new streams if the Tx Configured bandwidth is more than 
95Gbps. The maximum Tx is 94.75Gbps (this is the TX Configured bandwidth).  
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1080p59 32 1080i29 8 x 0 x x 0 93.816 95.08417216 

1080p59 32 1080i29 8 2110-30 512 1 x 0 94.5471 95.83377165 

1080p59 32 1080i29 8 2110-31 512 1 x 0 94.7437 96.03041384 

1080p59 32 1080i29 8 2110-30 256 0.125 x 0 94.6829 95.95513344 

1080p59 32 1080i29 8 2110-31 128 0.125 x 0 94.2977 95.60373722 

1080p59 32 1080i29 8 2110-31 192 0.125 x 0 94.5285 95.91544371 

Notes:  

Measured BW contains FCS, preamble and interframe gap. 

The measurements in the table assumed the audio is evenly distributed among processors and we 
should recommend that in high bandwidth scenarios. 

The last populated column (Measured bandwidth) can be exposed by reading (every second) one 
register per Primary and one register per Secondary and display that information as Current Throughput. 
This value is calculated as per Annex A in the SMPTE 2110-10 standard.  

Measured bandwidth field contains interframe gap, preamble and FCS bytes in the calculation and that 
is similar to the rate% reported by the switch. 
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Environmental 

Temperature  

The operating temperature of the SNP is 32°F to 86°F (0°C to 30°C) with relative humidity of 10% to 90% 
non-condensing. 

The non-operating temperature is -20 to 70 degrees C.  
 

Mechanical 
Item Specification  

Dimensions 

     Height 1RU or 1.75 in.   

     Width 17.5 in. (44.45 cm) without ears, 19 in. (48.3 cm) with ears for rack 
mounting 

     Depth 23 3/8 in. (59.4 cm) from front rail to back of box (including connectors but 
not cables) 

No more than 1.5 inches from front rail to absolute front of installed unit 
(including screws and pushbuttons) 

Note: SNP requires at least 2.5 in. (6.3 cm) of space behind the unit for 
cooling and cabling.  

Weight 16.5 lbs (7.5 kg) 
 

 

Power Consumption 
Item Specification  

Number  Two independent, load-sharing power supplies  

Two IEC C14 power inlets, one for each power supply 

Input voltage 100 to 240 VAC Operating  range 

Frequency 50 to 60 Hz Operating 47 to 63 Hz 

Inrush current  At 264 VAC, at 25°C cold start, 15 Apk typical 

Efficiency Typical 93% @230VAC 

Power factor At 240 VAC, full load, typical 0.98 

Harmonic distortion Complies with the requirements of EN61000-3-2 

Power consumption Less than 350 watts total, as measured across both of the AC mains cords 

Maximum input current 4.5 A per input  

Heat dissipation 367 W 
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MCL and Magellan Control System 
In This Appendix 

Magellan Control System Configuration ................................................ 517 
SNP Configuration .................................................................................. 525 
SNP Program Mapping ........................................................................... 528 

When the SNP operates in Master Control Switcher (MCL) mode, Magellan Control System can be used 
to route signals to the MCL program inputs, and route MCL outputs to destinations. The following steps 
take you through configuring SNP and Magellan Control System.  

Notes: 

From a Magellan Control System perspective: 

• SNP-MCL program inputs are defined as Destinations in Magellan Control System 

• SNP-MCL program outputs are defined as Sources in Magellan Control System 

• Ensure you’re running at least Magellan Control System 3.8.1 (or higher) and Navigator 5.8.2 (or 
higher) and follow these instructions. 

 
 

Magellan Control System Configuration 

Create a Routing Device and Endpoint Device (for the SNP) 
1. In Navigator, create a routing system and poll the IP address of the desired Magellan Control 

System.   

2. Run the Magellan Control System Client 

3. Ensure you have a Routing Device and an Endpoint device for the SNP (defined via the Device 
Foundry) 

4. Ensure you have a logical template defined (for example, HD Video) for use in creating destinations 

 
 

Appendix A 



Selenio™ Network Processor  Appendix A 

User Guide  MCL and Magellan Control System 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 518 

 

Define Destinations 
1. Go to the Database Editor (Database Foundry > Database Editor) 

 

2. Go to the Destinations tab  

 

3. Add the MCL’s inputs as destinations (for example, Bus A, Bus B, Key 1, Fill 1, etc.) 

In this example, we consider an SNP with Processors configured as follows: 

▪ Proc A – MCL UHD 

▪ Proc B – Proc A MCL extension 

▪ Proc C- MCL HD (MCL Mode) 

▪ Proc D – MCL HD (Dual DSK Mode) 

See section below on SNP to SNP Mapping. 

4. Save the database. Publish the database.  

SNP Processor Mapping to the Magellan Control System Destinations 

The following screenshots illustrate the SNP Processor Mapping to the Magellan Control System 
Destinations to create: 
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Destination created for MCL Bus A input 
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Destination created for MCL Bus B input 
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Destination created for MCL Bus A input (DSK Mode) 
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Destination created for MCL Bus B input (DSK Mode) 
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Destination created for MCL Bus A input UHD. 

 
 

Destination created for MCL Bus B input UHD. 
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Destination created for MCL Key 1 input UHD. 

 
 

Destination created for MCL Fill 1 input UHD. 
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SNP Configuration 

Define the Magellan Control System Server in SNP 

Follow these steps to set up communication between your Magellan Control System and SNP: 

1. Click Configure > Element and go to the SNP Management tab 

2. Under External Devices > LRC Configuration > LRC Server IP Address, enter the IP Address of your 
SDNO server 

Note: This specifies to the SNP unit which Magellan Control System to communicate with.   

 
 

Define Routing Settings in SNP 
1. Set the desired SNP Processor to Master Control Lite 

2. Click the Processor’s Edit button and then go to MCL Tab > MCL Configuration > Router 
Configuration 

Note: This section contains settings to bind the router database with SDNO and SNP.   

3. In the Source Table Name section: 

a. Select the Source Number (1-16 sources) 

b. Enter the Logical Source Name  

Note: Name must match what’s defined on the Magellan Control System, as it is validated 
against the configured Magellan Control System Server. In case of a source name mismatch with 
the Magellan Control System database, an alarm will be asserted: 
 

 

c. Enter the Presentation or Display Name 

Note: This name will be displayed on the hardware panels and is a maximum of 16 characters. If 
left blank, the Router Database’s Logical Source Name will be displayed on the hardware panel 
used. 

d. Optionally the Source Audio Gain can be set 
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4. In the Routing Control section 

a. Enter the Bus A and Bus B Destination Names (see SNP Program Mapping section below) 

b. Enter the Program and Preset Follow Names - You can configure optional Magellan Control 
System destinations that follow the routing status of MCL PGM/PST output destinations, for 
example, you can configure 2 MV PIP destinations so that you can monitor MCL PGM/PST 
output signals on a Multiviewer. 

Note: The name must match what's defined on the Magellan Control System. In case of a 
destination name mismatch with the Magellan Control System database, an alarm will be asserted. 
 

 

c. Enter the AUX Destination Name 

d. Select the Program Source – this is the LRC source to be routed to the Program. 

Note that this is a live parameter and will perform a route. Route Status can be seen in the 
Routing Status section below. 

e. Select the Preset Source - this is the LRC source to be routed to the Preset 

Note that this is a live parameter and will perform a route. Route Status can be seen in the 
Routing Status section below. 

f. Select the AUX Source - this is the LRC source to be routed to the AUX Bus 

Note that this is a live parameter and will perform a route. Route Status can be seen in the 
Routing Status section below. 

g. Enter the User ID – this is the LRC User ID.  
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Note: When configured as a non-zero value, SNP-MCL will PROTECT the MCL output routing 
destinations, so other panels cannot route to these destinations by accident.  

 

5. In the Routing Status section 

a. Program Status: Displays the current source routed to the Program (if any) 

b. Preset Status: Displays the current source routed to the Preset (if any) 

c. AUX Status: Displays the current source routed to the Aux (if any) 
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SNP Program Mapping 
When a Processor is configured as MCL: 

The MCL inputs are as follows for HD 1.5G and 3G (from a router perspective these are Destinations): 

Section 1 - Program 1 Bus A 

Section 1 - Program 2 Bus B 

Section 1 - Program 3 Key 1 

Section 1 - Program 4 Fill 1 

Section 2 - Program 1 Key 2 

Section 2 - Program 2 Fill 2 

Section 2 - Program 3 Key 3 

Section 2 - Program 4 Fill 3 

 

The MCL outputs are as follows for HD 1.5G and 3G (from a router perspective these are Sources): 

Section 1 - Program 1 Program Output 

Section 1 - Program 2 Preset Output 

Section 1 - Program 3 Clean 1 

Section 1 - Program 4 Clean 2 

Section 2 - Program 1 Clean 3 

Section 2 - Program 2 Clean 4 

Section 2 - Program 3 Clean 5 

Section 2 - Program 4 Clean 6 

 

The MCL inputs are as follows for UHD (when ‘UHD Input Routing Configuration’ is set to: AB, ABKF, 
ABKFKF, and ABKFKFKF): 

Processor A, Section 1 - Program 1 Bus A 

Processor A, Section 2 - Program 1 Bus B 

Processor B, Section 1 - Program 1 Key 1 

Processor B, Section 2 - Program 1 Fill 1 

Processor C, Section 1 - Program 1 Key 2 

Processor C, Section 2 - Program 1 Fill 2 
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Processor D, Section 1 - Program 1 Key 3 

Processor D, Section 2 - Program 1 Fill 3 

 

The MCL inputs are as follows for UHD (when ‘UHD Input Routing Configuration’ is set to: KFAB, KFABKF, 
and KFABKFKF): 

 

Processor A, Section 1 - Program 1 Key 1 

Processor A, Section 2 - Program 1 Fill 1 

Processor B, Section 1 - Program 1 Bus A 

Processor B, Section 2 - Program 1 Bus B 

Processor C, Section 1 - Program 1 Key 2 

Processor C, Section 2 - Program 1 Fill 2 

Processor D, Section 1 - Program 1 Key 3 

Processor D, Section 2 - Program 1 Fill 3 

 

The MCL outputs are as follows for UHD (for all ‘UHD Input Routing Configurations’): 

 

Processor A, Section 1 - Program 1 Program Output 

Processor A, Section 2 - Program 1 Preset Output 

Processor B, Section 1 - Program 1 Clean 1 

Processor B, Section 2 - Program 1 Clean 2 

Processor C, Section 1 - Program 1 Clean 3 

Processor C, Section 2 - Program 1 Clean 4 

Processor D, Section 1 - Program 1 Clean 5 

Processor D, Section 2 - Program 1 Clean 6 
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MCL and ADC 
Note: This appendix is draft content. 

SNP-MCL can be controlled using ADC Automation. 

SNP-MCL communicates with the ADC Automation System over a TCP socket. TCP port numbers are as 
follows for a processor set to the Master Control Lite personality:  

Processor Port 

Processor A 31000 

Processor A 31001 (second path when in DSK Mode) 

Processor B 31002 

Processor B 31003 (second path when in DSK Mode) 

Processor C 31004 

Processor C 31005 (second path when in DSK Mode) 

Processor D 31006 

Processor D 31007 (second path when in DSK Mode) 

ADC Automation communicates with each MCL Playout Channel separately. The MCL Hardware panel 
(see MCL Hardware Panel (on page 489)) can control a single or multiple Playout Channels at the same 
time, as a Playout Group. 

In This Appendix 

Connecting ADC Automation to SNP-MCL ............................................. 531 
Keyer Control ......................................................................................... 531 
Logo IDs .................................................................................................. 531 
Using External Keys ................................................................................ 532 
DSK-Mode - Subscription support .......................................................... 534 
DSK-Mode - Upstream Router Control .................................................. 534 
DSK-Mode - Dual Channel Support ........................................................ 534 

 
 

Appendix B 
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Connecting ADC Automation to SNP-MCL 
The Moxa #NP6650-32 TCP/IP-to-RS-422 Converter is recommended to connect ADC Automation to 
SNP-MCL. If you currently have an ADC Automation System with internal serial connections, you do not 
necessarily need the Moxa device. A device that supports RS-422 to TCP Client would suffice. 

To configure the Moxa device (to make the RS-422 serial ports available to the ADC Device Server), see 
the MOXA ADC Virtualization User Note (part of the SNP 2.2 doc set).  On the Moxa device, it is 
recommended using higher port numbers, 25 to 32, for IP client ports to convert between TCP and RS-
422. 
 

Keyer Control 
The MCL Personality can only up to 4 keyers. For Automation, the Keyers are enumerated as 3, 4, 5, 6.  

Depending upon configuration, they can be used as an external key or an internal key with graphic. ADC 
sends specific commands based on the keyer selected. 

Keyer commands are issued by using a bit map. The table below illustrates the relationship in the 
protocol bit map to the key # in the MCL Personality.  

<Keyer> Keyer Select (unsigned byte) MCL Key 

Bit 0 Keyer 1 not used 

Bit 1 Keyer 2 not used 

Bit 2 Keyer 3 Key 1 

Bit 3 Keyer 4 Key 2 

Bit 4 Sqeezeback not used 

Bit 5 Keyer 5 Key 3 

Bit 6 Keyer 6 Key 4 

Bit 7 Reserved not used 

 
 

Logo IDs 
If an invalid Logo ID is used, ADC automation sends "LOGO_SELECT 255" as pat of the message string.  
Ensure you do not: 

• Define a logo with ID 255  

• Leave the logo ID undefined 

• Use ID 0 or below 
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Using External Keys 
Keyers 1 and 2 normally control external keyers. However, the  KEY MOD command, returns a NAK, 
therefore no further settings are available.  

To us an external key in an ADC playlist, manually set the Keyer settings in the MCL GUI, ensuring the 
keyer is set to type External. 

 

In the ADC Playlist, set the keyer number (3,4,6,7), but do not set the logo number.  The keyer will turn 
on/off only with the last settings used.  See the example below.  

 

Line # in Event Field Event Description 

2 Key 1, if set as the above example,  will put the external key 1 "On Air" 10 
seconds (as per the "Time" field) after Event 1 starts,  It will stay on for 10 
seconds as per the "Dur" field.  

4 Key 2, if set similar to the above example,  will put the external key 2 "On Air" 
10 seconds (as per the "Time" field) after Event 3 starts,  It will stay on for 10 
seconds as per the "Dur" field.   

6 Key 3, if set similar to the above example,  will put the external key 3 "On Air" 
10 seconds (as per the "Time" field) after Event 5 starts,  It will stay on for 10 
seconds as per the "Dur" field.   
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Line # in Event Field Event Description 

8 Key 4, if set similar to the above example,  will put the external key 4 "On Air" 
10 seconds (as per the "Time" field) after Event 7 starts,  It will stay on for 10 
seconds as per the "Dur" field.  

10 Key 1, if set as the above example,  will put the external key 1 "On Air" 10 
seconds (as per the "Time" field) after Event 9 starts,  It will stay on for 10 
seconds as per the "Dur" field.   

12 Key 1, will be loaded with Logo ID "7". and will be put "On Air" 10 seconds (as 
per the "Time" field) after Event 11 starts,  It will stay on for 10 seconds as per 
the "Dur" field.  

14 Key 1, will retain the last information. In this case it is still loaded with Logo ID 
"7". and will be put "On Air" 10 seconds (as per the "Time" field) after Event 
13 starts,  It will stay on for 10 seconds as per the "Dur" field.   

• The keyer retains the last settings. Only the logo number can be changed. To play an external key 
after this, manually set the keyer back to External.  

• While Keyers support external audio via the fill channel in manual mode, the keyer on/off command 
via automation only supports video fill/key video. Audio from the fill source will not be put on air.   

Note, this is different than "Audio Over" which takes it's sources the Key via the keyer Alpha's audio. 

• The SNP Automation Protocol returns a <NAK> for invalid logo IDs. ADC turns on the keyer but  with 
previously loaded logo.  

• Non-standard Logo IDs will not be displayed in the Logo dropdown in the GUI, and will return 
<NAK>. 
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DSK-Mode - Subscription support 
ADC automation does not support the subscribe function.  The last tab in the ADC configuration tool for 
IconMaster MCS has a setting for IconMaster or IconKey DSK. The latter disables a function that tells 
automation to ignore manually controlled keyers. This functionality requires the subscription command 
such that automaton is aware of the manual keyer changes.  

 
 

DSK-Mode - Upstream Router Control 
The original DSL-3901 is a standalone device that does not have upstream router control. The ADC user 
notes indicate this along with alternate suggestions.  For backward compatibility with the DSK-3901,  the 
upstream router control via automation has been disabled,  Manual control of the upstream inputs  can 
be performed via the MCL (DSK Mode) GUI.   
 

DSK-Mode - Dual Channel Support 
The DSK-3901 supports two channels but via CCS Control. While using the IconMaster protocol, the B 
Channel is utilized still as a PST for setting up the keyers. The DSK-3901 has only one serial port for 
external automation. The MCL/DSK combination through the multiple TCP/IP Port assignment, can have 
automation control of Channel  A and/or B  independently.  
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Servicing 
Note: The original SNP-GW-3GX32 chassis has been retired from sale.  The metal shell and front panel 
assembly and power supplies have been superseded entirely by the SNP-GW-3Gx32-HS-QF chassis, now 
sold under the SNP-PLATFORM-4A part number (see Orderable Part Numbers (on page 35)). The revised 
chassis features hot-swappable power supplies and higher-performance fans.  In addition, all SNP main 
boards (regardless of chassis) shipped after November 2019 have been fitted with additional airflow-
guides on the main circuit board in order to improve the operating temperature environment on-board.   

While the unit is mounted in the rack and fully cabled, you can swap out the power supplies, front panel, 
or the primary electronics assembly (main board). Procedures for switching main PCB assembly and 
front panel and fan bracket assemblies are the same for both frames.  

Note: Except for replacing the power supply in an SNP-GW-3GX32-HS-QF frame with hot swappable 
power supplies, all these tasks must be completed with the unit off and power cords disconnected from 
the frame.  

 

Customer-Replaceable Parts 

Front Panel Assemblies 

SNP-FNPL-ASSY SNP-GW-3GX32 frames 
Front Panel Assembly (on page 538) 

SNP-FNPL-HS-QF SNP-GW-3GX32-HS-QF  
Front Panel Assembly (on page 538)  

SNP-FPNL-HS-HQF            Spare Front Panel with Variable Speed Fans (Field Replaceable) 

PCB Assemblies 

SNP-MAIN-PCB-ASSY SNP-GW-3GX32 and SNP-GW-3GX32-HS-QF frames 
Main PCB Assembly (SNP-MAIN-PCB-ASSY)  (on page 543) 

SNP-MAIN-PCB-ASSY       Spare Main PCB Assembly (Field Replaceable) 

Power Supplies 

SNP-350W-ACPS-ASSY SNP-GW-3GX32 frames 
Redundant PSU Assembly (Field-Replaceable) (SNP-350W-ACPS-ASSY) 
(on page 539) 

Appendix C 
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SNP-400W-ACPS-HS SNP-GW-3GX32-HS-QF frames  
Hot-Swappable Power Supply (SNP-GW-3GX32-HS-QF) (on page 540) 
(OmniPower. For use with SNP Classic and SNP-XL) 

SNP-400W-ACPS-HS SNP-GW-3GX32-HS-QF frames  
Hot-Swappable Power Supply (SNP-GW-3GX32-HS-QF) (on page 540) 
(Zippy Inc. For use with SNP-XL only) 

Fans 

SNP-SPARE-BBFAN SPARE FAN FOR SNP BB FPGA FIELD REPLACEMENT 
See Replacing the BB Fans on SNP-GW-3GX32-HS-QF (on page 557) 

SNP-SPARE-IPFAN            SPARE FAN FOR SNP IP FPGA FIELD REPLACEMENT 
See Replacing the IP Fan on SNP-GW-3GX32-HS-QF (on page 544) 

SNP-SPARE-FPFAN           SPARE FAN FOR SNP FRONTPANEL QF/HQF FIELD REPLACEMENT 

Air Guides 

SNP-AIR-GUIDE-KIT        SNP-GW-3GX32 & SNP-GW-3GX32-HS-QF 
Man PCB Air Guides to improve airflow (Field Upgrade Kit) 

SNP-HW-UPGRADE-KIT    SNP-AIR-GUIDE-KIT and Spare Front Panel with Variable Speed Fans 
(SNP-FPNL-HS-HQF) 

To remove and replace any of these hardware components, you will need a Phillips screwdriver with #2 
bit.  
 

Determining what Hardware you have  
• Front Panels (on page 537) 

• Redundant PSU Assembly (Field-Replaceable) (SNP-350W-ACPS-ASSY) (on page 539) 

• Hot-Swappable Power Supply (SNP-GW-3GX32-HS-QF) (on page 540) 

• Main PCB Assembly (SNP-MAIN-PCB-ASSY)  (on page 543) 
 

Hardware Feature Compatibility Notes 

All units which will run the “Production Multiviewer” personality, Quad-1080p-Conversion personality, 
or JPEG-XS personalities MUST be fitted with the airflow guides and the HS-QF fans in order to meet the 
thermal performance specifications quoted in the manual.  Prolonged operation of the new SNP 
features at elevated ambient temperatures, without the upgraded fans and airflow guides, can cause 
the FPGAs to run at elevated temperatures, cause FPGA over-temperature alarm assertions, and likely 
shorten the service life of the unit. 

In order to facilitate customers with older units to purchase and run the more recent Features (in 
addition to purchasing a license for the feature) we offer the following upgrade materials which can be 
installed on existing chassis. 
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Orderable Item Description  

SNP-FPNL-HS-HQF SNP Front Panel assembly with Variable 
Speed Fans (Field Replaceable) 

See Front Panel Assemblies 
section in Servicing (on page 535) 

SNP-AIR-GUIDE-KIT  Main PCB Air Guides for SNP-GW-3GX32 
& SNP-GW-3GX32-HS-QF to improve 
airflow (Field Upgrade Kit)  

See Air Guides section in 
Servicing (on page 535) 

 

SNP-HW-UPGRADE-KIT Includes SNP-AIR-GUIDE-KIT and an SNP-
FPNL-HS-HQF Front Panel assembly with 
HS-QF Variable Speed Fans  

See Air Guides section in 
Servicing (on page 535) 

 

Front Panels 

There are three kinds of front panels: 

Frame Front Panel Notes 

SNP-GW-3GX32 SNP-FPNL-ASSY Original 

SNP-GW-3GX32 SNP-GW-
3GX32-HS-QF 

SNP-FPNL-HS-HQF  

  

Front panel assembly with access door and 
quiet fans. Replaces the SNP-FPNL-HS-QF and 
adds air guides with higher maximum speed 
fans for improved cooling. 

SNP-GW-3GX32-HS-QF SNP-FPNL-HS-QF  

Front Panels SNP-FPNL-HS-QF and SNP-FPNL-HS-HQF look very similar. To determine which front panel 
you have and whether an upgrade is required, look on the right side of the front panel:  

 

A label indicates what panel your SNP has.  
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Front Panel Assembly 

The front panel unit is specific to the frame type, and includes the display, metalwork, and all four 
cooling fans. Individual parts of the front panel are not field-serviceable, but you can remove and 
replace the entire front panel.  

In SNP-GW-3GX32 frames, to replace either the Main PCB Assembly (SNP-MAIN-PCB-ASSY)  (on page 
543)or the Redundant PSU Assembly (Field-Replaceable) (SNP-350W-ACPS-ASSY) (on page 539), you 
must first power down the unit before removing the front panel assembly. 

In SNP-GW-3GX32-HS-QF frames, you only need to remove the front panel when replacing the Main 
PCB Assembly (SNP-MAIN-PCB-ASSY)  (on page 543). The hot swappable power supplies can be accessed 
separately. See Hot-Swappable Power Supply (SNP-GW-3GX32-HS-QF) (on page 540) for more 
information.  
 

Removing the Front Panel 

The front panel can be removed and replaced, for example if fans or lights fail on the panel.  

The instructions for removing both SNP-FPNL-ASSY for SNP-GW-3GX32 frames or SNP-FPNL-HS-QF for 
SNP-GW-3GX32-HS-QF frames are the same. The pictures below display the process using an SNP-FPNL-
ASSY and a SNP-GW-3GX32 frame.  

1. Turn OFF SNP power using the power switch on the left. 

Use a screwdriver to release the thumb screws at the left and right ends of the front panel.  

 

2. Gently slide the entire front panel away from the chassis.  
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Installing the Front Panel 

1. Gently slide the entire front panel onto the chassis.  

2. Use a screwdriver to replace the thumb screws at the left and right ends of the front panel.  

3. Power ON the SNP. 

Your SNP is ready to use.  
 

Redundant PSU Assembly (Field-Replaceable) (SNP-350W-
ACPS-ASSY) 

The Power supply assembly (SNP-350W-ACPS-ASSY) is located at the right end of the SNP.  

 
 

Removing the Power Supply Assembly 

Before removing the power supply assembly, you must remove the front panel of the SNP. See 
Removing the Front Panel (on page 538) for more information. It is not necessary to remove the top of 
the chassis to remove the power supply, meaning that you can replace the power supply while the 
entire unit remains in the rack.  

1. Unscrew the lock pin until it springs free (it is a captive screw so will not escape completely). 

2. Slide the safety lever to the left.  

3. Push the tip of the ejector lever and then pull first to release the handle, and then to remove the 
power supply from the chassis.  
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Installing the Power Supply 
1. Line the power supply up with the space provided and slide it gently in until it will not go any 

further.  

2. Push the ejector lever until it is flush with the power supply.  

3. Slide the safety lever to the right.  

4. Screw the safety lever with a screwdriver until it is "finger tight".  

Before returning your SNP to full operation, you must reattach the front panel. See Installing the Front 
Panel (on page 539) for more information.  
 

Hot-Swappable Power Supply (SNP-GW-3GX32-HS-QF) 

To remove and install the hot-swappable power supply (SNP-GW-3GX32-HS-QF), see the following 
topics:  

• Removing the Individual Hot-Swappable Power Supply (on page 540) 

• Installing the Hot-Swappable Power Supply (on page 542) 

Devices that contain hot-swappable power supplies have a front panel with release screws for the hot-
swappable power supplies. 

 

If your front panel does not have these screws, then you must remove your device from service before 
swapping out power supplies.  See Redundant PSU Assembly (Field-Replaceable) (SNP-350W-ACPS-ASSY) 
(on page 539).  
 

Removing the Individual Hot-Swappable Power Supply 

Without turning the device off, follow these steps:  

1. Determine which power supply needs replacement.  

This information is available in the SNP Manager. see Power Supply Status  (on page 366).  

Or you can look inside the front right of the SNP; the power supply that is running and functioning 
correctly will have two green lights in its upper right corner.  

2. Unscrew the two screws that hold the hot swappable power supply cover in place on unit front.  
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3. Slide the power supply cover away from the front of the SNP.  

 

4. Unplug only the power supply to be replaced.  

Power Supply A/B indicators are etched into the metal on the bottom of the frame on the front, and 
on the back; and both power supply cables are labeled.   

Ensure you are removing power from the malfunctioning power supply.  

 
5. Slide the power supply release latch to the left and while holding it in the released position use the 

handle at the bottom of the power supply to slide it from the SNP frame. 
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Installing the Hot-Swappable Power Supply 

With the SNP frame power supply access panel open, follow these steps:  

1. Slide the power supply into the empty space.  

 
2. Connect the power cord to the power supply. 

You can do this step before completely locking the power supply into place, or after. It might be 
easier to do it before.  

Note: When installing power supplies (especially if you have disconnected both power supplies) that 
the cables are labeled. It is very important that the correct cable be attached to each power supply. 
Power supply slot identification is etched into the metal of the frame on the front, and screened 
onto the back of the frame. If you do not connect the correct cable to the correct power supply, 
indicators in the SNP Manager will not provide correct power supply health information.  

 

3. Push the power supply the rest of the way into the device until the release latch snaps into place.  

4. Replace the power supply access panel cover.  

Ensure that the access panel cover is completely engaged, so the angled lips at the top and bottom hold 
the power cords in place. 
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Main PCB Assembly (SNP-MAIN-PCB-ASSY)  

The SNP main board assembly (SNP-MAIN-PCB-ASSY) fits snugly to the left of the power supply.  

 
 

Removing the Main PCB Assembly 

Before removing the main board, you must remove the front panel of the SNP. See Removing the Front 
Panel (on page 538) for more information. It is not necessary to remove the top of the chassis to remove 
the main board, meaning that you can service SNP while the entire unit is rack-mounted.  

1. Pressing both sides of the fly-over cable, evenly slide it away from the connector.  

Do not pull the fly-over cable cord.  

2. Park it straightened and out of the way.  

 

3. Turn the captive thumb screw to release the board from the chassis base. It will spring when 
released.  

4. Holding the ejectors at the left and right ends of the board, press the ends and then slide them first 
open 15-20 degrees and then slide the board out of the frame.  

 
 



Selenio™ Network Processor  Appendix C 

User Guide  Servicing 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 544 

 

Installing the Main PCB Assembly 
1. Line the main board up with the space provided and slide it gently in until it will not go any further.  

2. Push the plate below and to the right of the thumbscrew.  

3. Push the ejectors at the left and right of the board firmly and evenly until the board will go no 
further.  

4. Press the ejectors in so they are at a right angle to the frame and the clips at the ends are engaged.  

5. Tighten the thumb screw.  

6. Carefully replace the fly-over, lining it up to slide evenly into the connector. The fly-over cable 
housing has a label "TOP" to indicate the top of the connector. 

Before returning your SNP to full operation, you must reattach the front panel. See Installing the Front 
Panel (on page 539) for more information.  
 

Replacing the IP Fan on SNP-GW-3GX32-HS-QF 

SNP-SPARE-IPFAN Kit Contents 

Verify the contents of your kit: 

Item Part Number Description Packing Qty 

1  Replacement IP Fan Bag-A 1 

2  TIE WRAP W/MTG HOLE*NYLON*4.3"LONG*0.10" 
WIDE*NYONL*UL94V-0*WHITE*FOR #4/M2.5 
SCREW MTG 

Bag-A 1 

Removing the Front Panel 

Disassemble the Front Panel from the SNP Chassis by doing the following: 

1. Using a #2bit Phillips screwdriver, loosen the 2 captive screws shown below. 

2. Pull the front panel assembly forward and away from the Chassis as shown below  

3. Store in a safe location 
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Removing the Main Board 
1. Access and Remove the Main PCB.  

 

Ensure you complete the previous step (Removing the Front Panel (on page 544)) before this one.  

Note that you can service the SNP while the entire unit is rack mounted so you don't have to remove 
the top of the chassis to remove the Main PCB. 

2. Pressing both sides of the fly-over cable, evenly slide it away from the connector. Do not pull the fly-
over cable cord. 

 

3. Park the disconnected fly-over cable straightened and out of the way as shown below. 

 

4. Turn the thumb screw to release the PCB board PCB and tray from the chassis.  

5. The screw will spring when released. 
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Thumb Screw Locked Position Thumb Screw Unlocked Position 

6. Press the tabs at the end of Left Ejector handle and Right Ejector handle and rotate until the board is 
released and starts to slide 

 

 

Releasing Left Ejector Releasing Right Ejector 

  

Opening Left Ejector Opening Right Ejector 

 

Ejector Handles, Screws, and Flyover Cable in Chassis 
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7. Slide the Main board completely out of the chassis and place it on a work surface. 

 

8. Identify the defective IP Fan 
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Removing the Defective IP Fan 
1. After identifying the defective fan trace the cable from the fan and remove the connector socket 

from the main board. 

Note IP Fan cables have a strain relief attached to a standoff as shown. 

 

When replacing the IP Fan, following this method: 

▪ Hold the standoff with a Needle nose plier to prevent it from rotating and remove the screw 
that’s holding the TIE WRAP. 

▪ After installing the replacement fan, a new TIE WRAP supplied must be used and the screw 
reattached to the standoff.  

▪ Observe the orientation of the fan as you will need to reinstall with the same orientation.   
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2. Remove the four IP Fan Screws using M4 hex driver and save them for reusing 

 
 

Replacing the New Fan 
1. Align the replacement Fan in place of the removed Fan while observing the following: 

▪ With wires exiting in Bottom right corner 

▪ Label facing down 

▪ Fan Mounting holes align to the Heatsink holes 
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2. Tighten the Fan with the heatsink using the four screws that were removed (in Removing the Main 
Board (on page 546)) 

 

3. Reconnect the Fan Cable connector 

4. Install the new Tie Wrap 

After installing the replacement fan, a new TIE WRAP supplied must be used and the screw 
reattached to the standoff.  

 

Reinstalling the Main Board 
1. Make sure Main board is in lined up and parallel with the sliding track of chassis shown below and 

slide it in gently 

 

Figure 25: Sliding Track Positions 

   

Figure 26: Sliding the Main Board into the Chassis 
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2. Push on the tray lip (shown below) to slide the board all the way in, to the point where it starts to 
engage with the mating connectors at the back. You will feel some resistance when this starts to 
happen, and the ejector handles will move slightly forward 

 

Figure 27: Tray Lip 

 

Figure 28: Ejector Handle Positions 

3. Push the ejector handles at the left and right of the board firmly and evenly until the board will go 
no further 

   

Figure 29: Ejector Handle Closure Directions 

▪ At this point the ejector should be locked into place. You will hear a "click" when the ejector is 
fully locked. 
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▪ In the fully locked position, the Captive Thumb screw should align to the mounting hole on the 
chassis. 

 

Figure 30: Ejector Handles in an Engaged Position 

  

Figure 31: Ejector Handles in Disengaged and Engaged Positions 

4. Tighten the thumbscrew by turning clockwise. 

  

Figure 32: Tightening Thumb Screws 
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5. Carefully reconnect the Fly-over, lining it up to slide evenly into the connector. 

Note the Orientation of the Cable (“TOP” Label facing up) 

 

Figure 33: Reconnecting the Fly-over Cable 

 

Reinstalling the Front Panel 
1. Assemble the Front Panel to the SNP Chassis 

 

Figure 34: Sliding the front panel into the chassis 

2. Orient and slide the Front Panel Assembly as shown. Ensure the High-Speed Cable (Fly-over cable) 
does not interfere with other Front Panel components.  

3. Push the Front Panel Assembly until the blind mating pin engages as shown below. You should feel 
some resistance.  
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4. Give a firm push to mate the card edge connector 

 

Figure 35: Push the Front Panel back into the SNP Chassis 

5. Secure the Front Panel Assembly to the Main Chassis with a #2-bit Phillips screwdriver  

 

Figure 36: Secure the Front Panel with Screws 
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Figure 37: Completed Assembly 

6. This completes your IP Fan replacement is complete. Your SNP is ready to return to service. 
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Replacing the BB Fans on SNP-GW-3GX32-HS-QF 

SNP-SPARE-BBFAN Kit Contents 

Verify the contents of your kit: 

Item Part Number Description Packing Qty 

1  Replacement BB Fan Bag-A 1 

2  TIE WRAP W/MTG HOLE*NYLON*4.3"LONG*0.10" 
WIDE*NYONL*UL94V-0*WHITE*FOR #4/M2.5 
SCREW MTG 

Bag-A 1 

 

Removing the Front Panel 

Disassemble the Front Panel from the SNP Chassis by doing the following: 

1. Using a #2bit Phillips screwdriver, loosen the 2 captive screws shown below. 

2. Pull the front panel assembly forward and away from the Chassis as shown below  

3. Store in a safe location 

 



Selenio™ Network Processor  Appendix C 

User Guide  Servicing 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 558 
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Removing the Main Board 
1. Access and Remove the Main PCB.  

 

Ensure you complete the previous step (Removing the Front Panel (on page 557)) before this one.  

Note that you can service the SNP while the entire unit is rack mounted so you don't have to remove 
the top of the chassis to remove the Main PCB. 

2. Pressing both sides of the fly-over cable, evenly slide it away from the connector. Do not pull the fly-
over cable cord. 

 

3. Park the disconnected fly-over cable straightened and out of the way as shown below. 

 

4. Turn the thumb screw to release the PCB board PCB and tray from the chassis.  

5. The screw will spring when released. 
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Thumb Screw Locked Position Thumb Screw Unlocked Position 

6. Press the tabs at the end of Left Ejector handle and Right Ejector handle and rotate until the board is 
released and starts to slide 

 

 

Releasing Left Ejector Releasing Right Ejector 

  

Opening Left Ejector Opening Right Ejector 

 

Ejector Handles, Screws, and Flyover Cable in Chassis 



Selenio™ Network Processor  Appendix C 

User Guide  Servicing 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 561 

 

7. Slide the Main board completely out of the chassis and place it on a work surface. 
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8. Identify the defective Fan 
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Removing the Defective Fan 
1. Identify the defective fan 
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Note: Cable on BB fan 1 is secured with Tie wrap as shown below. 

 

2. If BB1 is to be replaced, then Remove the tie wrap. 

▪ Hold the standoff with a Needle nose plier to prevent it from rotating and remove the screw 
that’s holding the TIE WRAP. 

▪ Keep the screw for reinstallation later 
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3. After identifying the defective fan trace the cable from the fan and unplug the fan cable from the 
main board. 

 

 

4. Remove the 2 BB Fan Screws using # 2 Philips Screwdriver and save for reusing. 
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5. Remove the defective fan and discard. 

 
 

Replacing the New Fan 
1. Align the replacement Fan in place of the removed Fan while observing the following: 

▪ With wires exiting in Bottom right corner 

▪ Label facing down 

▪ Fan Mounting holes align to the Heatsink holes 
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2. Tighten the Fan with the heatsink using the four screws that were removed (in Removing the 
Defective Fan (on page 563)) 

 

3. Reconnect the Fan Cable connector 

Fan Connectors are polarized (will mate only in the correct orientation) 

 

4. Install the new Tie Wrap 

After installing the replacement fan, a new TIE WRAP supplied must be used and the screw 
reattached to the standoff using a Needle Nose plier.  
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Reinstalling the Main Board 
1. Make sure Main board is in lined up and parallel with the sliding track of chassis shown below and 

slide it in gently 

 

Figure 38: Sliding Track Positions 

   

Figure 39: Sliding the Main Board into the Chassis 

2. Push on the tray lip (shown below) to slide the board all the way in, to the point where it starts to 
engage with the mating connectors at the back. You will feel some resistance when this starts to 
happen, and the ejector handles will move slightly forward 

 

Figure 40: Tray Lip 
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Figure 41: Ejector Handle Positions 

3. Push the ejector handles at the left and right of the board firmly and evenly until the board will go 
no further 

   

Figure 42: Ejector Handle Closure Directions 

▪ At this point the ejector should be locked into place. You will hear a "click" when the ejector is 
fully locked. 

▪ In the fully locked position, the Captive Thumb screw should align to the mounting hole on the 
chassis. 

 

Figure 43: Ejector Handles in an Engaged Position 



Selenio™ Network Processor  Appendix C 

User Guide  Servicing 

 

© 2024 Imagine Communications Corp.          Proprietary and Confidential. April 2024 | Page 570 

 

 

  

Figure 44: Ejector Handles in Disengaged and Engaged Positions 

4. Tighten the thumbscrew by turning clockwise. 

  

Figure 45: Tightening Thumb Screws 

5. Carefully reconnect the Fly-over, lining it up to slide evenly into the connector. 
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Note the Orientation of the Cable (“TOP” Label facing up) 

 

Figure 46: Reconnecting the Fly-over Cable 

 

Re-installing the Front Panel 
1. Assemble the Front Panel to the SNP Chassis 

 

Figure 47: Sliding the front panel into the chassis 

2. Orient and slide the Front Panel Assembly as shown. Ensure the High-Speed Cable (Fly-over cable) 
does not interfere with other Front Panel components.  

3. Push the Front Panel Assembly until the blind mating pin engages as shown below. You should feel 
some resistance.  
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4. Give a firm push to mate the card edge connector 

 

Figure 48: Push the Front Panel back into the SNP Chassis 

5. Secure the Front Panel Assembly to the Main Chassis with a #2-bit Phillips screwdriver  

 

Figure 49: Secure the Front Panel with Screws 
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Figure 50: Completed Assembly 

6. This completes your BB Fan replacement is complete. Your SNP is ready to return to service. 
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Replacing the FP Fan on SNP-GW-3GX32-HS-QF 

SNP-SPARE-FP FAN Kit Contents 

Verify the contents of your kit: 

Item Part Number Description Packing Qty 

1 131-
100051Q00 

Replacement FP Fan Bag-A 1 

 

Removing the Front Panel 

Disassemble the Front Panel from the SNP Chassis by doing the following: 

1. Using a #2bit Phillips screwdriver, loosen the 2 captive screws shown below. 

2. Pull the front panel assembly forward and away from the Chassis as shown below  

3. Store in a safe location 
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Dissassemble the PSU Bay Cover 

Remove the PSU Bay Cover (159-100797Q00) from the Assembled Front Panel (159-100796Q00) and 
Fan Bracket (164-100741Q00), by loosening the two (2) thumb screws 

 
 

 

Dissassemble the Fan Bracket from the Front Panel 
1. Unplug Fan 2 header and Fan 3 header 

a. Disconnect Fan 2 wire plug to the top "Fan 2" header, and Fan 3 wire plug to the bottom "Fan 3" 
header on Front Panel board  

 

 

 

1. Dismantle the Front Panel and Fan Bracket assembly 

a. Remove the six (6) Black Flat Head Screws (4-40X3/16FHBK_Q) and separate Front Panel and 
Fan Bracket sub-assembly  
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a. Please keep this screw for later as it will be needed for reassembling the Front Panel 

b. The following figure shows the Metal Front Panel in transparent and the Fan Bracket in solid 
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Identify the Defective Fan and Replace 

Note: This instruction covers how to replace all 4 fans. However, after separating the front panel and fan 
bracket, you need to  remove only the respective defective Fan as shown. 

1. Unplug Fan 1 header and Fan 4 header 

a. Disconnect Fan 1 wire plug from the header on Front Panel Extender Board. Location shown in 
figure.   

a. Disconnect Fan 4 wire plug from the panel-mount connector. Location shown in figure. 

 

2. Disassemble Original Fans 

a. Unscrew the 4-40x1 ¼ pan head Fan screws (141-000025Q00, 4 per Fan) on the defective Fan(s) 
as needed. 

b. Save the removed screws for reattachment and Discard the removed Fans. 

 

3. Assemble replacement Fans 

a. In place of the removed Fan install the replacement Fan (131-100051Q00) as needed.  
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b. Orient the Fans (131-100051Q00) with the airflow towards the rear of the chassis (use molded 
arrow on fan body as guide). For Fan 1, 2, and 4, the wires exiting the right side, and for Fan 3, 
the wires need to exit the left side. Insert Fan 1 and Fan 2 into the opening of Fan Bracket. 
Mount each fan to the Fan Bracket with four (4) 4-40x1 ¼ Pan Head Fan Screws at all of the four 
(4) mounting holes.  

 

4. Plug Fan 1 header and Fan 4 header. 

a. Plug the Fan 1 wire to the header on Front Panel Extender Board  

b. Plug the Fan 4 wire to the panel-mount connector 

 

 
 

Reattach the Fan Bracket to the Front Panel 
1. Assemble Front panel and Fan Bracket sub assembly 

a. Orient Front Panel and Fan Bracket sub-assembly. Align the card edge connector on the back of 
the Front Panel Display (170-101720Q0x) with the card edge on the Front Panel Extender Board 
(770-101721Q0x), and push the two sub-assemblies together, ensure they are firmly mated. 
Secure the Fan Bracket (164-100741Q0x) to the Front Panel (159-100796Q0x) with six (6) Black 
Flat Head Screws (4-40X3/16FHBK_Q).  
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a. Metal Front Panel shown in transparent and Fan Bracket shown in solid 

 

2. Plug Fan 2 header and Fan 3 header 

a. Connect Fan 2 wire plug to the top "Fan 2" header, and Fan 3 wire plug to the bottom "Fan 3" 
header on Front Panel board  

 

 
 

Assemble PSU Bay Cover 

Orient/Insert the PSU Bay Cover (159-100797Q00) to the Assembled Front Panel (159-100796Q00) and 
Fan Bracket (164-100741Q00), tighten the two (2) thumb screws  
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Completed Front Panel Assembly Front View 

 

 

Completed Front Panel Assembly Rear View 
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Reinstall the Front Panel 
1. Assemble the Front Panel to the SNP Chassis 

 

Figure 51: Sliding the front panel into the chassis 

2. Orient and slide the Front Panel Assembly as shown. Ensure the High-Speed Cable (Fly-over cable) 
does not interfere with other Front Panel components.  

3. Push the Front Panel Assembly until the blind mating pin engages as shown below. You should feel 
some resistance.  

4. Give a firm push to mate the card edge connector 

 

Figure 52: Push the Front Panel back into the SNP Chassis 
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5. Secure the Front Panel Assembly to the Main Chassis with a #2-bit Phillips screwdriver  

 

Figure 53: Secure the Front Panel with Screws 

 

Figure 54: Completed Assembly 

6. This completes your FP Fan replacement. Your SNP is ready to return to service. 
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Laser Safety for Fiber Optic Back Modules 
WARNING! 
Use of controls, adjustments, and procedures other than those specified in this document may result in 
hazardous laser radiation exposure. 

Optical fiber telecommunication systems use semiconductor laser transmitters that emit infrared light 
that is normally not visible to the human eye. Although a conventional laser produces a small beam of 
light, the power density is very high, and it can damage your eyes. 

If a beam of laser light enters the eye, the eye magnifies and focuses the energy on the retina. The 
energy that reaches the retina can be as much as 100,000 times more than at the cornea and, as a 
result, it can burn the retina. 

Laser transmission products are classified in four major groups (Class 1, 2, 3, and 4), according to their 
emissions and potential for causing injury. Fiber optic transmitter modules in this series are designated 
Class 1. 
 

Precautions for Enclosed Systems 

In its normal operating mode, an optical fiber communication system is totally enclosed and presents no 
risk of eye injury. However, if the fiber optic cables that interconnect various components of an optical 
fiber disconnect or break, you may be exposed to laser emissions. Also, technicians may be exposed to 
laser emissions during installation and servicing. 

Unlike some other laser designs, semiconductor lasers have a highly divergent beam that decreases 
rapidly with distance. The greater the distance, the less energy will enter the eye, and the less potential 
risk for eye injury. 

WARNING! 
Eye damage may occur if an optical instrument such as a microscope, magnifying glass, or eye loupe is 
used to stare at the energized fiber end. 

Under normal operating conditions, optical fiber telecommunication systems are completely enclosed; 
nonetheless, observe the following precautions: 

• Do not stare into optical connectors or broken fibers. 

• Ensure technicians have satisfactorily completed an approved training course before performing 
installation or maintenance. 

• Ensure there are appropriate warning labels near the optical ports of the modules. 
 

Precautions for Unenclosed Systems 

During service, maintenance, or restoration, an optical fiber telecommunication system is considered 
unenclosed. Under these conditions, follow the practices described below. 
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CAUTION! 
Only authorized, trained personnel shall be permitted to do service, maintenance, and restoration. 

1. Avoid exposing the eye to emissions from unterminated, energized optical connectors at close 
distances. 

2. Ensure that only authorized, trained personnel use optical test equipment during installation or 
servicing. 

3. Turn off all laser sources before scanning a fiber with an optical test set. 

4. Keep all unauthorized personnel away from the immediate area of the optical fiber systems during 
installation and service. 

For guidance on the safe use of optical fiber communication systems in the workplace, consult ANSI 
Z136.2, American National Standard for Safe Use of Lasers in the U.S. or outside the U.S., IEC-60825, 
Part 2. 
 

Label 

The SNP is a Class 1 laser product when used with a fiber optic back module. 

 

Figure 55: Label for Class 1 Laser Products 

 

Inspecting and Cleaning Fiber Optic Connections 

When connecting fibers to a back module, ensure that you do not touch the end of the fiber, or allow it 
to become dirty. Small amounts of microscopic dust or other contaminants can seriously impair or 
disable a fiber optic network. If you touch the end of a fiber prior to connecting it to the back module, or 
otherwise allow it to become dirty, you must carefully inspect and clean the connection. 

This table lists some typical contaminants of a fiber optic connection. 

Table 1: Typical Contaminants 

Contaminant Comments 

Dust particle, 1 micron Can block up to 1% of the light transmission, creating a loss of 0.05 dB 

Dust particle, 9 microns Although microscopic, the particle can completely block the fiber core 

Human hair Typically 50 to 75 microns in diameter 

Oil Frequently caused by touching 

Film residues Can accumulate from vapors or smoke 

Powdery coatings Can be left behind after water or other solvents evaporate 
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Important Points 

• Before you begin cleaning, always inspect the fiber connections. 

• Inspect and clean both fiber ends every time you make a connection. 

• Keep a protective cap on unplugged fiber connectors. 

• Do not touch the end of a fiber. 

• Store unused protective caps in a clean resealable container, located nearby for easy access. 

• Do not reuse cleaning tissues or swabs. 

• Do not allow alcohol or another wet cleaning agent to dry on a fiber end. 

• Never touch the dispenser tip of an alcohol bottle or any clean portion of a tissue or swab. 

• Use care when handling the fiber; do not twist or pull. 

• Keep your cleaning fluids away from open flame or spark. 

The illustration shows the acceptable limits of defects in a fiber connection. 

 

Figure 56: Fiber Optic Cross-Section 

 

Inspection Procedure 

To inspect and clean the fibers, follow these steps: 

1. Ensure the fiber is not "live." 
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WARNING! 
Eye damage may occur if an optical instrument such as a microscope, magnifying glass, or eye loupe 
is used to stare at an energized fiber end. 

2. Inspect the fiber endface with a fiberscope. 

3. If the fiber endface is clean, return to the installation instructions; if the connector is dirty, proceed 
to the dry cleaning instructions below. 

 

Dry Cleaning Procedure 

If you are using cartridge- or pocket-style dry cleaning tools, follow the manufacturer’s directions. If you 
are using lint-free wipes, follow these steps: 

1. Fold the lint-free wipe four to eight times into a square, taking care to avoid touching the cleaning 
surface of the wipe. 

2. Lightly wipe the fiber tip in the central portion of the lint-free wipe. 

CAUTION: Do not scrub the fiber. Excessive rubbing will leave scratches. 

3. Repeat the wiping action on another clean section of the wipe or a new wipe. 

4. Inspect the connector again with the fiberscope. 

5. If the connection is clean, return to the installation steps; if the connector is still dirty, proceed to 
the wet cleaning instructions. 

 

Wet Cleaning Procedure 

Using 99.8% isopropyl alcohol and lint-free wipes, follow these steps to wet clean the fiber: 

1. Fold the wipe into a square, about 4 to 8 layers thick. 

2. Moisten one section of the lint-free wipe with one drop of 99.8% alcohol, ensuring that a portion of 
the wipe remains dry. 

3. Lightly wipe the fiber end in the alcohol-moistened portion of the lint-free wipe. 

4. Immediately repeat the wiping action on the dry section of the wipe, removing any residual alcohol. 

5. Inspect the fiber endface again, and if necessary, repeat the wet cleaning with another clean section 
of the lint-free wipe. 

CAUTION! 
Do not scrub the fiber. Excessive rubbing will leave scratches. 

6. Dry clean any remaining residue, and then inspect the connector again. 

7. If the contamination persists, repeat the dry and wet cleaning procedure until the endface is clean. 

If the fiber end still remains dirty after repeated cleaning attempts, call Customer Service for further 
instructions; if the fiber end is clean, return to the installation instructions. 
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